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Disclaimers 
All information disclosed in this document is protected by the copyrights of NEC. 
Copying or reproducing this document, in whole or in part, without the prior written approval of NEC is 
prohibited. 
The contents of this document are subject to change without notice. 
NEC assumes no responsibility for any technical or editorial errors or omissions that may exist in this 
document. 
NEC does not guarantee the accuracy, usefulness, or completeness of the content or any other 
information provided in this document. 
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Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:  

 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 
THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,  
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

http://www.apache.org/licenses/LICENSE-2.0.html�


 

 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. THE EFI SPECIFICATION AND ALL OTHER INFORMATION 
ON THIS WEB SITE ARE PROVIDED "AS IS" WITH NO WARRANTIES, AND ARE SUBJECT TO 
CHANGE WITHOUT NOTICE. 
You may not reverse-assemble, reverse-compile, or otherwise reverse-engineer any software 
provided solely in binary form. 
The foregoing license terms may be superseded or supplemented by additional specific license terms 
found in the file headers of files in the EFI Application Toolkit. 
GNU GENERAL PUBLIC LICENSE Version 2, June 1991 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA  
02110-1301 USA. 
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 
is not allowed. 
 
Preamble 
  The licenses for most software are designed to take away your freedom to share and change it.  
By contrast, the GNU General Public License is intended to guarantee your freedom to share and 
change free software--to make sure the software is free for all its users. This General Public License 
applies to most of the Free Software Foundation's software and to any other program whose authors 
commit to using it. (Some other Free Software Foundation software is covered by the GNU Library 
General Public License instead.) You can apply it to your programs, too. 
  When we speak of free software, we are referring to freedom, not price. Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free software 
(and charge for this service if you wish), that you receive source code or can get it if you want it, that 
you can change the software or use pieces of it in new free programs; and that you know you can do 
these things. 
  To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to 
ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you 
distribute copies of the software, or if you modify it. 
  For example, if you distribute copies of such a program, whether gratis or for a fee, you must give 
the recipients all the rights that you have. You must make sure that they, too, receive or can get the 
source code. And you must show them these terms so they know their rights. 
  We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which 
gives you legal permission to copy, distribute and/or modify the software. 
  Also, for each author's protection and ours, we want to make certain that everyone understands that 
there is no warranty for this free software. If the software is modified by someone else and passed on, 
we want its recipients to know that what they have is not the original, so that any problems introduced 
by others will not reflect on the original authors' reputations. 
  Finally, any free program is threatened constantly by software patents. We wish to avoid the danger 
that redistributors of a free program will individually obtain patent licenses, in effect making the 
program proprietary. To prevent this, we have made it clear that any patent must be licensed for 
everyone's free use or not licensed at all. 
  The precise terms and conditions for copying, distribution and modification follow. 
 
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION 
AND MODIFICATION 
0. This License applies to any program or other work which contains a notice placed by the copyright 
holder saying it may be distributed under the terms of this General Public License. The "Program", 
below, refers to any such program or work, and a "work based on the Program" means either the 
Program or any derivative work under copyright law: that is to say, a work containing the Program or a 
portion of it, either verbatim or with modifications and/or translated into another language.  
(Hereinafter, translation is included without limitation in the term "modification".) Each licensee is 
addressed as "you". 
Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope. The act of running the Program is not restricted, and the output from the Program is 



 

 
 

covered only if its contents constitute a work based on the Program (independent of having been 
made by running the Program). Whether that is true depends on what the Program does. 
 
1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 
medium, provided that you conspicuously and appropriately publish on each copy an appropriate 
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to 
the absence of any warranty; and give any other recipients of the Program a copy of this License 
along with the Program. 
You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee. 
 
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based 
on the Program, and copy and distribute such modifications or work under the terms of Section 1 
above, provided that you also meet all of these conditions:  
a) You must cause the modified files to carry prominent notices stating that you changed the files and 
the date of any change. 
b) You must cause any work that you distribute or publish, that in whole or in part contains or is 
derived from the  
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms 
of this License. 
c) If the modified program normally reads commands interactively when run, you must cause it, when 
started running for such interactive use in the most ordinary way, to print or display an announcement 
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that 
you provide a warranty) and that users may redistribute the program under these conditions, and 
telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but 
does not normally print such an announcement, your work based on the Program is not required to 
print an announcement.) 
 
These requirements apply to the modified work as a whole. If identifiable sections of that work are not 
derived from the Program, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them 
as separate works. But when you distribute the same sections as part of a whole which is a work 
based on the Program, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every part regardless 
of who wrote it. 
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by 
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works 
based on the Program. 
In addition, mere aggregation of another work not based on the Program with the Program (or with a 
work based on the Program) on a volume of a storage or distribution medium does not bring the other 
work under the scope of this License. 
 
3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 
executable form under the terms of Sections 1 and 2 above provided that you also do one of the 
following:  
a) Accompany it with the complete corresponding machine-readable source code, which must be 
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange; or, 
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge 
no more than your cost of physically performing source distribution, a complete machine-readable 
copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above 
on a medium customarily used for software interchange; or, 
c) Accompany it with the information you received as to the offer to distribute corresponding source 
code. (This alternative is allowed only for noncommercial distribution and only if you received the 
program in object code or executable form with such an offer, in accord with Subsection b above.) 
 
The source code for a work means the preferred form of the work for making modifications to it. For an 
executable work, complete source code means all the source code for all modules it contains, plus 



 

 

any associated interface definition files, plus the scripts used to control compilation and installation of 
the executable. However, as a special exception, the source code distributed need not include 
anything that is normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, unless that 
component itself accompanies the executable. 
If distribution of executable or object code is made by offering access to copy from a designated place, 
then offering equivalent access to copy the source code from the same place counts as distribution of 
the source code, even though third parties are not compelled to copy the source along with the object 
code. 
 
4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is 
void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so long 
as such parties remain in full compliance. 
 
5. You are not required to accept this License, since you have not signed it. However, nothing else 
grants you permission to modify or distribute the Program or its derivative works. These actions are 
prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program 
(or any work based on the Program), you indicate your acceptance of this License to do so, and all its 
terms and conditions for copying, distributing or modifying the Program or works based on it. 
 
6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the Program 
subject to these terms and conditions. You may not impose any further restrictions on the recipients' 
exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties 
to this License. 
 
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of 
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this 
License and any other pertinent obligations, then as a consequence you may not distribute the 
Program at all. For example, if a patent license would not permit royalty-free redistribution of the 
Program by all those who receive copies directly or indirectly through you, then the only way you could 
satisfy both it and this License would be to refrain entirely from distribution of the Program. 
If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply and the section as a whole is intended to apply in other 
circumstances. 
It is not the purpose of this section to induce you to infringe any patents or other property right claims 
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of 
the free software distribution system, which is implemented by public license practices. Many people 
have made generous contributions to the wide range of software distributed through that system in 
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is 
willing to distribute software through any other system and a licensee cannot impose that choice. 
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of 
this License. 
 
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Program under this License may 
add an explicit geographical distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded. In such case, this License incorporates the 
limitation as if written in the body of this License. 
 
9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns. 
Each version is given a distinguishing version number. If the Program specifies a version number of 
this License which applies to it and "any later version", you have the option of following the terms and 



 

 
 

conditions either of that version or of any later version published by the Free Software Foundation. If 
the Program does not specify a version number of this License, you may choose any version ever 
published by the Free Software Foundation. 
 
10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission. For software which is copyrighted by 
the Free Software Foundation, write to the Free Software Foundation; we sometimes make 
exceptions for this. Our decision will be guided by the two goals of preserving the free status of all 
derivatives of our free software and of promoting the sharing and reuse of software generally. 
 
NO WARRANTY 
  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO 
THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE 
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION. 
 
  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO 
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU 
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER 
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
 
END OF TERMS AND CONDITIONS 
How to Apply These Terms to Your New Programs 
  If you develop a new program, and you want it to be of the greatest possible use to the public, the 
best way to achieve this is to make it free software which everyone can redistribute and change under 
these terms. 
  To do so, attach the following notices to the program. It is safest to attach them to the start of each 
source file to most effectively convey the exclusion of warranty; and each file should have at least the 
"copyright" line and a pointer to where the full notice is found. 
    <one line to give the program's name and a brief idea of what it does.> 
 
    Copyright (C) <year> <name of author> 
    This program is free software; you can redistribute it and/or modify it under the terms of the GNU 
General Public License as published by the Free Software Foundation; either version 2 of the License, 
or (at your option) any later version. 
    This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; 
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR 
PURPOSE. See the GNU General Public License for more details. 
    You should have received a copy of the GNU General Public License along with this program; if 
not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 
USA 
 
Also add information on how to contact you by electronic and paper mail. 
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:  
    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with 
ABSOLUTELY NO WARRANTY; for details type 'show w'. This is free software, and you are welcome 
to redistribute it under certain conditions; type 'show c' for details. 
 



 

 

The hypothetical commands 'show w' and 'show c' should show the appropriate parts of the General 
Public License. Of course, the commands you use may be called something other than 'show w' and 
'show c'; they could even be mouse-clicks or menu items--whatever suits your program. 
You should also get your employer (if you work as a programmer) or your school, if any, to sign a 
"copyright disclaimer" for the program, if necessary. Here is a sample; alter the names:  
  Yoyodyne, Inc., hereby disclaims all copyright interest in the program' 
Gnomovision' (which makes passes at compilers) written by James Hacker. 
 
  <signature of Ty Coon>, 1 April 1989 
  Ty Coon, President of Vice 
 
This General Public License does not permit incorporating your program into proprietary programs.  
If your program is a subroutine library, you may consider it more useful to permit linking proprietary 
applications with the library. If this is what you want to do, use the GNU Library General Public 
License instead of this License. 
 
・ Copyright (c) 1989 The Regents of the University of California. 

All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:  
1. Redistributions of source code must retain the above copyright 

notice, this list of conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

3. All advertising materials mentioning features or use of this software 
must display the following acknowledgement:  
This product includes software developed by the University of 
California, Berkeley and its contributors. 

4. Neither the name of the University nor the names of its contributors 
may be used to endorse or promote products derived from this software 
without specific prior written permission. 

 
 THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ''AS IS'' AND 
 ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

 
• This is version 2004-May-22 of the Info-ZIP copyright and license. The definitive version of this 

document should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely. 
 
Copyright (c) 1990-2004 Info-ZIP. All rights reserved.  

For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of 
individuals:  
Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, 
Hunter Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, 
Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor 
Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, 
Kai Uwe Rommel, Steve Salisbury, Dave Smith, Christian Spieler, Antoine Verheijen, Paul 
von Behren, Rich Wales, Mike White  
This software is provided "as is," without warranty of any kind, express or implied. In no event 



 

 
 

shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or 
consequential damages arising out of the use of or inability to use this software.  
Permission is granted to anyone to use this software for any purpose, including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions:   
• Redistributions of source code must retain the above copyright notice, definition,   

disclaimer, and this list of conditions.  
 

• Redistributions in binary form (compiled executables) must reproduce the above  
copyright notice, definition, disclaimer, and this list of conditions in documentation and/or  
other materials provided with the distribution. The sole exception to this condition is  
redistribution of a standard UnZipSFX binary (including SFXWiz) as part of a  
self-extracting archive; that is permitted without inclusion of this license, as long as the  
normal SFX banner has not been removed from the binary or disabled.  

• Altered versions--including, but not limited to, ports to new operating systems, existing  
ports with new graphical interfaces, and dynamic, shared, or static library versions--must  
be plainly marked as such and must not be misrepresented as being the original source. 
Such altered versions also must not be misrepresented as being Info-ZIP  
releases--including, but not limited to, labeling of the altered versions with the names  
"Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations),  
"Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such  
altered versions are further prohibited from misrepresentative use of the Zip-Bugs or  
Info-ZIP e-mail addresses or of the Info-ZIP URL(s).  

• Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ,"  
"Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases. 

 
・ This product includes Zip which has been modified from Pocket Zip (Info-Zip). 
・ This product includes JRE (Java Runtime Environment) software distributed free-of-charge from 

Oracle Corporation, and software (Xerces-C++ Version 3.1.1) distributed free-of-charge from 
Apache Software Foundation. We ask that you use these products upon agreement with the 
respective license agreements. For details regarding copyrights and proprietary rights, refer to the 
license files below:  
JRE:  <Directory in which JRE is installed>: \LICENSE 
Xerces-C++ Version 3.1.1: The Xerces-C++ Version 3.1.1 is available in both source distribution 
and binary distribution. Xerces-C++ is made available under the Apache Software License, 
Version 2.0.  
http://www.apache.org/licenses/LICENSE-2.0.html 

・ This product includes software distributed for free (log4net for .NET Framework 2.0 Version 
1.2.10.0) by Apache Software Foundation.  
For details regarding copyrights and proprietary rights, refer to the files below:  
  For SSC product,  <Install media>:  \DPM\License\log4net for .NET Framework 2.0\  
  For DPM unbundled product,  <Install media>:  \License\log4net for .NET Framework 2.0\   

・ This product includes software distributed for free (Spring.Net Core functionality Version 
1.2.0.20313) by SpringSource. 
For details regarding copyrights and proprietary rights, refer to the files below:  
  For SSC product,  <Install media>:  \DPM\License\Spring.Net Core functionality\  
  For DPM unbundled product,  <Install media>:  \License\Spring.Net Core functionality\   

 
・ This product includes software distributed for free (Prototype JavaScript framework, version 

1.6.0.3) by Prototype Core Team. 
For details regarding copyrights and proprietary rights, refer to the below:  
========================================================================== 
 Prototype is freely distributable under the terms of an MIT-style license. 
 For details, see the Prototype web site:  http://www.prototypejs.org/ 
========================================================================== 

・ This product includes software distributed for free (Tree Container Library(TCL) Version 5.0.6) by 
Datasoft Solutions.  

 



 

 

･  It was downloaded from 
 ftp://ftp.ie.u-ryukyu.ac.jp/pub/software/kono/nkf171.shar 
 
 ftp://ftp.iij.ad.jp/pub/NetNews/fj.sources/volume98/Nov/981108.01.Z 
   Subject:  nkf 1.7 (Network Kanji Filter w/Perl Extenstion) 
   Message-ID:  <29544.910459296@rananim.ie.u-ryukyu.ac.jp> 
 
Copyright:  
 
Copyright (C) 1987, Fujitsu LTD. (Itaru ICHIKAWA) 
  (E-Mail Address:  ichikawa@flab.fujitsu.co.jp) 
Copyright (C) 1996,1998 Kono, COW 

  (E-Mail Address:  kono@ie.u-ryukyu.ac.jp) 
 

Everyone is permitted to do anything on this program  
including copying, modifying, improving. 
as long as you don't try to pretend that you wrote it. 
i.e., the above copyright notice has to appear in all copies. 
You don't have to ask before copying or publishing. 

THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE. 
 
･   ORIGINAL LICENSE:  

This software is 
(c) Copyright 1992 by Panagiotis Tsirigotis 

 
The author (Panagiotis Tsirigotis) grants permission to use, copy, 
and distribute this software and its documentation for any purpose  
and without fee, provided that the above copyright notice extant in 
files in this distribution is not removed from files included in any 
redistribution and that this copyright notice is also included in any  
redistribution. 

 
Modifications to this software may be distributed, either by distributing 

the modified software or by distributing patches to the original software, 
under the following additional terms:  

 
1. The version number will be modified as follows:  

          a. The first 3 components of the version number 
(i.e <number>.<number>.<number>) will remain unchanged. 

b. A new component will be appended to the version number to indicate 
            the modification level. The form of this component is up to the  
            author of the modifications. 
 

2. The author of the modifications will include his/her name by appending it  
  along with the new version number to this file and will be responsible for  
  any wrong behavior of the modified software. 

 
The author makes no representations about the suitability of this software for any purpose. It is 
provided "as is" without any express or implied warranty. 
 
Modifications:  
Version:  2.1.8.7-current 
Copyright 1998-2001 by Rob Braun 
 
Sensor Addition 
Version:  2.1.8.9pre14a 
Copyright 2001 by Steve Grubb 
 
This is an excerpt from an email I received from the original author, allowing 



 

 
 

xinetd as maintained by me, to use the higher version numbers:  
 
 

I appreciate your maintaining the version string guidelines as specified 
in the copyright. But I did not mean them to last as long as they did. 
 

So, if you want, you may use any 2.N.* (N >= 3) version string for future 
xinetd versions that you release. Note that I am excluding the 2.2.* line; 
using that would only create confusion. Naming the next release 2.3.0 
would put to rest the confusion about 2.2.1 and 2.1.8.*. 
 

• Some icons used in this program are based on Silk Icons released by Mark James under a 
Creative Commons Attribution 2.5 License. Visit http://www.famfamfam.com/lab/icons/silk/ for 
more details. 

• The Cygwin DLL and utilities are Copyright © 2000, 2001, 2002, 2003, 2004, 2005, 2006, 2007, 
2008, 2009, 2010, 2011 Red Hat, Inc. Other packages have other copyrights.  
UNIX® is a registered trademark of the Open Group in the United States and other countries.  

• Copyright (C) 2001-2003 Hewlett-Packard Co.Contributed by Stephane Eranian 
eranian@hpl.hp.com 

• Copyright 1994-2008 H. Peter Anvin - All Rights Reserved 
• All other company names and product names mentioned in this document are trademarks or 

registered trademarks of the respective companies. 
• Each source and binary file stored on the install media is affiliated with the respective source and 

binary file license. 
 



 

 
xi 

 

Contents 
Introduction .......................................................................................................................... xvii 

Target Audience and Purpose .............................................................................................................. xvii 
Document Structure .............................................................................................................................. xvii 
DeploymentManager Manual Organization .......................................................................................... xviii 
Documentation Guidelines .................................................................................................................... xix 

1. Web Console Overview ................................................................................................ 3 
1.1. Web Console Overview ........................................................................................................... 4 

1.1.1. Login Window ..................................................................................................................................... 7 
1.1.2. Account ............................................................................................................................................... 8 

2. Management .................................................................................................................. 11 
2.1. Management View ................................................................................................................... 12 
2.2. User Icon .................................................................................................................................. 13 
2.3. User List ................................................................................................................................... 14 

2.3.1. Add User ............................................................................................................................................. 15 
2.3.2. Edit User ............................................................................................................................................. 16 
2.3.3. Delete User ......................................................................................................................................... 18 

2.4. "License" Icon .......................................................................................................................... 19 
2.5. Registration License List .......................................................................................................... 20 

2.5.1. Add License Key ................................................................................................................................. 20 
2.5.2. Delete License Key ............................................................................................................................. 21 

2.6. "DPM Server" Icon ................................................................................................................... 22 
2.7. Base Information about the Management Server .................................................................... 23 

2.7.1. Detail Setting ...................................................................................................................................... 24 
2.7.1.1. "General" Tab ..................................................................................................................................... 25 
2.7.1.2. "Scenario" Tab .................................................................................................................................... 28 
2.7.1.3. "Network" Tab ..................................................................................................................................... 30 
2.7.1.4. "DHCP Server" Tab ............................................................................................................................ 32 
2.7.2. Guard Parameter Setting .................................................................................................................... 33 
2.7.3. Package Download Setting ................................................................................................................. 35 
2.7.3.1. Add Package Web Server ................................................................................................................... 38 
2.7.3.2. Edit Package Web Server ................................................................................................................... 40 
2.7.3.3. Delete a Package Web Server ............................................................................................................ 42 
2.7.3.4. Base Information about the Package Web Server .............................................................................. 44 
2.7.4. Automatic Update Setting ................................................................................................................... 45 

3. Operations ..................................................................................................................... 49 
3.1. "Operations" View .................................................................................................................... 50 
3.2. "Resource" Icon ....................................................................................................................... 51 
3.3. "Machine" Icon ......................................................................................................................... 53 

3.3.1. Add Machine Group ............................................................................................................................ 54 
3.3.2. Delete Machine Group ........................................................................................................................ 57 
3.3.3. Import Machine Data........................................................................................................................... 59 
3.3.4. Export Machine Data .......................................................................................................................... 62 

3.4. "Group" Icon ............................................................................................................................. 63 
3.5. Machine Group Details ............................................................................................................ 64 

3.5.1. Edit Machine Group ............................................................................................................................ 67 
3.5.2. Delete Machine Group ........................................................................................................................ 70 
3.5.3. Add Sub Group ................................................................................................................................... 71 
3.5.4. Delete Subgroup ................................................................................................................................. 75 
3.5.5. Add Managed Machine ....................................................................................................................... 76 
3.5.6. Move Machine .................................................................................................................................... 82 
3.5.7. Delete Machine ................................................................................................................................... 84 
3.5.8. Batch Network Setting ........................................................................................................................ 85 
3.5.9. Batch Set Automatic Update Time ...................................................................................................... 87 

3.6. Menu Operations for a Group .................................................................................................. 90 



 

 
xii 

3.6.1. Batch Execution ................................................................................................................................... 90 
3.7. Managed Machine Details ........................................................................................................ 93 

3.7.1. Machine Status .................................................................................................................................... 96 
3.7.1.1. HotFix/Application List ......................................................................................................................... 99 
3.7.1.2. Package Applying Status (Package List) ............................................................................................. 100 
3.7.2. Edit Managed Machine ........................................................................................................................ 102 
3.7.3. Move Machine ..................................................................................................................................... 109 
3.7.4. Delete Machine .................................................................................................................................... 109 

3.8. Menu Operations to a Machine ................................................................................................ 110 
3.8.1. Power On ............................................................................................................................................. 110 
3.8.2. Shutdown............................................................................................................................................. 111 
3.8.3. Assign Scenario ................................................................................................................................... 112 
3.8.4. Delete Scenario Assignment ............................................................................................................... 117 
3.8.5. Power Management Schedule ............................................................................................................. 118 
3.8.6. Execute Scenario ................................................................................................................................ 121 
3.8.7. Interrupt Scenario Execution ............................................................................................................... 123 
3.8.8. Error Cancellation ................................................................................................................................ 124 
3.8.9. Interrupt Cancellation .......................................................................................................................... 125 

3.9. "New Machine" Icon ................................................................................................................. 126 
3.9.1. New Machine Detailed Information ...................................................................................................... 127 
3.9.2. Add New Machine ............................................................................................................................... 128 
3.9.3. Delete New Machine ........................................................................................................................... 135 

3.10. "Scenario" Icon ......................................................................................................................... 136 
3.10.1. Add Scenario Group ............................................................................................................................ 137 
3.10.2. Delete Scenario Group ........................................................................................................................ 138 

3.11. "Scenario Group" Icon .............................................................................................................. 139 
3.12. Scenario Group Details ............................................................................................................ 140 

3.12.1. Edit Scenario Group ............................................................................................................................ 142 
3.12.2. Delete Scenario Group ........................................................................................................................ 143 
3.12.3. Add Sub-scenario Group ..................................................................................................................... 143 
3.12.4. Delete Sub-scenario Group ................................................................................................................. 144 
3.12.5. Add Scenario ....................................................................................................................................... 145 
3.12.6. Move Scenario ..................................................................................................................................... 145 
3.12.7. Copy Scenario ..................................................................................................................................... 147 
3.12.8. Delete Scenario ................................................................................................................................... 149 
3.12.9. Assign scenario ................................................................................................................................... 149 

3.13. Add Scenario ............................................................................................................................ 151 
3.13.1. "HW Settings" Tab ............................................................................................................................... 152 
3.13.2. "OS" Tab .............................................................................................................................................. 153 
3.13.3. "Package" Tab ..................................................................................................................................... 154 
3.13.4. "Backup/Restore" Tab ......................................................................................................................... 158 
3.13.5. "Option" Tab ........................................................................................................................................ 168 

3.14. Menu Operations for a Scenario .............................................................................................. 170 
3.14.1. Edit Scenario ....................................................................................................................................... 170 
3.14.2. Copy Scenario ..................................................................................................................................... 171 
3.14.3. Move Scenario ..................................................................................................................................... 171 
3.14.4. Delete Scenario ................................................................................................................................... 171 
3.14.5. Assign Scenario ................................................................................................................................... 171 

3.15. Scenario Detail Information ...................................................................................................... 172 
3.16. "Image" Icon ............................................................................................................................. 176 
3.17. Image Detailed Information ...................................................................................................... 177 

3.17.1. Package Image Detailed Information ................................................................................................... 180 
3.17.2. Package Applying Status (Machine List) ............................................................................................. 182 
3.17.3. Backup Image Detailed Information ..................................................................................................... 184 

4. Monitor ........................................................................................................................... 187 
4.1. "Monitor" view ........................................................................................................................... 188 
4.2. "Scenario Execution List" Icon ................................................................................................. 189 
4.3. Scenario Execution List ............................................................................................................ 190 

4.3.1. Status Batch Clear ............................................................................................................................... 192 
4.3.2. Backup/Restore Execute List ............................................................................................................... 193 
4.3.3. Run Immediately .................................................................................................................................. 197 
4.3.4. Cancel Scenario .................................................................................................................................. 197 



 

 
xiii 

4.4. "Scenario Execution Results List" Icon .................................................................................... 198 
4.5. Scenario Execution Results List Details .................................................................................. 199 

4.5.1. Save in CSV Format ........................................................................................................................... 201 
4.5.2. Delete Log .......................................................................................................................................... 201 

4.6. "Automatic Update Results List" Icon ...................................................................................... 202 
4.7. Automatic Update Results List Details ..................................................................................... 203 

4.7.1. Automatic Update Results Details Display .......................................................................................... 205 
4.7.2. Maximum Number of Logs Settings .................................................................................................... 205 
4.7.3. Save in CSV Format ........................................................................................................................... 207 
4.7.4. Delete Log .......................................................................................................................................... 207 

5. Image Builder ................................................................................................................ 211 
5.1. Connection Settings ................................................................................................................. 212 
5.2. Creating a Floppy Disk Image .................................................................................................. 213 
5.3. Registering an Operating System ............................................................................................ 216 
5.4. Creating a Setup Parameter File ............................................................................................. 219 

5.4.1. Creating a Disk Duplication Data File (Windows) ............................................................................... 219 
5.4.1.1. Creating a Disk Duplication Data File (Windows Server 2000/Windows Server 

2003/Windows XP) ............................................................................................................................. 219 
5.4.1.2. Creating a Disk Duplication Data File (Windows Server 2008/Windows Vista/Windows 7) ................ 243 
5.4.2. Batch Creation of Disk Duplication Data Files (Windows) ................................................................... 264 
5.4.3. Creating a Disk Duplication Parameter File (Linux) ............................................................................ 272 
5.4.4. Batch Creation of Disk Duplication Parameter File (Linux) ................................................................. 291 
5.4.5. Creating a Parameter File for an OS Clear Installation (Linux) ........................................................... 297 
5.4.6. Batch Creation of Parameter File for OS Clear Installation (Linux) ..................................................... 335 

5.5. Package Registration/Modification........................................................................................... 342 
5.5.1. Create Windows Package ................................................................................................................... 343 
5.5.2. Modify Windows Package ................................................................................................................... 358 
5.5.3. Create Linux Package......................................................................................................................... 359 
5.5.4. Modify Linux Package ......................................................................................................................... 363 
5.5.5. Package Creation/Registration ........................................................................................................... 365 

5.6. Delete Package ........................................................................................................................ 366 
5.7. Batch Registration .................................................................................................................... 368 
5.8. License Agreement Display Settings ....................................................................................... 369 

6. PackageDescriber ......................................................................................................... 371 
6.1. Initial settings: Set Environment ............................................................................................... 372 
6.2. Create Package ....................................................................................................................... 377 

6.2.1. Basic Information ................................................................................................................................ 377 
6.2.2. Execution Setting Information ............................................................................................................. 383 
6.2.3. Applicable OS and Language Information .......................................................................................... 386 
6.2.4. Dependency Information ..................................................................................................................... 387 
6.2.5. ID Information ..................................................................................................................................... 397 

6.3. Modify/Delete Package ............................................................................................................ 403 
6.4. Registration and Deletion in Package Web Server .................................................................. 406 
6.5. Online Update .......................................................................................................................... 409 

7. Other Tools .................................................................................................................... 411 
7.1. Port Opening Tool .................................................................................................................... 412 

7.1.1. Port Number Setting ........................................................................................................................... 412 
7.1.2. Executing the Tool on Each Machine ................................................................................................. 414 

7.2. Disk Configuration Check Tool ................................................................................................ 415 
7.2.1. Creating a Disk Configuration Check Scenario ................................................................................... 415 
7.2.2. Assigning a Disk Configuration Check Scenario ................................................................................. 416 
7.2.3. Executing a Disk Configuration Check Scenario ................................................................................. 417 
7.2.4. Checking the Disk Configuration Check Scenario Execution Results ................................................. 418 
7.2.5. Checking the Disk Number (Partition Number) by DiskViewer ........................................................... 419 

7.3. Automatic Update Status Display Tool .................................................................................... 424 
7.3.1. Client Setting Tool .............................................................................................................................. 425 
7.3.2. About DeploymentManager ................................................................................................................ 425 

7.4. Scenario Option Setting Tool ................................................................................................... 426 



 

 
xiv 

7.5. Backup Image File Verification Tool......................................................................................... 427 
8. Command Reference ..................................................................................................... 431 

8.1. Operation from the Command Line .......................................................................................... 432 
8.1.1. DPM Server Display ............................................................................................................................ 435 
8.1.2. Display Managed Machine List and Managed Machine Details........................................................... 435 
8.1.3. Display Scenario List ........................................................................................................................... 436 
8.1.4. Power On ............................................................................................................................................. 436 
8.1.5. ShutDown ............................................................................................................................................ 437 
8.1.6. Assign Scenario/Remove Scenario Assignment .................................................................................. 438 
8.1.7. Execute Scenario ................................................................................................................................ 438 
8.1.8. Interrupt Scenario Execution ............................................................................................................... 439 
8.1.9. Display Scenario Execution Status ...................................................................................................... 439 
8.1.10. Status Clear ......................................................................................................................................... 440 
8.1.11. Managed Machine Registration ........................................................................................................... 440 
8.1.12. Delete Managed Machine .................................................................................................................... 441 
8.1.13. Help ..................................................................................................................................................... 441 

9. Maintenance .................................................................................................................. 445 
9.1. Changing the Management Server IP Address ....................................................................... 446 
9.2. Changing a Managed Machine's IP Address ........................................................................... 449 
9.3. Notes for Machines Mounted with Multiple LAN Cards ........................................................... 450 
9.4. Device and Storage Notes ....................................................................................................... 451 

9.4.1. Compatibility Module ........................................................................................................................... 451 
9.4.2. HDD Multi-Vendor Support .................................................................................................................. 451 

9.5. Data Backup Plan .................................................................................................................... 453 
9.5.1. Backing up Data of DeploymentManager When Configuring the Initial Setup or Changing the 

Configuration ....................................................................................................................................... 453 
9.5.2. Backing Up the Updated Data of DeploymentManager ....................................................................... 454 
9.5.3. Restoring Backup Data ........................................................................................................................ 456 

10. Precautions .................................................................................................................... 459 
10.1. Web Console ............................................................................................................................ 460 
10.2. NEC US110 Support ................................................................................................................ 461 

10.2.1. Confirming Installation of DPM Client .................................................................................................. 461 
10.2.2. Creating a Package for US110 ............................................................................................................ 462 
10.2.3. Distributing a Package for US110 ........................................................................................................ 462 
10.2.4. How to Create a Package for Windows CE (for use with NEC US110) ............................................... 463 
10.2.4.1. Preparation Before a Package Registration......................................................................................... 463 
10.2.4.2. Creating Packages in PackageDescriber ............................................................................................ 466 
10.2.5. DPM Client Upgrade Installation (for use with NEC US110)................................................................ 471 

10.3. Notes on Using MasterScope Network Manager ..................................................................... 472 
10.4. Notes for Simultaneous Execution of Multiple Scenarios ........................................................ 479 

11. Troubleshooting ............................................................................................................ 481 
11.1. Web Console ............................................................................................................................ 482 
11.2. Database .................................................................................................................................. 486 
11.3. Management Server ................................................................................................................. 487 
11.4. Managed Machine .................................................................................................................... 489 
11.5. Scenario ................................................................................................................................... 490 
11.6. Execute Scenario ..................................................................................................................... 491 

11.6.1. Overview.............................................................................................................................................. 491 
11.6.2. Creating a Linux Install Parameter File ................................................................................................ 496 
11.6.3. OS Installation by Disk Duplication ...................................................................................................... 497 
11.6.4. OS Clear Installation ............................................................................................................................ 499 
11.6.5. Service Packs / HotFixes / Linux Patch Files / Application Installation ................................................ 500 
11.6.6. Backup/Restore ................................................................................................................................... 504 
11.6.7. Distribution of BIOS/Firmware Floppy Disk Images ............................................................................. 507 

11.7. Managed Machine Registration ............................................................................................... 508 
11.8. Automatic Update ..................................................................................................................... 509 
11.9. Automatic Download ................................................................................................................ 515 



 

 
xv 

11.10. Power On ................................................................................................................................. 517 
11.11. Schedule Management ............................................................................................................ 518 
11.12. Machine Information Import/Export .......................................................................................... 519 
11.13. Network Settings ...................................................................................................................... 520 
11.14. Operating Without DHCP Server ............................................................................................. 522 
11.15. PackageDescriber .................................................................................................................... 524 
11.16. Inquiry of Obstacle Occurrence ............................................................................................... 525 

Appendix A Service List ................................................................................................... 531 
Methods and Order of Start Service, Stop Service ............................................................................... 533 

Appendix B Event Log ...................................................................................................... 535 
Appendix C Error Information .......................................................................................... 537 
Appendix D Network Port and Protocol List ................................................................... 539 
Appendix E DPM Log Output ........................................................................................... 545 
Appendix F How to Check Component Versions ........................................................... 551 
Appendix G Glossary........................................................................................................ 553 
Appendix H Windows OS/Service Pack Support ............................................................ 557 
Appendix I Revision History ........................................................................................... 559 
 





 

 
xvii 

Introduction 
 

Target Audience and Purpose 
The "Reference Guide" is targeted to system administrators who operate DeploymentManager 
(hereafter, DPM) and explains DPM screen operations, tools, maintenance-related information, and 
troubleshooting. 
 

Document Structure 
Part I DeploymentManager Function Reference 
 
1 Web Console Overview: Explains the names and the outline of the DeploymentManager 

Web Console. 
2 Management: Explains users, licenses, and the configuration of DPM Server in the 

Management view. 
3 Operations: Explains the operations of DeploymentManager. 
4 Monitor: Explains viewing the status for managed machines and logs on the 

DeploymentManager. 
 
Part II Tools 
 
5 Explains Image Builder, which is a tool for registering images. 
 6 PackageDescriber: Explains PackageDescriber, which is a tool for registering on the 

Package Web Server. 
7 Other Tools: Explains how to handle when the problem occurs on DPM. 
 
Part III How to Use Commands 
 
8 Command Reference: Explains command lines used by the DPM. 
 
Part IV Maintenance Information 
 
 9 Maintenance: The environment set up that is to be performed after the DPM installation and 

prior to the application start is listed. 
 10 Precautions: Explains precautions regarding the Web Console, etc. 
 11 Troubleshooting: Explains the DPM error information handling method. 
 
Appendices 
Appendix A Service List 
Appendix B Event Log 
Appendix C Error Information 
Appendix D Network Port and Protocol List 
Appendix E DPM Log Output 
Appendix F How to Check Component Versions 
Appendix G Glossary 
Appendix H Windows OS/Service Pack Support 
Appendix I Revision History 
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DeploymentManager Manual Organization  
 
 
DPM manuals are structured as described below. 
In addition, the name of each manual is described in this manual according to the "Name in this 
Manual". 
 
Name of Manual Name in this Manual  Role of Manual 

DeploymentManager 
Ver6.0 First Step Guide First Step Guide 

Intended for DPM users. Provides a product 
overview, and describes the each functions, 
the method of the system design, operating 
environment, etc. 

DeploymentManager 
Ver6.0 Installation Guide Installation Guide 

Intended for system administrators who 
install DPM. Explains tasks such as how to 
install, upgrade, and uninstall DPM. 

DeploymentManager 
Ver6.0 Operation Guide Operation Guide 

Intended for system administrators who 
operate DPM. Explains the setup 
procedures of the environment for operation 
and the operation procedures based on an 
actual operation flow. 

DeploymentManager 
Ver6.0 Reference Guide Reference Guide 

Intended for system administrators who 
operate DPM. Explains DPM screen 
operations, tools, maintenance-related 
information, and troubleshooting. This guide 
is a supplement to the Installation Guide and 
the Operation Guide. 

 
 The latest information of DPM can be acquired from the following site: 

http://www.nec.com/masterscope/deploymentmanager/ 
The Reference Guide is not included in the install media, and is only available on the 
site. 



 

 
xix 

 

Documentation Guidelines 
 
The following describes important points regarding the notation used in this manual. 
 
・ The notation used for DPM products is as follows: 

Notation in this Manual Product Name 
DPM unbundled product DeploymentManager Ver6.0 
SSC product DeploymentManager Ver6.0 for SSC(*1) 

*1 
This is a product that is bundled with SigmaSystemCenter and VirtualPCCenter. 

 
・ The screen images in this manual are based on the DPM unbundled product. The license 

related displays are only for the DPM unbundled product. They are not displayed for SSC 
products. 

 
・ Product versions and revisions are expressed as follows. 

Example) For DPM Ver6.0, "6" refers to the version and "0" refers to the revision. 
 
・ The install media included with the DPM product is called "Install Media" in this manual. 
 
・ IA32 architecture is described as "IA32" in this manual and EM64T architecture as "EM64T". 
 
・ The path used to install DPM on IA32 and EM64T is different on the Windows OS. The IA32 

environment is used as a general rule in this manual so please replace it when you read it. 
Example) 
•For IA32:C:\Program Files\NEC\DeploymentManager 
•For EM64T:C:\Program Files (x86)\NEC\DeploymentManager 

 
・ The registry path for IA32 and EM64T is different on the Windows OS. The IA32 environment is 

used as a general rule in this manual so please replace it when you read it. 
Example) 
•For IA32:HKEY_LOCAL_MACHINE\SOFTWARE 
•For EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node 

 
・ The SQL Server mentioned in this manual is based on SQL Server 2008 R2 Express that is 

included in the install media so please replace it when you read it. 
Example) 

DPM database path 
•For SQL Server 2008 R2 Express x86: 

C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI\MSSQL\Binn 
•For SQL Server 2005 Express Edition x86: 

C:\Program Files\Microsoft SQL Server\MSSQL.x\MSSQL\Binn 
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・ The meaning of each icon used in this manual is as follows: 

 Important messages alert you to cautionary or warning items related to functions, 
operations, and settings. These are items that are especially important for the 
operation of DPM. 

 Note messages alert you to cautionary items related to functions, operations, and 
settings. 

 
 Complementary items for operation such as convenient functions. 

 
・ The displays and procedures of DPM may differ according to the operating system used. This 

document is based on Windows Server 2008 and Windows 7, in principle. Read the displays 
and procedures as those that appear in your operating system. (In part, there may be mention of 
operating systems prior to Windows Server 2008 and Windows 7.)  
Example) 

The procedure for checking the DPM version differs by operating system as follows: 
･For Windows Server 2008: 
1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select View -> Choose details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 

･For Windows 7: 
1) From the Start menu, click Control Panel -> Programs and Features. 
2) Right-click Name that appears in the center of your screen, and select More. 
3) On the Choose Details screen, check the Version check box and click the OK button. 

･For an OS other than the above 
1) From the Start menu, click Control Panel -> Add or Remove Programs. 
2) Select the applicable component, and click on Click here for support information. 

 
・ As long as Windows Server 2003 R2/Windows Server 2008 R2 are not mentioned, so please 

replace Windows Server 2003/Windows Server 2008 when you read it. 
 
・ In descriptions of screen operation procedures, arbitrary names to be specified by the user 

appear in bold and italics as follows:  Scenario Group. 
Example) 

In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 
 
・ The version of JRE shown on the screen may not be the latest that DPM can use. Replace the 

description with the displayed version. 
 
・ Please carry out following procedures when Finish DPM related tasks appears in this 

document. 
•If a scenario is running, wait until the scenario ends. 
•If an automatic update is being executed, wait until it ends. 
•f you are operating the Web Console or the DPM tool, please end them. 

 
・ 1MByte is calculated as 1024KByte. 

1GByte is calculated as 1024MByte. 
 



 

 
1 

PPaarrtt  II  DDeeppllooyymmeennttMMaannaaggeerr  
FFuunnccttiioonn  RReeffeerreennccee  

 
 
 
 
 
 
 
  
 
This Section explains the overview and each functions of the DPM Web Console. 
 
 
• 1 Web Console Overview. .............................................................................................. 3 
• 2 Management. .............................................................................................................11 
• 3 Operations .................................................................................................................49 
• 4 Monitor .....................................................................................................................187 
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1. Web Console Overview 
 
 
 
 
 
 
 
 
 
 
This chapter explains the name of the component on the DPM Web Console and the overview. 
 
The items covered in this chapter are as follows: 
 
 
•  1.1 Web Console Overview. .............................................................................................. 4 
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1.1. Web Console Overview 
You can perform various operations using the Web Console, such as machine operations and group 
management, etc. 
The Web Console is comprised of the following 9 components. 
 
 
 
 
 

 

 

Tree View 

Main menu Main Window Title Bar 
Configuration menu 

Action Menu 

Operation menu 

Action Link 

Group Box 
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(1) Title Bar 

The title bar is normally displayed at the top of the Web Console. 
The title bar is organized from the account management function and the main menu. 

 

 Description 
User Name 
(Authority) 

Displays the user name and authority for login user. 

Account You can change the password for the user who is logged in, display a notification 
dialog or set the number of items to display in the group box. 
Please see Section 1.1.2, "Account" regarding the account management 
function. 

Logout Logs out from the DPM. 
 

•Main Menu 
You can switch the contents of tree view and main window by clicking each menu. 

 

 Description 
Management The Management view is the view that you use for the DPM initial 

configuration/environment settings such as managing DPM users and 
authority, user lists, license management and DPM Server settings, etc. 

Operations The Operations view is the view that you use for normal operations such as 
adding a new group or machine, or executing a scenario, etc. 

Monitor  The Monitor view is the view that you use for monitoring information 
necessary to operate the DPM such as scenario execution status or 
automatic update execution status, etc. 

 
(2) Tree View 

When you click on the main menu, it will switch the tree view. 
When you click on a tree view icon, detailed information about that icon will be displayed in the 
main window and the configuration and operations for that icon will be displayed in the 
Configuration menu and the Operation menu. 

 
(3) Main Window 

This is the DPM main window. Detailed information is displayed about the icon selected in the 
tree view. 

 
•Group Box 
The group box indicates the box that displays the detailed information and the lists displayed in 
the main window. You can click on the name of the column in the group box to display " " 
(ascending order/descending order) and sort the items. You cannot sort only the Edit items. 
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•The items that are displayed in the group box are shown in the table below. 

Display Count Select the number of items such as user lists and managed 
machines, etc. that will be displayed in the group box. 

"Action" Link Indicates the links in each group box where you can perform 
operations on the selected resource in the group box. 
You do this by selecting the checkbox in the left column of the group 
box to select the resource target for the operation and then clicking 
on the Action link. 

"Action" Menu Indicates the menu where you can select from the Machine 
Individual Operations in each group box, and you can perform 
operations on the selected resource in the group box. 
You do this by selecting the checkbox in the left column of the group 
box to select the resource target for the operation and selecting the 
Action menu. 

Checkbox Select the item that is the operation target from the Action link/Action 
menu. 
If you select the check in the very top checkbox, you can select all of 
the users or managed machines, etc. on the corresponding page. 

The following will be shown if the number of the items exceeds the specified Display Count. 

 < Moves to the previous page. 
> Moves to the next page. 
<< Moves to the initial page. 
>> Moves to the last page. 
(Text box) Enter the number of the page. 
Go Moves to the page set in the text box. 

 
(4) Configuration Menu, Operation Menu 

These are the menus for configuration/operation for the target resource. The menu content will 
differ depending on the authority (Administrator, Operator, or Observer) of the user. Please see 
"2.2 User Icon" regarding the user authority. 
The operations performed with this menu can be performed for the resource selected from the 
icons in the tree view. 
A notification dialog box will be displayed if the operation cannot be performed. 

 
 Refresh in the Operation menu refreshes the same as pressing the F5 key. 

However, if the F5 key is pressed while you are operating the screen, it will move 
to the first screen of the Operations/Management/Monitor view. If you click on 
Refresh in the Operation menu, the current screen will be refreshed. 

 
 When you operate on the screen, a password cab be requested and a 

confirmation message can be displayed by the guard parameter setting. 
Please see "2.7.2 Guard Parameter Setting" regarding the settings screen. 
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1.1.1. Login Window 
The login window is displayed when you start the DPM Web Console. Please start the DPM Web 
Console using the following steps. 
 
(1) Select All Programs from the Start menu and select Internet Explorer. 
 
(2) Once the browser has started, enter the following URL. 
 

http://localhost/DPM/Login.aspx 
 

 If you are accessing the DPM Server from a different machine, please use the 
following URL. 
http://IP address of the DPM Server/DPM/Login.aspx 

 
(3) The login window is displayed. Then start the DPM Web Console. 
 

 
 

DeploymentManager Login 
 User Name 

(Entry required) 
Enter the User name. 

Password 
(Entry required) 

Enter the password. 

Remember User Name If you enter a check in the checkbox, you can omit 
entering the user name from the next time you log in. 
If you delete the cookies using Internet Explorer's Internet 
Options, the check will be removed and it will be 
necessary to re-enter the user name. 

"Login" You can log into the DPM by clicking the Login button 
after the user name and password are entered. 
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1.1.2. Account 
In the Account Setting screen, you can change the password of the user being logged in and 
configure whether to display the notice dialog. 
 
(1) On the Web Console, click Account in the title bar. 
 
(2) The Account Setting screen is displayed in the main window. 
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Account Setting 

 Change Password If you check in the Change Password checkbox, you can 
change the password. By default, the checkbox is not 
checked. 

 Old Password 
(Entry required) Input the currently used password. 

New Password  
(Entry required) 

Enter the password to change to. The number of 
characters allowed is 1 - 128 single-byte characters. A 
character can be any single-byte alphanumeric characters 
or any of the following symbols: 
! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ 

Confirm New Password 
(Entry required) 

Re-enter the same password for confirmation. 

Show Notice Dialog When you check the Show Notice Dialog checkbox, you 
can configure the Notice Dialog display. 

 
If this is checked, the Notice Dialog will be displayed the 
next time the Web Console is started. Also, this screen will 
be displayed if you press the F5 key in an arbitrary 
window. 
By default, the checkbox is checked. 
If you place a check in the Do not show this dialog box 
again checkbox, then this will disable the Show Notice 
Dialog settings. 

The Count Of Items 
Displayed Per Page 
(Entry required) 

This is for setting the number of items that will be 
displayed on one page for pages such as Machine List 
where the list is displayed on multiple pages. 
Up to 999 items can be displayed on one page. 
The number setting can be set by entering the number of 
items. 
Please enter single-byte number characters separated by 
commas to set the number. 
The default value is "20, 50, 100." 
If it is configured with multiple numbers, it will be displayed 
using the selection of the number configured in the group 
box Display Count. 
Furthermore, the first number that is entered into the 
textbox will be the default value. 
Example) If "50, 20, 100" is entered, "50" will be the 
default value. 

OK Saves the setting details on the Account Setting screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Account Setting screen. 

 



 

 
 



 

 
11 

 
 

2. Management 
 
 
 
 
 
 
 
 
 
 
This chapter explains the configuration of users, licenses, and DPM Server managed by 
Management view. 
 
The items covered in this chapter are as follows: 
 
 
• 2.1 Management View. ....................................................................................................12 
• 2.2 User Icon....................................................................................................................13 
• 2.3 User List. ....................................................................................................................14 
• 2.4 "License" Icon. ...........................................................................................................19 
• 2.5 Registration License List. ...........................................................................................20 
• 2.6 "DPM Server" Icon. ....................................................................................................22 
• 2.7 Base Information about the .......................................................................................23 
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2.1. Management View 
You can configure the information necessary to use DPM, such as DPM user and authority 
management, user lists, license management and DPM Server configuration, etc. in the Management 
view. 
 
When you click on Management in the title bar, it will switch to the Management view. The 
Management Function List group box is displayed in the main window. 
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2.2. User Icon 
You can manage the accounts of the users who are using DPM with the User icon. 
You can access the User icon from the User icon at the tree view of the Management view or from 
User in the Management Function List group box displayed in the Management view. 
Click on the User icon to display the User List group box on the main window. Please see Section 2.3, 
"User List" regarding the screen. 
 
It is necessary to configure the authority for each user account. The usable range of DPM is limited by 
the type of the authority. 
The three types of authority are listed below. 
 

Administrator You can perform all of the operations such as DPM configuration, changes, 
machine operation or group management, etc. from the Management, 
Operations and Monitor views. 
The Administrator can change any user's password. 

Operator You can perform management etc. for machines, machine groups and scenario 
groups from the Operations and Monitor views. 
You cannot perform DPM Server management, user or authority management 
or license management in the Management view. 

Observer You can only see the machine operating status in the Operations or Monitor 
views. 
You cannot perform operations in the Management, Operations or Monitor 
views. 

 
 Management View Operations View Monitor view 
Administrator You can operate and see You can operate and 

see 
You can operate 
and see 

Operator You can only see some of 
the screens(*1) 

You can operate and 
see 

You can operate 
and see 

Observer You can only see some of 
the screens(*1) 

You can only see You can only see 

*1 
Can only see the following screen under the Management view. 
•Configuration menu -> Detail Setting screen 

 
  Please see "2.3.2 Edit User" regarding changing the authority or password. 

 There is a user (deployment_user) that already exists at the time of the 
installation to use the single sign on from SSC and the DPM Command Line. 
Also, there are the following restrictions for this user. 
•Login from the Web Console by the user is not available. 
•This user cannot be deleted. 

The initial password for this user is "dpmmgr". When executing the DPM 
Command Line, please specify the password of "deployment_user". 
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2.3. User List 
You see a list of the users registered with DPM in the User List group box. The User List group box is 
displayed in the main window when you click on the User icon. 
 

 
 

User List 
 Display Count Select the Display Count to be displayed in the user list. 

"Action" Link When you click on Delete User, the user with a check in 
the checkbox on the left side will be removed. 
Multiple users can be deleted at the same time by putting 
checks by multiple users. 

(Checkbox) Select a user. All users will be selected if you put a check 
in the top checkbox. 

User Name Displays the user name. This cannot be edited. 
Confirm the login status with the icon. 

     :Logged in 
(grey):Logged off 

Authority Displays the user's authority. 
Please see "2.2 User Icon" regarding the authority. 

Description Displays the user description. 
Edit You can edit the user information. Click on the " " icon to 

display the Edit User screen on the main window.  
Please see Section 2.3.2, "Edit User" regarding the Edit 
User screen. 
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2.3.1. Add User 
Add the users who will use DPM. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) Click on the User icon in the tree view. Or, you can click on User in the Management Function 

List group box displayed in the main window. 
 
(3) The Configuration menu for the User icon will be displayed. Then click on Add User. 
 
(4) The Add User screen will be displayed in the main window and you can configure each item. 
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Add User 
 User Name 

(Entry required) 
Enter the new user name to be added. 
The number of characters that can be entered is 1 - 32 
single-byte characters. The allowed characters are 
alphanumeric characters. 
The following symbols cannot be used. 
\ / < > * :  ; , + = ? " 
The alphabet characters are case sensitive. 

Authority 
(Selection required) 

Select the authority for the user. The three types of 
authority for the users are listed below. 
•Administrator 
•Operator 
•Observer 

Password 
(Entry required) 

Enter the password for the user. 
The number of characters that can be entered is 1 - 128 
single-byte characters. The allowed characters are 
alphanumeric characters. 
The following symbols cannot be used. 
! " # $ % & ' ( ) * + , - . / :  ; < = > ? @ [ \ ] ^ _ ` { | }  - 
The alphabet characters are case sensitive. 

Confirm Password 
(Entry required) 

Re-enter the same password as confirmation. 

Description You can enter the user's description. 
Up to 128 single-byte characters can be entered. 
The allowed characters are single byte alphanumeric 
characters. 
This entry is optional. 

OK The user is added and it returns to the previous window. 
Cancel It returns to the previous window without adding the user. 

 
 There is no limit on the maximum number of users you can add. 

 

2.3.2. Edit User 
Edit the users registered in the DPM. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) Click on the User icon in the tree view. Or, you can click on User in the Management Function 

List group box displayed in the main window. 
 
(3) When the User List group box is displayed, click on the Edit User Icon ( ) for the user to be 

edited. 
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(4) The Edit User screen will be displayed in the main window. Then edit each item. 
 

 
 

Edit User 
 User Name Display the user name. This cannot be edited. 

Authority Displays the user's authority. The authority can be 
changed from the list box. 
The authority will become effective from the next login. 

Change Password If you check in the Change Password checkbox, you can 
change the password. By default, the checkbox is not 
checked. 
The changed password will be reflected immediately. 

Password Input the password to be set. 
The number of characters that can be entered is 1 - 128 
single-byte characters. Any single-byte alphabet and 
numeric characters or any of the following symbols can be 
entered. 
! " # $ % & ' ( ) * + , - . / :  ; < = > ? @ [ \ ] ^ _ ` { | }  - 
The alphabet characters are case sensitive. 

Confirm Password 
(Input required) 

Enter the same password as you entered in Password for 
confirmation. 

Description The user description is displayed and can be edited. 
Up to 128 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric 
characters. 

OK Saves the setting details on the Edit User screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Edit User screen. 
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2.3.3. Delete User 
Delete a user registered to DPM. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) Click on the User icon in the tree view. Or, you can click on User. In the Management Function 

List group box displayed in the main window. 
 
(3) Enter a check in the checkbox in the left column of the User to be Deleted on the User List 

group box that is displayed in the main window. 
 
(4) When you click on the Action link for Delete User, a confirmation dialog will be displayed. 
 
(5) Click on the OK button. 
 

 A deleted user that is already logged in or one who deletes yourself will stay 
active until you log off or the Web Console times out. 
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2.4. "License" Icon 
You can manage licenses registered with DPM with the License icon. 
You can access the License icon from the License icon at the top of the Management view tree view 
or from License in the Management Function List group box displayed in the Management view 
main window. Click on the License icon to display the Registration License List group box on the 
main window. Please see Section 2.5, "Registration License List" regarding the screen. 
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2.5. Registration License List 
A list of the registered licenses is displayed by the DPM in the Registration License List group box. 
The Registration License List group box is displayed in the main window when you click on the 
License icon. 
 

 
 

Registration License List 
 Display Count Select the Display Count to be displayed in the registered 

license list. 
"Action" Link When you click Delete License Key, the selected license 

will be deleted. 
Please select the radio button for the license to be deleted 
and perform the operation. 

(Radio Button) Select the license to delete. 
License name Displays the license key name. 
License Key Displays the license key. 
Registration day Displays the date the license key was registered. 

 
 If using SSC bundled product, it is not necessary to register the DPM license so the 

License icon will not be shown on the Management view. 
Please see the SigmaSystemCenter Installation Guide about registering licenses for 
SSC bundled product. 

 

2.5.1. Add License Key 
Add the DPM license key. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) Click on the License icon in the tree view. Or, you can click on License in the Management 

Function List group box displayed in the main window. 
 
(3) The Configuration menu for the License icon will be displayed. Then click on Add License 

Key. 
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(4) The Add License Key screen will be displayed in the main window. Then enter the license key 

and press the OK button. 
 

 
 

Add License Key 
 License key 

(Entry required) 
Enter the license key. Please enter upper and lower case 
letters correctly. 
•A license is required for each of the machines which are 
introduced, operated and managed by DPM. 
Please see Section 2.3, "DeploymentManager Product 
Line and Licenses" in First Step Guide for information 
regarding the license. 
•If you do not register the license key, you can only 
register up to 10 machines, and the trial period will be up 
to 30 days. You will not be able to use the DPM if you 
exceed the 30 day period. 

OK The license is added and it returns to the previous 
window. 

Cancel It returns to the previous window without adding the 
license. 

 

2.5.2. Delete License Key 
Delete the DPM license key. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) Click on the License icon in the tree view. Or, you can click on License in the Management 

Function List group box displayed in the main window. 
 
(3) Select License to Delete from the Registration License List group box that is displayed in the 

main window. 
 
(4) When you click on the Action link for Delete License Key, a confirmation dialog will be 

displayed. 
 
(5) Click on the OK button. 
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2.6. "DPM Server" Icon 
You can configure the DPM environment such as behavior of DPM Server and Folder for Image, etc. 
using the DPM Server icon. You can access the DPM Server icon from the DPM Server node at the 
top of the Management view tree view or from DPM Server in the Management Function List group 
box displayed in the Management view main window. 
Click on the DPM Server icon to display the Base Information group box on the main window. 
Please see Section 2.7, "Base Information about the Management Server" regarding the screen. 
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2.7. Base Information about the Management 
Server 

Base information about the DPM Server is displayed in the Base Information group box. The Base 
Information group box is displayed in the main window when you click on the DPM Server icon. 
 

 
 

Base Information 
 Product Name Displayed as Deployment Manager. 

Product Version Displays the DPM version. 
IP Configuration 
 IP Address The Management Server IP address is displayed. If there 

are multiple IP addresses, then all will be displayed. 
Web Site 
 Comment Displays a description of the Web site information. 

Protocol Displays the communication protocol for connecting to 
the Web site. 

IP Address:TCP Port Displays the Web site's IP address and port number. 
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2.7.1. Detail Setting 
The Management Server settings can be confirmed/changed. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Or, you can click on Management Server in the 

Management Function List group box displayed in the main window. 
 
(3) The Configuration menu for the DPM Server icon will be displayed, then click on Detail 

Settings. 
 
(4) Each item can be configured using each of the General, Scenario, Network and DHCP 

Server tabs on the Detail Setting screen which is displayed in the main window. 
Please see Section 2.7.1.1, "General Tab" through Section 2.7.1.4, "DHCP Server Tab" for a 
description of each screen. 
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2.7.1.1. "General" Tab 
In the General tab, you can view and configure license information, server information, server 
configuration, Folder for Backup Image, and Folder for Image. 
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Overview 
 License Information 

 License Count Displays the number of licenses that are registered for the 
DPM Server. This cannot be edited. The "License" will not 
be displayed for SSC bundles product. 
(The DPM license is included with SSC) 

Server Information 
 Computer Name The Management Server machine name is displayed. 

This cannot be edited. 
IP Address The ANY or Management Server IP address is configured. 

ANY is configured so that the DPM Server is able to use 
all of the LAN board equipped on the Management 
Server. If there are multiple IP addresses assigned, 
multiple IP addresses will be displayed in the list box and 
can be selected. 
The default is ANY.(*1) 

Server Setting 
 Check the completion of 

a scenario by the 
communication with 
DPM Client 

You can monitor the scenario completion in real time by 
entering a check in the Check the completion of a 
scenario by the communication with DPM Client 
checkbox. You can confirm scenario completion by 
communication between the DPM Server and the DPM 
Client. 

Upgrade DPM Client 
automatically 

You can automatically upgrade the DPM Client on the 
installed machine by entering a check in the Upgrade 
DPM Client automatically checkbox. If this checkbox is 
checked, the DPM Client will communicate with the DPM 
Server when it runs and if the DPM Client version is 
different from that on the server, it will automatically 
upgrade to the same version as that on the server. 

Image Setting 

 Folder for Backup Image Configure the Folder for Backup Image. 
Select the folder using the Browse button or the path can 
be specified by direct input. 
The number of characters that can be entered is 1 - 80 
single-byte characters. 
The alphanumeric characters, single-byte spaces. 
The following symbols cannot be used. 
/ * ? < > " | : 
The default is "C: \DeployBackup." 
Furthermore, please configure the Folder for Backup 
Image as a folder that is confirmed to have sufficient free 
space. 
This is not required.(*2)(*3) 

Folder for Image 
(Entry required) 

Configure a folder where OS, applications and service 
packs, etc. can be saved for remote install using DPM. 
Select the folder from Browse button or the path can be 
specified by direct input. 
The number of characters allowed is 1-254 single-byte 
characters. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot not be used. 
/ * ? < > " | , 
The default is "C: \Deploy." 
Please configure the Folder for Image as a folder that is 
confirmed to have sufficient free space.(*2)(*4) 



Base Information about the Management Server 
 

Part I DeploymentManager Function Reference 
27 

OK Saves the setting details on the Detail Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Detail Setting screen. 

*1 
 Perform the following in the case of changing the IP address configuration. 

•Performs a shutdown for all managed machines from the Web Console so that DPM 
Client on managed machines registered with the DPM Server can communicate with the 
Management Server. 

•Change the configuration of the IP address of the Management Server in the Image 
Builder (Remote Console). 

•There may be cases where the Image Builder (Remote Console) cannot communicate 
with the Management Server so please change the IP address of the Management 
Server configured in the Image Builder (Remote Console). 

The configuration can be run by selecting Start menu -> All Programs -> 
DeploymentManager -> Image Builder. 

 Be careful of the following if an IP Address other than ANY is selected. 
If multiple IP addresses are assigned to one LAN board, please configure the first IP 
address visible in the OS. The DPM may not operate correctly if another IP address is 
configured. 

 Restart the following services if the network information (IP address is changed or 
fluctuates) changes. 
•DeploymentManager PXE Management 
•DeploymentManager PXE Mtftp 

 The LAN board of the all target managed machines needs to be connected to one LAN 
board of the Management Server when IP Address is set to ANY and it is transmitted 
using multicast with a remote update scenario. 

 Configure the IP Address to other than ANY (the IP address configured by the used 
LAN board) when a restore scenario is executed with multicast option. 

*2 
 If you change the Folder for Backup Image, change the image file location of already 

created backup and restore scenarios and the following scenarios created by default: 
•System_Backup 
•System_Restore_Unicast 

After the configuration is changed, restart the Management Server. The DPM Server will 
not work properly until it is restarted. 

 You cannot specify the following folders as the location for the Folder for Backup Image 
or the Folder for Image. 
•Using the same folder for the Folder for Backup Image and the Folder of Image 
•The Windows system folder 
•A folder used by another application 
•Directly under the drive 
Example) "D: \" 
•Network drives 

Also, you cannot specify a subfolder of the Folder for Image as the Folder for Backup 
Image. 
And if you change the Folder for Backup Image or the Folder for Image, do not do any 
steps other than those listed in the User's Guide (directly editing or removing, etc. using 
Explorer). 
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*3 
If you change the Folder for Backup Image, the backup image files will not be automatically 
moved to the changed location. You will need to move the files manually. 

*4 
 Grant access that will allow access with full control on the Folder for Image by the user 

that performs the DPM operations or the account (the default is local system account 
(SYSTEM)) used by each service with the name that start with "DeploymentManager" on 
the Management Server. 

 If the exports folder that is under the Folder for Image is configured as an NFS shared 
folder, take the following steps when changing the Folder for Image. 
1) Remove the NFS shared folder configuration from the exports folder. 
2) Change the Folder for Image from the Detail Setting screen. 
3) Configure the exports folder under the Folder for Image as an NFS shared folder. 

 If you change the Folder for Image, you will not be able to configure the subfolders of 
the current Folder for Image as the changed location. 

 Specify an empty folder if you are setting up an existing folder as the new Folder for 
Image. 

 Stop the Image Builder temporarily prior to changing the Folder for Imager and then 
start it again after the folder change. 

 

2.7.1.2. "Scenario" Tab 
You can configure the scenario timeout time in the Scenario tab. 
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Scenario 
 Timeout Setting (*1) 

 Hardware Setting 
(Input required) 

Configure the default value for the timeout for distributing 
floppy disk image of BIOS/Firmware update (Scenario HW 
Setting tab). 
This can be configured in one minute increments from "1" 
to "9999" minutes. 
The default value is "10" minutes. 

Linux Installation 
(Input required) 

Configure the timeout for installing the Linux OS (Scenario 
OS tab). 
This can be configured in one minute increments from "1" 
to "9999" minutes. 
The default value is "120" minutes. 

OK Saves the setting details on the Detail Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Detail Setting screen. 

*1 
 The scenario timeout is the timeout of executing a scenario. A scenario execution error will 

occur when the scenario has not completed after the time specified for each item has been 
exceeded. 

 If you set both the HW Setting tab and the OS tab on the Add Scenario screen, each 
timeout will be valid for the execution times for Hardware Setting and Linux Installation. 
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2.7.1.3. "Network" Tab 
You can configure the remote power operation and configure the number of machines for 
simultaneous execution of a scenario in the Network tab. 
 

 
 

Network 
 Remote Power Control Setting 

 Remote Power On 
Interval 
(Entry required) 

You can set the execution interval for remote power ON for 
each machine by batch execution of remote power ON. 
This can be configured in one second increments from "1" to 
"99" seconds. 
The default value is "2" seconds. 

Remote Power On 
Timeout 
(Entry required) 

This is the wait time for a response from the machine for a 
remote power ON or scenario execution time. This can be 
configured in one minute increments from "0" to "99" minutes. 
The default value is "10" minutes. 
If this is set to 0, then it will continue waiting for a response from 
the managed machine (The timeout of the remote power ON 
will not occur).(*1) 

Scenario Execution Setting 
 Machines For 

Simultaneous 
Execution 
(Entry required) 

Configure the number of machines that can run scenarios 
simultaneously. This can be set from "1" to "1000" machines. 
The default value is "5" machines. (*2) 
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OK Saves the setting details on the Detail Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Detail Setting screen. 

*1 
If you perform remote power ON or a scenario on multiple managed machines, the default 
value of the timeout for the remote power ON value may cause a timeout error. 
In principle, set the Remote Power On Timeout to be greater than the following value. 
(Remote power on interval) * (the number of scenario executing machines) + (the managed 
machines startup time). 
Furthermore, a remote power ON error will occur if there is no response within the time. 
Increase this value if it can be powered ON but a power ON error occurs. 

*2 
 The following will happen if simultaneous execution was done with a larger number of 

machines than the value that was set for the Machines For Simultaneous Execution. 
・ If it is set to distribute using unicast in a restore scenario 

Scenarios will be executed on the number of machines set as Machines for 
Simultaneous Execution and other managed machines will wait. Then, when 
scenarios have completed, the scenario will run sequentially on the waiting managed 
machines. If you manually turn on the power for the managed machines that are waiting 
for execution of a scenario, the scenario will be executed on more than the number of 
machines set as Machines for Simultaneous Execution. 

・ If it is set to distribute using multicast in a remote update scenario 
If Scenarios are simultaneously executed on more computers than the number 
specified under Machines for Simultaneous Execution, the scenario will be executed up 
to the specified number of Machines for Simultaneous Execution. Errors will occur on 
the surplus machines. In such a case, remove the scenario execute error on Web 
Console. Then, adjust the number of Machines for Simultaneous Execution to an 
appropriate value and re-run the scenario for those managed machines that had a 
scenario execute error. 
See Section 3.8.8, "Error Cancellation" about remove the error. 

 A maximum value of Machines for Simultaneous Execution is 1000 machines, but the 
load on the network will increase as the number of scenarios concurrently running 
increases. 

 The number of machines that are running automatic updates and scenarios is 
simultaneously 1000 machines. Therefore, even if both of the number of machines set 
here and maximum number of machines for automatic update (Management view – DPM 
Server icon – Automatic Update Setting in the Configuration menu –Maximum 
Number Of Machines For Automatic Update (1-1000)) are set to 1000 machines, the 
number of machines which is executed simultaneously will be less than 1000. 
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2.7.1.4. "DHCP Server" Tab 
You can configure whether to use a DHCP server in the DHCP Server tab. 
 

 
 

DHCP Server 
 Use A DHCP Server Select this to use a DHCP Server. 

 DHCP Server is installed 
on the machine 

Select this if the DHCP Server is running on the same 
machine as the DPM Server. 

DHCP Server is installed 
on an another machine 

Select this if the DHCP Server is running on a different 
machine than the DPM Server. 

Do Not Use A DHCP Server Select this not to use a DHCP server. 
OK Saves the setting details on the Detail Setting screen and 

returns to the previous window. 
Cancel Returns to the previous window without saving the setting 

details from the Detail Setting screen. 
 

 Please see First Step Guide Appendix B "For Customers Who Cannot Easily  
Install a DHCP Server" about operating without setting up a DHCP server. 
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2.7.2. Guard Parameter Setting 
You can set the guard parameters. By setting the guard parameters, you enter the password of the 
login user or warning messages are displayed when operating, and you can prevent operation 
misses. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Then click on Guard Parameter 

Setting. 
 
(4) A screen appears that requires entry of the password. Enter the password. 
 

 Please enter the password that is the password for the login user. 
 
(5) The Guard Parameter Setting screen is displayed. Then select Password, Warning or None 

and click the OK button. These become effective immediately after setting. The DPM service 
does not need to be restarted. 

 
The operation of the Password, Warning or None selected from the Guard Parameter Setting 
screen is shown in the table below. 

 

Setting value Description 
Password A password entry screen will be displayed at the time of each operation, and 

you cannot operate it if the correct password is not entered. 
Warning A confirmation message will be displayed as a warning at the time of each 

operation. 
None Nothing will be displayed at the time of each operation. 
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 The default guard parameter settings are those in the above figure. 
 

Guard Parameter Setting 
 Add Machine Set the Add Machine guard parameters. 

Delete Machine Set the Delete Machine guard parameters. 
Add Group Set the Add Group guard parameters. 
Delete Group Set the Delete Group guard parameters. 
Add Scenario Set the Add Scenario guard parameters. 
Edit Scenario Set the Edit Scenario guard parameters. 
Delete Scenario Set the Delete Scenario guard parameters. 

Assign scenario Set the Assign Scenario guard parameters 

Remove Scenario 
Assignment 

Set the Remove Scenario Assignment guard 
parameters 

Execute Scenario Set the Execute Scenario guard parameters. 

Cancel Scenario Execution Set the Cancel Scenario Execution guard parameters. 

Power ON/Shutdown Set the Power ON/Shutdown guard parameters 

Package Download Setting Set the Package Download Setting guard parameters. 

Automatic Update Setting Set the Automatic Update Setting guard parameters. 

Set Automatic Update Time 
by the Batch 

Set the Set Automatic Update Time by the Batch 
guard parameters. 

OK Saves the setting details on the Guard Parameter 
Setting screen and returns to the previous window. 
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Cancel Returns to the previous window without saving the 
setting details from the Guard Parameter Setting 
screen. 

 

2.7.3. Package Download Setting 
You can add, edit, or delete Package Web Server or package automatic downloads. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Download Setting screen appears in the main window. Then set each item. 
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Package Download Setting 
 Proxy 

 Address Set the IP address or the host name of the proxy if 
accessing the Package Web Server using a proxy. 
The number of characters that can be entered is up to 127 
single-byte characters. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
\ * ? 
The default is blank. 

Port 
(Setting required) 

Set the proxy port number if accessing the Package Web 
Server using a proxy. 
This can be set in the range of "1 - 65535". 
The default value is "80." 

Download Automatically When you enter a check in the Download Automatically 
checkbox, you can set the timing for package automatic 
downloads. By default, the checkbox is not checked. (*1) 

 Left List Box Set the cycle and day of the week for the automatic 
download. You can select from the following. 
•Every Hour 
•Everyday 
•Sun - Sat (Sunday - Saturday) 

Right List Box Set the time for the automatic download. You can select 
from the following. 
•If you select Every Hour  
10 minute increments from "0" to "50" minutes  
•If you select Everyday  
Hourly increments from "0: 00" to "23: 00"  
•If you selected any of Sun - Sat (Sunday - Saturday)  
Hourly increments from "0: 00" to "23: 00" 

Package Web Server 
 (Checkbox) All Package Web Servers will be selected if you put a 

check in the top checkbox. 
Server Address Displays the Package Web Server IP address. 

If there are multiple Package Web Servers registered, 
they will be displayed in ascending order. 
When you click on the displayed IP address, the base 
information for the Package Web Server will be displayed 
in the main window. 

Server ID Displays the Package Web server identifier. 
When a package is downloaded to the Management 
Server, the server ID will be attached in front of each 
package's ID number. 

Download Displays whether the Package Web Server is the target of 
automatic downloads. 

Proxy Displays whether a proxy is used when downloading a 
package from the Package Web Server. 

Latest Download 
Information 

Displays success/fail of the download or the time of the 
latest download. 



Base Information about the Management Server 
 

Part I DeploymentManager Function Reference 
37 

Edit Edit the Package Web Server. Click on the " " icon to 
display the Edit Package Web Server screen on the main 
window. For the edit screen, see Section 2.7.3.2, "Edit 
Package Web Server". 

"Action" Link •When you click on Add, the Add Package Web Server 
screen is displayed and you can add a Package Web 
Server. For the screen, see Section 2.7.3.1, "Add 
Package Web Server". 
•When you click Delete, the selected Package Web Server 
will be deleted. 
When a check is entered in the checkbox in the left 
column of the Package Web Server, you can select and 
delete multiple Package Web Servers. 

OK Saves the setting details on the Package Download 
Setting screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Package Download Setting screen. 

*1 
The DPM Server does not acquire the most recent system time until the next download, so if 
you change the Windows system time after you set the automatic download, the download 
may not be performed as scheduled. 

 
  You can temporarily delete the package that was automatically downloaded 

to the Management Server using the package delete function of the Image 
Builder. 
However, if you do not delete the corresponding package from the Package 
Web Server, it will be downloaded again at the set time of the automatic 
download. 

 If a package is deleted from the Package Web Server using 
PackageDescriber, the package on the Management Server will be deleted 
at the time the next automatic download is performed. 

 
 You cannot change the package download setting during automatic download. 
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2.7.3.1. Add Package Web Server 
Add a Package Web Server. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Web Server group box is displayed in the main window, then click on the Action 

link for Add. 
 
(5) The Add Package Web Server screen appears in the main window. Set each item. 
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Add Package Web Server 
 Server ID 

(Setting required) 
Set the Package Web Server ID. 
The number of characters allowed is 1 - 7 single-byte 
characters. A character can be any single-byte alphabet 
and numeric characters or any of the following symbols. 
_ - 
"local" (case insensitive) is already reserved and cannot 
be used. 

Address 
(Setting required) 

Set the Package Web Server IP address. 
Up to 255 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
\ * ? 
The default is blank. 

Port 
(Setting required) 

Set the Package Web Server port number. This can be set 
in the range of "1 - 65535." The default value is "80." 

Use Proxy A proxy will be used when accessing the Package Web 
Server if a check is entered in the Use Proxy checkbox. 
Do not set user authentication to the proxy server when 
using a proxy server. By default, the checkbox is not 
checked. 

Select Automatic 
Download Target 

The package will be regularly downloaded from the 
Package Web Server when a check is entered in the 
Select Automatic Download Target checkbox. 
Always enter a check in the checkbox to perform an 
automatic download. By default, the checkbox is not 
checked.(*1) 

User Authentication If a check is entered in the User Authentication 
checkbox, user authentication will be performed when the 
Package Web Server is accessed. 
Enter a check when user confirmation is required to 
access the Package Web Server. When you enter a check 
in User Authentication, the User Name and Password 
entry is enabled and User Name is a required entry item. 
By default, the checkbox is not checked. 

 User Name 
(Entry required) 

Enter the basic authentication user name set in the IIS. 
The number of characters allowed is 1 - 63 single-byte 
characters. Only single-byte alphanumeric characters can 
be used. 

Password Enter the basic authentication password set in the IIS. 
The number of characters allowed is 1 - 63 single-byte 
characters. 
Only single-byte alphanumeric characters can be used. 
This entry is optional. 

OK Saves the setting details on the Add Package Web Server 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Add Package Web Server screen. 

*1 
The Management Server does not acquire the most recent system time until the next 
download, so if you change the Windows system time after you set the automatic download, 
the download may not be performed as scheduled. 
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2.7.3.2. Edit Package Web Server 
Edit a Package Web Server. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) Once the Package Web Server group box is displayed in the main window, click on the Edit 

icon( ) for the Package Web Server to be edited. 

 
(5) The Edit Package Web Server screen appears in the main window. Edit each item. 
 
You can also display the Package Web Server screen using the following steps. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Or, the Management Function List group box 

appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Web Server group box appears in the main window. Click on the Server 

Address (IP address). 
 
(5) The Configuration menu for the Package Web Server appears. Click Edit Package Web 

Server. 
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(6) The Edit Package Web Server screen appears in the main window. Edit each item. 
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Edit Package Web Server 
 Server ID The Package Web Server ID is displayed. This cannot be 

edited. 
Address 
(Entry required) The Package Web Server IP address can be edited. 

Up to 255 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric 
characters. The following symbols cannot be used. 
\ * ? 

Port The Package Web Server port number can be edited. This 
can be set in the range of "1 – 65535". The default value is 
"80." 

Use Proxy A proxy will be used when accessing the Package Web 
Server if a check is entered in the Use Proxy checkbox. 
Do not set user authentication to the proxy server when 
using a proxy server. 

Select Automatic 
Download Target 

The package will be regularly downloaded from the 
Package Web Server when a check is entered in the 
Select Automatic Download Target checkbox. 
Always enter a check in the checkbox to perform an 
automatic download. 

Change User Authorize When a check is entered in the Change User Authorize 
checkbox, the User Authentication checkbox is enabled.  

User Authentication Enter a check in the User Authentication checkbox when 
user authentication is required to access the Package 
Web Server. 
When you enter a check, entry of User Name and 
Password is enabled. 

 User Name 
(Entry required) 

Edit the basic authentication user name set in the IIS. 
The number of characters allowed is 1 - 63 single-byte 
characters. 
Only single-byte alphanumeric characters can be used. 

Password Edit the basic authentication password set in the IIS. 
The number of characters allowed is 1 - 63 single-byte 
characters. 
Only single-byte alphanumeric characters can be used. 
This entry is optional. 

OK Saves the setting details on the Edit Package Web 
Server screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Edit Package Web Server screen. 

 

2.7.3.3. Delete a Package Web Server 
Delete a Package Web Server. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Or, the Management Function List group box 

appears in the main window. Then click on DPM Server. 
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(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Web Server group box is displayed in the main window. Then enter a check in 

the left column of the Package Web Server to Delete and click on the Action link for Delete. 
 
(5) The confirmation dialog box appears. Click the OK button. 
 
You can also delete the Package Web Server using the following steps. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Web Server group box appears in the main window. Click on the Server 

Address (IP address) 
 

(5) The Configuration menu for the Package Web Server appears. Click Delete Package Web 
Server. 

 

 
 
(6) The confirmation dialog box appears. Click the OK button. 
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2.7.3.4. Base Information about the Package Web Server 
Displays the base information about the Package Web Server. 
  
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download 

Setting. 
 
(4) The Package Web Server group box is displayed in the main window. Then click on the 

Server Address link. 
 
(5) The Base Information group box for the Package Web Server is displayed in the main window. 
 

 
 
 

Base Information 
 Server ID Displays the Package Web Server ID. 

Address Displays the Package Web Server IP address. 
Port Displays the Package Web Server port number. 
Use Proxy Displays Yes if a proxy server is used and No if a proxy 

server is not used. 
Target of Auto Download Displays Yes if it is target of auto download and No if it is 

not target of auto download. 
User Authorize Displays Used if user authentication is set and Unused if 

user authentication is not set. 
User Name Displays the user name. 
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2.7.4. Automatic Update Setting 
Set the automatic update. 
 
(1) When you click on Management on the title bar in the Web Console, it will switch to the 

Management view. 
 
(2) In the tree view, click on the DPM Server icon. Also, the Management Function List group 

box appears in the main window. Then click on DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Automatic Update Setting. 
 
(4) The Automatic Update Setting screen will be displayed in the main window and you can 

configure each item. 
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Automatic Update Setting 
 Maximum Number Of 

Machines For Automatic 
Update(1-1000) 

This is the setting for the upper limit on the number of 
machines that can do automatic updates at the same time.  
The Maximum Number Of Machines For Automatic 
Update is not a group unit; this is for all of the machines 
that are registered to the Management Server. 
This can be set in the range of "1-1000" units. The default 
value is "5" machines.(*1) 

The Maximum Transfer 
Rate (1-500MB/min) 

When you enter a check in The Maximum Transfer Rate 
checkbox, you can control the transfer rate when 
transferring the automatic update files. 
The maximum transfer rate is set as the maximum data 
volume in MB that will transfer in 1 minute. This can be set 
in the range of "1 - 500." The default value is "500" 
MB/minute. 
By default, the checkbox is not checked. 

Automatic Update During The New Group's Registration 
 Automatic Update Set the default value for the automatic update function 

for the new group. 
•Constantly Off 
•ON At Startup 
•OFF At Startup 

The default is OFF At Startup. 
The following setting values will be disabled if the setting 
is Constantly Off. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval(Min) 

When you set the automatic update function to 
Constantly Off, the managed machine will not request 
not applied packages from the Management Server. (*2) 

Automatic Update Time Set the default value for the automatic update time for 
the new group. 

 Left List Box Set the day for performing the automatic update. You 
can select from the following. 
•Everyday 
•Sunday - Saturday(Sun. - Sat) 

The default is blank 
Right List Box Select hourly increments from "0:00" to "23:00." If you 

select Empty in the left list box, the setting time will be 
disabled. 
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  Application Timing Set the default value for the automatic update 
application timing for the new group. 
•Immediately 
•At Next Startup 
•Show Confirmation 

The default is At Next Start up. 
If the application Timing setting is Immediately or At 
Next Startup, the screen will not be shown on the 
managed machines.(*3) 

Retry Count It will re-try the connection up to the set number of Retry 
Count. 
This can be set in the range of "0 – 5" times. The default 
value is "1" time. 

Retry Interval(Min.) Set the default value for the Retry Interval (Min.) for the 
new group. 
This can be configured in five minute increments from 
"5" to "30" minutes. The default value is"5" minutes. 

OK Saves the setting details on the Automatic Update 
Setting screen and returns to the previous window. 

Cancel Returns to the previous window without saving the 
setting details from the Automatic Update Setting 
screen. 

 
*1 

The number of machines that are simultaneously running automatic updates and scenarios is 
1000 machines. Therefore, even if both of the number of machines set here and maximum 
number of machines for scenario simultaneous execution (Management view – DPM Server 
icon – Detail Setting in the Configuration menu –> Network tab -> Machines For 
Simultaneous Execution in Scenario Execution Setting group box) are set to 1000 
machines, the number of machines which is executed simultaneously will be less than 1000. 

*2 
Automatic update setting example and action 
•If the automatic update is ON At Startup and the automatic update time is set to Everyday 
12: 00, an automatic update will be performed when the managed machine starts up and 
everyday at 12: 00. 
•If the automatic update is Off At Start up and the automatic update time is set to 
Wednesday 12: 00, an automatic update will be performed each week on Wednesday at 
12: 00. An automatic update will not be run on the managed machine at start up. 
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*3 

Each of the Application Timing choices and operations are shown in the table below. 
Choices Operation 

Immediately Applies the package immediately. 
The status of the managed machine will change to Applying 
A Package(Automatic Update). 

At Next Startup Applies the package at the next start up. 
The status of the managed machine will change to Waiting 
For Restart(Automatic Update). 

Show Confirmation The following screen will be displayed on the managed 
machine. 
Click to Execute Immediately or Run at Next startup. 

 
 

 Automatic updates will not be performed for machines registered to a new 
machine group. It must be added to a group to perform an automatic update. 

 
 A package that has the priority Highest or High at the time of creation is sent 

with automatic update. See Section 5.5, "Package Registration/Modification" for 
details. 
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3. Operations 
 
 
 
 
 
 
 
 
 
 
This chapter explains the operation and the configuration for machines, groups, scenarios and images 
on Operations view. 
 
The items covered in this chapter are as follows: 
 
 
• 3.1 "Operations" View ......................................................................................................50 
• 3.2 "Resource" Icon .........................................................................................................51 
• 3.3 "Machine" Icon ...........................................................................................................53 
• 3.4 "Group" Icon ...............................................................................................................63 
• 3.5 Machine Group Details ..............................................................................................64 
• 3.6 Menu Operations for a Group ....................................................................................90 
• 3.7 Managed Machine Details .........................................................................................93 
• 3.8 Menu Operations to a Machine ...............................................................................110 
• 3.9 "New Machine" Icon .................................................................................................126 
• 3.10 "Scenario" Icon ........................................................................................................136 
• 3.11 "Scenario Group" Icon .............................................................................................139 
• 3.12 Scenario Group Details ............................................................................................140 
• 3.13 Add Scenario ...........................................................................................................151 
• 3.14 Menu Operations for a Scenario ..............................................................................170 
• 3.15 Scenario Detail Information .....................................................................................172 
• 3.16 "Image" Icon .............................................................................................................176 
• 3.17 Image Detailed Information......................................................................................177 
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3.1. "Operations" View 
Functions such as information settings, information display and information management (add, edit or 
delete) for the various resources (machine, scenario, or image, etc.) are provided in the Operations 
view. 
When you click on Operations in the title bar, it will switch to the Operations view. The Summary 
Information group box is displayed in the main window. 
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3.2. "Resource" Icon 
You can manage resources used by the DPM with the Resource icon. 
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Summary Information 
 Resource Type 

 Machine When you click on Machines, the Group List screen is 
displayed. 

 Scenario Executing When you click on Scenario Executing, the machines 
with normal status will be displayed on the Monitor view - 
Execute Scenario List screen. Please see Section 4.3, 
"Scenario Execution List" regarding the screen. 

Scenario Execute 
Error 

When you click on Scenario Execute Error, the 
machines with error status will be displayed on the 
Monitor view - Execute Scenario List screen. Please see 
Section 4.3, "Scenario Execution List" regarding the 
screen. 

Scenario Execute 
Stop 

When you click on Scenario Execute Stop, the machines 
with error status will be displayed on the Monitor view - 
Execute Scenario List screen. Please see Section 4.3, 
"Scenario Execution List" regarding the screen. 

Scenario When you click on Scenario, the Group List group box is 
displayed. Please see Section 3.10, "Scenario Icon" 
regarding the screen. 

Image When you click on Image, the Image List screen is 
displayed. Please see "3.16 Image Icon" regarding the 
screen. 

 HW Image When you click on HW Image, the HW Image list is 
displayed in the Image List group box. Please see Section 
3.17, "Image Detailed Information" regarding the screen. 

OS Image When you click on OS Image, the OS Image list is 
displayed in the Image List group box. Please see 
Section 3.17, "Image Detailed Information" regarding the 
screen. 

Package When you click on Package, the Package list is displayed 
in the Image List group box. Please see Section 3.17.1, 
"Package Image Detailed Information" regarding the 
screen. 

Backup Image When you click on Backup Image, the Backup Image is 
displayed in the Image List group box. Please see 
Section 3.17.3, "Backup Image Detailed Information" 
regarding the screen. 
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3.3. "Machine" Icon 
You can manage groups and machines used by the DPM with the Machines icon. 
You can access the Machines icon from the Machines icon at the top of the Operations view - tree 
view or from Machine in the Summary Information group box displayed in the Operations view – 
the main window. 
Click on the Machines icon to display the Group List group box on the main window. 
 

 
 

Group List 
 Display Count Select the number of the group registered with the DPM 

Server to display. 
"Action" Link When you click Delete Group the selected group will be 

deleted. 
Please select the radio button for the group to be deleted 
and perform the operation. 

Name Displays the name of the groups that are registered for the 
DPM Server. When you click the name, the detailed 
information for the concerned group will be displayed. 

Subgroup Number 
(Directly/Subordinates) 

Displays the number of groups directly under/subordinate 
of the concerned group. 

Machine Number 
(Directly/Subordinates) 

Displays the number of machines (managed machines) 
directly under/subordinate of the concerned group. 

Edit You can edit the group information. Click on the " " icon 
to display the "Edit Group" screen on the main window. 
Please see Section 3.5.1, "Edit Machine Group" 
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3.3.1. Add Machine Group 
Add a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Machines icon. The Summary Information group box appears in 

the main window. Click on Machine. 
 
(3) The Configuration menu for the Machines icon will be displayed. Then click on Add Group. 

 
(4) The Add Group screen appears in the main window. Set each item. 
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Add Group 
 Name 

(Entry required) 
Enter the group name. Up to 1 - 64 single-byte characters 
can be entered. The allowed characters are single-byte 
alphanumeric characters. 
The following symbols cannot be used. 
; # 
Regardless of the layer, adding a subgroup with the same 
name will fail. 

Network Setting  Set the group network. 
This will be the default value for newly added machines. 
The default will be Subnetwork is same with DPM 
Server. 

 Subnetwork is same with 
DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as the DPM Server. 

Subnetwork is not same 
with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than the DPM Server. 
Select this when the group scheduled to be added goes 
through a router and belongs to a different network than 
the Management Server. 
The following items will be enabled if the setting is 
Subnetwork is not same with DPM Server. 
•Default Gateway 
•Subnet Mask 

Set up is required if the items are enabled. 
 

 
Default Gateway 
(Setting required) 

Set the default gateway when the managed machines of 
the group are on a different Subnetwork from the DPM 
Server. The top order of the IP address (first octet) is set in 
the range of "1-223". 

Subnet Mask 
(Setting required) 

Set the subnet mask when the managed machines of the 
group are on a different Subnetwork than the DPM Server. 

Automatic Update Setting This setting will be default values for newly added 
machines. 
When adding a machine group, the values set on the 
Management view -> Automatic Update Setting screen 
are displayed as default. 
Please see Section 2.7.4, "Automatic Update Setting" 
regarding the screen. 
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  Automatic Update Set the automatic update function. You can select the 
following operations. 
•Constantly OFF 
•ON At Startup 
•OFF At Startup 

The default is OFF At Start up. 
The following setting values will be disabled it the setting is 
Constantly OFF. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval(Min.) 

When you set the automatic update function to 
Constantly OFF, the managed machine will not request 
not applied packages from the Management Server. 
(*Please see Section 2.7.4, "Automatic Update Setting" 
regarding the Automatic Update setting example and 
action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box Select the date. You can select from the following. 
•Everyday 
•Sun - Sat 

The default is blank. 
Right List Box Select hourly increments from "0: 00" to "23: 00." If you 

select Empty in the left list box, the setting time will be 
disabled. 

Application Timing Set the package application timing. You can select from 
the following. 
•Immediately 
•At Next Start up 
•Show Confirmation 

The default is At Next Start up. 
If the application timing setting is Immediately or At Next 
Start up, the confirmation screen will not be shown on the 
managed machines. (*Please see Section 2.7.4, 
"Automatic Update Settings" about the Application Timing 
selection and operation.) 

Retry Count If the connection to the Management Server failed, the 
connection will be re-tried the set number of times. This 
can be set in the range of "1 – 5" times. 
The default value is "1" time. 

Retry Interval(Min.) If the connection to the Management Server failed, the 
connection will be re-tried at the set time interval. This can 
be configured in five minute increments from "5" to "30" 
minutes. 
The default value is "5" minutes. 

OK The machine group is created with the setting details from 
the Add Group screen and it returns to the previous 
window. 

Cancel Returns to the previous window without saving the setting 
details from the Add Group screen. 
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Note that the upper limit to machine groups and managed machines is as follows. 
Item Upper Limit 
Total number of machine groups(total number of machine groups including 
sub-machine groups) 1000 

Number of machine group layers 20 
Number of managed machines registered per machine group(total number 
including managed machines under sub-machine groups affiliated with 
machine group)(*1) 

10000 

Total number of managed machines(total number of managed machines 
affiliated with all machine groups, including sub-machine groups) 40000 

*1 
If you exceed the number of managed machines that can be registered with one machine 
group, you cannot add a machine to the group or a subordinate sub-group. 

 

3.3.2. Delete Machine Group 
Delete a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click on the Resource icon, then click on the Machines icon. 
 
(3) The Group List group box is displayed. Then select Machine Group to Delete. 
 
(4) When you click on the Action link for Delete Group, a confirmation dialog will be displayed. 
 
(5) Please click on the OK button and run. 
 
You can also do the following steps to delete a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon, then click on the Machine icon - Machine Group 

icon. 
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(3) The Configuration menu for the Machine Group icon will be displayed, and then click on Delete 

Group. 
 

 
 
(4) The confirmation dialog box appears. Click the OK button. 
 

  When you delete a group, the sub-groups and machines directly under the 
corresponding group will also be deleted. 

 If the Status column of any of the managed machines belonging to the group 
has one of the following status, the group cannot be deleted. Furthermore, if 
the status condition of the sub-group machines is any of these, the group 
cannot be deleted. 
•Scenario Executing 
•Scenario Execute Error 
•Scenario Execute Stop 
•Remote Power ON Error 
•Automatic Update Progress 
•Transferring Files(Automatic Update) 
•Setting Automatic Update Time 
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3.3.3. Import Machine Data 
Execute the batch registration of the machine data. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click on the Machines icon. The Summary Information group box appears in 

the main window. Click on Machine. 
 
(3) The Configuration menu for the Machine icon will be displayed. Then click on Import 

Machine Data. 
 
(4) The Import Machine Data screen is displayed in the main window. Then please select the CSV 

file from the Browse button in the CSV File Settings group box. 
 

 
 

CSV File Setting 
 CSV File 

(Setting required) Displays the CSV file path. 

Browse Click on the Browse button and select the CSV file for the machine 
data. 
You cannot import the file if the CSV File Path is blank, if it is not a 
CSV format, or if the CSV file format is invalid. 
Also, if there is a group with the machine data (CSV file), it will be 
necessary to create a group with the same structure from the Web 
Console first. You cannot automatically create a group from the 
machine data so if the group in the machine information (CSV file) 
does not exist in the Web Console, adding a machine will fail. 
If there are levels of groups, and the subgroups are created in the 
Web Console in the same way, Machines will also be imported 
under the subgroup. However, the group name registered to the 
machine must be described in the CSV file. 
Once the file is imported, please click on Operations menu -> 
Refresh, and confirm that is imported correctly.(*1) 

Encoding 

 UTF-8 Select this if the encoding is UTF-8. 
Shift-JIS Select this if the encoding is Shift-JIS. 
ISO-8859-1 Select this if the encoding is ISO-8859-1. 
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*1 
 Please change the file character code to UTF-8 when importing CSV files created with 

DPM versions prior to 6.0. Also, there are the following restrictions. 
1) When using machine data (CSV file) created with a DPM version prior to 5.0. 

It is possible to import the CSV file as is without editing. 
However, a UUID column was added from DPM Ver5.0, so the UUID column will not 
exist for a CSV file created with a version prior to DPM Ver5.0. 
By importing, the column is set by blank (without designation). 

2) When using machine data (CSV file) created with a DPM version prior to Ver6.0. 
There were group types (general group/BladeServer group) in versions prior to DPM 
Ver6.0, but the group type was taken out of DPM Ver6.0 and they were unified into a 
general group (simply called Group from DPM Ver6.0). 
•For a BladeServer group, please manually delete the "#" from the front of the group 
name in the CSV file. 
•The Unit ID/Slot ID/Scenario assignment permission and Slot width values created by 
the BladeServer group can be disregarded. The scenario assignment is always 
permitted from DPM Ver6.0. 

 An explanation of the CSV file format. 
1) The first row of the CSV file is the comment row. The first row is fixed and Machine 

Name, Group Name, MAC Address, IP Address, Kernel ID, Kernel Display Name, 
UUID are displayed. 

2) From the second row, data is processed, so please describe the machine data since the 
second row. 

3) If one managed machine have multiple MAC addresses, please note them delimited 
with a "|" between each MAC address. 

4) When specifying a character string including ", please enter it as "" and enclose the item 
itself with" 

5) Please enter "--" (two single-byte hyphens) when omitting MAC address, IP address, 
Kernel ID, Kernel display name or UUID. 

 
CSV File Format 
Machine Name,Group Name,MAC Address,IP Address,Kernel ID,Kernel Display Name,UUID 
"First machine name, group name, MAC address, IP address, kernel ID, kernel display name, UUID 
"Second machine name, group name, MAC address, IP address, kernel ID, kernel display name, 
UUID  

• 
• 

 
Example) When creating a CSV file to register the machine information according to the details in the 

following chart, do it like sample01.csv. 
Machine 
Name 

Group 
Name 

MAC Address IP Address Kernel 
ID 

Kernel 
Display 
Name 

UUID 

COMP1 GROUP1 00-11-22-33-44-55 None None None None 

COMP2 00-11-22-33-44-66 192.168.0.1 None None b4e8f2e4-a2ff-4464-a97
c-7e93fef0542a 

COMP3 00-11-22-33-44-77 192.168.0.2 kernel1 NEC 
Express58
00 001 

None 

COMP4 GROUP2 00-11-22-33-44-88 
00-11-22-33-44-99 

192.168.0.3 
192.168.0.4 

Kernel2 NEC 
Express58
00 002 

8dda9b94-6918-42ed-b
d4c-1aa3cfec750c 
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sample01.csv 
Machine name, group name, MAC address, IP address, kernel ID, kernel display name, UUID 
"COMP1","GROUP1","00-11-22-33-44-55","--","--","--","--" 
"COMP2","GROUP1","00-11-22-33-44-66","192.168.0.1","--","--","b4e8f2e4-a2ff-4464-a97c-7e93fe
f0542a" 
"COMP3","GROUP1","00-11-22-33-44-77","192.168.0.2","kernel1","NEC Express5800 001","--" 
"COMP4","GROUP2","00-11-22-33-44-88|00-11-22-33-44-99","192.168.0.3,192.168.0.4","kernel2",
"NEC Express5800 001","8dda9b94-6918-42ed-bd4c-1aa3cfec750c" 

 
Furthermore, the values for sample01.csv are described. 
Item Designation 

Required/ 
Optional 

Description 

Machine Name Setting Required Enter the machine name. Up to 1 - 63 single-byte characters 
can be entered. The allowed characters are single-byte 
alphanumeric characters. 
The following symbols and single-byte spaces cannot be used. 
. , ; `  -  ! @ # $ ^ & * = + { } % \ | :  ' " < > / ? [ ] 
Also, You cannot register a machine name with just numbers. 

Group Name Setting Required Enter the group name to which the machine is registered. 
Up to 1 - 64 single-byte characters can be entered. 
The allowed numbers of characters are single-byte 
alphanumeric characters. 
The following symbols cannot be used. 
; # 

MAC Address Optional Enter the MAC address. 
A hexadecimal number can be entered (0 - 9/a - f/A - F). 
Enter it in the form "xx-xx-xx-xx-xx-xx." 
If there are multiple MAC addresses, please note the MAC 
addresses each delimited with a "|". 
i.e. "00-15-87-1e-c2-11"|"00-12-75-1e-d2-32" 
Please enter "--" (two single-byte hyphens) when omitting the 
MAC address. 
Furthermore, when running an import of machine data, all of the 
MAC addresses noted in the CSV are imported, however only 
the primary MAC address will be shown in the Web Console. 
Please enter either or both of the MAC address/UUID. 

IP Address Optional Enter the IP address. 
The type of characters that can be used are "0 - 9." Please enter 
them in the form "xxx-xxx-xxx-xxx." 
If there are multiple IP addresses, please note the IP addresses 
each delimited with a ",". 
Example) "192.168.74.1,172.28.154.106" 
Please enter "-- (two single-byte hyphens) when omitting the IP 
address. 
Furthermore, only the IP address (the IP address used by the 
DPM Server and the DPM Client) used for communication will 
be displayed in the Web Console, so if the IP address is 
omitted, this will be shown as blank. 

Kernel ID Optional Enter the kernel ID. 
Please enter "--" (two single-byte hyphens) when omitting the 
kernel ID. 

Kernel Display 
Name 

Optional Enter the kernel display name. 
Please enter "--" (two single-byte hyphens) when omitting the 
kernel display name. 
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UUID Optional Enter the UUID. 
A hexadecimal number can be entered. (0 - 9/a - f/A - F). 
Please enter them in the form 
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx." 
Please enter "--" (two single-byte hyphens) when omitting the 
UUID. 
Please enter either or both of the MAC address/UUID. 

 
  You can import a CSV file even if it describes mixed multiple groups. 

 You can also register with a CSV file output using Export Machine Data. 
Please see Section 3.3.4, "Export Machine Data" about exported CSV files. 

 

3.3.4. Export Machine Data 
The machine data is exported as a CSV format file. Once the machine data export is performed, you 
can simply make a format. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click on the Machines icon. Or by clicking on the Machines icon, the 

Summary Information group box appears in the main window. Click on Machine. 
 
(3) The Configuration menu for the Machines icon will be displayed. Then click on Export 

Machine Data. 
 
(4) The File Download dialog box is displayed and then please click on the Save button and save 

the CSV format. 
 

  All of the machines included under the sub-group are exported. 
 The export will be for just the group the machine is registered with. 
 It will not export the Network Setting and Automatic Update Time Setting 

information. The default when importing will be the same settings as the 
registered group. 

 If the managed machine has multiple MAC addresses, all MAC addresses will be 
exported. 
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3.4. "Group" Icon 
The machines are classified by group and managed in the Group icon. 
You can access the Group icon from the Machines icon -> Group icon at the top of the Operations 
view -> tree view or from Machine -> Group icon in the Summary Information group box displayed 
in the Operations view -> main window. 
Click on the Group icon to display the Group Detail, the Machine List, and the Subgroup List group 
box in the main window. 
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3.5. Machine Group Details 
Displays the group detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Display Group 

Detail icon. 
 
(3) Displays the Group Detail, Machine List and Subgroup List group box in the main window. 
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Group Detail Displays the group detail. 

This group box is not displayed by default. 
Please expand it by clicking on the arrow ( ) in the right. 

 Parent Group Name The parent group name is displayed only when it is a 
submachine group (The group level is the second level or 
is lower than the second level). The parent group name will 
not be displayed for groups directly under the Machine 
(first level groups). 

Name Displays the group name. 
Network Setting Displays the group network setting. 
 Network Displays whether the managed machines of the group are 

on the same Subnetwork as the DPM Server. 
Default Gateway Displays the default gateway when the managed 

machines of the group are on a different Subnetwork than 
the DPM Server. 

Subnet Mask Displays the subnet mask when the managed machines of 
the group are on a different Subnetwork than the DPM 
Server. This cannot be edited. 

Automatic Update Setting Displays the automatic update setting for the group. 
 Automatic Update Displays the automatic update function. 

Automatic Update Time Displays the automatic update time. 
Application Timing Displays the operation for the automatic update application 

timing. 
Retry Count Displays the number of retries. 
Retry Interval(Min.) Displays the retry interval. 

Machine List 
 Display Count Select the number of items of the managed machines 

registered in the group to display. 
"Action" Link When you click Move Machine, the selected managed 

machine is moved between groups. 
You can move multiple managed machines between 
groups by entering a check in the checkbox on left column 
of the managed machine. 
When you click Delete Machine, the selected managed 
machine is deleted. 
You can delete multiple managed machines by entering a 
check in the checkbox on left column of the managed 
machine. 

"Action" Menu Performs the operation on the selected managed machine. 
You can select the following from the action menu. 
•Power ON 
•Shutdown 
•Set Power Management Schedule 
•Assign Scenario 
•Remove Scenario Assignment 
•Execute Scenario 
•Scenario Execute Stop 
•Remove Error 
•Remove Interruption 

If you select Set Power Management Schedule, the 
Power Management Schedule screen will be displayed. 
Please see Section 3.8.5, "Power Management Schedule" 
regarding the screen. 

Name Displays the name of the managed machine registered 
with the group. This cannot be edited. 
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IP Address Displays the IP address of the managed machine. This 
cannot be edited. 

MAC Address Displays the MAC address of the managed machine. This 
cannot be edited. 

 Status The status of the managed machine is displayed. Please 
see Section 3.7.1, "Machine Status" regarding status types 
and explanations. 

Power Displays the machine power status. 
Scenario Name Displays the scenario assigned to the machine. 

Click on Scenario Name to display the Scenario Detail 
screen on the main window. 
Please see Section 3.15, "Scenario Detail Information" 
regarding the screen. 

Edit Edit a machine group. Click on the " " icon to display the 
Edit Machine screen on the main window. Please see 
Section 3.7.2, "Edit Managed Machine" regarding the edit 
screen. 

Subgroup List 
 Display Count Select the number of items of the sub-groups registered in 

the group to display. 
"Action" Link When you click Delete Group the selected sub-group will 

be deleted 
Please select the radio button for the sub-group to be 
deleted and perform the operation. 

(Radio Button) Select a sub-group. 
Name Displays the name of the sub-group registered with the 

group. This cannot be edited. 
Subgroup Number 
(Directly/Subordinates) 

Displays the number of sub-groups directly 
under/subordinate to the concerned group. 

Machine Number 
(Directly/Subordinates) 

Displays the number of machines (managed machines) 
directly under/subordinate to the concerned group. 

Edit Edit a sub- group. Click on the " " icon to display the "Edit 
Group" screen on the main window. Please see Section 
3.5.1, "Edit Machine Group" regarding the edit screen. 
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3.5.1. Edit Machine Group 
Edit a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Edit Group icon. 
 
(3) The Configuration menu for the Machine Group icon will be displayed, and then click on Edit 

Group. 
 
(4) Click on the OK button to display the Edit Group screen on the main window and please edit 

each item. 
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Edit Group 
 Parent Group Name The parent group name is displayed only when it is a 

sub-machine group (The group level is the second level or 
is lower than the second level). 
The parent group name will not be displayed for groups 
(first level groups) directly under the Machines. 

Name 
(Setting required) 

Enter the group name. Up to 1 - 64 single-byte characters 
can be entered. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
; # 
Regardless of the layer, editing with the same name will 
fail. 

Network Setting Edit the group network setting. 
The default is the value set on the Add Group screen.  
Please see Section 3.3.1, "Add Machine Group" regarding 
the Add Group screen. 
If you edit the group network setting this will become the 
default value for the newly added machine. 

 Subnetwork is same with 
DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as the DPM Server. 

Subnetwork is not same 
with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than the DPM Server. Please 
select this when the group scheduled to be added goes 
through a router and belongs to a different network than 
the DPM Server. 
The following items will be enabled if the setting is 
Subnetwork is not same with DPM Server. 
•Default Gateway 
•Sub-net Mask 

Set up is required if the items are enabled. 
 

 
Default Gateway 
(Setting required) 

Set the default gateway when the managed machines of 
the group on a different Subnetwork than the DPM Server. 
The top order of the IP address (first octet) is set in the 
range of "1-223." 

Subnet Mask 
(Setting required) 

Set the subnet mask when the managed machines of the 
group on a different Subnetwork than the DPM Server. 

Reflect setting to the 
machines that has been 
already registered to this 
group as well 

You can also apply the network settings to the managed 
machines belonging to this group If you enter a check in 
the Reflect setting to the machines that has been 
already registered to this group as well checkbox. By 
default, the checkbox is not checked. 

 Reflect setting to the 
direct machine 

Select this to apply the setting details to the machines 
directly under the group. 
Reflect setting to the direct machine is selected by 
default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting details to groups and 
machines under the group. 
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 Automatic Update Setting Edit the automatic update settings for the group. 
The default is the value set on the Add Group screen.  
Please see Section 3.3.1, "Add Machine Group" regarding 
the Add Group screen. 
If you edit the automatic update settings, this will become 
the default value for the newly added machine. 

 Automatic Update Set the automatic update function. You can select from 
the following. 
•Constantly Off 
•ON At Start up 
•OFF At Start up 

The default is the value set on the Add Machine Group 
screen. Please see Section 3.3.1, "Add Machine Group" 
regarding the setting values. 
The following setting values will be disabled it the setting 
is Constantly Off. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval (Min.) 

When you set the automatic update function to 
Constantly OFF, the managed machine will not request 
not applied packages to the Management Server. 
(*Please see Section 2.7.4, "Automatic Update Setting" 
regarding the Automatic Update Setting Example and 
Action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box Select the day for performing the automatic update.  You 
can select from the following. 
•Everyday 
•Sun. – Sat. 

The default is the value set on the Add Machine Group 
screen. Please see Section 3.3.1, "Add Machine Group" 
regarding the setting values. 

S You can select hourly increments from "0: 00" to "23: 00." 
If you select Empty in the left list box, the setting time will 
be disabled. 

Application Timing Set the package Application Timing. You can select 
from the following. 
•Immediately 
•At Next Start up 
•Show Confirmation 

The default is the value set in the Add Machine Group.  
Please see Section 3.3.1, "Add Machine Group" regarding 
the setting values. At Next Start up 
If the Application Timing setting is Immediately or At 
Next Start up, the user confirmation screen will not be 
shown on the managed machines. (*Please see Section 
2.7.4, "Automatic Update Setting" about the Application 
Timing Selection and Operation.) 
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  Retry Count If the connection to the DPM Server failed, the connection 
will be re-tried the specified number of times for re-try.  
This can be set in the range of "1 – 5" times. 
The default is the value set in the Add Machine Group.  
Please see Section 3.3.1, "Add Machine Group" regarding 
the setting values. 

Retry Interval(Min.) If the connection to the DPM Server failed, the connection 
will be re-tried at the set time interval. This can be 
configured in five minute increments from "5" to "30" 
minutes. 
The default is the value set in the Add Machine Group.  
Please see Section 3.3.1, "Add Machine Group" regarding 
the setting values. 

 Reflect setting to the 
machines that has been 
already registered to this 
group as well 

You can also apply the automatic update settings to the 
managed machines belonging to this group If you enter a 
check in the Reflect setting to the machines that has 
been already registered to this group as well 
checkbox. By default, the checkbox is not checked. 

 Reflect setting to the 
direct machine 

Select this to apply the setting details to the machines 
directly under the group. 
Reflect setting to the direct machine is selected by 
default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting details to groups and 
machines under the group. 

OK Saves the setting details on the Edit Group screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Edit Group screen. 

 

3.5.2. Delete Machine Group 
Delete a machine group. 
Please see Section 3.3.2, "Delete Machine Group" regarding the details. 



Machine Group Details 
 

Part I DeploymentManager Function Reference 
71 

 

3.5.3. Add Sub Group 
Add a sub-machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon and click Machine Group to Add subgroup. 
 
(3) The Configuration menu for the Machine Group icon will be displayed, then click on Add 

Subgroup. 
 
(4) The Add Group screen appears in the main window. Enter the subgroup information and set 

each item. 
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Add Group  
 Parent Group Name Display the parent group name. This cannot be edited. 

Name 
(Entry required) 

Enter the subgroup name. Up to 1 - 64 single-byte 
characters can be entered. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
; # 
Regardless of the layer, adding a subgroup with the same 
name will fail. 

Network Setting Edit the network settings for a subgroup. 
The new group will inherit the set values of the parent 
group. Please see Section 3.3.1, "Add Machine Group" 
regarding the set values. 
If network settings are performed on the subgroup, these 
will become the default values for machines under the 
corresponding group. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as the DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than the DPM Server. 
Select this when the group scheduled to be added goes 
through a router and belongs to a different network than 
the DPM Server. 
The following items will be enabled if the setting is 
Subnetwork is not same with DPM Server. 
•Default Gateway 
•Subnet Mask 

Set up is required if the items are enabled. 

 
 

Default Gateway 
(Setting required) 

Set the default gateway when the managed machines of 
the group are on a different Subnetwork than the DPM 
Server. The top order of the IP address (first octet) is set in 
the range of "1-223." 

Subnet Mask 
(Setting required) 

Set the subnet mask when the managed machines of the 
group are on a different Subnetwork than the DPM Server. 

Automatic Update Setting Perform automatic updates setting for a sub group. 
The new group will inherit the set values of the parent 
group. Please see Section 3.3.1, "Add Machine Group" 
regarding the set values. 
If automatic update setting are performed on the 
subgroup, these will become the default values for 
machines under the corresponding group. 
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  Automatic Update Set the automatic update function. You can select from the 
following. 
•Constantly OFF 
•ON At Startup 
•OFF At Startup 

The default is OFF At Start up. 
The following setting will be disabled it the setting is 
Constantly OFF. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval (Min.) 

When you set the automatic update function to 
Constantly OFF, the managed machine will not request 
not applied packages to the Management Server. (*Please 
see Section 2.7.4, "Automatic Update Setting" regarding 
the Automatic Update setting example and action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box Select the date. You can select from the following. 
•Everyday 
•Sun - Sat 

The default is blank. 
Right List Box Select hourly increments from "0: 00" to "23: 00". If you 

select Empty in the left list box, the setting time will be 
disabled. 

Application Timing Set the package application timing. You can select from 
the following. 
•Immediately 
•At Next Start up 
•Show Confirmation 

The default is At Next Start up 
If the application timing is Immediately or At Next Start 
up, the confirmation screen will not be shown on the 
managed machines. (*Please see Section 2.7.4, 
"Automatic Update Setting" about the Application Timing 
selection and operation.) 

Retry Count If the connection to the Management Server failed, the 
connection will be re-tried the set number of times. This 
can be set in the range of "0 – 5" times. 
The default value is "1" time. 

Retry Interval(.Min) 
 

If the connection to the Management Server failed, the 
connection will be re-tried at the set time interval. This can 
be configured in five minute increments from "5" to "30" 
minutes. 
The default value is "5" minutes. 

OK The sub-machine group is created with the setting details 
on the Add Group screen and it returns to the previous 
window. 

Cancel Returns to the previous window without saving the setting 
details from the Add Group screen. 
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Note that the upper limit to machine groups and managed machines is as follows. 
Item Upper Limit 
Total number of machine groups (total number of machine groups including 
subgroups) 1000 

Number of machine group layers 20 
Number of managed machines registered per machine group (total number 
including managed machines under subgroups affiliated with machine 
group)(*1) 

10000 

Total number of managed machines (total number of managed machines 
affiliated with all machine groups, including sub-machine groups) 40000 

*1 
If you exceed the number of managed machines that can be registered with one machine 
group, you cannot add a machine to the group or the subordinate sub-group. 
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3.5.4. Delete Subgroup 
Delete a sub-machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon ->Machine Group icon -> Sub-group 

to Delete icon. 
 
(3) The Configuration menu for the Sub Machine Group icon will be displayed, and then click on 

Delete Group. 
 

 
 
(4) Click on the OK button. 
 

 When you delete a group, the sub-groups and managed machines right under the 
group will be also deleted. 
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3.5.5. Add Managed Machine 
Add a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click on the Resource icon, click on the Machines icon, then click on the 

Machine Group to Add Managed Machine icon. 
 
(3) The Configuration menu for the Group icon will be displayed, and then click on Add Machine. 
 
(4) The Add Machine screen appears in the main window. Please set each item. 
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Add Machine 
 Group Name Displays the name of the group to which the managed machine 

will be added. This cannot be edited. 
Machine Name 
(Entry required) 

Enter the managed machine name. 
Up to 1 - 63 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols and single-byte spaces cannot be used. 
Also, You cannot register a machine name with just numbers. 
. , ; `  -  ! @ # $ ^ & * = + { } % \ | :  ' " < > / ? [ ] 
If the OS is already installed on the machine to be added, you 
must enter the same name as the machine (OS) has. 
If the DPM Client is installed, even if the name of the added 
machine and the actual machine is different, the name will be 
automatically changed to the actual machine name on the Web 
Console when the machine is turned ON. 
If the same machine name already exists under the same 
Management Server, the name of the already existing machine 
will be changed to "(Machine Name)x" (with the x being a 
number from "1" to "39999" entered in order).(*1) 

MAC Address 
(You must enter either or 
both of the MAC 
address/UUID) 

Enter the MAC address of the managed machine. 
A hexadecimal number can be entered.(0 - 9/a - f/A - F). 
Enter it in the form "xx-xx-xx-xx-xx-xx." 

UUID 
(You must enter either or 
both of the MAC 
address/UUID) 

Enter the managed machine UUID. 
A hexadecimal number can be entered.(0 - 9/a - f/A - F).  Enter 
them in the form 
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx." 
If you enter all "0" or all "F", the value is handled "nothing" by the 
DPM. 
If the UUID is unclear, register the machine without UUID. Please 
make the corresponding machine be booted from network, or 
please install the DPM Client. The UUID will be complete through 
the network boot or the DPM Client installation.(*2) 

Deploy-OS Select Deploy-OS used by the managed machine when you 
execute backup/restore/disk configuration was checked. 
Please contact your sales or support representative about the 
setting values for each machine type. 
 
The Deploy-OS installed in the DPM Server is displayed in the 
list box. 
If the Deploy-OS for the machine that is being used is not 
displayed in the list box, obtain a support module from your sales 
or support representative and install the module on the 
Management Server, and the supported Deploy-OS will be 
shown in the list box. 

Scenario Setting 
 Assign Scenario Select to assign a scenario to a managed machine. The Browse 

button in the Scenario Name text box is enabled. 
Scenario Name Set the scenario which will be assigned to the managed 

machines. 
When you click on the Browse button, the Select Scenario 
screen is displayed so please select the scenario and click on the 
OK button. 
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  Remove Scenario 
Assignment Select to remove the scenario assignment 

Scenario Applying 
Schedule If you put a check in the Scenario Applying Schedule 

checkbox, you can set the scenario applying schedule. If you do 
not set the scenario, you cannot enter a check in the checkbox. 

Only 
Once 

The schedule will be executed only once. 
Date 
(Setting 
required) 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

The allowed characters are single-byte numbers. 
Daily The schedule is carried out on the set "Day" and "Time" from "Start Date." 

Start Date  
(Setting 
required) 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required) 

Set the time. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

Interval  
(Setting 
required) 

Edit the interval in day units. This can be set in the range of "1 - 
99" days. 
The default value is once per day. 

Weekly The schedule will be carried out weekly on the set "Day of the Week" and 
"Time." 
Start Date  
(Setting 
required) 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required) 

Set the time. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 
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Day of the 
Week Setting  
(Setting 
required) 

Set one or more of Sunday - Saturday. 

Monthly The schedule will be carried out monthly on the set "Date" and "Time."  
Start Month 
(Setting 
required) 

Set the start month. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

End Month Set the end month. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the end month is not set, the schedule will repeatedly run the 
set content. This need not be configured. 

Time 
(Setting 
required) 

Set the time. 
You can enter the following range in the textbox. 
•"Hr"  0 - 23 
•"Min" 0 - 59 

Day 
(You Must Set 
Either Day/ 
Week 

If you select Day, set the day from the list box. 
Example) "End of Month" day 

Week 
(You Must Set 
Either Day/ 
Week 

If you select Week, set the day of the week from the list box. 
Example) "1(First)" - "Monday" 

Power 
Management Schedule 

If you enter a check in the Power Management Schedule 
checkbox, you can manage the machine's power status. 
If a check is entered, select either or both Power ON Time 
/Shutdown Time. 

Only 
Once 

The schedule will be executed only once. 
Power ON Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you enter a check in the Power ON Time checkbox, you can 
set the power ON time. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

Set the time at least 5 minutes from the current time. 
Shutdown 
Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you enter a check in the Shutdown Time checkbox, you can 
set the shutdown time. 
You can enter the date (year/month/day) or click on the " " icon 
on the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

Set the time at least 5 minutes from the current time. If you set 
this at the same time as the Power ON Time, set the interval 
with at least a space of 10 minutes. 
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Do not show 
countdown 
dialog 

If you enter a check in the Do not show countdown dialog 
checkbox, the countdown dialog is not displayed at the time of 
shutdown. 

Specify 
Day 

The schedule will be carried out on the set "Day of the Week" and "Time." 
Power On Time If you enter a check in the Power ON Time checkbox, you can 

set the power ON time. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

Shutdown 
Time 

If you enter a check in the Shutdown Time checkbox, you can 
set the shutdown time. 
You can enter the following range in the textbox. 
•"Hr" 0 - 23 
•"Min" 0 - 59 

If you set this at the same time as the Power ON Time, set the 
interval with at least a space of 10 minutes. 

Do not show 
countdown 
dialog 

If you enter a check in the Do not show countdown dialog 
checkbox, you cannot display the countdown timer dialog at the 
time of shutdown or not. 

Day of the 
Week Setting  
(Setting 
required) 

Set one or more of Sunday - Saturday. 

Network Setting 
 Subnetwork is same with 

DPM Server 
Select this when the managed machine is on the same 
Subnetwork as the DPM Server. 

Subnetwork is not same 
with DPM Server 

Select this when the managed machines is on a different 
Subnetwork than the DPM Server. 
Select this when the managed machine scheduled to be added 
goes through a router and belongs to a different network than the 
DPM Server. 
The following items will be enabled if the setting is Subnetwork 
is not same with DPM Server. 
•Default Gateway 
•Subnet Mask 

Set up is required if the items are enabled. 

 

Default Gateway  
(Setting required) 

Set the default gateway when the managed machine is on a 
different Subnetwork than the DPM Server. The top order of the 
IP address (first octet) is set in the range of "1-223." 

Subnet Mask 
(Setting required) 

Set the subnet mask when the managed machine is on a 
different Subnetwork than the DPM Server. 



Machine Group Details 
 

Part I DeploymentManager Function Reference 
81 

 

 Automatic Update Setting 
 Automatic Update Set the automatic update function. You can select from the 

following. 
•Constantly OFF 
•ON At Startup 
•OFF At Startup 

The default is OFF At Start up. 
The following setting will be disabled it the setting is 
Constantly OFF. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval (Min.) 

When you set the automatic update function to Constantly 
OFF, the managed machine will not request not applied 
packages to the Management Server. (*Please see Section 
2.7.4, "Automatic Update Setting" regarding the Automatic 
Update setting example and action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box Select the day for performing the automatic update. You 
can select from the following. 
•Everyday 
•Sun - Sat 

The default is blank. 
Right List Box Select hourly increments from "0: 00" to "23: 00". If you 

select Empty in the left list box, the setting time will be 
disabled. 

Application Timing Set the package application timing. You can select from the 
following. 
•Immediately 
•At Next Start up 
•Show Confirmation 

The default is At Next Start up 
If the application timing is Immediately or At Next Start up, 
the confirmation screen will not be shown on the managed 
machines. (*Please see Section 2.7.4, "Automatic Update 
Setting" about the Application Timing selection and 
operation.) 

Retry Count If the connection to the Management Server failed, the 
connection will be re-tried the set number of re-try times. 
This can be set in the range of "1 – 5" times. 
The default value is "1" time. 

Retry Interval (Min.) If the connection to the Management Server failed, the 
connection will be re-tried at the set time interval. This can 
be configured in five minute increments from "5" to "30" 
minutes. 
The default value is "5" minutes. 

OK The machine is added with the setting details on the Add 
Machine screen and it returns to the previous window. 

Cancel It returns to the previous window without adding the 
machine with the setting details from the Add Machine 
screen. 
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*1 
 Please enter the correct machine name. DPM performs name resolution on the registered 

machine name when confirming the machine's existence or running a scenario, and 
performs TCP/IP communication using the obtained IP address. Please see Section 2.2.1, 
"Regarding the Network Environment," in First Step Guide regarding the details. 

 Please do not change the machine name for the machine for which the scenario schedule 
is set when the DPM Web Console is not running. A scenario execution error will occur or 
the scenario may run on the wrong machine. However, the correct schedule will run for the 
changed item when the main window screen is operating. 

*2 
The DPM will distinguish the registered machine by UUID, so SSC coordination may not be 
performed normally if the UUID is not registered. In that case, please register the UUID. 
 

3.5.6. Move Machine 
Move a managed machine between groups. You can move the managed machine regardless of its 
status (automatic update status/scenario status/power status). 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Enter a check in the checkbox in the left column of the Machine to Move on the Machine List 

group box that is displayed in the main window. 
 
(4) Click Move Machine of Action link. 
 
(5) The Move Machine dialog box is displayed and then set Move Target Group. 
 

 
 
(6) Click on the OK button. 
 



Machine Group Details 
 

Part I DeploymentManager Function Reference 
83 

 
You can also display the Move Machine screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon - Machines icon - Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window. Then click on the name of the 

Machine to Move. 
 

(4) The Configuration menu for the machine will be displayed, and then click on Move Machine. 
 

(5) The Move Machine dialog box is displayed and then set Move Target Group. 
 

(6) Click on the OK button. 
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3.5.7. Delete Machine 
Delete a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Enter a check in the checkbox in the left column of the Machine to Delete on the Machine List 

group box that is displayed in the main window. 
 
(4) When you click on the Action link for Delete Machine, a confirmation dialog will be displayed. 
 
(5) Click on the OK button. 
 
You can also execute Delete Machine using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Machine to Delete. 
 
(4) The Configuration menu for the machine will be displayed, and then click on Delete Machine. 
 
(5) Click on the OK button. 
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3.5.8. Batch Network Setting 
Set the network settings as a batch. Batch Network Setting can be applied to the machines directly 
under the group or the groups and machines under the group that is the target for the application. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch 

Network Setting icon. 
 

(3) The Configuration menu for the Machine Group icon will be displayed, and then click on 
Network Setting from Batch Setting. 
 

(4) The Batch Network Setting screen will be displayed in the main window and you can configure 
each item. 
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Batch Network Setting 

 Group Name Displays the group name. This cannot be edited. 

Network Setting Configure the network settings. 
The default is selected as the Subnetwork is same with DPM Server. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machines of the group are on the same 
Subnetwork as the DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machines of the group are on a different 
Subnetwork than the DPM Server. 
Select this when the group scheduled to be added goes through a 
router and belongs to a different network than the DPM Server. 
The following items will be enabled if the setting is Subnetwork is 
not same with DPM Server. 
•Default Gateway  
•Subnet Mask  

Set up is required if the items are enabled. 

 
 

Default Gateway  
(Setting required)  

Set the default gateway when Subnetwork is not same with DPM 
Server is selected. The top order of the IP address (first octet) is set 
in the range of "1-223." 

Subnet Mask 
(Setting required)  

Set the subnet mask when Subnetwork is not same with DPM 
Server is selected. 

Apply To Object  Set the target for the network batch. 

  Reflect setting to the 
direct machine 

Select this to apply the setting to the machines directly under the 
group. 
Reflect setting to the direct machine is selected by default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to groups and machines under the 
group. 

OK Saves the batch settings details of the Batch Network Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting details from 
the Batch Network Setting screen. 
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3.5.9. Batch Set Automatic Update Time 
The automatic update time for the managed machine registered with the group is set by batch. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Set Automatic 

Update Time icon. 
 

(3) The Configuration menu for the Machine group icon will be displayed, and then click on Set 
Automatic Update Time from Batch Setting. 
 

(4) The Batch Set Automatic Update Time screen will be displayed in the main window and you 
can configure each item. 
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Batch Set Automatic Update Time 

 Group Name Displays the group name. This cannot be edited. 

Automatic Update Time Setting 

 Automatic Update Set the automatic update function for the group. You can select 
from the following. 
•Constantly Off 
•ON At Startup 
•OFF At Startup 

The default is OFF At Startup. 
The following setting values will be disabled it the setting is 
Constantly Off. 
•Automatic Update Time 
•Application Timing 
•Retry Count 
•Retry Interval (Min) 

When you set the automatic update function to Constantly Off, 
the managed machine will not request not applied packages to the 
Management Server. (*Please see Section 2.7.4, "Automatic 
Update Setting" regarding the automatic update setting example 
and action.) 

Automatic Update Time Set the automatic update time for the group. 

 Left List Box  Select the day for performing the automatic update. You can select 
from the following. 
•Everyday 
•Sunday - Saturday(Sun. – Sat) 

The default is blank. 

Right List Box  Select hourly increments from "0: 00" - "23: 00". If you select 
Empty in the left list box, the setting time will be disabled. 

Application Timing Set about the operation of application timing of the package. 
You can select from the following. 
•Immediately 
•At Next Startup 
•Show Confirmation 

The default is At Next Start up. 
If the application timing is Immediately or At Next Startup up, the 
screen will not be shown on the managed machines. (*Please see 
Section 2.7.4, "Automatic Update Setting" about the selection of 
application timing and operation.)  

Retry Count  If the connection to the Management Server failed, the connection 
will be re-tried by the set number of re-try times. This can be set in 
the range of "0 - 5" times. 
The default value is "1" time. 

Retry Interval(Min.) If the connection to the Management Server failed, the connection 
will be re-tried at the set time interval. This can be configured in 
five minute increments from "5" to "30" minutes. 
The default value is "5" minutes. 
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Apply To Object Set the target for Batch Set Automatic Update Time. 

 Reflect setting to the 
direct machine 

Select this to apply the setting to the machines directly under the 
group. 
Reflect setting to the direct machine is selected by default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to groups and machines under the 
group. 

OK Saves the batch settings details of the Batch Set Automatic 
Update Time screen and returns to the previous window. 

Cancel Returns to the previous window without saving the batch settings 
details from the Batch Set Automatic Update Time screen. 
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3.6. Menu Operations for a Group 
Explains the menus related to the operations used by the group. 
 

3.6.1. Batch Execution 
These are batch operations such as Assign Scenario, Remove Scenario Assignment, Power ON, 
Shutdown, Execute Scenario, Scenario Execute Stop for all of the managed machines in the 
corresponding group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch 

Execution icon. 
 

(3) The Machine List group box is displayed. Then please perform the various operations from 
Batch Execution on the Operation menu. 
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Batch Execution  

 Assign Scenario  Assigns the scenario to all managed machines in the corresponding 
group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.3, "Assign scenario" regarding the setting 
items for Assign Scenario. 

Remove Scenario 
Assignment  

Deletes the scenario assignment for all managed machines in the 
corresponding group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.4, "Delete Scenario Assignment" regarding 
the setting items for Remove Scenario Assignment. 

Power ON  This will do Power ON for all managed machines in the corresponding 
group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.1, "Power ON" regarding the setting items for 
Power ON. 

Shutdown  This will do shutdown for all managed machines in the corresponding 
group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.2; "Shutdown" regarding the setting items for 
Shutdown. 

Execute Scenario  This will execute the scenario for all managed machines in the 
corresponding group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.6, "Execute Scenario" regarding the setting 
items for Execute Scenario. 

Scenario Execute Stop 
 

This will do Scenario Execute Stop for all managed machines in the 
corresponding group. 
Select the target from the Apply To Object group box using the radio 
button for the target machines as shown in the following example. 
Please see Section 3.8.7, "Interrupt Scenario Execution" regarding the 
setting items for Scenario Execute Stop. 

 



3 Operations 
 

DeploymentManager Ver6.0 Reference Guide 
92 

 
Example) 

If you click on Assign Scenario from Batch Execution on the Operation menu, the Batch 
Assign Scenario screen will be displayed. 

 
 

The common items on the Batch Execution screen are as follows. 
* Please see the chapters listed in the chart above regarding the each of the setting items for the 
Operation menu. 

Application Target  

 Group Name Displays the group name. This cannot be edited. 

Apply To Object  Set the target of the batch operation. 

 Reflect setting to the 
direct machine  

Select this to apply the setting to the machines directly under the 
group. 
Reflect setting to the direct machine is selected by default. 

Reflect setting to the 
subordinate machine  

Select this to apply the setting details to groups and machines 
under the group. 

Run Now   
(only for Assign Scenario) 

The scenario will run immediately on the target machine. An error 
message will be displayed if there is no scenario assigned to the 
target machine. 

OK Batch execution will be done and returns to the previous window. 

Cancel Returns to the previous window without doing batch execution. 
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3.7. Managed Machine Details 
Displays the machine detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed, and then click on the name of the Machine to 

Display Information. 
 

(4) The Machine Detail group box is displayed in the main window. 
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Machine Detail 

 

Name Displays the name of the managed machine. This cannot be edited. 

Group  Displays the corresponding group to which the managed machine 
belongs. This cannot be edited. 

UUID Displays the UUID of the managed machine. 

IP Address  If there are multiple IP addresses for the managed machine, the IP 
address for communicating with the Management Server will be 
displayed. This will be displayed as empty if there is no IP address 
information. 

MAC Address Displays the MAC address of the managed machine. 

Deploy-OS Displays Deploy-OS used by the managed machine when you 
execute backup/restore/disk configuration check. 

Status Displays the status of the managed machine. Please see Section 
3.7.1, "Machine Status" regarding the status. 
Click on Status to display the Execute Scenario List screen on the 
main window. Please see Section 4.3, "Scenario Execution List" 
regarding the screen. 

Power  Displays the power status of the managed machine. Please see 
Section 3.8.1, "Power ON" to Section 3.8.2, "Shutdown" regarding the 
power status. 

Operating System  Displays the name of the OS on the managed machine. 

Service Pack  Displays the service pack information for the managed machine. 

HotFix/Application  Displays the Detail. If there is a HotFix or Application. 
Click on Detail to display the HotFix/Application List screen on the 
main window. 
Please see Section 3.7.1.1, "HotFix/Application List" for details. 

Package Applying Status  Displays the Detail link. 
Click on Detail to display the Package Applying Status (Package 
List) screen on the main window. 
Please see Section 3.7.1.2, "Package Applying Status (Package 
List)" regarding the screen. 

Scenario Assignment  

 Scenario Name  Displays the scenario assigned to the managed machine. 
Click on Scenario Name to display the Scenario Detail screen on 
the main window. 
Please see Section 3.15, "Scenario Detail Information" regarding the 
screen. 

Scenario Applying 
Schedule  

Displays the scenario applying schedule. 

Schedule  Displays the scenario applying schedule time. 

Power Management Schedule Information 

 Schedule  Displays the power management schedule. 
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Power ON Time Displays the power ON time. 

Shutdown Time  Displays the shutdown time. 

Do not show countdown 
dialog  

Displays whether or not the countdown dialog will be displayed at 
shutdown. 

Network Settings 

 Network  Displays whether it is the same Subnetwork as the DPM Server. 

Default Gateway  Displays the default gateway when the managed machine is on a different 
Subnetwork than the DPM Server. 

Subnet Mask Displays the subnet mask when the managed machine is on a different 
Subnetwork than the DPM Server. 

Automatic Update Settings  

 

Automatic Update  Displays the automatic update function. 

Automatic Update Time Displays the automatic update time. 

Application Timing  Displays the application timing. 

Retry Count  Displays the number of retry count. 

Retry Interval(Min)  Displays the retry interval. 
 
 

 The following value will be displayed if the machine's OS is Windows Server 2003 R2. 
Operating System: Microsoft Windows Server 2003 Standard Edition,  

or Microsoft Windows Server 2003 Enterprise Edition  
Service Pack    : Service Pack 1  

 
 The machine name displayed in the Web Console will be only the host name in the FQDN. 

The domain suffix will not be shown. 
 



3 Operations 
 

DeploymentManager Ver6.0 Reference Guide 
96 

 

3.7.1. Machine Status 
The DPM displays status information of the machine. 
The status information displayed in Status and Power on the Machine Detail screen shows the 
scenario execution status, the automatic update status and the power status. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Machine to Confirm Status. 
 

(4) The Machine Detail group box is displayed, and then confirm the Status column and the Power 
column. 
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 Status 
Displays the scenario execution status and the automatic update status for the machine. 

Status Description 

(Empty)  The status will be empty if it is not in the middle of running a scenario or 
automatic update. 

Scenario Executing  This is displayed when running a scenario. 

Scenario Execute Stop  This is displayed if scenario execution for a machine is interrupted. 
If you click on Scenario Execute Stop displayed in the Status column, a 
scenario execution list will be displayed. See Section "4.3 Scenario 
Execution List" regarding the scenario execution list. 

Scenario Execute Error  This is displayed when there is a scenario execution error. 
If you click on Scenario Execute Error displayed in the Status column, a 
scenario execution list will be displayed. See Section "4.3 Scenario 
Execution List" regarding the scenario execution list. 
Furthermore, if a scenario and automatic update are executed at the 
same time, scenario execution error will be displayed at the automatic 
update error. 
Please see Section 4.7, "Automatic Update Results List Details" 
regarding the error status. 

Remote Power ON Error This is displayed when there is a Power On error. 
If you click on Remote Power ON Error displayed in the Status column, 
a scenario execution list will be displayed. See Section "4.3 Scenario 
Execution List" regarding the scenario execution list. 

Applying A Package(Automatic 
Update) 

This displayed when applying an automatic update package. 

Transferring 
Files(Automatic Update) 

This displayed when transferring an automatic update file to a managed 
machine. 

Confirming With 
User(Automatic Update) 

This is displayed when confirming the user of executing an automatic 
update. 

Waiting For Restart(Automatic 
Update) 

This is displayed when waiting for a machine restart. 

Automatic Update in Progress This is displayed when confirming the package after the automatic update 
starts. 

Automatic Update 
Execution Error  

This is displayed when there is an error with the automatic update. 

Setting Automatic Update 
Time  

This is displayed when setting the automatic update time for the managed 
machine. 
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 The method is different for handling errors related to scenarios and errors related to automatic 

update. 
•Errors related to scenarios  

Please remove the error. Please see Section 3.8.8, "Error Cancellation" about the removing 
the error.  
Furthermore, a scenario execution error will occur when the scenario does not complete until 
the timeout expires, which was set in Section 2.7.1.2, "Scenario Tab."  

•Errors related to automatic update  
Please handle this by execute it again or restarting the DPM Client. 

 

 Power 
Displays the machine power status. 

Power  Description 

On 
This is the machine's power On status. The icon is green. 

Off  
This is the machine's power Off status. The icon is black. 
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3.7.1.1. HotFix/Application List 
The list of HotFix/applications applied to the machine is displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Machine with the Applied HotFix/Application. 
 

(4) Click on HotFix/Application - Detail in the Machine Detail group box. 
 

(5) The Applied HotFix and Installed Application group box is displayed in the main window. 
 

 
 

Applied HotFix 

 HotFix Name Displays the applied HotFix list. 

Installed Applications 

 Application Name Displays the installed applications list. 
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 When service packs, HotFix, and applications are installed on a Windows managed 

machine, you cannot shut down after installation if it has the following status. 
Please be careful that these conditions do not occur if shutdown is specified. 
•The machine is locked by a workstation lock  
•The machine is locked with a screensaver with a password  
•The machine is connected to remote desktop, terminal service, or other remote 
connection software  
•There is data that is being edited or there is an application that does not respond to 
a shutdown request. 

 

3.7.1.2. Package Applying Status (Package List) 
The package applying status of the managed machine (package list) is displayed. 
The package application status is only displayed for Windows OS packages. Linux OS packages will 
not be displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, so click on the name of the 

Machine to which the package was applied. 
 

(4) Click on Package Applying Status -> Detail. 
 

(5) The Package Applying Status (Package List) group box is displayed in the main window so 
please confirm the Applied Status column corresponding to the package ID. 

 

 
 

Package Applying Status (Package List) 

 Display Count Select the Display Count to be displayed in the package list. 

Package ID  Displays the package ID. 

Summary Displays the package summary. 

Applied Date  Displays the package applied date. 

Applied Status  Displays the package applied status. (*1) 
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 Packages that cannot be applied to the managed machine won't be displayed in the list. 

 
*1 

Explains the display of the package applying status. 
The display of the 
package applied 
status 

Description 

Applied This is the status when the package has been applied to the managed machine. 
This is displayed if the prerequisites (conditions specified in the Dependency 
Information tab at the time of package creation) for applying the package have 
been met and the package application completion conditions (MS number, ID 
Information and conditions specified for application information) have been 
met. 
The absorbing service pack will determine to meet the package application 
complete conditions if the version of the service pack on the managed machine 
is the same as the Absorbing Service Pack or if it is newer in automatic 
update process. 

Not Applied The package is unapplied. 
This will be displayed if the conditions specified in the Dependency 
Information tab are met and if the MS Number, ID Information and conditions 
specified for application information are not met. 

Unnecessary Application of the package is unnecessary. 
This is displayed if the conditions specified in the Dependency Information are 
not met. There is no "Unnecessary" status for Windows CE (NEC US110). 

Unrecognized The application status cannot be identified. 
This is displayed when nothing is specified in the MS number and ID 
Information tabs. 

 
A package will not be displayed on the list in the following case because it is not a package 
application target. 

If the OS, language and service pack of the managed machine does not meet the OS, 
Lang, Base Service Pack or Absorbing Service Pack specified in Applicable 
OS/Language at the time of package creation by Image Builder or PackageDescriber, it is 
not a package application target and the package will not be displayed on the list. 
Please see Section 5, "Image Builder" or Section 6, "PackageDescriber" regarding the 
details of the methods for setting these. 
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The conditions for the display of the package application status are below. 

 
OS/Language/Service Pack/Group Information 
Conditions met Conditions 

not met 
Managed Machine Information Inquiry (Not 

displayed 
on the list) 

Inquiry completed Inquiry not 
completed 

MS Number/Dependent Information/Service Pack Not Applied 
(*2) Conditions 

met 
Conditions not met There is no MS 

number and 
Dependency 
Information for 
the package 

Applied  
(*1) 

Dependency Unrecognized 
Conditions met  Conditions 

not met 
Not Applied 
 

Unnecessary  

*1 
This is not displayed on the Package Applying Status (Machine List). 

*2 
"Not Applied" will be displayed if the inquiry is incomplete in automatic update handling or 
information sending from a managed machine to Management Server. 

 

3.7.2. Edit Managed Machine 
Edit the setting information for a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window. Then click on the name of the 

Machine to Edit. 
 

(4) The Configuration menu for the machine will be displayed, and then click on Edit Machine. 
 

(5) The Edit Machine screen appears in the main window. Then edit each item. 
 
You can also display the Edit Machine screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 

(3) The Machine List group box is displayed in the main window, click on the Edit icon ( ) for 

the Machine to Edit. 
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(4) The Edit Machine screen appears in the main window. Then edit each item. 
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Edit Machine  

 Group Name Displays the corresponding group name to which the managed machine 
belongs. This cannot be edited. 

Machine Name 
(Entry required) 

Edit the managed machine name. Up to 1 - 63 single-byte characters can be 
entered. 
The allowed characters are alphanumeric characters. 
The following symbols and single-byte spaces cannot be used. Also, You 
cannot edit a machine name that has only numbers. (*1) 
. , ; `  -  ! @ # $ ^ & * = + { } % \ | :  ' " < > / ? [ ] 
Please do not change the machine name of the machine for which the 
scenario schedule is set when the Web Console is not running. A 
scenario execution error will occur or the scenario may run on the other 
machines. However, the correct schedule will run when the Web Console 
is running and the machine name has changed. 

MAC Address Displays the MAC address of the managed machine. This cannot be 
edited. 

UUID Displays UUID of the managed machine are displayed. This cannot be 
edited. 

Deploy-OS Select Deploy-OS used by the managed machine when you execute 
backup/restore/disk configuration check. 
Please contact your sales or support representative about the setting 
values for each machine type. 
The Deploy-OS installed in the DPM Server is displayed in the list box. 
If the Deploy-OS for the machine that is being used is not displayed in the 
list box, obtain a support module from your sales or support 
representative and install the module on the DPM Server and the 
supported Deploy-OS will be shown in the list box. 

Scenario Setting  

 Assign scenario  Select to assign a scenario to a managed machine. The Browse button in 
the Scenario Name text box is enabled. 

Scenario Name  Set the scenario which will be assigned to the managed machines. 

When you click on the Browse button, the Select Scenario screen is 
displayed so please select the scenario and click on the OK button. 

Remove Scenario 
Assignment  

Select to remove the scenario assignment. 

Scenario Applying 
Schedule  

If you put a check in the Scenario Applying Schedule checkbox, you 
can set the scenario applying schedule. If you haven't set the scenario, 
you cannot enter a check in the checkbox. 

Only 
Once 

The schedule will be executed Only Once. 

Date 
(Setting 
required)  

Edit the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
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Time 
(Setting 
required)  

Edit the time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Daily The schedule is carried out on the set "Day" and "Time" from "Start Date."  

Start Date  
(Setting 
required)  

Edit the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Date  Edit the end date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set content. 
This need not be configured. 

Time 
(Setting 
required)  

Edit the time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Interval  
(Setting 
required)  

Edit the interval in day units. This can be set in the range of "1  -  99" 
days. 
The default value is once per day. 

Weekly  The schedule will be carried out weekly on the set "Day of the Week" and "Time."  

Start Date  
(Setting 
required)  

Edit the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Date  Edit the end date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set content. 
This need not be configured. 

Time 
(Setting 
required)  

Edit the time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  53 
•"Min" 0  -  29  

Day of the 
Week Setting  
(Setting 
required)  

Set one or more of Sunday - Saturday. 

Monthly The schedule will be carried out monthly on the set "Date" and "Time."  
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Start Month 
(Setting 
required)  

Edit the start month. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Month  Edit the end month. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the end month is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Edit the time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Day  
(You Must Set 
Either Day/ 
Week 

If you select Day, set the day from the list box. 

Example) "End of Month" day   

Week  
(You Must Set 
Either Day / 
Week 

If you select Week, set the day of the week from the list box. 
Example) "1" - "Mon." 

Power Management 
Schedule  

If you enter a check in the Power Management Schedule checkbox, 
you can manage the managed machine's power status. 
If a check is entered, select either or both Power ON Time / Shutdown 
Time. 

Only 
Once 
 

The schedule will be executed Only Once. 

Power ON Time If you enter a check in the Power ON Time checkbox, you can edit the 
power ON time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Set the time at least 5 minutes from the current time. 
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Shutdown Time  If you enter a check in the Shutdown Time checkbox, you can edit the 
shutdown time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Set the time at least 5 minutes from the current time. If you set this at the 
same time as the Power ON Time, set the interval with at least a space 
of 10 minutes. 

Do not show 
countdown 
dialog 

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule will be carried out on the set "Day of the Week" and "Time."  

Power On Time If you enter a check in the Power ON Time checkbox, you can edit the 
power ON time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

Shutdown Time  If you enter a check in the Shutdown Time checkbox, you can edit the 
shutdown time. 
You can enter the following range in the textbox. 
•"Hr" 0  -  23 
•"Min" 0  -  59  

If you set this at the same time as the Power ON Time, set the interval 
with at least a space of 10 minutes. 

Do not show 
countdown 
dialog  

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Day of the Week 
Setting  
(Setting 
required)  

Set one or more of Sunday  -  Saturday. 

Network Setting 

 Subnetwork is same 
with DPM Server 

Select this when the managed machine is on the same Subnetwork as 
the DPM Server. 
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Subnetwork is not 
same with DPM Server 

Select this when the managed machine is on a different Subnetwork than 
the DPM Server. 
Select this when the machine goes through a router and belongs to a 
different network than the DPM Server. 
The following items will be enabled if the setting is Subnetwork is not 
same with DPM Server. 
•Default Gateway  
•Subnet Mask  

Set up is required if the items are enabled. 

 
 

Default Gateway  
(Setting 
required)  

Set the default gateway when the managed machine is on a different 
Subnetwork than the DPM Server. The top order of the IP address (first 
octet) is set in the range of "1-223." 

Subnet Mask 
(Setting 
required)  

Edit the subnet mask when the managed machine is on a different 
Subnetwork than the DPM Server. 

Automatic Update Setting  

 Automatic Update  

Set the automatic update function. You can select the following 
operations. 
•Constantly OFF 
•ON At Startup  
•OFF At Startup  

The following setting will be disabled if the setting is Constantly OFF. 
•Automatic Update Time  
•Application Timing  
•Retry Count 
•Retry Interval (Min.)  

When you set the automatic update function to Constantly OFF, the 
managed machine will not request not applied packages to the 
Management Server. (*Please see Section 2.7.4, "Automatic Update 
Setting" regarding the Automatic Update setting example and action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box  Select the day for performing the automatic update. You can select from 
the following. 
•Everyday  
•Sun - Sat  

Right List Box  Select hourly increments from "0: 00" to "23: 00". If you select Empty in 
the left list box, the setting time will be disabled. 
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Application Timing  Set the package application timing. You can select from the following. 
•Immediately  
•At Next Startup 
•Show Confirmation  

If the application timing is Immediately or At Next Startup, the 
confirmation screen will not be shown on the managed machines. 
(*Please see Section 2.7.4, "Automatic Update Setting" about the 
Application Timing selection and operation.)  

Retry Count  If the connection to the Management Server failed, the connection will be 
re-tried the set number of re-try times. This can be set in the range of "1 - 
5" times. 

Retry Interval(Min.)   If the connection to the Management Server failed, the connection will be 
re-tried at the set time interval. This can be configured in five minute 
increments from "5" to "30" minutes. 

OK Saves the settings details on the Edit Machine screen and returns to the 
previous window. 

Cancel Returns to the previous window without saving the settings details from 
the Edit Machine screen. 

*1 
If the DPM Client is installed, even if the name of the machine registered on the Web 
Console and the actual machine is different, the name on the Web Console will be 
automatically changed to the actual machine name when the machine is turned ON. 
If the same name machine already exists under the same Management Server, the name of 
the already existing machine will be changed to "(Machine)x" (with the x being a number 
from 1 to 39999 entered in order). 
 

3.7.3. Move Machine 
Move a machine. 
Please see Section 3.5.6, "Move Machine" regarding moving a machine. 
 

3.7.4. Delete Machine 
Delete a machine. 
Please see Section 3.5.7, "Delete Machine" regarding deleting a machine. 
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3.8. Menu Operations to a Machine 
Explains the Action menu and Operation menu for the machine. 
 

3.8.1. Power On 
Turn ON the power of the managed machine. 
You can operate Power ON for only one managed machine or selected multiple managed machines 
with Machine Individual Operations. 
 

• To operate for only one managed machine 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Power ON. 
 

(4) The Operation menu for the managed machine is displayed, so click on the Operation -> 
Power ON. 

 
• To operate selected multiple managed machines 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Machine to Power ON in the Machine 

List group box that is displayed in the main window. 
 

(4) Click on Power ON of Machine Individual Operations… from the Action menu. 
 

The Power column icon will become "  (green)" after Power ON. 
If Power ON fails, the Power column icon becomes "  (yellow)" and Remote Power ON Error is 
displayed. Also, an error message is displayed. 
 

  If the Machine List group box status still shows power OFF after execute Power ON, 
please click on Refresh from the Operation menu to refresh to the latest information. 

 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Power ON for 
batch operations for all managed machines. 
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3.8.2. Shutdown 
Shut down a managed machine. 
You can operate Shutdown for only one managed machine or selected multiple machines with 
Machine Individual Operations. 
 

• To operate for only one managed machine 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Machine to shut down. 
 
(4) The Operation menu for the managed machine will be displayed, and then click on Shutdown. 
 

• To operate selected multiple managed machines 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Enter a check in the checkbox in the left column of the Machine to shut down on the Machine 

List group box that is displayed in the main window. 
 
(4) Click on Shutdown of Machine Individual Operations… from the Action menu. 

The Power column icon will become "  (black) off" after Shutdown. 
If Shutdown fails, nothing will be displayed. 

 
  Please install the DPM Client on the machine to perform shutdown. It will be 

automatically installed if you install OS by using DPM. Please see Section 2.2, "Installing 
the DPM Client" in the Installation Guide for details. 

 You cannot shut down if the Windows managed machine status is as follows. 
• The machine is locked by a workstation lock. 
• The machine is locked with a screen saver with a password. 
• The machine is connected to remote desktop, terminal service, or other remote 
connection software. 

• There is data that is being edited or there is an application that does not respond 
to a shutdown request. 

If password lock function is enabled by default in the OS, shut down after canceling the 
password lock. 

 
 If a Linux machine is operating on X Window system, when Console is not running, you 

cannot confirm that shutdown was executed. 
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  If the Machine List group box status still shows power ON after execute Shutdown, 

please click on Refresh from the Operation menu to refresh to the latest information. 
 If shutdown is performed on a Windows machine, a countdown dialog box will be 

displayed on the managed machine. If you click on the Cancel button at this time, you 
can cancel the shutdown. If it is a Linux machine, a countdown message will be displayed 
on the managed machine. You can cancel the shutdown by executing 
/usr/local/bin/depcancel from the console. If the OS of the managed machine is SUSE 
Linux Enterprise and it is an environment that X-Window is not running (run level 3), there 
are cases that two message lines appear during remote updating or remote shutdown. 
This message does not affect operations. 

 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Shutdown of 
batch operations for all managed machines. 

 

3.8.3. Assign Scenario 
Assign the scenario to managed machines. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window. Then click on the name of the 

Managed Machine to Assign Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click on Assign 
Scenario. 
 

(5) The Assign Scenario screen appears so set each item. 
 
You can also display the Assign Scenario screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Check the check box on the left of 

the Managed Machine to Assign Scenario. 
 

(4) Click on Assign Scenario from Machine Individual Operations… from the Action menu. 



Menu Operations to a Machine 
 

Part I DeploymentManager Function Reference 
113 

 
(5) The Assign Scenario screen appears in the main window so set each item. 
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Assign Scenario  

 Base Information  Displays the base information for the managed machine. 
This group box is not displayed by default. 
Please expand it by clicking on the arrow ( ) in the right. 

 Name Displays the name of the managed machine. 

Group Displays the corresponding group name to which the managed 
machine belongs. 

UUID Displays the UUID. 

IP Address  Displays the IP address. If there are multiple IP addresses for the 
managed machine, all of the IP addresses will be displayed. 

MAC Address Displays the MAC address. This cannot be edited. 

Deploy-OS Displays Deploy-OS used by the managed machine when you 
execute backup/restore/disk configuration check. 

OS Name  Displays the OS name. 

Service Pack  Displays the service pack information for the machine. 
Nothing will be displayed if a service pack is not applied. 

Scenario Settings  

 Assign Scenario  Select to assign a scenario. 

The Browse button in the Scenario Name text box is enabled. 

Scenario Name  Set the scenario which will be assigned to the machines. 

Remove Scenario 
Assignment  

You can’t select Remove Scenario Assignment in this screen. 
To Remove Scenario Assignment, please operate from Machine 
List group box -> Action menu -> Remove Scenario Assignment. 
Please see Section 3.5, "Machine Group Details" for details. (*1) 

Scenario Applying 
Schedule  

If you check the Scenario Applying Schedule checkbox, you can 
set the scenario applying schedule. If you do not set the scenario, 
you cannot enter a check in the checkbox. 

Only 
Once 

The schedule will be executed Only Once. 

Date 
(Setting 
required)  

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Daily The schedule will be executed on the set "Day" and "Time" from Start Date. 

Start Date  
(Setting 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on 
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required)  the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Interval  
(Setting 
required)  

Edit the interval in day units. This can be set in the range of "1  -  
99" days. 
The default value is once per day. 

Weekly  The schedule will be executed weekly on the set "Day of the Week" and "Time." 

Start Date  
(Setting 
required)  

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Day of the Week 
Setting  
(Setting 
required)  

Set one or more of Sunday  -  Saturday. 

Monthly The schedule will be executed monthly on the set "Date" and "Time." 

Start Month 
(Setting 
required)  

Set the start month. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
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End Month  Set the end month. 
You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
If the End Month is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Day  
(You must set 
either 
Day/Week.) 

If you select Day, select the day from the list box. 
example) "Last of the Month" day   

Week  
(You must set 
either 
Day/Week.) 

If you select Week, select the day of the week from the list box. 
example) "1" "Monday" 

Run Now   Assigns the scenario and execute it immediately. 

OK Assigns the scenario with the setting details on the Assign Scenario 
screen and returns to the previous window. 

Cancel Returns to the previous window without assigning the scenario with 
the setting details from the Assign Scenario screen. 

*1 
Likewise, normally the radio button of Remove Scenario Assignment cannot be selected on the 
Operation menu -> Batch Execution - Assign Scenario. 

 
  Please do not change the date or time on the Management Server after setting the 

scenario applying time. Also, please do not set the time for the scenario applying 
time and the power ON or shutdown as the same time. This may result in the 
processing not performing correctly. 

 For a monthly schedule, the schedule won't be run if you select the 29th, 30th or 31st 

as there are months that do not have those days. 
Example) If the monthly date is set to be the 31st, the schedule will not be run in 

February, April, June, September or November. The schedule will be executed in 
January, March, May, July, August, October and December. 

 
 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Assign 

Scenario for batch operations for all managed machines. 
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3.8.4. Delete Scenario Assignment 
Remove the assignment of the scenario from the managed machine. 
You can operate Remove Scenario Assignment for only one managed machine or selected multiple 
managed machines with Machine Individual Operations. 
 

• To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Remove Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click on Remove 
Scenario Assignment. 

 
• To operate selected multiple managed machines  

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Check the check box on the left of 

the Machine to Remove Scenario. 
 

(4) Click on Remove Scenario Assignment of Machine Individual Operations… from the Action 
menu. 

 
 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Remove 

Scenario Assignment for batch operations for all managed machines. 
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3.8.5. Power Management Schedule 
Set the power management schedule for the managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Schedule Power Management. 
 

(4) The Operation menu for the managed machine will be displayed, and then click on Set Power 
management Schedule -> OK button. 
 

(5) Click on the OK button to display the Power Management Schedule screen on the main 
window and then set each item. 
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Power Management Schedule  

 Base Information  Display the base information for the managed machine. 
This group box is not displayed by default. 
Please expand it by clicking on the arrow ( ) in the right. 

 Name Displays the name of the managed machine. 

Group Displays the corresponding group name to which the managed machine 
belongs. 

UUID Displays the UUID. 

IP Address  Displays the IP address. If there are multiple IP addresses for the 
managed machine, all of the IP addresses will be displayed. 

MAC Address Displays the MAC address. 

Deploy-OS Displays Deploy-OS used by the managed machine when you execute 
backup/restore/disk configuration check. 

OS Name  Displays the OS name. 

Service Pack  Display the service pack information for the machine. 
Nothing will be displayed if a service pack is not applied. 

 Power Management 
Schedule  

If you enter a check in the Power Management Schedule checkbox, you 
can manage the machine's power status. 

If a check is entered, select either or both Power ON Time / Shutdown 
Time. 

Only 
Once  

The schedule will be executed Only Once. 

Power On Time 
(Setting 
required) 

If you enter a check in the Power ON Time checkbox, you can set the 
power ON time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
Set the time at least 5 minutes from the current time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Shutdown 
Time  

If you enter a check in the Shutdown Time checkbox, you can set the 
shutdown time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Set the time at least 5 minutes from the current time. If you set this at the 
same time as the Power ON Time, set the interval with at least a space of 
10 minutes. 
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Do not show 
countdown 
dialog   

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule will be executed on the set "Day of the Week" and "Time."  

Power On Time 
(Setting 
required) 

If you enter a check in the Power ON Time checkbox, you can set the 
power ON time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Shutdown 
Time  
(Setting 
required) 

If you enter a check in the Shutdown Time checkbox, you can set the 
shutdown time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

If you set this at the same time as the Power ON Time, set the interval 
with at least a space of 10 minutes. 

Do not show 
countdown 
dialog   

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Day of the 
Week Setting  
(Setting 
required)  

Set one or more of Sunday - Saturday. 

OK Saves the settings details on the Power Management Schedule screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the settings details from 
the Power Management Schedule screen. 
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3.8.6. Execute Scenario 
Execute the scenario assigned to the managed machines. 
You can operate Execute Scenario for only one managed machine or selected multiple managed 
machines with Machine Individual Operations. 
 

• To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Execute Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click on Execute 
Scenario. 

 
• To operate selecting multiple managed machines  

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Check the check box on the left of 

the Machine to Execute Scenario. 
 

(4) Click on Execute Scenario of Machine Individual Operations… from the Action menu. 
 

  To execute a scenario of the backup/restore/disk configuration check, you will 
need to set up the Deploy-OS that corresponds to the machine model of the 
managed machine before scenario execution. Please see Section 3.9.2, "Add 
New Machine" regarding how to set the Deploy-OS. 

 In the case that the scenario does not run when the power of the managed 
machine is on, perform one of the following operations:   
• On the Edit Scenario screen, select the Forced Execution Of A Reboot Is 

Performed Before Execution checkbox in the Scenario Execution 
Operation Setting group box on the Option tab. 

* If the Windows managed machine has the following status, you cannot 
restart, even if you enter a checkmark next to Forced Execution Of A 
Reboot Is Performed Before Execution. 

- The machine is locked by a workstation lock. 
- The machine is locked with a screensaver with a password 
- The machine is connected to remote desktop, terminal service, or other 

remote connection software 
- There is data that is being edited or there is an application that does not 

respond to a shutdown request. 
• Restart the managed machine manually. 
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 DPM executes UDP communication when data is sent by multicast. 

With UDP communication, if devices of a different transmission rate are located on the 
path, a difference occurs in the volume of data transmitted between the transmission side 
and reception side, sometimes the data transmission fail. 
If this happens, it will take a longer time to complete the scenario. 

 
  A managed machine prior to rebooting can execute 100 scenarios specified under 

Execute At Next Startup under Execution Timing Setting on the Package tab of 
the scenario. If you execute 101 or more scenarios, reboot the managed machine.  
Rebooting allows you to execute another 100 scenarios. 

 If you specified an application at the same time as the service pack, HotFix, or Linux 
patch file, the service pack, HotFix, or Linux patch file will first be applied followed by 
application installation. 

 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Assign 
Scenario about batch operations for all managed machines. 

 
Also, if Password or Warning is set in Execute Scenario in the Management view -> DPM 
Server -> Guard Parameter Setting screen, the following Confirm Scenario Setting screen will 
be displayed when the scenario runs. 
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Confirm Scenario Setting  

 Scenario Name  Displays the scenario name. 

Scenario Information 

 Scenario Name  Displays the scenario name. 

Scenario Group Name  Displays the scenario group name. 

Type  Displays the scenario type. 

The scenario information displayed here will differ depending on type of scenario selected in 
Scenario Name. Please see Section 3.15, "Scenario Detail Information" regarding the details. 

Options  

 The Scenario Execution Option Setting set in the Add Scenario screen -> Option tab will be 
displayed. Please see Section 3.13.5, "Option Tab" regarding the settings. 

Target Machine  

Machine Name  Displays the name of the managed machine on which the scenario 
will run. 

OK The scenario is run using the settings details on the Confirm 
Scenario Setting screen and it returns to the previous window. 

Cancel It returns to the previous without running the scenario using the 
settings details from the Confirm Scenario Setting screen. 

 

3.8.7. Interrupt Scenario Execution 
Stop the execution of the scenario assigned to the managed machines. 
You can operate Scenario Execute Stop for only one managed machine or selected multiple 
managed machines with Machine Individual Operations. 
 

• To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Stop Scenario Execute. 
 

(4) The Operation menu for the managed machine will be displayed, and then click on Scenario 
Execute Stop. 

 
• To operate selecting multiple managed machines  

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Check the check box on the left of 
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the Machine to Stop Scenario Execute. 
 

(4) Click on Scenario Execute Stop of Machine Individual Operations… from the Action menu. 
 

In the case of Scenario Execute Stop the machine icon becomes " " and Scenario Execute Stop 
is displayed. An error message will be displayed if Scenario Execute Stop fails. 
 

 You cannot restart a scenario where the scenario was stopped. In order to re-run the scenario, 
please perform the restart scenario execution once the scenario interrupt process has 
completed. 

 
 The Scenario Execute Stop status will automatically clear and return to normal once the 

interrupt process has completed. The interrupt process for the executed scenario may take 
some time. 

 
 Please see Section 3.6.1, "Batch Execution" regarding Batch Execution - Scenario Execute 

Stop regarding batch operations for all managed machines. 
 

3.8.8. Error Cancellation 
Remove the Scenario Execution Error for the scenario assigned to the managed machine and 
Remote Power ON Error. 
You can operate Remove Error for only one managed machine or selected multiple managed 
machines with Machine Individual Operations. 
 

• To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Remove Error. 
 
(4) The Operations menu for the managed machine will be displayed, and then click on Remove 

Error. 
 
(5) Click on the OK button. 

 
• To operate selecting multiple managed machines  

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Managed Machine to Remove Error on 

the Machine List group box that is displayed in the main window. 
 

(4) Click on Remove Error of Machine Individual Operations… from the Action menu. 
 

(5) Click on the OK button. 
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3.8.9. Interrupt Cancellation 
Remove Interruption for the scenario assigned to the managed machines. 
You can operate Remove Interruption for only one managed machine or selected multiple managed 
machines with Machine Individual Operations. 
 
You do Remove Interruption in the following cases. 
- The latest information is still Scenario Execute Stop when more than 2 hours have passed since 

the Scenario Execute Stop. 
- The managed machine has been manually powered OFF. 
After the process of Scenario Execute Stop is completed, the status returns to normal. So normally it 
is not necessary to do Remove Interruption. 
 

• To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box is displayed in the main window, then click on the name of the 

Managed Machine to Remove Interruption. 
 
(4) The Operation menu for the managed machine will be displayed, and then click on Remove 

Interruption. 
 

• To operate selecting multiple managed machines  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Enter a check in the checkbox in the left column of the Managed Machine to Remove 

Interruption on the Machine List group box that is displayed in the main window. 
 
(4) Click on Remove Interruption of Machine Individual Operations… from the Action menu. 

 
  If the status of the machine on the Web Console is still Scenario Execute Stop after 

selecting Remove Interruption, please click on Refresh in the Operation menu to 
refresh the latest information. 

 When you execute Remove Interruption, there may be cases where the interrupt 
processing does not proceed normally and the following status may occur. In this 
case, please manually turn the power of the managed machine ON or OFF. 

•You cannot turn the power ON or OFF for the managed machine from the Web 
Console. 

•You cannot execute a scenario. 
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3.9. "New Machine" Icon 
The new machine is managed with the New Machine icon. 
You can access the New Machine icon from the Machines icon -> New Machine icon on the tree 
view of the Operations view. 
Click on the New Machine icon to display the Machine List group box on the main window. 
 
Furthermore, if the managed machine supports PXE boot, the New Machine icon is automatically 
displayed in the tree view when a PXE packet is received. 
Also, even if the machine does not support PXE boot, if the DPM Client is installed on the machine, 
the DPM Client communicates with the Management Server when the machine is run and the New 
Machine icon will automatically be displayed in the tree view. 

 
 

New Machine List  

 Display Count Select the display count to be displayed for the new machine. 

"Action" Link •When you click Add Machine, the selected new machine will be 
added. 

You can select and add multiple new machines by entering a check 
in the checkbox on left column of the new machine. 
•When you click Delete Machine, the selected new machine will be 
deleted. You can select and delete multiple new machines by 
entering a check in the checkbox on left column of the new 
machine. 

(Checkbox)  You can select multiple machines by entering a check in the left 
column checkbox. You can select all of the new machines if you put 
a check in the top checkbox. 

MAC Address Displays the MAC address of the new machine. 
Click on the MAC address to display the Base Information group 
box on the main window. Please see Section 3.9.1, "New Machine 
Detailed Information" regarding the base information. 

UUID Displays the UUID of the new machine are displayed. 

IP Address  Displays the IP address of the new machine. 
If there are multiple IP addresses, the IP address for 
communicating with the Management Server will be displayed. This 
will be displayed as empty if there is no IP address information. 

 



"New Machine" Icon 
 

Part I DeploymentManager Function Reference 
127 

 

3.9.1. New Machine Detailed Information 

Displays the new machine detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> New Machine icon. 

 
(3) The New Machine List screen is displayed, and then click on the MAC Address for the new 

machine to display detailed information. 
 

(4) The Base Information group box is displayed in the main window. Then please confirm base 
information for the new machine. 

 

 
 

Basic Information  

 UUID Displays the UUID. This cannot be edited. 

MAC Address Displays the MAC address. This cannot be edited. 

IP Address  Displays the IP address. This cannot be edited. 
If there are multiple IP addresses, the IP address for 
communicating with the Management Server will be displayed. 
This will be displayed as empty if there is no IP address 
information. 
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3.9.2. Add New Machine 
Add a new machine. 
You can select one machine or multiple machines and add them to a group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen is displayed in the main window. Then enter a check in the left 

column of the New Machine to Add and click on the Action link for Add Machine. 
 
(4) The Add New Machine screen appears in the main window. Please set each item. 

 
You can also display the Add New Machine screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine icon -> MAC Address of the 

New Machine to Add. 
 

(3) The Configuration menu for the new machine will be displayed. Then click on Add Machine. 
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(4) The Add New Machine screen appears in the main window. Please set each item. 
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Add New Machine  

 Group Name Select the group from the list box. This cannot be edited. 

Machine Name Displays the new machine name. 
To add multiple new machines, all of the new machines are displayed in 
the list box. 
The default is "pc-xxx_xxx_xxx_xxx(xx-xx-xx-xx-xx-xx)". 
pc-xxx_xxx_xxx_xxx is the IP address and (xx-xx-xx-xx-xx-xx) is the 
MAC address. This cannot be edited. 
If the DPM Client is installed, even if the name of the added machine 
and the actual machine is different, the name on the Web Console will 
be automatically changed to the actual machine name when the 
machine is turned ON. 
If the same machine name already exists under the same Management 
Server, the name of the already existing machine will be changed to 
"(Machine Name)x" (with the x being a number from 1 to 39999 entered 
in order). 

MAC Address When only one new machine is added, the MAC address is 
automatically acquired and displayed. The MAC address is not 
displayed if multiple machines are added. The MAC address cannot be 
edited. 

UUID When only one new machine is added, the UUID is automatically 
acquired and displayed. The UUID is not displayed if multiple machines 
are added. 
The UUID cannot be edited. 
DPM distinguishes between registered machines using UUID. 

Deploy-OS Select Deploy-OS used by the managed machine when you execute 
backup/restore/disk configuration check. 
Please contact your sales or support representative about the setting 
values for each machine model. 
The Deploy-OS installed in the DPM Server is displayed in the list box. 
If the Deploy-OS for the machine that is being used is not displayed in 
the list box, obtain a support module from your sales or support 
representative and install the module on the DPM Server and the 
supported Deploy-OS will be shown in the list box. 

Scenario Setting 

 Assign scenario  Select to assign a scenario. 

The Browse button in the Scenario Name text box is enabled. 

Scenario Name  Set the scenario which will be assigned to the added managed 
machines. 

Remove Scenario 
Assignment  

Select to remove the scenario assignment. 

Scenario Applying 
Schedule  

If you put a check in the Scenario Applying Schedule checkbox, you 
can set the scenario applying schedule. If you haven't set the scenario, 
you cannot enter a check in the checkbox. Setting is required if this is 
checked. 
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 Only 
Once 

The schedule will be executed Only Once. 

Date 
(Setting 
required) 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

Time 
(Setting 
required) 

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

 Daily The schedule will be executed on the set "Day" and "Time" from Start Date. 

Start Date 
(Setting 
required) 

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59  

Interval  
(Setting 
required)  

Edit the interval in day units. This can be set in the range of "1 - 99" 
days. 
The default value is once per day. 

Weekly  The schedule will be executed weekly on the set "Day of the Week" and "Time." 

Start Date  
(Setting 
required)  

Set the start date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0 - 23 
• "Min" 0 - 59  

Day of the 
Week Setting  

Set one or more of Sunday - Saturday. 
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(Setting 
required)  

Monthly The schedule will be executed monthly on the set "Date" and "Time."  

Start Month 
(Setting 
required)  

Set the start month. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 

End Month  
 

Set the end month. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
If the End Month is not set, the schedule will repeatedly run the set 
content. This need not be configured. 

Time 
(Setting 
required)  

Set the time. 
You can enter the following range in the textbox. 
• "Hr" 0 - 23 
• "Min" 0 - 59 

Day  
(You Must Set 
Either Day/ 
Week 

If you select Day, select the day. 
・ 01 - 31 
・ End of Month  

Example) "End of Month" day   

Day of the 
Week  
(You Must Set 
Either Day/ 
Week 

If you select Week, set the day of the week. 
Example) "1" - "Mon." 

 Left List Box  Select from the following. 
• 1st  -  4th 
• Last  

Right List 
Box  

Select from the following. 
• Monday - Sunday  

Power 
Management  
Schedule  

If you enter a check in the Power Management Schedule checkbox, 
you can manage the machine's power status. 
If a check is entered, select either or both Power ON Time / Shutdown 
Time. 

Only 
Once  

The schedule will be executed Only Once. 

Power 
On Time 
(Setting 
required) 

If you enter a check in the Power ON Time checkbox, you can set the 
power ON time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
Set the time at least 5 minutes from the current time. 
You can enter the following range in the textbox. 
• "Hr" 0 - 23 
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• "Min" 0 - 59 

Shutdown 
Time 
(Setting 
required) 

If you enter a check in the Shutdown Time checkbox, you can set the 
shutdown time. 
You can enter the date (year/month/day) or click on the " " icon on the 
side of the textbox and select the date from the displayed calendar. 
Please enter using YYYY/MM/DD format. 
You can enter the following range in the textbox. 
• "Hr" 0  -  23 
• "Min" 0  -  59 

Set the time at least 5 minutes from the current time. If you set this at 
the same time as the Power ON Time, set the interval with at least a 
space of 10 minutes. 

Do not show 
countdown 
dialog 

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule will be executed on the set "Day of the Week" and "Time."  

Power 
On Time 
(Setting 
required) 

If you enter a check in the Power ON Time checkbox, you can set the 
power ON time. 
You can enter the following range in the textbox. 
• "Hr" 0 - 23 
• "Min" 0 - 59 

Shutdown 
Time 
(Setting 
required) 

If you enter a check in the Shutdown Time checkbox, you can set the 
shutdown time. 
You can enter the following range in the textbox. 
• "Hr" 0 - 23 
• "Min" 0 - 59 

Do not show 
countdown 
dialog 

If you enter a check in the Do not show countdown dialog checkbox, 
the countdown dialog is not displayed at the time of shutdown. 

Day of the 
Week Setting  
(Setting 
required)  

Set one or more of Sunday - Saturday. 

 Network Setting Edit the network settings for a managed machine. 
The default is selected as the Same Subnetwork as the DPM Server. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machine is on the same Subnetwork as 
the DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machine is on a different Subnetwork 
than the DPM Server. 
Select this when the group scheduled to be added goes through a router 
and belongs to a different network than the DPM Server. 
The following items will be enabled if the setting is Subnetwork is not 
same with DPM Server. 
• Default Gateway  
• Subnet Mask  
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Set up is required if the items are enabled. 

 Default Gateway  
(Setting required)  

Set the default gateway when the managed machine is on a different 
Subnetwork than the DPM Server. The top order of the IP address (first 
octet) is set in the range of "1-223." 

Subnet Mask 
(Setting required)  

Set the subnet mask when the managed machine is on a different 
Subnetwork than the DPM Server. 

Automatic Update Setting  Perform automatic update settings for a new managed machine. 
The default is the value set on the Management view – DPM Server 
icon - Automatic Update Setting screen. 
Please see Section 2.7.4, "Automatic Update Setting" regarding the 
Automatic Update Setting screen. 

 Automatic Update Set the automatic update function. You can select from the following. 
• Constantly OFF 
• ON At Startup  
• OFF At Startup  

The default is OFF At Start up. 
The following setting will be disabled if the setting is Constantly OFF. 
• Automatic Update Time  
• Application Timing 
• Retry Count 
• Retry Interval (Min.) 

When you set the automatic update function to Constantly OFF, the 
managed machine will not request not applied packages to the 
Management Server. (*Please see Section 2.7.4, "Automatic Update 
Setting" regarding the Automatic Update setting example and action.) 

Automatic Update Time Set the automatic update time. 

 Left List Box  You can set the day for performing the automatic update. You can 
select from the following. 
• Everyday  
• Sun - Sat  

The default is blank. 

Right List Box  You can select hourly increments from "0: 00" to "23: 00". 

Application Timing  Set the operation for the automatic update application timing when a 
new managed machine is registered to the group. You can select from 
the following. 
• Immediately 
• At Next Start up 
• Show Confirmation 

If the application timing is Immediately or At Next Start up, the 
confirmation screen will not be shown on the managed machines. 
(*Please see Section 2.7.4, "Automatic Update Setting" about the 
Application Timing selection and operation.) 

Retry Count If the connection to the Management Server failed, the connection will 
be re-tried the set number of re-try times. This can be set in the range of 
"1 - 5" times. 

Retry Interval (Min.)  If the connection to the Management Server failed, the connection will 
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be re-tried at the set time interval. This can be configured in five minute 
increments from "5" to "30" minutes. 

OK Adds the new machine with the setting details on the Add New 
Machine screen and returns to the previous window. 

Cancel It returns to the previous window without adding the new machine with 
the setting details from the Add New Machine screen. 

 

3.9.3. Delete New Machine 
Delete a new machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen is displayed. Then enter a check in the left column of the New 

Machine to Delete and when you click on the Action link for Delete Machine, a confirmation 
dialog box is displayed. 
 

(4) Click on the OK button. 
 
You can also delete the new machine, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen is displayed, and then click on the MAC Address for the New 

Machine to Delete. 
 

(4) The Configuration menu for the new machine will be displayed. Then click on Delete 
Machine. 
 

(5) The confirmation dialog box appears. Click the OK button.
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3.10. "Scenario" Icon 
You can manage the scenario group and scenario from the Scenarios icon. 
You can access the Scenarios icon from the Scenarios icon at the top of the tree view of the 
Operations view or from Scenario in the Summary Information group box displayed on the main 
window of the Operations view. 
Click on the Scenarios icon to display the Group List group box on the main window. 
 

 
 

Scenario Group List  

 Display Count You can select the Display Count to be displayed in the 
scenario group. 

"Action" Link When you click Delete Group, the selected scenario group will 
be deleted. Please select the radio button for the scenario group 
to be deleted and perform the operation. 

Name Displays the scenario group name. This cannot be edited. 

Subgroup Number 
(Directly/Subordinates)  

Displays the number of subgroups directly under/subordinate 
to the concerned group. 

Scenario Number 
(Directly/Subordinates) 

Displays the number of scenarios directly under/subordinate to 
the concerned group. 

Edit Edit a scenario group name. Click on the " " icon to display 
the Edit Scenario Group screen on the main window. 
Please see Section 3.12.1, "Edit Scenario Group" regarding 
the Edit Scenario Group screen. 

 
 A Built-in Scenarios group is already existed when DPM Ver6.0 is installed. 

The following scenarios are registered under Built-in Scenarios by default. 
•System_AgentUpgrade_Multicast 
•System_Backup 
•System_DiskProbe 
•System_LinuxAgentUpgrade_Multicast 
•System_Restore_Unicast 
•System_WinCEAgentUpgrade_Multicast 

 

javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);�
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3.10.1. Add Scenario Group 
Add the scenario group to which the scenario belongs prior to adding the scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> Scenarios icon. 

 
(3) The Configuration menu for the Scenarios icon will be displayed, then click on Add Group. 

 
(4) The Add Scenario Group screen appears in the main window. Set each item. 

 

 
 

Add Scenario Group  

 Name  
(Setting required) 

Enter the scenario group name. Up to 1 - 64 single-byte characters can be 
entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
; # 
You cannot add a scenario group with the same name. 

OK The scenario group is created with the setting details on the Add Scenario 
Group screen and it returns to the previous window. 

Cancel It returns to the previous window without creating the scenario group with 
the setting details from the Add Scenario Group screen. 

 
The following table shows the upper limit related to the number of scenario groups and scenario files. 

Item Upper Limit 

Total number of scenario groups (total number of scenario groups including 
sub-scenario groups) 

1000 

Number of scenario group layer 20 

Number of scenario files that can be registered per a scenario group Unrestricted 

Total number of scenarios (total number of scenarios affiliated with all scenario 
groups, including sub-scenario groups) 

Unrestricted 
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3.10.2. Delete Scenario Group 
 
Delete a scenario group. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> Scenarios icon. 

 
(3) The Group List group box is displayed in the main window. Then select Scenario Group to 

Delete. 
 

(4) When you click on the Action link for Delete Group, a confirmation dialog will be displayed. 
 

(5) Click on the OK button. 
 
You can also delete a scenario group, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenario icon -> Scenario Group to Delete icon. 

 
(3) The Configuration menu for the Scenario Group icon will be displayed, and then click on 

Delete Group. 
 

(4) The confirmation dialog box appears. Click the OK button. 
 

  When you delete a scenario group, the sub-scenario groups and scenarios under the 
corresponding group will also be deleted. 

 You cannot delete a scenario group if there are machines with a Scenario Executing, 
Scenario Execute Error, or Scenario Execute Stop.  
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3.11. "Scenario Group" Icon 
The scenarios are classified by scenario group and managed in the Scenario Group icon. 
You can access the Scenario Group icon from the Scenarios icon -> Scenario Group icon at the 
top of the tree view of the Operations view or from Scenarios icon -> Scenario Group icon in the 
Summary Information group box displayed on the main window of the Operations view. 
Click on the Scenario Group icon to display the Base Information, the Scenario List, and the 
Subgroup List group box in the main window. 
Please see Section 3.12, "Scenario Group Details" regarding the screen. 
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3.12. Scenario Group Details 
Displays the scenario group details information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Display 

Details icon. 
 

(3) Displays the Base Information, Scenario List and Subgroup List group box in the main 
window. 

 

 
 

Base Information  Displays the scenario group basic information. 
This group box is not displayed by default. 

Please expand it by clicking on the arrow ( ) in the right. 

 Parent Group Name  Displays the Parent Group Name only when it is a sub-scenario 
group (The scenario group level is the second level or is lower than 
the second level). The Parent Group Name will not be displayed 
for scenario groups (first level scenario groups) directly under the 
Scenario icon. 

Name Displays the scenario group name. 

Scenario List  

 Display Count Select the Display Count of the scenarios registered in the group. 
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 "Action" Link ・ When you click Move Scenario, the selected scenario is moved 
between groups. You can move multiple scenarios between 
groups by entering a check in the checkbox on left column of the 
scenario. 

・ You can copy the selected scenario if you enter a check in the 
checkbox on left column of the scenario and then click on Copy 
Scenario. 

・ When you click Delete Scenario, the selected scenario will be 
deleted. You can select and delete multiple scenarios by entering 
a check in the checkbox on left column of the scenario. 

・ The selected scenario is assigned to the managed machine if 
you enter a check in the checkbox on left column of the scenario 
and click on Assign Scenario. 

(Checkbox)  You can select all of the scenarios if you put a check in the top 
checkbox. 

Scenario Name  Displays the name of the scenario registered with this scenario 
group. 

Type  Displays the scenario type. 

Edit Edit a scenario. Click on the " " icon to display the Edit Scenario 
screen on the main window. 
Please see Section 3.13.1, "HW Settings Tab" - Section 3.13.5, 
"Option Tab" regarding the Edit Scenario screen. 

Subgroup List  

 Display Count Select the Display Count of the sub-groups registered in the group 
to display. 

"Action" Link When you click Delete Group, the selected sub-group will be 
deleted. 
Please select the radio button for the sub-group to be deleted and 
perform the operation. 

(Radio Button)  Select the sub-groups directly under the concerned group. 

Name Displays the name of the sub-group registered with this group. 

Subgroup 
Number(Directly/Subo
rdinates)  

Displays the number of sub-groups directly under/subordinate to 
the concerned group. 

Scenario 
Number(Directly/Subo
rdinates) 

Displays the number of scenarios directly under/subordinate to the 
concerned group. 

Edit Edit a scenario group name. Click on the " " icon to display the 
Edit Scenario Group screen on the main window. Please see 
Section 3.12.1, "Edit Scenario Group" regarding the Edit Group 
Scenario screen. 
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3.12.1. Edit Scenario Group 
Edit the scenario group name. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Edit icon. 

 
(3) The Configuration menu for the Scenario Group icon will be displayed, and then click on 

Edit Group. 
 

(4) The Edit Scenario Group screen appears in the main window. Then edit the scenario group 
name. 

 

 
 

Edit Scenario Group  

 Name 
(Setting required) 

Edit the scenario group name. Up to 1 - 64 single-byte 
characters can be entered. 
The allowed characters are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
; # 
You cannot edit a scenario group with the same name. 

OK Saves the settings details on the Edit Scenario Group screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
details from the Edit Scenario Group screen. 
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3.12.2. Delete Scenario Group 
Delete a scenario group. 
Please see Section 3.10.2, "Delete Scenario Group" for details. 
 

3.12.3. Add Sub-scenario Group 
Add a sub-scenario group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add 

Sub-scenario Group icon. 
 

(3) The Configuration menu for the Scenario Group icon will be displayed, then click on Add 
Subgroup. 
 

(4) The Add Scenario Group screen appears in the main window, and then set the sub-scenario 
group name. 

 

 
 

Add Scenario Group  

 Parent Group Name  Displays the parent scenario group name. This cannot be edited. 

Name 
(Setting required)  

Set the scenario group name. 
Up to 1 - 64 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
; # 
You cannot add a scenario group with the same name. 

OK The sub-scenario group is created with the setting details on the Add 
Scenario Group screen and it returns to the previous window. 

Cancel It returns to the previous window without creating the sub-scenario 
group with the setting details from the Add Scenario Group screen. 
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The following table shows the upper limit related to the number of scenario groups and 
scenario files. 

Item Upper Limit 

Total number of scenario groups (total number of scenario groups including 
sub-scenario groups) 

1000 

Number of scenario group layers 20 

Number of scenario files that can be registered per scenario group Unrestricted 

Total number of scenarios (total number of scenarios affiliated with all scenario 
groups, including sub-scenario groups) 

Unrestricted 

 

3.12.4. Delete Sub-scenario Group 
Delete a sub-scenario group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete 

Sub-scenario Group icon. 
 

(3) The Subgroup List group box is displayed. Then select Sub-scenario Group to Delete. 
 

(4) When you click on the Action link for Delete Group, a confirmation dialog will be displayed. 
 

(5) Click on the OK button. 
 
You can also delete the sub-scenario group, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete 

Sub-scenario Group icon. 
 

(3) The Subgroup List group box is displayed, and then click on the name of the Sub-scenario 
Group to Delete. 

 
(4) The Configuration menu for the Sub-scenario Group icon will be displayed, and then click 

on Delete Group. 
 
(5) The confirmation dialog box appears. Click the OK button. 
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3.12.5. Add Scenario 
Add a scenario. 
Please see Section 3.13, "Add Scenario" for details. 
 

3.12.6. Move Scenario 
Move a scenario between groups. You can move a scenario regardless of the managed machine's 
status (automatic update status/scenario status/power status). 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Scenario to be Moved on the 

Scenario List group box that is displayed in the main window. 
 

(4) Click Move Scenario under the Action link. 
 
(5) The Move Scenario dialog box is displayed and then set Target Group. 

 

 
 
(6) Click on the OK button. 
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You can also move the scenario, following steps below. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window, then click on the name of the 

Scenario to Move. 
 

(4) The Configuration menu for the Scenario will be displayed, and then click on Move 
Scenario. 
 

(5) The Move Scenario dialog box is displayed and then set Target Group. 
 

(6) Click on the OK button. 
 

 You can select and move multiple scenarios that are under the same group. 
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3.12.7. Copy Scenario 
Copy a scenario between groups. You can copy a scenario regardless of the managed machine's 
status (automatic update status/scenario status/power status). 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Scenario to be Copied on the 

Scenario List group box that is displayed in the main window. 
 

(4) Click Copy Scenario under the Action link. 
 

(5) The Copy Scenario screen is shown in the main window. Then select Copy To -> Target 
Group. 

 

 
 
(6) Click on the OK button. 
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You can also display the Copy Scenario screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window, then click on the Scenario 

Name to Copy. 
 

(4) The Configuration menu for the Scenario will be displayed, and then click on Copy 
Scenario. 
 

(5) The Copy Scenario screen is shown in the main window. Then select Copy To -> Target 
Group. 
 

(6) Click on the OK button. 
 

Copy Scenario  

 Scenario Name 
(Setting required) 

Displays the scenario name on the target. The scenario name is 
displayed as "Original Scenario Name_YYYY-MM-DD hh-mm-ss". 
You can edit the scenario name. Up to 1 - 58 single-byte characters 
can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
. , \ / :  ; * ?" < > | 

Copy To  Select the scenario group of the target. 

OK Copy the scenario with the settings details on the Copy Scenario 
screen and returns to the previous window. 

Cancel Returns to the previous window without copying the scenario with the 
settings details on the Copy Scenario screen. 

 
 The contents of each tab on the original scenario are displayed and can be edited. Please 

see Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding editing. 
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3.12.8. Delete Scenario 
Delete a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Scenario to Delete on the Scenario 

List group box that is displayed in the main window. 
 

(4) When you click on the Action link for Delete Scenario, a confirmation dialog will be displayed. 
 

(5) Click on the OK button. 
 
You can also display the Delete Scenario screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window, then click on the name of the 

Scenario to Delete. 
 

(4) The Configuration menu for the Scenario will be displayed, and then click on Delete 
Scenario. 
 

(5) The confirmation dialog box appears. Click the OK button. 

3.12.9. Assign scenario 
Assign a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Enter a check in the checkbox in the left column of the Scenario Name on the Scenario List 

group box that is displayed in the main window. 
 

(4) Click Assign Scenario in the Action link. 
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(5) The Assign scenario screen appears in the main window. Then select a Group. 

 
 
(6) The machine list under the group selected in (5) is displayed in the Machine List group box. 

Then select the Machine to Assign Scenario. 
 
(7) Please click on the OK button and run. 

 
You can assign the scenario, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenario icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window. Then click on the Scenario 

Name. 
 

(4) The Configuration menu for the Scenario will be displayed, and then click on Assign 
Scenario. 
 

(5) The Assign scenario screen appears in the main window. Then select a Group. 
 

(6) The machine list under the group selected in (5) is displayed in the Machine List group box. 
Then select the Machine to Assign Scenario. 
 

(7) Click on the OK button.
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3.13. Add Scenario 
Add a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add Scenario 

icon. 
 

(3) The Configuration menu for the Scenario Group icon will be displayed, then click on Add 
Scenario. 
 

(4) The Add Scenario screen appears in the main window. Set each item. 
 

 
 

Add Scenario  

 Group Name Displays the scenario group name. This cannot be edited. 

Scenario Name  
(Setting required) 

Set the scenario name. Up to 1 - 58 single-byte characters can be 
entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
. , \ / :  ; * ? " < > | 

 
 Please see Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" for an 

explanation of each of the tabs (HW Setting, OS, Package, Backup/Restore and 
Option). 
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3.13.1. "HW Settings" Tab 
Set the HW Setting tab of the scenario. 
 
 

 
 

HW Setting  

 Image File Name  

 1. - 8. Select the image file from the 8 list boxes. 
Please select Floppy Disk Image created using Image Builder as 
the image file. 
You cannot select the image file name here if you selected the Disk 
Configuration Check radio button in Execute Backup/Restore on 
the Backup/Restore tab. 

 
 You cannot perform registration or deletion of the image file at the same time as creating or 

editing a scenario. Please do not run Image Builder at the same time the scenario 
creation/editing screen is open. 
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3.13.2. "OS" Tab 
Set the OS tab of the scenario. 
 

 
 

OS  

 OS  

 OS Name  Select the OS name. 
The OS you can select from the list box is only Linux. 
If you select Linux, the Setup Parameters File setting items 
will be enabled. 
You cannot set the OS Name if you selected Restore or 
Disk Configuration Check radio button in Execute 
Backup/Restore on the Backup/Restore tab. 

OS Type   If you selected Linux as the OS Name, the OS type is 
automatically set. 

Setup Parameter File  

 It Assigns By The 
Machine Name  

Select this to assign by the machine name. 
It Assigns By The Machine Name is selected by default. 

Specify File Name 
(Setting required) 

Specify the setup parameter file name previously created by 
Image Builder when you install the OS. 
You can specify the file name in the list box by selecting the 
radio button. Setting is required if the item is enabled. 

 
 You cannot set OS and Package tab at the same time with restore scenario. 
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3.13.3. "Package" Tab 
Set the Package tab of the scenario. 
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Package  

 Package  

 Name Displays the name of the package to be executed. 

Type  Displays the type of the package to be executed. 
There are the following two types. 
• Service packs/hotfixes/Linux patch files  
• Applications  

"Action" Link • The Add Package group box is displayed when you click on Add. 

 
You can select and add multiple packages by entering a check in the 
checkbox in the left column of the package to add. The added package 
will be displayed in the Package group box. 
Furthermore, please use Image Builder to create the package to be 
added. Please see Section 5.5, "Package Registration/Modification" 
regarding creating a package. 
The default will be like the above Add Package screen. 
• When you click Delete, the selected package will be deleted. You can 
select and delete multiple packages by entering a check in the 
checkbox on left column of the package. 

Up The checked package will move up one place. 

Down The checked package will move down one place. 

Add Package  

 (Checkbox)  Enter a check in the checkbox in the left column of the package to add. 
When you enter a check in the checkbox and click on the OK button, 
the package will be added to the Package group box. 

Name Displays the name of the package. 

Type  Displays the type of the package. 
There are the following two types. 
• Service packs/hotfixes/Linux patch files  
• Applications  

OK Adds the package and closes the Add Package group box. 

Cancel Closes the Add Package group box without adding the package. 

Execution Timing Setting  

 Execute Immediately 
After Distribution 

Select this radio button to execute the package immediately after 
distribution. This setting is effective when only remote updates are 
executed. 

Execute At Next 
Startup  

Select this to execute the package at the time of the next startup. This 
setting is effective when only remote updates are executed. 
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A managed machine prior to rebooting can execute 100 scenarios 
specified under Execute At Next Startup under Execution Timing 
Setting on the Package tab of the scenario. If you want to execute 101 
or more scenarios, reboot the managed machine. Rebooting allows you 
to execute another 100 scenarios. 
Furthermore, please be careful of the following if Execute At Next 
Startup is selected. 
・ If you enter a check in the Turn Off Power After Scenario 

Execution under the Option tab, the managed machine's power will 
not turn OFF when the update is completed, but will turn OFF after 
the data distribution. 

・ The managed machine will have a scenario execution error if there is 
an update or an application scenario execution during update at next 
startup. Please retry executing the scenario after the update is 
completed. 

Distribution Conditions Setting  

 Restart After Applying  If you enter a check in the Restart After Applying checkbox, the 
managed machine will be restarted after the package execution. 
Restart After Applying takes priority in the case of scenarios set only 
on the Package tab, and the managed machine will be restarted after 
the package execution. 

 Distribution Condition Setting  

  Transmit Data By 
Unicast  

Select this to send data by unicast. 
Transmit Data By Unicast is the default. 
Please select Transmit Data By Unicast in cases when you cannot 
send the data by multicast. such as to perform an update on another 
network segment beyond the router. 
Furthermore, it is not necessary to set the multicast IP for scenarios 
where Transmit Data By Unicast is checked. 

Transmit Data By 
Multicast  

Select this to send data by multicast. The following items are valid.(*1) 
• Maximum Targets (1-1000)  
• Maximum Waiting Time (1-1440 minutes)  
• Multicast IP Address(Package) 
• Multicast TTL  
• Maximum Transmission Rate  

 Maximum Targets 
(1-1000)  
 

Set the number of machines to which the scenario will be assigned. 
When the preparation is ready for the number specified here on the 
managed machines assigned the same scenario, the scenario will start. 

This can be set in the range of "1 - 1000". 
The default is blank. 

Maximum Waiting 
Time (1-1440 
minutes)  
 

Set the maximum wait time when sending data by multicast. This can be 
set in the range of "1 - 1440". 
The default value is "10" minutes. 

If you exceed the Maximum Wait Time, the update will start only on the 
managed machines with an executable status. 

Multicast IP 
Address(Package)   

Set the multicast IP address. 

The multicast IP is the IP address specified for the multicast. The 
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(Setting required)  multicast IP address can be set in the range of "224.0.0.0  -  
239.255.255.255."  However, the range of "239.192.0.0  -  
239.255.255.255" is recommended. (*1) 
Please change the multicast IP address for the each scenario such as 
multiple scenarios of Installing service packs, hotfixes, Linux patch files, 
and applications. 

Multicast TTL  Sets the number for multicast TTL. This can be specified in the range of 
"1 - 127."  The default value is "16." (*2) 

Maximum 
Transmission Rate  
(Setting required)  

When you enter a check in the Maximum Transfer Rate checkbox, you 
can control the scenario transfer rate. 

The maximum transfer rate is set as the maximum data volume in MB 
that will transfer in 1 minute. This can be set in the range of "1 - 
999999999" The default value is "500" MB/minute. 

By default, the checkbox is not checked. Please perform the settings to 
match the environment used. 

*1 
 Multicast is a communication method of using a single packet and sending the same data to 

multiple machines at the same time. With this, you can reduce the traffic on the LAN. 
 After the scenario execution has been directed and after the execution preparation has been 

completed, it will wait until the number of machines equals the maximum number of target or 
until the maximum wait time has been exceeded when running an update/application. There is 
no function for immediately executing an update/application on a computer that is in a waiting 
state. 

 If neither the maximum number of target nor the maximum wait time has been specified, it will 
immediately run without waiting for other computers after the scenario runs. 

*2 
The packet lifetime is indicated in TTL. This value is decremented by 1 each time it passes 
through the router, and it is disposed of once it reaches "0." The packet cannot pass through 
the router if it is set to "1."  

 
  You cannot set OS and Package tab at the same time with restore scenario. 

 There are warnings against running multiple different scenarios at the same time. 
Please see Section 10.4, "Notes for Simultaneous Execution of Multiple 
Scenarios" for the warning. 
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3.13.4. "Backup/Restore" Tab 
Set the Backup/Restore tab of the scenario. 
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Backup/Restore  

 Execute Backup/Restoration  

 (Checkbox)  If you enter a check in the checkbox, the backup, restore and disk 
configuration check scenario setting items will be enabled. By default, the 
checkbox is not checked. 

 Backup Select this to create a backup scenario. 

Restore Select this to create a restore scenario. 
You cannot select settings other than the HW tab at the same time. 

Disk Configuration 
Check  

Select this to create a disk configuration check scenario. 
You cannot select Disk Configuration Check at the same time if it is set 
on the Package tab. 

Image File  
(Setting required) 

Set the backup image name of backup/restore scenario and the stored 
location. Please enter the file path including the file extension (.lbr) in the 
Image File column, or click on the Browse button and specify the backup 
image file. If you select backup and do not enter the file extension (.lbr), it 
will automatically be added. 
• If entering the file path, the number of characters that can be entered for 

backup/restore are as follows. 
- Backup: 120 single-byte characters 
* The above number of characters is the maximum number of 

characters when a check is entered in all of the Machine Name/MAC 
Address/UUID checkboxes. In other cases, up to 128 single-byte 
characters can be entered. 

- Restore: 254 single byte characters 
* The above number of characters is the maximum number of 

characters when a check is entered in all of the Machine Name/MAC 
address/UUID checkboxes. In other cases, up to 260 single-byte 
characters can be entered. 

• The allowed characters for both backup and restore are single-byte 
alphanumeric characters and single-byte spaces. The following symbols 
cannot be used. 

/ * ? < > | :  " 
• When specified using the Browse button  

- This can be selected when entering a check in the backup or restore 
checkbox. 

- You cannot specify a folder that dose not exist. A scenario error will 
occur when the backup scenario runs if the folder that dose not exist 
is specified. 
If the stored location of the backup image file is a drive formatted 
using FAT format, you can only create a backup image file that is less 
than 4GB (2GB for FAT16) based on the system limitations. 
Also, if checks are entered for Machine Name, MAC Address and 
UUID at the time the backup scenario is created, please enter a check 
in the same checkboxes when creating the restore scenario. If you 
enter a check the Machine Name, MAC Address and UUID, they will 
be added to the end of the backup image file name. If you do not 
check the same boxes, a restore file will be specified with a different 
name than the backup file and the restore cannot run.(*1) 
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Browse  Specify the backup image file of the backup scenario or the restore 
scenario from the Browse button. 
When you click the Browse button, the Image File Setting screen is 
displayed. Please select the backup image file (.lbr). 
Or, please enter the backup image file name in the Image File Name 
column. 

 

Machine Name If you enter a check in the Machine Name checkbox, the machine name 
will be automatically added to the end of the backup image file name. 
Example) BackUp_PC01.lbr 

An underscore will be added between the backup image file name 
(BackUp) and the machine name (PC01). 
Also, the Machine Name, MAC Address and UUID will be added in 
order if multiple items of the Machine Name, MAC Address and 
UUID are specified. 

You can enter a check in the checkbox in the following cases. 
• When creating a backup scenario or a unicast restore scenario  
• Only when the machine of the backup and the restore target are the 

same  
MAC Address If you enter a check in the MAC Address checkbox, the MAC Address 

will be automatically added to the end of the backup image file name. 
Example) BackUp_00-16-57-1a-b2-47.lbr  

An underscore will be added between the backup image file name 
(BackUp) and the MAC Address (00-16-57-1a-b2-47). 
Also, the Machine Name, MAC Address and UUID will be added in 
order if multiple items of the Machine Name, MAC Address and 
UUID are specified. 

You can enter a check in the checkbox in the following cases. 
• When creating a backup scenario or a unicast restore scenario  
• Only when the machine of the backup and the restore target are the 

same 
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UUID If you enter a check in the UUID checkbox, the UUID will be automatically 
added to the end of the backup image file name. 
You can enter a check in the checkbox in the following cases. 
• When creating a backup scenario or a unicast restore scenario  
• Only when the machine of the backup and the restore target are the 

same  

Comment Comments about the backup image file can be added as information. 
Up to 638 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
This setting is optional. 

Backup/Restore Target 

 Disk Number (1-1000)  Specify the disk number. This can be set in the range of "1 - 1000". 
The default value is "1."  
Furthermore, please set this after confirming the disk number by the Disk 
Viewer. Also, the disk number for before DPM Ver5.0 and DPM Ver5.0 or 
later may differ, please run the Disk Configuration Check.  Please see 
Section 7.2 "Disk Configuration Check Tool" for details. (*2) 

Partition Setting  

 
 
 

Entire Disk  You can select this option in case of backup/restore. 
If you select this option, the entire disk is backed up/restored. 

Specify  You can select this option in case of backup/restore. 
If you select this option, the specified partition is backed up/restored. When you 
select this, you can specify the Partition Number. 
When executing a backup by specifying a partition number, it is 
necessary that the disk for restore be the same configuration (number of 
partitions, arrangement, size and file system) as when executing backup. 
Also, restore to the same partition as when executing backup. 

 
Example) If you execute backup of the first partition on a disk that is 

configured with the first partition as NTFS (10GB) and the second 
partition as NTFS (40GB), the restore disk must be configured with the 
first partition as NTFS (10GB) and the second partition as NTFS 
(40GB). In this case, you can specify only the first partition in the 
restore scenario. 

Partition Number 
(1-1000)  

Set the partition number. This can be set in the range of "1 - 1000."  The 
default value is "1."  
Under normal conditions, the Partition number is assigned starting from 
the beginning of the disk. If there are hidden partitions or expansion 
partitions on the disk, however, the way in which the numbers are 
assigned changes. 
Therefore, please confirm the disk number using the Disk Viewer prior to 
executing a backup/restore. 
When you specify a partition for restoration, be sure to match the partition 
configuration (number of partitions, arrangement, size and file system) 
and the specified partition between the backup partition and the restoring 
partition. 

Hidden Partition Is When you enter a check in the Hidden Partition Is Disregarded  
checkbox, hidden partitions will be ignored. By default, the checkbox is 
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Disregarded  
(Backup/Restore)  

checked. 
If a check was entered for Hidden Partition Is Disregarded  
(Backup/Restore), it won't count the hidden partitions. 
Therefore, when the disk device is separated into four partitions  
(A)  -  (D) as the following example, specify "2" as partition number if 
you want to specify partition (D). 
 
Example) Disk device 

Hidden 
Partition 

(A) 

Normal 
Partition 

(B) 

Hidden 
Partition 

(C) 

Normal 
Partition 

(D) 
Please specify partition number "4" if Hidden Partition Is 
Disregarded (Backup/Restore) is not selected. 

(*3) 

 Multicast Condition 
Setting  

The multicast transmission settings can be done only if Restore is 
selected from the Execute Backup/Restoration group box. 

 Transmit Data By 
Unicast   

Select this to send data by unicast. The settings can be done only if 
Restore is selected from Execute Backup/Restoration. 
Transmit Data By Unicast is the default. 
Please select Transmit Data By Unicast in cases where you cannot 
send the data by multicast such as to perform a restore on a network 
segment beyond the router. 
Furthermore, it is not necessary to set the multicast IP for scenarios 
where Transmit Data By Unicast is checked. 

Transmit Data By 
Multicast  

Select this to send data by multicast. The following settings become valid 
if Restore is selected from Execute Backup/Restoration. 
• Maximum Targets (1-1000)  
• Maximum Waiting Time (1-1440 Min.) 
• Multicast IP Address (Restore) 
• Multicast TTL  
• Maximum Transmission Rate  

Maximum Targets 
(1-1000)  

Set the number of machines to which the scenarios will be assigned. 
The restore scenario starts when the number of managed machines 
which have been assigned same scenario and have completed 
preparation reaches the number specified here. 
The maximum number of packets can be set in the range of "1 - 1000".  
The machine will wait for the restore if the number of executing scenario 
exceeds the setting. At the time when the restore completes on the 
machine executing restore and either the Maximum Targets or 
Maximum Waiting Time condition is satisfied, or when you click Run 
Now on the Backup/Restore Execute List screen, the restore begins on 
machines in a standby state. 
Furthermore, DPM executes UDP communication when data is sent by 
multicast. 
With UDP communication, if a device with a different transmission rate is 
located on the path, a difference occurs in the volume of data transmitted 
between the transmission side and reception side, which can result in 
data transmission failure. 
If this happens, the amount of time until scenario completion may increase. 
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Maximum Waiting Time 
(1-1440 minutes)  

Set the maximum wait time when sending data by multicast. This setting 
is possible only when restore is selected. When the wait time specified 
here exceeds, restore will start only on the machines which are on an 
executable condition. This can be set in the range of "1 - 1440". 
The default value is "10" minutes. 

Multicast IP Address 
(Restore)  
(Setting required)  

Set the multicast IP address. 
The multicast IP is the IP address specified for the multicast. The 
multicast IP address can be set in the range of "224.0.0.0  -  
239.255.255.255." However, the range of "239.192.0.0  -  
239.255.255.255" is recommended. 
To run multiple restore scenarios, please change multicast IP address on 
the each scenarios. (*4) 

Multicast TTL  
(Setting required)  

Sets the number for multicast TTL. This can be specified in the range of 
"1 - 127". The default value is "16." (*5) 

Maximum 
Transmission Rate  
(Setting required)  

When you enter a check in the Maximum Transfer Rate checkbox, you 
can control the transfer rate. 

The maximum transfer rate is set as the maximum data volume in MB 
that will transfer in 1 minute. This can be set in the range of "1 - 500."  
The default value is "500" MB/minute. 
By default, the checkbox is not checked. Please perform the settings to 
match the environment used. 

Backup Setting  

 Data Compress  

 Compress  Please select the radio button to send compressed data when executing 
the backup/restore. 

Not Compress  Please select the radio button to send not compressed data when 
executing the backup/restore. 

The Number Of 
Backup Image File 
Generations To Be 
Managed (0-99)  

Sets the generation management number of the backup image file. 
Generation management is a function used to specify the number of 
backup data copy generations you would like to save. 
This can be set in the range of "0 - 99". The default value is "0."  
When you use generation management function, the number of image 
files to be created is the number of generation management + 1. Pay 
attention to free space in HDD where image files are to be stored. 
(*6) 
Example) 

When the number of generation management is 5; and size per image 
file is 
approx. 5GB: 

5GB x (5 + 1) = 30GB 
Therefore, approx. 30GB free space is necessary at maximum. 

Create Verification 
Data 

If you enter a check in the Create Verification Data checkbox, the verify 
data will be created. 
Verification data is a function used to verify whether any backed up data 
has been damaged since the time of backup. 
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This function allows you to check at the time of data restoration whether 
or not the backup data is invalid (whether data has been damaged, and 
so forth) using the Backup Image File Verification Tool. 

*1 
 The following warnings are for the case of a restore scenario. 

• If you enter a check in the Machine Name, MAC Address or UUID checkbox, and then 
change the machine name, etc. for that machine, you will not be able to continue to manage 
the backup image for backups prior to the change. For this reason, please remove the check 
from the Machine Name, MAC Address or UUID checkboxes and specify an existing backup 
image in the Image File Column in order to restore an existing backup image. 

• If you select Transmit Data By Multicast, you cannot use variables in the backup image file 
name. A scenario will fail if you use variables. 

• If you select Transmit Data By Unicast, the specified backup image file name will be 
obtained following the corresponding variables if you include variables in the backup image 
file name. 
If the specified backup image does not exist, it will search for the most recent backup image 
file with the "yyyymmddhhmmss" assigned. 

 If you backup removing the check from the Machine Name, MAC Address or UUID 
checkboxes. 
• It is recommended that you do not specify a backup image name that already exists in the 

same Folder for Backup Image. If you specify the same backup image file name, the backup 
image file names will be duplicates and it cannot backup normally. 

• It is recommended not to perform backup of multiple managed machine with one scenario at 
the same time. If it is run with one scenario, the backup image file will be overwritten and it 
cannot backup normally. 

 For backup, the backup data is created first as a temporary file. The temporary file is renamed 
the name specified in the scenario at the completion of the backup, and deleted automatically. 
Therefore, if you execute the same scenario at least twice, free space is necessary for the 
size of the created image file and the temporary file. 

 When specifying the path of an image file in another computer connected to the network 
(hereafter referred to as "file server"),perform the following actions. 
If you use Windows Server 2003/Windows Server 2008/ Windows Server 2008 R2 as the OS 
of the Management Server and file server, configure the following settings: 
Perform the operations indicated in the steps 1 to 3 below on the Management Server. 
1) Log on the machine which DPM Server is installed, using an account with administrator 

authority. 
2) From Start, select Control Panel, select Management tool, then select Service. 

Open the following service property, select Account in Log On tab, enter account 
and its password used when you install DPM Server. 

DeploymentManager Backup/Restore Management 
DeploymentManager API Service 

Also set on DeploymentManager PXE Management only when Management view -> 
DPM Server icon ->Detail Setting -> DHCP Server tab ->Do Not Use A DHCP Server 
is selected on Web Console. 
Please specify a password of at least 1 character for Windows Server 2003. The start of 
the service will fail at step 3 if the password is not set. 
Please specify a password that meets the password policy in the case of Windows Server 
2008 and Windows Server 2008 R2. 
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The following important notes are for the file server. 
・ Please create a user with the Account and Password used when the DPM 

Server was installed on the file server. 
・ Please configure that the account indicated here has access rights with full 

control to the Folder for Image on the file server. 
3) Restart services you changed the settings in step 2. 

 
Perform the operations indicated in the steps 4 to 6 below on the file server. 
4) Log on using an account that has Administrator authority. 
5) Create a Folder for Backup Image by Explorer, etc to save backup image 

files. 
6) Add an account that has administrator authority configured in step 2 to permit the 

access to the Folder for Backup Image that is created in step 5, 
 

Perform the following 7 to 8 on the Web Console. 
7) When creating a scenario, enter the file path under the folder created in step 5 for 

the Image File of Backup/Restore tab. For the path of the folder of image file, 
please enter a UNC (Universal Naming Convention) format (\\Machine 
Name\Folder for Backup Image\Sub-directory) path name in Image File. 

8) Execute the scenario 
 You cannot perform registration or deletion of image file at the same time as creating or 

editing a scenario. Please do not operate Image Builder if the scenario creation/editing 
screen is open. 

*2 
If any one of the following is relevant, back up all disks in which necessary data are stored. 
Until the backup or restore of all disks are completed, make sure that the OS does not start 
up. In order to prevent the OS from starting up when the scenario is executed, check the 
Turn Off Power After Scenario Execution from Option tab. 
・ If the backup source and restoration destination are located in different devices. 
・ If HDD configuration (disk order, disk type (SCSI,IDE, etc.)) of the restore destination 

is different than the backup source (if they are different, there is possibility that 
problems occurs on the system after the restore. Please backup and restore with the 
same configuration). 

 
・ The data required for OS startup are stored over multiple disks 
・ If the data required for OS startup and the data required for disk duplication 

(Windows: sysprep, Linux: /opt/dpmclient) are stored over multiple disks 
・ When files, needed as the system, are stored in a different HDD. 
・ When disks are connected over multiple disks or multiple partitions, such as other 

drives being mounted to the directory. 
・ When it is necessary to have consistency in the data between disks or partitions 

(dynamic disk, LVM1/LVM2, etc.) 
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*3 

 Systems, depending on the manufacturer, may not recognize a maintenance partition 
as a hidden partition. 

Example) The maintenance partition used by the EXPRESSBUILDER for Express5800 
series is not recognized as a hidden partition. 

 The partition number is assigned in the order of primary partitions and then logical 
drives in extended partition. 

Example) For the disk below, partition (A) is "1," the expansion partition logic drive (B) is 
"3," the expansion partition logic drive (C) is "4" and partition (D) is "2." 

 
Disk 

Primary Partition 
(A) 

Expansion Partition 
Logic Drive (B) Logic Drive (C) 

 

Primary Partition 
(D) 

*4 
Multicast is a communication method of using a single packet and sending the same data 
to multiple machines at the same time. With this, you can reduce the traffic on the LAN. 

*5 
TTL means the packet lifetime. This value is decremented by 1 each time it passes 
through the router, and it is disposed of once it reaches "0." The packet cannot pass 
through the router if it is set to "1." 

*6 
 If you are doing generation management, a time stamp 

(year/month/day/hour/minute/second) which is the time of creating the backup image file 
is added to the name of the file. 

 
・ If the The Number Of Backup Image File Generations To Be Managed is 0 

The timestamp cannot be attached to the backup image file name. If the backup 
image file name specified by the scenario exists prior to backup, the backup image 
file will be deleted. 

 
・ If The Number Of Backup Image File Generations To Be Managed is 1 or higher 

If the backup image file name specified by the scenario exists prior to backup, the 
update time for this backup image file is obtained and a timestamp is added to the 
backup image file name for generation management. 

 
 For a scenario that the generation management is disabled, and if you change it to enabled on 

operation, a timestamp will be added to the backup image file name from the time of the next 
backup. 
In this case, the previous backup images that were created when generation management was 
disabled will be renamed, having a time stamp added the next time the scenario runs. 

 
 If the generation management is enabled and there is already a backup image with the same 

file name including the time stamp, the backup image file won't be overwritten, but a scenario 
error will occur. 
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 If backup exceeds the specified number of times, the oldest image file is deleted automatically. 

 
Example)  

If the backup data should be stored 10 times, enter "10." For the first backup, the image file 
name will be specified file name.lbr. 
From second time on, the previous image file name will be changed from specified file 
name.lbr to specified file name with time-stump.lbr, and the file to be stored this time will 
be named as specified file name.lbr. 

 
 You can only enter a check in the Machine Name, MAC Address and UUID checkboxes if 

the machine to backup and the machine to restore are the same. 
• You can select the following. 
- Backup/restore (for the same machine) 

• You cannot select the following. 
- OS installation by disk duplication 
- Backup/restore (for different machines ) 

 
  You cannot set OS and Package tab at the same time with restore scenario. 

 There are notes for running multiple different scenarios at the same time. Please see 
Section 10.4, "Notes for Simultaneous Execution of Multiple Scenarios" for the note. 
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3.13.5. "Option" Tab 
Set the Option tab of the scenario. 
You can control the power status of the managed machines before and after the scenario execution 
from the Options tab. 
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Option  

 Scenario Execution Option Setting  

 Forced Execution Of A 
Reboot Is Performed 
Before Execution  

If you enter a check in the Forced Execution Of A Reboot Is Performed 
Before Execution checkbox, the managed machine will be restarted 
before the scenario runs. 
If the OS is running on the managed machine before the scenario 
execution, it will be forcibly restarted and then the scenario will run. 
This option is effective in the following cases. 
• If the DPM Client is installed on the managed machine  
• If you are using the following functions  

- Backup  
- Restore  
- OS clear installation  
- Distribution of floppy disk image for BIOS/firmware  

• If you execute the scenario on managed machines where the OS is 
running   

Turn Off Power After 
Scenario Execution  

If you enter a check in the Turn Off Power After Scenario Execution 
checkbox, the managed machine will be powered OFF after the scenario 
execution. 
In the case of OS installation by disk duplication, under Scenario 
Execution Option Setting on the Option tab of the backup scenario, do 
not enter a check in the Turn Off Power After Scenario Execution 
check box. If you enter a check, turn the power ON manually after the 
backup has completed. The master machine is then reconfigured. 

OK The scenario is added using the setting details from the Add Scenario 
screen and it returns to the previous window. 

Cancel It returns to the previous window without adding the scenario using the 
setting details from the Add Scenario screen. 

 
  Please be sure to enter a check Forced Execution Of A Reboot Is Performed Before 

Execution to run the scenario when the OS is running on the machine. However, if you 
are executing a remote update (independently installing service packs, Installing service 
packs, HotFix, Linux patch files, and applications) scenario, it is not a problem if the OS is 
running, so you do not need to check Forced Execution Of A Reboot Is Performed 
Before Execution. The machine won't restart even if you enter a check and the scenario 
runs. 

 If the Windows managed machine has the following status, you cannot shut down, even if 
you enter a check on Forced Execution Of A Reboot Is Performed Before Execution. 
・ The machine is locked by a workstation lock. 
・ The machine is locked with a screensaver with a password  
・ The machine is connected to remote desktop, terminal service, or other remote 

connection software  
・ There is data that is being edited or there is an application that does not respond to a 

shutdown request. 
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3.14. Menu Operations for a Scenario 
The menus related to the operations for the scenario will be explained. 
 

3.14.1. Edit Scenario 
Edit a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window, then click on the Scenario 

Name to Edit. 
 

(4) The Configuration menu for the Scenario icon will be displayed, then click on Edit Scenario. 
 

(5) The Edit Scenario screen will be displayed in the main window and you can edit each item. 
 

You can also display the Edit Scenario screen using the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 

(3) The Scenario List group box is displayed in the main window, then click on the Edit icon( ) 

for the scenario to edit. 
 
(4) The Edit Scenario screen will be displayed in the main window and you can edit each tab. 
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Edit Scenario  

 Group Name Displays the scenario group name. This cannot be edited. 

Scenario Name  Displays the scenario name. This cannot be edited. If you want to edit 
it, please re-create the same scenario and specify a scenario name 
newly. 

OK Saves the settings details from the Edit Scenario screen and returns 
to the previous window. 

Cancel Returns to the previous window without saving the setting details on 
the Edit Scenario screen. 

 
 Please see Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding 

editing each tab. 
 

3.14.2. Copy Scenario 
Copy a scenario. 
Please see Section 3.12.7, "Copy Scenario" for details. 
 

3.14.3. Move Scenario 
Move a scenario. 
Please see Section 3.12.6, "Move Scenario" regarding the details. 
 

3.14.4. Delete Scenario 
Delete a scenario. 
Please see Section 3.12.8, "Delete Scenario" for details. 
 

3.14.5. Assign Scenario 
Assign a scenario. 
Please see Section 3.12.9, "Assign Scenario" for details. 
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3.15. Scenario Detail Information 
Displays the scenario detail information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box is displayed in the main window. Then click on the Scenario 

Name. 
 

(4) Displays the Scenario Detail, Option and Machine List group box in the main window. 
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Scenario Detail 

 Scenario Name Displays the scenario name. This cannot be edited. 

Scenario Group Name Displays the scenario group name. This cannot be edited. 

Type Displays either of the following types. 

• Disk Configuration check 
• Restore 
• Backup 
• Package 
• OS 
• HW setting 

The displayed type and the setting details are shown in the Scenario 
Detail group box. 

HW Setting If HW Setting is displayed in the Type column, HW Setting will be 
displayed in the Scenario Detail group box. 
The image file name set in the Add Scenario screen -> HW Setting 
tab will be displayed. 

 Image File Name Displays the image file name. 

OS Install If OS is displayed in the Type column, OS Install will be displayed in the 
Scenario Details group box. Only the status set in the Add Scenario 
screen -> OS tab will be displayed. 

 OS Name Displays the OS name. 

OS Type Displays the OS category. 

Setup Parameter File Displays the setup parameter file. 

Backup If Backup is displayed in the Type column, Backup will be displayed 
on the Scenario Details group box. The backup scenario will be 
created by specifying on the Add Scenario screen -> Backup/Restore 
tab and only the set status will be displayed. 

 Image File Displays the backup image file of the backup scenario. 

Image File Comment Displays comments that are entered in the Comment column. 

Disk Number Displays the disk number. 

Partition Setting Displays the partition settings. 

A Hidden Partition Is 
Disregarded 

Displays whether a hidden partition will be disregarded. 

Compress Data Setting Displays whether to compress the data. 

The Number Of Backup 
Image File Generations 
To Be Managed 

Displays the number of the backup image file generation to be 
managed. 

Create Verification Data Displays whether to create the verify data. 
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Restore If Restore is displayed in the Type column, Restore will be displayed 
on the Scenario Details group box. The restore scenario will be 
created by specifying on the Add Scenario screen -> Backup/Restore 
tab and only the set status will be displayed. 

 Image File Displays the backup image file of the restore scenario. 

Disk Number Displays the disk number. 

Partition Setting Displays the partition settings. 

A Hidden Partition Is 
Disregarded 

Displays whether a hidden partition will be ignored. 

Multicast Distribution 
Condition Setting 

Displays for send data by Unicast or send data by Multicast. 

Maximum Targets Displays the maximum number of targets. 

Maximum Waiting Time Displays the maximum wait time. The unit is minute. 

Multicast IP Address 
(Package) 

Displays the multicast IP address. 

Multicast TTL Displays the number for multicast TTL. 

Maximum Transmission 
Rate 

Displays the maximum transfer rate. The unit is MB/minute. 

Package If Package is displayed in the Type column, Package will be displayed 
on the Scenario Details group box. Only the status set in the Add 
Scenario screen -> Package tab will be displayed. 

 Package Name Displays the name of service packs/hotfixs/applications. 

Execution Timing 
Setting 

Displays the scenario execution timing. 

Distribution Conditions 
Setting 

Displays if the DPM Client is restarted after package execution. 

Multicast Distribution 
Condition Setting 

Displays for send data by Unicast or send data by Multicast. 

Maximum Targets Displays the maximum number of targets. 

Maximum Waiting Time Displays the maximum wait time. The unit is minute. 

Multicast IP Address 
(Package) 

Displays the multicast IP address. 

Multicast TTL Displays the number for multicast TTL. 

Maximum Transmission 
Rate 

Displays the maximum transfer rate. The units is MB/minute. 

Option 
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 Forced Execution Of A 
Reboot Is Performed 
Before Execution  

Displays whether forced execution of reboot on the managed machine 
is performed before execution. 

Turn Off Power After 
Scenario Execution  

Displays whether the power of the managed machine is turned off after 
the scenario execution. 

Machine List  

 Display Count Select the number of managed machines to be displayed. 

Machine Name Displays the name of the machine that the scenario is assigned. 

IP Address  Displays the IP address of the machine that the scenario is assigned. 

MAC Address Displays the MAC address of the machine that the scenario is 
assigned.. 

Group Name Displays the name of the group in which the machine that the scenario 
is assigned is registered. 
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3.16. "Image" Icon 
You can manage the different types of image information such as package, backup image, HW image 
or OS image from the Image icon. 
You can access the Image icon from the Image icon at the top of the Operations view tree view or 
from the Image icon in the Summary Information group box displayed in the Operations view main 
window. 
Click on the Image icon to display the Search Conditions and Image List group boxes on the main 
window. 
Please see Section 3.17, "Image Detailed Information" regarding the screen. 
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3.17. Image Detailed Information 
Displays the detailed information for the each images, the package, backup image, HW image and OS 
image. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> Image icon. 

 
Or, the Summary Information group box appears in the main window. Click on Image. 
 

(3) Displays the Search Conditions and Image List group box in the main window. 
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Search Conditions  

 Image Type  Select the search image type. You can select from the following. 

• All Type  
• HW image  
• OS image  

• Package  
• Backup Image  

The default is All Type. 

If you select Package or Backup Image, You can search the image 
that meets the conditions that you specified. The condition that can 
be specified varies depending on Package or Backup Image. 
• Package  

OS, Type, Date 
• Backup image  

Date, Machine Name 

OS  If you search by OS type, you can select the type of OS to search. 
The default is "All OS." 

Type  If you search by type, you can select the type of package to search. 
You can select from the following. 

• All Type  
• HotFix 
• Service Pack 

• Linux Patch 
• Application 

The default is All Type. 

Date If you search by date, you can enter the start date and end date to 
search. 

You can enter the date (year/month/day) or click on the " " icon on 
the side of the textbox and select the date from the displayed 
calendar. 
Please enter using YYYY/MM/DD format. 
• If you specify only the start date, it will search with the search 
condition of dates after the start date. 

• If you specify only the end date, it will search with the search 
condition of dates up to the end date. 

• If you specify the start date and end date, it will search with the 
search condition within the specified period. 

Machine Name Enter the machine name to search by the machine name. 
1 - 63 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
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Search If you click on the Search button, it will search for images with the 
specified search conditions. 

The search results will be displayed in the Image List group box. 

Image List  

 Display Count Select the number of images to be displayed. 

Image Name  Displays the image name. 
You can confirm the basic information for the Package and Backup 
Image by clicking on the image name. 
Please see Section 3.17.1, "Package Image Detailed Information" 
regarding the Package. 
Please see Section 3.17.3, "Backup Image Detailed Information" 
regarding the Backup Image. 
You cannot click on the image name for a HW Image or an OS 
Image. 

Summary Displays the summary of the image. 

Image Type  Displays the image type. 

Date Displays the date and time that the image is created. 

Applying Status  If the Image Type is Package, a ">>" will be displayed in the 
Applying Status column. 
Click on >> to display the Package Applying Status (Machine 
List) screen on the main window. Please see Section 3.7.1.2, 
"Package Applying Status (Machine List)" regarding the screen. 
If the Image Type is other than Package, the Applying Status will 
be blank. 
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3.17.1. Package Image Detailed Information 
Displays the package image detail information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> Image icon. 

 
(3) The Image List group box is displayed in the main window. Then click on the Image Name. 

 
(4) Displays the Base Information and Applicable OS and language group box in the main 

window. 
 

You can also display the package image basic information screen using the following steps. 
 
(1) The Summary Information group box appears in the main window. Click on the Package 

icon. 
 

(2) The Image List group box is displayed in the main window. Then click on the Image Name. 
 

(3) Displays the Base Information and Applicable OS and language group box in the main 
window. 
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Base Information 

 Package Name Displays the package name. 

Summary Displays the summary of the package. 

Type  Displays the package type. 

Release Date Displays the package released date. 

MS Number Displays the MS Q Number or the KB number for hotfixes or service 
packs. 

Major Version Displays the major version of the service pack. 

Minor Version Displays the minor version of the service pack. 

Application Name Displays the application name of the package. 

Applicable OS and language 

 OS Name Displays the name of the OS that is the target of the package. 

Language Displays the OS language that is the target of the package. 

Base Service Pack Displays the list of the Base Service Pack. 

Absorbing Service Pack Displays the list of the Absorbing Service Pack. 
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3.17.2. Package Applying Status (Machine List) 
Display the Package Applying Status (Machine List). 
The package applying status is only displayed for Windows OS packages. Linux OS packages are not 
displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click on the Resource icon -> Image icon. 

 
(3) The Image List group box is displayed in the main window. Then click on ">>" in Applying 

Status. 
 

(4) Displays the Base Information and Package Applying Status (Machine List) group box in the 
main window. 

 
You can also display the Package Applying Status (Machine List) screen using the following steps. 
 
(1) The Summary Information group box appears in the main window. Click on the Package 

icon. 
 

(2) The Image List group box is displayed in the main window. Then click on ">>" in Applying 
Status. 
 

(3) Displays the Base Information and Package Applying Status (Machine List) group box in the 
main window. 
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Package Applying Status(Machine List)  

 

 

Base Information  

 Package ID  Displays the package ID. 

The Number Of  
Machines  

Displays the number of managed machines related to the package. 

Applied  Displays the number of the managed machines that the package was 
applied. 

Not Applied  Displays the number of the managed machines that the package was 
not applied. 

Unnecessary  Displays the number of the managed machines that it is unnecessary 
to apply the package. 

Unrecognized Displays the number of the managed machines that it is 
unrecognized whether the package was applied. 

 Package Applying Status(Machine List)  

 Display Count You can select the Display Count of managed machines to display on 
the Package Applying Status(Machine List) screen. 

Group Name Displays the name of the group that the managed machine is 
registered. 

Machine Name Displays the name of the managed machine. 

MAC Address Displays the MAC address of the managed machine. 

Applied Status  Displays the applied status of the package. 
Please see Section 3.7.1.2, "Package Applying Status (Package 
List)" for details on the applied status. 
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3.17.3. Backup Image Detailed Information 
Display the backup image detailed information. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 

(2) In the tree view, click on the Resource icon -> Image icon. The Summary Information 
group box appears in the main window. Click on Image -> Backup Image icon. 
 

(3) The Image List group box is displayed in the main window. Then click on the Image Name. 
 

(4) The Image Base Information Of Image, Original Base Information and Original Applied 
Packages group boxes are displayed. 
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Base Information Of Image  

 Image Name  Displays the folder for backup image and image file name. 

Create Date Time  Displays the date when the backup image was created. 

Disk Number  Displays the disk number. 

Partition Number  Displays the partition number. 

Compress Or Not Displays if the backup image is compressed or not. 

Specify Verification Data 
Or Not  

Displays if the backup image verify data exists or not. 

A Hidden Partition Is 
Disregarded Or Not  

Displays whether hidden partitions will be ignored or not. 

Backup Execution Time  Displays the time taken for backup execution. 

Image File Size  Displays the image file size. 

Specify Full Sector Or Not  Displays whether full sector option is set or not. 

Product Version (DPM 
Server)  

Displays the DPM version of the Management Server. 

Original Base Information  

 Machine Name Displays the name of the machine from which the backup image was 
created. 

Summary Displays the comment of the backup image. 

IP Address  Displays IP Address of the machine that the backup image was 
created. 

MAC Address Displays MAC Address of the machine that the backup image was 
created. 

UUID Displays UUID of the machine that the backup image was created. 

OS Name  Displays OS Name of the machine that the backup image was 
created. 

Original Applied Packages 

 Display Count Select the Display Count of Original Applied Packages. 

Package Name Displays the package name. 

Summary Displays the summary of the package. 

Type  Displays the package type. 
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4. Monitor 
 
 
 
 
 
 
 
 
 
 
This chapter explains viewing the status of managed machines and logs on the DPM using the 
Monitor view. 
 
The items covered in this chapter are as follows: 
 
 
• 4.1 "Monitor" view ..........................................................................................................188 
• 4.2 "Scenario Execution List" Icon .................................................................................189 
• 4.3 Scenario Execution List ...........................................................................................190 
• 4.4 "Scenario Execution Results List" Icon ....................................................................198 
• 4.5 Scenario Execution Results List Details ..................................................................199 
• 4.6 "Automatic Update Results List" Icon ......................................................................202 
• 4.7 Automatic Update Results List Details ....................................................................203 
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4.1. "Monitor" view 
You can monitor the information necessary to use the DPM, such as scenario execution status and 
automatic update status, etc. in the Monitor view. You can also clear the status of multiple managed 
machines by the batch. 
 
When you click on Monitor in the title bar, it will switch to the Monitor view. The Monitor Function 
List group box is displayed in the main window. 
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4.2. "Scenario Execution List" Icon 
You can view the execution status list for Scenario Execution on the DPM, and batch clear the 
abnormal statuses. 
You can access the Scenario Execution List icon from the Scenario Execution List icon at the 
top of the Monitor view tree view or from Scenario Execution List in the Monitor Function List 
group box displayed in the Monitor view main window. 
Click on the Scenario Execution List icon to display the Execute Scenario List group box on the 
main window. Please see Section 4.3, "Scenario Execution List" regarding the screen. 
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4.3. Scenario Execution List 
The following information is displayed in the Scenario Execution List screen. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Scenario Execution List icon. Or in the Monitor Function List 

group box in the main window, click Scenario Execution List. 
 

(3) The Execute Scenario List group box is displayed in the main window. 
 

 
 

Execute Scenario List 

 Display Count Select the number of managed machines to be displayed. 

Status The scenario execution status can be selected and displayed from 
the following three types. 
• All Status 
• Normal Status 
• Error Status 

Please select Normal Status to confirm the running status. 
The default is All Status. 

Machine Name Displays the name of the managed machine that is running the 
scenario or has completed scenario execution. When you click on 
the machine name, the Operation view - Machine Detail group 
box is displayed. Please see Section 3.7, "Managed Machine 
Details" regarding the Machine Detail. 

IP Address Displays the IP address of the managed machine that is running the 
scenario or has completed scenario execution. This will be blank for 
managed machines without IP address information. 

MAC Address Displays the MAC address of the managed machine that is running 
the scenario or has completed scenario execution. 
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Group Name Displays the group name of the managed machine that is running 
the scenario or has completed scenario execution. If the group is 
layered, the parent group name for the managed machine that is 
running the scenario or has completed scenario execution is 
displayed. 
When you click on the group name, the Operation view - Group 
Detail group box is displayed. Please see Section 3.5, "Machine 
Group Details" regarding the Group Detail group box. 

Scenario Name Displays the name of the running scenario or the completed 
scenario. 

Status Displays the status of the managed machine that is running the 
scenario or has completed scenario execution. (*1) 

Execute Status Displays the execution progress as percent (%) in the status bar. 
If the status is Scenario Executing it will be displayed by a 
progress bar up to "100%". 
The progress bar will show "0%" for Scenario Execute Stop, 
Scenario Execute Error or Remote Power ON Error. 

Detail For running scenarios including backup/restore, ">>" appears in the 
Detail column. It will be blank for other scenarios. 
When you click on ">>", the Backup/Restore Execute List screen 
is shown. Please see Section 4.3.2, "Backup/Restore Execute List" 
regarding the screen. (*2) 

*1 
There are the following types in the status of the machine that the scenario is running and 
completed. 
Execute Status Description 

Scenario Executing This is displayed when the scenario is running. 

Scenario Execute Stop This is displayed when the scenario has been interrupted. 

Scenario Execute Error This is displayed when there is a scenario execution error. 

Remote Power ON Error This is displayed when the remote power on is failed. 

Execution Completed This is displayed when scenario execution has completed. 
*2 

">>" is displayed until the scenario status information including backup/restore for the 
managed machine was cleared. ">>" won't be displayed except for the above cases. 
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4.3.1. Status Batch Clear 
Batch clear the status for scenarios run by DPM. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click on the Monitor icon -> Scenario Execution List icon. Or in the Monitor 

Function List group box in the main window, click Scenario Execution List. 
 

(3) In the Operation menu, click Batch Clear Status. 
 

(4) The Status Clear screen is displayed in the main window. Then enter a check in the status 
information to be cleared. 
 

(5) Click on the OK button. 
 

 
 

Clear Status Information 

 Scenario Execute Finish  The status when scenario execution has completed. 

Scenario Execute Stop  The status when scenario execution is interrupted. 

Scenario Execute Error  The status when there is a scenario execution error. 

Remote Power ON Error The status when there is a remote power on error. 

OK The selected statuses will be batch cleared and it returns to the 
previous window. 

Cancel It returns to the previous window without clearing the selected 
statuses. 

 
 The statuses cleared in Clear Status Information are reflected in the Scenario 

Execution List group box and the clear status can be confirmed. 
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4.3.2. Backup/Restore Execute List 
Manage the backup/restore scenario execution status. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in 

the main window, click Scenario Execution List. 
 

(3) The Scenario Execution List group box appears. Click on ">>" in the Details column. 
 

(4) The Backup/Restore Execute List screen is displayed in the main window. 
Depending on unicast or multicast, the information that will be displayed in the Backup/Restore 
Execute List screen differs.. 

 
<Data is transferred using unicast> 
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Machine Information 

 
 

Machine Name Displays the machine name. 

IP Address  Displays the IP address of the machine. 

MAC Address Displays the MAC address of the machine. 

Group Name Displays the corresponding group name for the machine. 

Execute Status 

 Scenario Name  Displays the scenario name. 

Type  Displays Backup or Restore (Unicast). 

Progress Status  Displays the execution progress as percent (%) in the status 
bar. 

Start Time  Displays the scenario start time. 

Execution Lapsed Time  Execution Lapsed Time is displayed while running a scenario. 
The Scenario End Time is displayed when the scenario 
execution completes. 

Transfer Size (MB)  Displays the transfer size. The whole size and the transferred 
size are displayed. The unit is MB. 

 
<Data is transferred using multicast> 

 



Scenario Execution List 
 

Part I DeploymentManager Function Reference 
195 

 
Machine Information  

 
 

Machine Name Displays the machine name. 

IP Address  Displays the IP address of the machine. 

MAC Address Displays the MAC address of the machine. 

Group Name Displays the corresponding group name for the machine. 

Execute Status 

 Scenario Name Displays the scenario name. 

Type  Displays Restore(Multicast) 

Progress Status The execution progress is displayed as percent (%) in the status 
bar. 

Start Time Displays the scenario start time. 

Execution Lapsed Time Execution Lapsed Time is displayed while running a scenario. 
The Scenario End Time is displayed when the scenario 
execution completes. 

Transfer Size (MB) Displays the transfer size. The whole size and the complete 
transfer size are displayed. The unit is MB. 

Multicast Execute Status 

 Start Target Number Displays the number of managed machines until starting the 
scenario execution  
The scenario will start when the number of managed machines 
reaches the Start Target Number. 

Current Target Number Displays the number of managed machines ready for scenario 
execution. 
The scenario execution will start when this number achieves the 
Start Target Number or the Remainder Time has been 
exceeded. 

Remainder Time(Min) Displays the time left until the scenario execution starts. 
Displayed by one minute increments. 

Multicast Machine List 

 Display Count Select the number of managed machines to be displayed  

Machine Name Displays the name of the managed machine that is running the 
scenario or has completed execution. 

MAC Address Displays the MAC address of the managed machine. 

Group Name Displays the corresponding group name for the managed 
machine. 

Execute Status Displays the scenario progress. (*1) 

Action Link • When you click on Start Now, scenario will start for all of the 
machines to which the scenario is assigned. 

• When you click on Interrupt Scenario, scenario will be 
interrupted for all of the machines to which the scenario is 
assigned. 



4 Monitor 
 

DeploymentManager Ver6.0 Reference Guide 
196 

*1 
The displayed state conditions can be the following types. 

Execute Status Description 

Backup Under preparation This is displayed when it is preparing for a backup. 

Backup Standby mode This is displayed when the backup is waiting for 
execution. 

Backup Running This is displayed when the backup is running. 

Backup Successful completion This is displayed when the backup completes 
successfully. 

Backup Verifying This is displayed when the verification data for the 
backup scenario is being created. 

Backup Stop processing This is displayed when a backup is canceled. 

Backup Error stops processing This is displayed when a backup error interruption is 
being executed. 

Backup Stop This is displayed when the user cancels the backup. 

Backup Error stop This is displayed when there is backup error interruption. 

Backup Pausing This is displayed when the backup is being halted. 

Restore Under preparation This is displayed when it is preparing for a restore. 

Restore Standby mode This is displayed when the restore is waiting for 
execution. 

Restore Running This is displayed when the restore is running. 

Restore Successful completion This is displayed when the restore completes normally. 

Restore Stop processing This is displayed when a restore is canceled. 

Restore Error stops processing This is displayed when there is restore error interruption 

Restore Stop This is displayed when the user cancels the restore on a 
managed machine. 

Restore Error stop This is displayed when there is restore error interruption. 

Restore Pausing This is displayed when the restore is being halted. 
 
 Please click on Refresh from the Operation menu and refresh the latest information in 

order to confirm the most recent execute status. 



Scenario Execution List 
 

Part I DeploymentManager Function Reference 
197 

 

4.3.3. Run Immediately 
Backup/restore immediately, even if the start conditions are not met. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in 

the main window, click Scenario Execution List. 
 
(3) The Scenario Execution List group box appears in the main window. Click on ">>" in the 

Detail column. 
 
(4) The Backup/Restore Execute List screen is displayed. Then click on the Start Now on the 

Action link. 
 
(5) Start the backup or restore immediately, even if the start conditions are not met. 

 
 Start Conditions are not Met indicates that the managed machines that have 

completed the execution preparation have not been reached the maximum number of 
targets or the execution time for the first managed machine for the restore has not 
reached the maximum wait time. 

 
 The execute status in the Backup/Restore Execute List for the managed machine 

that has completed execution preparation will be Waiting Execution. 
 

4.3.4. Cancel Scenario 
Stop the scenario at the time of backup/restore. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in 

the main window, click Scenario Execution List. 
 

(3) The Scenario Execution List group box appears in the main window. Click on ">>" in the 
Detail column. 
 

(4) The Backup/Restore Execute List screen is displayed. Then click on the Interrupt Scenario 
on the Action link. 

 
 If you click on Interrupt Scenario multiple times, the number of Stop Execution log 

displayed in Scenario Execution Result List will be the number of times you clicked. 
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4.4. "Scenario Execution Results List" Icon 
The Scenario Execution Result List icon displays the list of the scenario execution results which has 
been executed in the DPM. 
You can access the Scenario Execution Result List icon from the Scenario Execution Result List 
icon at the top of the Monitor view tree view or from Scenario Execution Result List in the Monitor 
Function List group box displayed in the Monitor view main window. 
Click on the Scenario Execution Result List icon to display the Scenario Execution Result List 
group box on the main window. Please see Section 4.5, "Scenario Execution Results List Details" 
regarding the screen. 
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4.5. Scenario Execution Results List Details 
The following information is displayed in the Scenario Execution Result List screen. 
The Scenario Execution Result List is displayed, sorted by the various items (Type, Date, MAC 
Address, Scenario Name, Machine Name and IP Address). 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click on the Monitor icon -> Scenario Execution Result List icon. Or in the 

Monitor Function List group box appears in the main window. Click Scenario Execution 
Result List. 
 

(3) The Basic Information and Scenario Execute Result List group box appear in the main 
window. 
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Basic Information  

 Scenario Execution Log(s)  Displays the number of scenario execution logs. 
You can confirm the number of logs shown here in the following 
Scenario Execution Result List group box. 

Scenario Execute Result List  

 Display Count Select the number of scenario execution logs to be displayed. 

Type  Displays the scenario execution status. (*1) 

Date  Displays the scenario date and time. 

Scenario Name  Displays the scenario name. 

Machine Name Displays the machine name. 
Furthermore, if it is upgraded from a version prior to DPM 
Ver6.0, the machine name will not be displayed in the result of 
scenario executed before the upgrade. 

IP Address  Displays the IP address. 
Furthermore, if it was upgraded from a version prior to DPM 
Ver6.0, the IP address will not be displayed in the result of 
scenario executed before the upgrade. 

MAC Address Displays the MAC address of the managed machine on which 
the scenario was executed. 
When you click on the MAC address, the Operation view - 
Machine Detail group box is displayed. 
Please see Section 3.7, "Managed Machine Details" regarding 
the Machine Detail group box. 

*1 
 The displayed scenario execution results list status can be the following types. 

Type  Description 

Stop Execution This is displayed when the scenario execution is interrupted. 

Interrupt The Time Out This is displayed when the timeout time set in the Management 
view -> DPM Server -> Detail Settings -> Scenario tab is 
exceeded. 
Interrupt The Time Out is displayed only in the case of 
Hardware Setting or Linux Installation scenario execution. 

Start Execution This is displayed when the scenario execution starts. 

Completed Execution  This is displayed when the scenario execution is completed. 

Error This is displayed when an error occurs during the scenario 
execution. 

 
 Remove the error if there is a scenario execution error. Please see Section 3.8.8, "Error 

Cancellation" about removing the error. 
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4.5.1. Save in CSV Format 
The scenario execution results are saved in the CSV format. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click on the Monitor icon -> Scenario Execution Result List icon. Or in the 

Monitor Function List group box appears in the main window, click Scenario Execution 
Result List. 
 

(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then 
click on Save in CSV. 
 

(4) The File Download dialog box is displayed. Then specify the output file name and path and 
save the scenario execution results. 

 
If the File Download dialog is not displayed, please confirm the security settings for your browser. 
・ Internet Explorer 

Select Internet Options from the Tools menu, then click on the Custom level button from the 
Security level for this zone on the Security tab and the Security Settings screen is 
displayed. 

 
1) Set Enable from Downloads – File Download. 
2) Set Enable from Downloads – Automatic prompting for file downloads. 
3) Set Prompt from Downloads – Font download. 

 

4.5.2. Delete Log 
Delete the log file. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click on the Monitor icon -> Scenario Execution Result List icon. Or in the 

Monitor Function List group box appears in the main window, click Scenario Execution 
Result List. 

 
(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then 

click on Delete Log from the Operation menu. 
 
(4) Click on the OK button. 

 
 The scenario execution results log file is saved in the following folder. Also, the log file 

can increase in size without limit until it's deleted. 
Default: C:\Program Files\NEC¥DeploymentManager\Datafile\LogFile\SnrReport 

Please see Appendix E, "DPM Log Output" regarding the log file. 
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4.6. "Automatic Update Results List" Icon 
The Automatic Update Result List icon displays the list of the automatic update execution results 
which has been executed in the DPM. 
You can access the Automatic Update Result List icon from the Automatic Update Result List 
icon at the top of the Monitor view tree view or from Automatic Update Result List in the Monitor 
Function List group box displayed in the Monitor view main window. 
Click on the Automatic Update Result List icon to display the Automatic Update Result List group 
box on the main window. Please see Section 4.7, "Automatic Update Results List Details" regarding 
the screen. 
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4.7. Automatic Update Results List Details 
The following information is displayed in the Automatic Update Result List screen. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor 

Function List group box appears in the main window, click Automatic Update Result List. 
 

(3) The Automatic Update Result List group box is displayed in the main window. 
 

 
 

Basic Information  

 Auto Update Log(s)  Displays the number of automatic update logs. 

Automatic Update Result 

 Display Count Select the number of automatic update logs to be displayed. 

Type  Displays the automatic update log type. (*1) 

Date  Displays the automatic update date and time. 

Machine Name Displays the name of automatic update machine (managed machine). 

MAC Address 
Displays the MAC address of the automatic update target. 
 

Detail When you click on " ", the Detail of Automatic Update Result 
screen is shown. 
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*1 

The displayed automatic update results list type can be the following types. 

Type  Description 

UpdateCompleted  This is displayed when the automatic update was successful. 

UpdateWarning  This is displayed when the execution conditions are not met during a check prior to 
the automatic update execution. The execution conditions are not met if there are 
more than the maximum number of automatic update clients or if the scenario is 
running, etc. 

UpdateError  This is displayed when an error occurs with the automatic update. 
* File transfer error or applicable package search failure, etc. 

NoticeCompleted  This is displayed when the automatic update notice was successful. 

NoticeError  This is displayed when an error occurs during the automatic update notice due to a 
communication error, etc. 

Time 
SettingCompleted 

This is displayed when automatic update time setting is completed. 

Time 
SettingWarning  

This is displayed when the automatic update time setting failed due to the failing of 
connection to the managed machine or communication, etc. 

 
 If there is an automatic update error, please re-run or restart the DPM Client. 



Automatic Update Results List Details 
 

Part I DeploymentManager Function Reference 
205 

 

4.7.1. Automatic Update Results Details Display 
Display the detail information of the automatic update result. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor 

Function List group box appears in the main window, click Automatic Update Result List. 
 

(3) The Automatic Update Result List group box appears in the main window. Then click on the 
Detail ( ) icon to confirm the automatic update results for the managed machine. 
 

(4) The detail of automatic update result is shown in the main window. 
 

 
 

 When you click on the Detail Icon ( ) of Automatic Update Result group box, the 
Detail Of Automatic Update Result will be displayed only if the automatic update 
result (xx-xx-xx-xx-xx-xx.rpt) exists in the DPM install folder (default value: 
C:\Programfiles\NEC\DeploymentManager\Datafile\LogFile\AuReport). 

 

4.7.2. Maximum Number of Logs Settings 
You can set the maximum output number for automatic updates. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor -> Automatic Update Results List icon. Or in the Monitor 

Function List group box appears in the main window, click Automatic Update Result List. 
 

(3) The Configuration menu for the Automatic Update Result List icon will be displayed, then 
click on Maximum Number of Log. 
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(4) The Maximum Number of Log Setting screen is displayed in the main window. Then set the 

maximum number of logs. 
 

 
 

Maximum Number of Log Setting  

 Maximum Number of Log 
(1-100000)  

Set the maximum number of output logs for the automatic 
updates. 
This can be set in the range of "1 - 100000."  
The default value is "10000."  

OK Saves the settings of the Maximum Number of Log Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the settings 
details from the Maximum Number of Logs Settings screen. 

 
  Only the specified maximum number of logs will be displayed on the screen. 

 If the maximum number of logs is set to less than 10000, the old information that 
exceeds the maximum number of logs will be deleted in order. If the maximum 
number of logs is set to more than 10000, 10% of the old logs that exceed the 
maximum number of logs will be deleted. 

 If you set the maximum number of logs smaller than the previously set value, it's 
possible that part of the logs may be deleted. 

 
  Please change the maximum number of logs according to the managed number of 

managed machines. 
 It is recommended that the maximum number of logs be set higher than the number 

of managed machines. 
For example, If you are managing 100 managed machines, and if you set the 
maximum number of logs to more than 100, then you can confirm the automatic 
update results for the updates for all of the managed machines. 
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4.7.3. Save in CSV Format 
The automatic update execution results and detailed information are saved in the CSV format. 
 

(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 

(2) In the tree view, click Monitor -> Automatic Update Results List icon. Or in the Monitor 
Function List group box appears in the main window, click Automatic Update Result List. 

 
(3) The Automatic Update Result List screen is displayed. Click on Save in CSV in Operation 

menu. 
 

(4) File Download dialog box is displayed. 
The automatic update execution results and detailed information are output in CSV format so 
please select CSV File for the file type and save. 

 
 If the File Download screen is not displayed, please confirm the security settings for your 

browser. Please see Section 4.5.1, "Save in CSV Format" regarding the settings. 
 

4.7.4. Delete Log 
Delete the automatic update results log file. 
 

(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 

(2) In the tree view, click Monitor -> Automatic Update Results List icon. Or in the Monitor 
Function List group box appears in the main window, click Automatic Update Result List. 

 
(3) The Automatic Update Result List screen is displayed. Click on Delete Log in Operation 

menu. 
 

(4) Click on the OK button. 
 

 The automatic update results log file is saved in the following folder., 
Default: C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\AuReport 

Please see "DPM Log Output" in Appendix E regarding the log file. 
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This Section explains tools to operate for DPM. 
 
 
• 5  .................................................................................................................................211 
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• 7 Other Tools ..............................................................................................................411 
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5. Image Builder 
 
 
 
 
 
 
 
 
 
 
This chapter explains Image Builder, which is a tool for registering images. 
 
The items covered in this chapter are as follows. 
 
 
• 5.1 Connection Settings .................................................................................................212 
• 5.2 Creating a Floppy Disk Image .................................................................................213 
• 5.3 Registering an Operating System ............................................................................216 
• 5.4 Creating a Setup Parameter File .............................................................................219 
• 5.5 Package Registration/Modification ..........................................................................342 
• 5.6 Delete Package .......................................................................................................366 
• 5.7 Batch Registration ...................................................................................................368 
• 5.8 License Agreement Display Settings .......................................................................369 
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5.1. Connection Settings 
These settings can be configured when using Image Builder (Remote Console). 
When changing the Management Server to which Image Builder (Remote Console) is connected, 
change the IP address entered during the first startup using the following procedure. 
 
(1) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
 
(2) Click on Setting connection. The Setting connection screen is displayed. 
 

 
 
(3) Enter the IP address of the DPM Server and click OK. The connection settings are now 

completed. 
 

 The LAN board of the DPM Server that can be connected to Image Builder (Remote 
Console) is the one indicated in Management view -> DPM Server icon -> Detailed 
Settings -> General tab -> Server Information -> IP address. 
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5.2. Creating a Floppy Disk Image 
By using the Creating Floppy Disk Image function, you can register floppy disk images of BIOS 
updates, firmware updates and distribute the images via the network. 
You can also register, distribute, and execute floppy images of other application programs that start 
up from a floppy disk. However the size of the programs should be up to the floppy disk size, 
1.44MByte. 
 
 This Section describes how to create an image of a floppy disk. 
The image is created using Image Builder. Once created, the image is registered to DPM Server. 
 
The following describes how to register a floppy disk image in DPM using Image Builder. 
First, get the floppy disk that automatically executes BIOS and firmware updates. And insert the disk 
into the floppy disk drive of the Management Server or the machine in which Image Builder (Remote 
Console) has been installed, in order to register the image in DPM. 
 
(1) From the Start menu of the computer where the Management Server or Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image 
Builder. 

 
(2) When Image Builder is launched, click Creating Floppy Disk Image/Registering EFI 

application. 
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 When you start Image Builder and select a menu item for the first time, the 

License Agreement dialog box appears. Read the agreement and click I agree. 
If you select I do not agree, you will not be able to use the function. 
 

 
 
(3) The Select registration image screen appears. Select Creating Floppy Disk Image and click 

the OK button. 
 

 
 
(4) The Creating Floppy Disk Image screen is displayed. Enter image file name and click OK. 
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Creating Floppy Disk Image 
 Image File Name  Enter the image file name. 

Only 8 single-byte numeric characters can be entered. A 
character can be any single-byte alphabet and numeric 
characters or any of the following symbols: 
. _ - 

OK A confirmation screen will appear. 
Cancel It will be returned to the Step (2). 

 
(5) A confirmation screen appears. Verify that the floppy disk is inserted, and click the OK button. 
 
(6) The Creating Image screen appears. Registration to DPM begins. 
 

 
 
(7) Registration is completed when the confirmation screen appears with the words "Image file 

creation is completed."  
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5.3. Registering an Operating System 
 

 If you create an NFS public folder other than Folder for Image\exports, you must register 
the operating system manually without using Image Builder. For details, see "About Linux 
Installation" in Section 3.5.6, "Precautions/Other" in the Operation Guide. 

 
(1) From the Start menu of the computer where the Management Server or Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image 
Builder. 

 
(2) When Image Builder is launched, click on Registering operating system. 
 
(3) The OS Registration screen is displayed and you can configure each item. 
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Registering operating system 
  

 
Operating System Name 

Enter the operating system name. 
Names such as Linux, ks, daemon, and pxelinux.* are 
reserved and cannot be registered. 
In Linux, numeric characters and the following symbols can be 
used:  
. _- ( ) 

 
Operating System Type 

Select the following operating systems from the list box. 
・ Red Hat Linux 3,4,5/VMWare ESX/Ctrix XenServer 
・ Red Hat Enterprise Linux 6 

initrd.img/vmlinuz folder The floppy disk drive is displayed here. The default is A:\. Click 
Browse and select the location of initrd.img/vmlinuz. 
If Red Hat Enterprise Linux 6 was selected, mount the ISO file 
for installation and select Images/pxeboot. 

CD-ROM Source Folder 
(Install ISO is displayed  
when Red Hat Enterprise  
Linux 6 is selected as  
Operating System Type.) 

When Operating System Type is selected, the CD-ROM drive is 
displayed. 
Click Browse and select the location of the folder containing the 
OS. 
If Red Hat Enterprise Linux 6 was selected, select the ISO file 
for installation. 

OK The OS image is created with the settings on the Registering 
operating system screen before returning to the previous 
window. 

Cancel The previous window is returned to without creating the OS 
image with the settings from the Registering operating system 
screen. 

 
 To prepare a Linux image file, all under the source folder of the specified CD-ROM are 

copied as the image file. 
With Red Hat Linux, multiple CD-ROMs are involved and thus a message prompting you 
to copy the next CD-ROM will appear after the first CD-ROM is copied. Insert the 
CD-ROMs in order, and continue copying. 
When an overwrite confirmation dialog box appears during this time, select Yes or Yes to 
All, and proceed. 

 
(4) To begin copying, click the OK button. After the vmlinuz/initrd.img files are copied, the CDs 

are copied. 
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(5) When the CDs have been copied, the Red Hat CD Image copy screen is displayed. If there are 

any installation CDs remaining, replace the CD and select Next. There are several Red Hat 
installation CDs. 

 

 
 
(6) During copying, screens such as the Confirm File Replace and Confirm Folder Replace 

might appear. Select Yes to All and continue with copying. 
 

 
 

 
 
(7) Once all CDs have been copied, the Red Hat CD Image copy screen appears. Select Finish. 
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5.4. Creating a Setup Parameter File 
The setup parameter file is a file which is used to perform an OS installation by disk duplication or an 
OS clear installation. The managed machines are configured using this file. We will describe a method 
for creating a separate setup parameter file for each managed machine, and a batch creation method. 

5.4.1. Creating a Disk Duplication Data File (Windows) 

This Section describes how to create a disk duplication data file for configuring individual machines 
when performing an OS installation by disk duplication in Windows. 

5.4.1.1. Creating a Disk Duplication Data File (Windows Server 

2000/Windows Server 2003/Windows XP) 
To create a disk duplication data file for Windows Server 2000/2003/XP, the data file is created and 
then the disk duplication data file is created on the basis of that data file. See "1. Creating a Data File" 
through "2. Creating a Disk Duplication Data File." 
The various settings configured in "1. Creating a Data File" become the default values in the disk 
duplication data file created in "2. Creating a Disk Duplication Data File." 
 
1. Creating a Data File  
Create the data file which will act as the basis for creating the disk duplication data file. 
 

  The entry items vary depending on the type of Windows OS. 
 Depending on the item, other entry items sometimes have to be checked. If any 

such messages appear on the screen, follow them. 
 You must use a setup parameter file created using DPM. 

Setup parameters created using a product other than DPM, such as using 
seamless setup with EXPRESSBUILDER which comes standard with the 
Express5800 Series, cannot be used. 

 
 Only create one data file. There is no need to create one for each of the machines 

which will be subject to disk duplication. The disk duplication data file is created based 
on this one file. 
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(1) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 
 

(2) Select "Setting Setup Parameter File." The Select Parameter screen is displayed. Select 
Windows Parameter File and click OK. 

 

 
 
(3) The Create Setup Parameter File screen appears. 
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(4) In the Setting Setup Parameter File screen, select File -> Create New information files. The 

Basic information screen will be displayed, so select the OS type in the red box of the 
following screen. The item in the red box must be set. 
The following items do not need to be set. 
･Target machine 
･OS Installation path 
･System Partition 
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Basic Information  
 OS type   TSelect the install OS. The following OS's can be selected. 

(*1) 
・ IA32(Intel Architecture 32bit) architecture 

-Windows 2000 Professional 
-Windows 2000 Server 
-Windows 2000 Advanced Server 
-Windows XP Professional 
-Windows Server 2003 Standard Edition 
-Windows Server 2003 Enterprise Edition 

・ EM64T(Extended Memory 64-bit Technology) architecture  
-Windows Server 2003 Standard x64 Edition 
-Windows Server 2003 Enterprise x64 Edition 

Activation If Windows XP or Windows Server 2003 is selected in OS type, the 
Activation setting is enabled. 

 Retail Version or OEM 
Version other than NEC 

Select this if you are using a retail version or OEM version other than 
NEC. (*2) 

NEC OEM Version Select this if you are using an NEC OEM version. (*2) 
*1 
 Activation is enabled when any of the following OS's are selected. 

Either Retail Version or OEM Version other than NEC or NEC OEM Version is selected. 
-Windows XP Professional 
-Windows Server 2003 Standard Edition 
-Windows Server 2003 Enterprise Edition 
-Windows Server 2003 Standard x64 Edition 
-Windows Server 2003 Enterprise x64 Edition 

 The setting data is not maintained if the OS type is changed. Make sure that each item is 
configured correctly. 

 The following options are displayed under OS type, but are not supported in this version. 
・ Windows Server 2003 Datacenter Edition 
・ Windows Server 2003 Datacenter x64 Edition 

 An activation (license authentication) request might appear during disk duplication. If this 
happens, follow the license authentication procedure in accordance with the instructions on the 
screen. 

*2 
 When running a DPM Server using an EM64T machine, keep the following in mind. 

･The data file cannot be created if NEC OEM Version is selected for the following OS 

media. If an OS installation by disk duplication is performed for these OS's, select Retail 
Version or OEM Version other than NEC and create the data file using the product key 
that came with the OS medium or the hardware. 
-Windows XP Professional(no SP, SP1)(CD number:243-110442-007-A) 
-Windows XP Professional w/SP2(excluding 2006/06and after)(CD 
number:243-110442-007-C) 

-Windows Server 2003 Standard Edition(no SP)(CD number:243-110442-100-A/C) 
-Windows Server 2003 Enterprise Edition(no SP)(CD number:243-110442-101-A/B/C) 
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 If NEC OEM was selected under Activation, the following screen is displayed, so insert the 

CD-ROM for the OS into the CD-ROM drive and click OK. 
 

 
 
(5) Click on the Next to display the User Information screen and then configure each item. 
 

        
 

 

Windows 2000 Professional 
Windows 2000 Server 
Windows 2000 Advanced Server  
When selecting Retail version or OEM 
version other than NEC When selecting NEC OEM Version 
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User Information 
 User Name 

(Entry required)  
Enter the name of the user. 
Up to 50 characters can be entered. The allowed characters 
are single-byte alphanumeric characters. 
The following symbols cannot be used. 
, 

Company name Enter the name of the company. 
Up to 50 characters can be entered. The allowed characters 
are single-byte alphanumeric characters. 
The following symbols cannot be used. 
, 
This entry is not optional. 

Product-Key Enter the Windows OS product key. 
Please enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx". 
This does not need to be enteredif NEC OEM Version is 
selected. 
In the case of a pre-installed machine, enter the product key on 
the sticker attached to the machine body. If the OS has been 
installed using a dedicated medium under a volume licensing 
contract with Microsoft, enter the product key that came with 
the medium. 

TimeZone Set the time zone. Select the appropriate region in the list box. 
This is optional. 
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(6) Select Next to display the Role of Computer screen. Items in red boxes in the screen below 

must be set. The item in the red box must be set. 
The following items do not need to be set. 

- Client License Mode 
- Specify an Account 
- Network setup 
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Role of Computer  
 Computer Name  

(Entry required)  
Enter the machine name registered in DPM. 
Up to 15 characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols and single-byte spaces cannot be used. 
. , ` ~ ! @ # $ & * % = + { } \ | ; : ' " < > / ? [ ] ^ ( ) 
Also, you cannot register a machine name made up only of 
numbers.  
Make sure the name is not the same as that of any other machine 
or domain/workgroup. 

Administrator Password Set the password for administrator authority. 
Only 14 single-byte characters can be entered. 
Only single-byte alphanumeric characters and symbols can be 
used. 
The following symbols as well as single-byte spaces and 
single-byte kana cannot be used. 
, " 
This need not be configured. 
If you do set a password, please refer to the password 
configuration policy for each OS, and then select one which can 
be set in the OS. 

Administrator Password 
again 

Re-enter the password set in Administrator Password. This 
must be entered if Administrator Password was set. 

MAC Address This is used during disk duplication. This item cannot be set. 
Domain Set the domain. Select Domain and enter the corresponding 

name. (*1) 
The following symbols and single-byte spaces may not be used. 
. , " \ / ; : | * ? < > [ ] 

Workgroup Set the workgroup. Select Workgroup and enter the 
corresponding name. 
The following symbols and single-byte spaces cannot be used. 
. , " \ ; : | * ? < > + = 

*1 
 When setting Domain, follow the password setting policy for the domain controller. If the 

domain is set in violation of the policy, OS installation by disk duplication might stop at every 
login screen. If this happens, log in manually. 

 Do not omit Password. Omitting it will result in a scenario execution error. 
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(7) Select Next to display the Display Setup screen. This does not need to be set for OS 

installation by disk duplication, so just click Next. 
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(8) Click on the Next to display the Network Setup screen and configure the NIC (LAN board). 

The items in red boxes in the screen below are set. The item in the red box must be set. 
The following items do not need to be set. 
- Network services 
- Network client 

 
When the NIC Settings are made, the Protocol Setting, IP Address, DNS, and WINS can be 
set. These settings can be indicated directly to the NIC of the machine. If the NIC is indicated, 
however, the MAC address must be entered. 
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Network Setup 
 NIC Settings 

 AutoDetect If the NIC is not specified, select AutoDetect. 
If AutoDetect is added to the MAC addresses list of the NIC to be 
added, the numbers 1-4 are added to AutoDetect. 
When performing an OS installation by disk duplication by setting 
AutoDetect, if there are several NICs, it is impossible to know which NIC 
to make the setting for. 

MAC Address If the NIC is specified, select MAC Address and enter the MAC address in 
the text box. 
MAC Address must be entered in the form "xx-xx-xx-xx-xx-xx."  
When performing an OS installation by disk duplication setting MAC 
Address, the settings are configured for the specified MAC address.  
For an NIC having a MAC address that is registered to the DPM, 
configure the settings so that network communication is possible, whether 
the address is acquired from a fixed IP address or the DHCP server. If 
network communication is impossible, the scenario might not be 
completed. 

Add Add any NIC's to the List of Added NIC MAC Addresses. 
Select AutoDetect or enter MAC Address and then click Add. 

MAC addresses list of 
the NIC to be added 

Displays a list of MAC address. 
Set one or more NIC's. Up to a total of four AutoDetect and MAC 
Addresses can be added. 

 Protocol setting Configure the protocol for added NIC's. Click on the Protocol Setting 
button to display the Protocol Setting screen. See "Protocol Settings" 
below for details on this screen. 

 
When adding an Internet Protocol (TCP/IP), a number of internet 
protocols (TCP/IP) equal to the number of NIC's added by selecting NIC 
Settings -> Add is added to the Protocol list to be added. 
The following is an example where two NIC's, 00-00-00-00-00-00 and 
AutoDetect1, have been added by selecting NIC Settings -> Add. 
Example) Protocol list to be added 
 
 
 

Delete To delete an added MAC address or AutoDetect, select the desired one 
from the list and click on Delete. 

Internet Protocol (TCP/IP) 00-00-00-00-00-00 
Internet Protocol (TCP/IP) AutoDetect1  
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 Protocol setting 
This Section describes the Protocol setting screen. 
 

 When setting several NIC's (LAN boards), repeat steps 3)-4). 

 
1) In the Protocol Setting screen, select Internet Protocol (TCP/IP) from the Protocol list 

box, and click the Add button. 
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Protocol Setting 
 Protocol Configure the protocol for the NIC. 

The following protocols can be added. Note that the selectable 
items vary depending on the OS. 
- Internet protocol (TCP/IP) 
(Setting required)  

- NWLINK IPX/SPX/NetBIOS-compatible transport protocol 
- Apple Talk protocol 
- Network monitor driver 
- NetBEUI protocol 
- DLC protocol 
- Streams environment 

Protocol list to be added 
(Setting required)  

Displays the list of added protocols. 
Select Protocol and click the Add button to add a protocol to 
the Protocol list to be added box. 

Details  Detailed settings for the internet protocol (TCP/IP) for each 
NIC are configured here. 
Select Internet Protocol (TCP/IP) from the Protocol list to be 
added box and click on the Details button. 
Click on the Details button to display the Internet Protocol 
(TCP/IP) and set each item. 
See the description below for details on the screen. 
This need not be configured. (*1) 

Delete  Deletes an added protocol. 
Select the protocol to delete from the Protocol list to be 
added box and click on the Delete button. 

OK Saves the settings on the Protocol Setting screen and returns 
to the previous window. 

Cancel Returns to the previous window without saving the settings in 
the Protocol Setting screen. 

*1 
When not setting 
Acquire Automatically is set as a default for all IP address, DNS, and WINS. The value of the 
scope ID is not reflected. 
Click on the OK button in the Protocol Setting screen, click on Next in the Network Settings 
screen, and proceed to (9) the Component Settings screen. 
 

2) Internet Protocol (TCP/IP) is added to the Protocol list to be added, so select this and click 
on the Details button. 
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3) The Settings Internet Protocol (TCP/IP) screen is displayed. Select the IP Setting tab in 

the Settings Internet Protocol (TCP/IP) screen and configure each item. 
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 Settings Internet Protocol (TCP/IP) 
 IP Setting Here you can set the IP address, subnet mask, gateway, and 

metrics. The settings differ depending on whether they are acquired 
automatically or set manually. 

 Acquire the IP address  
automatically 
 

Selecting this radio button causes the IP address to be acquired 
automatically. 
The default setting is Acquire the IP address automatically. 

Use the following IP 
address 

Selecting this radio button enables setting of the IP address, subnet 
mask, gateway, and metric. 

 IP Address  
 Add Clicking the Add button causes the TCP/IP Address screen to be 

displayed, so enter the IP address and subnet mask. 

 

Please enter these in the form "xxx xxx xxx xxx"  
Clicking on Add in the TCP/IP Address screen causes the IP 
address and subnet mask to be added to the IP Address box. 
Up to a total of four IP addresses and subnet masks can be set for 
each NIC. 

Edit Select the IP address/subnet mask to be edited from the IP 
Address box and click on the Edit box. The TCP/IP Address 
screen is displayed, enabling editing of the IP address/subnet 
mask. 

Delete Select the IP address/subnet mask to be deleted from the IP 
Address box and click on the Delete button. This deletes the IP 
address/subnet mask. 

Default gateway  
 Add Clicking the Add button causes the TCP/IP gateway address 

screen to be displayed, so enter the gateway and metric. 

 

Please enter these in the form "xxx xxx xxx xxx"  
The metric is entered as a single-byte number. This can be set in 
the range of "1-9999."  The default value is "1."  
Clicking on Add in the TCP/IP gateway address screen causes the 
gateway/metric to be added to the Default Gateway box. 
Up to a total of four gateways and metrics can be added. 
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Edit Select the gateway/metric to be edited from the Default Gateway 
box and click on the Edit button. The TCP/IP gateway address 
screen is displayed, enabling editing of the gateway/metric. 

Delete Select the gateway/metric to be deleted from the Default Gateway 
box and click on the Delete button to delete the gateway/metric. 

 
 If the system is being run with the Check the completion of a scenario by the 

communication with DPM Client checkbox checked (Web Console Management view, 
DPM Server icon -> Detail setting in Configuration menu -> General tab) and the 
system cannot communicate with the Management Server using the IP address which has 
been set, scenario execution may not be completed. 
In this case, either set the correct IP address or place a check in the Turn Off Power After 
Scenario Execution checkbox (Add Scenario screen -> Option tab) when creating the 
scenario. 
If the Turn Off Power After Scenario Execution checkbox is not checked, scenario 
execution completion can be detected irrespective of the IP address set in the data file. 

 
4) Set the items in the DNS/WINS tab on Settings Internet Protocol (TCP/IP) screen. 
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Settings Internet Protocol (TCP/IP)  
 DNS/WINS The DNS and WINS settings are made here. The settings differ 

depending on whether they are acquired automatically or set 
manually. 

 Acquire the address of 
DNS server 
automatically 

Select this to acquire the address of the DNS server automatically. 
Select this if the managed machine is a DNS server. 
The default setting is Acquire the address of DNS server 
automatically. 

Use the following 
address of DNS server 

Select this to set the IP address of the DNS server. 

DNS Server Address (the Order of Use) 
 Add By clicking the Add button, the TCP/IP DNS Server screen is 

displayed, so enter the address of the DNS server. 

 

Please enter these in the form "xxx xxx xxx xxx" 
Clicking on Add in the TCP/IP DNS Server screen causes the 
address of the DNS server to be added to the DNS Server Address 
(the Order of Use) box. Up to four DNS server addresses can be 
added. 

Edit Select the DNS server address to be edited from the DNS Server 
Address (the Order of Use) box and click on the Edit button. The 
TCP/IP DNS Server screen is displayed, enabling editing of the 
DNS server address. 

Delete Select the DNS server address to be deleted from the DNS Server 
Address (the Order of Use) box and click the Delete button to delete 
the DNS server address. 

Acquire the address of 
WINS server 
automatically 
 

Select this to acquire the address of the WINS server automatically. 
Select this if the managed machine is a WINS server. 
The default setting is Acquire the address of WINS server 
automatically. 

Use the following 
address of WINS server 

Select this to set the IP address of the WINS server. 

WINS Server Address (the Order of Use) 
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 Add Clicking the Add button causes the TCP/IP WINS Server screen to be 
displayed, so enter the address of the WINS server. 

 
Please enter these in the form "xxx xxx xxx xxx"  
Clicking on Add in the TCP/IP WINS Server screen causes the address 
of the WINS server to be added to the WINS Server Address (the 
Order of Use) box. Up to four WINS server addresses can be added. 

Edit Select the WINS server address to be edited from the WINS Server 
Address (the Order of Use) box and click on the Edit button. The 
TCP/IP WINS Server screen is displayed, enabling editing of the WINS 
server address. 

Delete Select the WINS server address to be deleted from the WINS Server 
Address (the Order of Use) box and click the Delete button to delete 
the WINS server address. 
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5) Set the ScopeID in the Settings Internet Protocol (TCP/IP) screen. 
 

 
 

Settings Internet Protocol (TCP/IP)  
 ScopeID Set the scope ID. 

The scope ID cannot be set for each NIC. If the internet protocol 
(TCP/IP) scope ID has been set for one NIC, the previously set scope 
ID is displayed, even if the Settings Internet Protocol (TCP/IP) 
screen is opened for the internet protocol (TCP/IP) of another NIC. 
This need not be configured. 

OK Saves the settings in the Settings Internet Protocol (TCP/IP) screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the settings in the 
Settings Internet Protocol (TCP/IP) screen. 
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(9) Select Next to display the Setting the Component screen. This does not need to be set for OS 
installation by disk duplication, so just click Finish. 
 

 



Creating a Setup Parameter File 
 

Part II Tools 
239 

 
(10) The License Agreement page is displayed. Please read this carefully and click on the I agree 

button. 
 

 
 

 If you select I do not agree, you will not be able to use the function. 
 

(11) Clicking on I agree displays the Specify a File screen. Click on the Browse button, select a file 
name, and save the data file. 
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Specify a File  
 File name Set the name of the data file that has been set and where it is 

contained. 
You can select where to save it with the Browse button or enter 
the file path directly. 
Up to 63 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
" / \ ; : | , * ? < > 
If you use the Browse button to set the directory and file name, 
set the file name so that it is no longer than 254 single-byte 
characters, including the path. 

OK Save the data file to the saving specified designated on the 
Specify a file screen. 

Cancel Closes the window without saving the data file with the settings. 
 

Creation of the data file is completed once the Create a Setup Parameter File screen is displayed. 
 

2. Creating a Disk Duplication Data File 
The disk duplication data file is created on the basis of the data file created in "1. Creating a Data 
File."  
 

 A disk duplication data file must be created for each machine to which the system will 
be deployed. 

 
(1) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 
 

(2) Select "Setting Setup Parameter File". The Select Parameters screen is displayed. Select 
Windows Parameter File and click OK. 

 
(3) The Create a Setup Parameter File screen is displayed. In the File menu, select Create New 

Disk copy information File for 2003/2000/XP(P). The Open screen is displayed. 
 

(4) Select the data file you created according to "1. Creating a Data File" in "5.4.1.1 Creating a Disk 
Duplication Data File (Windows Server 2000/Windows Server 2003/Windows XP)."  
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(5) The Setup Information File screen is displayed. Set the data required for the managed 

machine in which setup is to be performed. Items in red boxes in the following screen must be 
set. 
The following tabs do not need to be set. 
- Basic information 
- Display Setup 
- Setting the Components 
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Setup Information File (*1) 
 Role of Computer - Computer Name must be set. 

The MAC address is automatically entered by entering the 
name of the machine registered to DPM and placing the 
cursor over the MAC Address field. 

- The following symbols as well as single-byte kana cannot be 
used in the Administrator Password and the password for 
Specify an Account. 
" , 

- For the MAC Address, enter the MAC address of the 
machine in which OS installation by disk duplication is 
executed. Please enter it in the form "xx-xx-xx-xx-xx-xx". 

User Information - User Name must be set. 
- On the ProductKey, set the product key used on the machine 

in which OS installation by disk duplication is executed. 
Network Setup Set as necessary. 

For an NIC having a MAC address that is registered to the 
DPM, configure the settings so that network communication is 
possible, whether the address is acquired from a fixed IP 
address or the DHCP server. If network communication is 
impossible, an executed scenario might not be completed. 

*1 
Items are configured with the content of the data file that has been prepared. Change as 
needed. 

 
(6) Click on the OK button to display the Specify a file screen and click on OK. 

Clicking on the Cancel button returns the screen to the previous window, without saving the 
settings in the Setup Information File screen. 

 
 The file name of the created setup parameters becomes the automatically input MAC 

address. The file name cannot be changed. 
 
Creation of a disk duplication data file is completed. 
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5.4.1.2. Creating a Disk Duplication Data File (Windows Server 

2008/Windows Vista/Windows 7) 
A disk duplication data file for Windows Server 2008, Windows Vista, and Windows 7 is created. 
The disk duplication data file for Windows Server 2008, Windows Vista, and Windows 7 includes the 
previous Disk Duplication Data File (Windows Parameter File) used in the version earlier than 
DPM Ver. 6.0, and a Disk Duplication Data File (Windows parameter file(Express)) that allows 
rapid setup of machines. 
 

  The Windows parameter file(Express) cannot be used for creation of large 
amounts of the disk duplication data file, so use the previous disk duplication 
data file. See "2. Creating a Disk Duplication Data File (Windows Parameter 
File," discussed below, for how to create a Disk Duplication Data File in large 
quantities. 

 A disk duplication data file created using the Windows parameter file(Express) 
cannot be edited in Image Builder by designating the Windows parameter file. 
Furthermore, a disk duplication data file created using the Windows parameter 
file cannot be edited in Image Builder by designating the Windows parameter 
file(Express). 

 Items which cannot be entered in the Image Builder screens are not used in 
settings of this procedure (creating a disk duplication data file for Windows 
Server 20008, Windows Vista, or Windows 7). 
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1. Creating a Disk Duplication Data File (Windows parameter file(Express)) 
In creating a disk duplication data file (Windows parameter file(Express)), the procedure for creating 
a disk duplication data file that can set a machine up rapidly. 
 
(1) From the Start menu of the computer where the Management Server or Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder. 
 

(2) Select "Setting Setup Parameter File." The Select Parameters screen is displayed. Select 
Windows Parameter File (Express) and click OK. 
 

 
 
(3) When the Create Setup Parameter File screen is displayed, click on Create a new disk copy 

files for 2008/Vista or later (B). 
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(4) When the Basic information screen appears, set the OS type. 
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Basic Information 
 OS type   Select the installation OS. The following OS's can be selected. 

(*1) 
・ IA32 
- Windows Server 2008 Standard 
- Windows Server 2008 Enterprise 
- Windows Server 2008 Datacenter 
- Windows Vista Business 
- Windows Vista Enterprise 
- Windows Vista Ultimate 
- Windows 7 Professional 
- Windows 7 Ultimate 
- Windows 7 Enterprise 
・ EM64T 
- Windows Server 2008 Standard x64 Edition 
- Windows Server 2008 Enterprise x64 Edition 
- Windows Server 2008 Datacenter x64 Edition 
- Windows Server 2008 R2 Standard 
- Windows Server 2008 R2 Enterprise 
- Windows Server 2008 R2 Datacenter 

Activation 
 Retail Version  

or OEM Version other 
than NEC 

Select this if you are using Retail Version or OEM Version other 
than NEC. 

NEC OEM Version Select this if you are using an NEC OEM version. 
However this cannot be selected about Windows Vista/Windows 7 
because OS installation by disk duplication for NEC OEM versions 
is not permitted due to the license. 

  MVLS Version Select this if you are using a volume licensed version. 

*1 
 The setting data is not maintained if the OS type is changed. Make sure that each item 

is configured correctly. 
 An activation (license authentication) request might appear during disk duplication. If 

this happens, follow the license authentication procedure in accordance with the 
instructions on the screen. 

 The following options are displayed under OS type, but are not supported in this 
version. 
・ Windows Server 2008 Datacenter Edition 
・ Windows Server 2008 Datacenter x64 Edition 
・ Windows Server 2008 R2 Datacenter 
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(5) After configuring the settings in the Basic Information screen, click on the Next to display the 

User Information screen and then configure each item. 
 
<Windows Server 2008 selected> <Windows Vista/7 selected> 
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User Information 
 User Name 

(Entry required)  
Enter the name of the user. 
Up to 50 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
, 

Company name Enter the name of the company. 
Up to 50 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols cannot be used. 
, 
This entry is optional. 

Product-Key Enter the Windows OS product key. 
Please enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx". 
In the case of a pre-installed machine, enter the product key on the 
sticker attached to the machine body. If the OS has been installed 
using a dedicated medium under a volume licensing contract with 
Microsoft, enter the product key that came with the medium. 
This must be entered if Retail Version or OEM Version other 
than NEC was selected in Activation in the Basic information 
screen. 
This does not need to be entered if NEC OEM Version is selected. 
If you selected MVLS Version, this does not need to be entered. 

Timezone Set the time zone. Select the appropriate region in the list box. 
This need not be configured. 

Language Select the language to use from the list box. The following three 
options are available. 
- Japanese 
- English 
- French 

Help protect Windows 
automatically 

This item is only for Windows Vista/Windows 7. 
Select the setting to automatically protect Windows from the list 
box. The following three options are available. 
- Use recommended settings. 
- install important updates only. 
- Ask me later. 

Select your computer's 
current location  

This item is only for Windows Vista/Windows 7. 
Select the current location of your computer from the list box. The 
following three options are available. 
- Home 
- Work 
- Public location 
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(6) After setting the User Information screen, select Next to display the Role of Computer 

screen. Items in red boxes in the screen below must be set. The item in the red box must be 
set. 
The following items do not need to be set. 
- Client License Mode 
- Network Setup 
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Role of Computer 
 Computer Name  

(Entry required)  
Enter the machine name registered in DPM. 
Up to 15 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters. 
The following symbols and single-byte spaces cannot be used. 
. , ` ~ ! @ # $ & * % = + { } \ | ; : ' " < > / ? [ ] ^ ( ) 
Also, you cannot register a machine name made up only of 
numbers. 
Make sure the name is not the same as that of any other machine 
or domain/workgroup. 
If the name of a machine registered to DPM is used, the 
Management Server automatically acquires the MAC address of 
the managed machine. 

Administrator Password Set the password for administrator authority. 
Select a password which can be set in the OS, referring to the 
password configuration policy for each OS. 
The number of characters that can be entered depends on the 
OS. 
• For Windows Server 2008: 
3-14 single-byte characters for mixed single-byte alphanumeric 
characters (including lower case for Latin letters). 

• For Windows Vista/Windows 7: 
Only 14 single-byte numeric characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols as well as single-byte spaces and 
single-byte kana cannot be used. 
, " 
This need is optional. 
If you do set a password, refer to the password configuration 
policy for each OS and select one which can be set in the OS. 

Administrator Password 
again 

Re-enter the password set in Administrator Password. This 
must be entered if Administrator Password was set. 

MAC Address If the NIC (LAN board) is specified, select MAC Address and 
enter the MAC address in the text box. 
MAC Address must be entered in the form "xx-xx-xx-xx-xx-xx". 
For an NIC having a MAC address that is registered to the DPM, 
configure the settings so that network communication is possible, 
whether the address is acquired from a fixed IP address or the 
DHCP server. If network communication is impossible, an 
executed scenario might not be completed. 

Domain Set the domain. Select Domain and enter the corresponding 
name. 
The following symbols and single-byte spaces cannot be used. 
, " \ / ; : | * ? < > [ ] 
When setting Domain, follow the password setting policy for the 
domain controller. If the policy is not followed, the OS installation 
by disk duplication will stop at every login screen. If this happens, 
log in manually. 
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Workgroup The workgroup name cannot be changed in Windows Server 
2008, Windows Vista, or Windows 7 when using the disk 
duplication data file (Windows parameter file). Use the existing 
workgroup. 
When using the disk duplication data file (Windows parameter 
file(Express)), the workgroup name can be changed. 

 Specify an Account This can only be entered if Domain has been selected. 
Check this to set the account and password when participating in 
a domain. 
If it is checked, Account, Password, and Password again can 
be set. 

 Account  Enter the account name. 
32 single-byte characters can be used. 
The following symbols cannot be used. 
, " / ; : * ? < > + = [ ] | 

Password  Enter the password. 
- For Windows Server 2008, 3-14 bytes can be entered using 

single-byte alphanumeric characters. 
The following characters cannot be used in the password. 

, " 
- For Windows Vista and Windows 7, enter no more than 14 bytes. 

The following characters cannot be used in the password. 
, " 

Do not omit the Password. Omitting it will result in a scenario 
execution error. 

Password again Enter the password entered in Password. 
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(7) After setting the Role of Computer screen, select Next to display the Network Setupscreen. 

Items in red boxes in the screen below must be set. 
The following items do not need to be set. 
- Network services 
- Network client 
 
The protocol can be set and the IP address, DNS, and WINS settings can be configured for the 
NIC (LAN board). With these settings, the NIC of the computer can be specified directly. If the 
NIC is indicated, however, the MAC address must be entered. 
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Network Setup 
 NIC Setting 

 AutoDetect If the NIC is not specified, select AutoDetect. 
If AutoDetect is added to the MAC Addresses list of the NIC to be added, the 
following numbers are added to AutoDetect. 
- Windows parameter file(Express): 1-8 
- Windows parameter file: 1-4 

When performing an OS installation by disk duplication by setting 
AutoDetect, if there are several NICs, it is impossible to know which NIC to 
make the setting for. 

MAC Address If the NIC is specified, select MAC Address and enter the MAC address in 
the text box. 
MAC Address must be entered in the form "xx-xx-xx-xx-xx-xx". 
If the data file is used in which the MAC Address is set, the settings are 
made to the specified MAC address. 
For an NIC having a MAC address that is registered to the DPM, configure 
the settings so that network communication is possible, whether the address 
is acquired from a fixed IP address or the DHCP server. If network 
communication is impossible, an executed scenario might not be completed. 

Add Adds a NIC. Select AutoDetect or enter MAC Address and then click Add. 
MAC Addresses list of 
the NIC to be added 

Displays a list of added NIC MAC addresses. 
Click on Add and add a MAC address to the list. 
Set one or more NIC's. The following total number of AutoDetect and MAC 
Addresses can be added: 
- Windows parameter file(Express): up to 8 
- Windows parameter file: up to 4 

Any NIC not configured here is configured so as to automatically acquire an 
IP address using DHCP. 

 Protocol Setting Configure the protocol for added NIC's. Click on the Protocol Setting button 
to display the Protocol Setting screen. See "  Protocol Setting" below for 
details on this screen. 

 
When adding an Internet Protocol (TCP/IP), a number of internet protocols 
(TCP/IP) equal to the number of NIC's added by selecting NIC Settings -> 
Add is added to the Protocol List to be Added. 
The following is an example where two NIC's, 00-00-00-00-00-00 and 
AutoDetect1, have been added by selecting NIC Settings -> Add. 
Example) Protocol list to be added 
 
 
 

Delete To delete an added MAC address or AutoDetect, select the desired one from 
the list and click on Delete. 

 

Internet Protocol (TCP/IP)  00-00-00-00-00-00 
Internet Protocol (TCP/IP)  AutoDetect1  
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 Protocol Setting 

This Section describes the Protocol Setting screen. 
 

1) In the Protocol Setting screen, select Internet Protocol (TCP/IP) from the Protocol list box, 
and click the Add button. 
 

 
 

Protocol Setting 
 Protocol Configure the protocol for the NIC. 

The protocol which can be added is Internet Protocol (TCP/IP). 
The number of protocols that can be added depends on the disk 
duplication data file that was created. 
• Windows parameter file(Express): up to 16 
• Windows parameter file: up to 4 

Protocol list to be added 
(Setting required)  

Displays the list of added protocols. 
Select Protocol and click the Add button to add a protocol to the 
Protocol List to be Added screen. 

Details  Detailed settings for the internet protocol (TCP/IP) for each NIC are 
configured here. 
Select Internet Protocol (TCP/IP) screen from the Protocol list to 
be added box and click on the Details button. 
Click on the Details button to display the Settings Internet 
Protocol (TCP/IP) and set each item. 
See the description below for details on the screen. 
This need not be configured. 
If the NIC is not configured, the IP address, DNS, and WINS settings 
are all "acquire automatically" by default. The value of the scope ID 
is not reflected. For the remaining settings, skip ahead to (8). 

Delete Delete an added protocol. 
Select the protocol to delete from the Protocol list to be added box 
and click on the Delete button. 
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OK Saves the settings in the Protocol Setting screen and returns to the 
previous window. 

Cancel Returns to the previous window without saving the settings in the 
Protocol Setting screen. 

 
2) Internet Protocol (TCP/IP) is added to the Protocol list to be added box, so select the 

protocol and click on the Details button. 
 

3) The Settings Internet Protocol (TCP/IP) screen is displayed. Select the IP Settings tab in the 
Settings Internet Protocol (TCP/IP) screen and configure each item. 

 
 There is no area to enter the scope ID with the disk duplication data file (Windows parameter 

file(Express)). 

 
 When setting several NIC's (LAN boards), repeat steps 3-4. 
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Settings Internet Protocol (TCP/IP) 
 IP Setting Here you can set the IP address, subnet mask, gateway, and metrics. The settings 

differ depending on whether they are acquired automatically or set manually. 

 Acquire the IP 
Address 
Automatically 

Selecting this radio button causes the IP address to be acquired automatically. 
The radio button is selected by default. 

Use the following 
IP Address 

Selecting this radio button enables setting of the IP address, subnet mask, gateway, 
and metric. 

 IP address  
 Add Clicking the Add button causes the TCP/IP Address screen to be displayed, so enter 

the IP address and subnet mask. 

 
Please enter these in the form "xxx xxx xxx xxx". 
Clicking on Add in the TCP/IP Address box causes the IP address and subnet mask to 
be added to the IP Address box. 
The total number of IP addresses and subnet masks that can be set for each NIC are 
as follows: 
• Windows parameter file(Express): up to 16 
• Windows parameter file: up to 4 

Edit Select the IP address/subnet mask to be edited from the IP Address box and click on 
the Edit box. The TCP/IP Address screen is displayed, enabling editing of the IP 
address/subnet mask.  

Delete Select the IP address/subnet mask to be deleted from the IP Address box and click on 
the Delete button. This deletes the IP address/subnet mask. 

Default Gateway 
 Add Clicking the Add button causes the TCP/IP Gateway Address screen to be displayed, 

so enter the gateway and metric. 

 
Please enter these in the form "xxx xxx xxx xxx."  
The metric is entered as a single-byte number. This can be set in the range of 
"1-9999."  The default value is "1."  
Clicking on the Add button in the Default Gateway box causes the gateway/metric to 
be added to the Default Gateway box. 
The total number of gateways and metrics that can be added is as follows:  
• Windows parameter file(Express): up to 16 
• Windows parameter file: up to 4 

Edit Select the gateway/metric to be edited from the Default Gateway box and click on the 
Edit button. The TCP/IP Gateway Address screen is displayed, enabling editing of the 
gateway/metric. 

Delete Select the gateway/metric to be deleted from the Default Gateway box and click on the 
Delete button to delete the gateway/metric. 
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 If the system is being run with the Check the completion of a scenario by the 

communication with DPM Client checkbox checked (Web Console Management view, 
DPM Server icon -> Detail Configuration in Configuration menu -> General tab -> 
Server Settings group box) and the system cannot communicate with the Management 
Server using the IP address which has been set, scenario execution may not be detected 
as having been completed. 
In this case, either set the correct IP address or place a check in the Turn Off Power After 
Scenario Execution checkbox (Add  Scenario screen -> Option tab) when creating the 
scenario in the Operations view of the Web Console. 
If the Turn Off Power After Scenario Execution checkbox is not checked, scenario 
execution completion can be detected irrespective of the IP address. 

 
4) The Settings Internet Protocol (TCP/IP) screen is displayed. Select the DNS/WINS tab in the 

Settings Internet Protocol (TCP/IP) screen and configure each item. 
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Settings Internet Protocol (TCP/IP)  
 DNS/WINS The DNS and WINS settings are made here. The settings differ 

depending on whether they are acquired automatically or set 
manually. 

 Acquire the address of  
DNS Server automatically 

Select this to acquire the address of the DNS server 
automatically. 
Select Acquire the address of DNS Server automatically if the 
destination machine is a DNS server. 
The radio button is selected by default. 

Use the following address 
 of DNS Server  

Select Use the following address of DNS Server to set the IP 
address of the DNS server. 

DNS Server Address (the Order of Use) 
 Add Clicking the Add button causes the TCP/IP DNS Server screen to 

be displayed, so enter the address of the DNS server. 

 
Please enter these in the form "xxx xxx xxx xxx."  
Clicking on Add in the TCP/IP DNS Server screen causes the 
address of the DNS server to be added to the Use the following 
address of DNS Server box. 
The total number of DNS server addresses that can be added is 
as follows:  
• Windows parameter file(Express): up to 16 
• Windows parameter file: up to 4 

Edit Select the DNS server address to be edited from the DNS Server 
Address (in Order of Use) box and click on the Edit button. The 
TCP/IP DNS Server screen is displayed, enabling editing of the 
DNS server address. 

Delete Select the DNS server address to be deleted from the DNS 
Server Address (in Order of Use) box and click the Delete button 
to delete the DNS server address. 
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Acquire the address of 

 

 

 

Select this to acquire the address of the WINS server 
automatically. 
Select Acquire the address for WINS Server Automatically if the 
destination machine is a WINS server. 
The radio button is selected by default. 

Use the following address 
of WINS server 

Enter a check in the Use the following address of WINS server 
checkbox to set the IP address of the WINS server. 

 WINS Address (the order of use) 
 Add Clicking the Add button causes the TCP/IP WINS Server screen 

to be displayed, so enter the address of the WINS server. 

 
Please enter these in the form "xxx xxx xxx xxx". 
Clicking on Add in the TCP/IP WINS Server screen causes the 
address of the WINS server to be added to the Use the following 
address of WINS server (the order of use) box. 
The total number of WINS server addresses that can be added is 
as follows:  
• Windows parameter file(Express): up to 16 
• Windows parameter file: up to 4 

Edit Select the WINS server address to be edited from the WINS 
Server Address (the order of use) box and click on the Edit 
button. The TCP/IP WINS Server screen is displayed, enabling 
editing of the WINS server address. 

Delete Select the WINS server address to be deleted from the WINS 
Server Address (the order of use) box and click the Delete button 
to delete the WINS server address. 
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 The address of the WINS server may sometimes not be set to the machine after disk 
duplication, even if the address of the WINS server is specified in the Windows parameter 
file(Express). 
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5) Set the Scope ID in the Settings Internet Protocol (TCP/IP) screen. This can only be set in 

the case of the disk duplication data file (Windows parameter file). This cannot be set with the 
disk duplication data file (Windows parameter file(Express)). 
 

 
 

Settings Internet Protocol (TCP/IP)  
 Scope ID Set the scope ID. 

The scope ID cannot be set for each NIC. If the internet protocol 
(TCP/IP) scope ID has been set for one NIC, the previously set scope 
ID is displayed, even if the Settings Internet Protocol (TCP/IP) 
screen is opened for the internet protocol (TCP/IP) of another NIC. 
This need not be configured. 

OK Click OK button when you reflect the settings in 3)-5). This saves the 
settings in the Settings Internet Protocol (TCP/IP) screen and 
returns to the previous window. 

Cancel Click the Cancel button when you do not reflect the settings in 3)-5). 
This saves the settings in the Settings Internet Protocol (TCP/IP) 
screen and returns to the previous window. 
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(8) After setting the Network Setup screen, click on the Finish button. 
 
(9) The License Agreement Consent page is displayed. Please read this carefully and click on I 

agree. 
 

 
 

 If you select I do not agree, you will not be able to use the function. 
 
(10) Click on the I agree button to display the Specify a file screen and click on OK. 

Creation of the parameter file is completed once the Creating Setup Parameter File screen is 
displayed. 
The file name is the automatically entered MAC address. 
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2. Creating a Disk Duplication Data File (Windows Parameter File)  
This Section describes the procedure for creating the disk duplication data file (Windows parameter 
file). 
 
(1) From the Start menu of the computer where the Management Server or Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder. 
 

(2) Select Setting Setup Parameter File". The Select Parameters screen is displayed. Select 
Windows Parameter File and click OK. 

 

 
 

(3) When the Setting Setup Parameter File screen is displayed, click on Create new disk copy 
information files2008/Vista or later (B). 
 

 
 

(4) The rest of the settings are the same as for the Windows parameter file(Express). See 
"1.Creating a Disk Duplication Data File (Windows parameter file(Express)."  The upper limit 
values sometimes vary between the Windows parameter file(Express) and the Windows 
parameter file. Differences are described in the description of the Windows parameter 
file(Express). 
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5.4.2. Batch Creation of Disk Duplication Data Files (Windows) 
When executing disk duplication on multiple Windows managed machines, a disk duplication data file 
must be created for each machine. 
This Section describes batch creation of Windows disk duplication data files. 
 

 Batch creation is not possible using a disk duplication data file created using the 
Windows parameter file (Express). 

 
(1) Prepare the disk duplication data file that will act as the basis for creating a large quantity of 

disk duplication data files. 
 

 For details on how to create the setup parameter file, see Section 5.4.1, "Creating a 
Disk Duplication Data File (Windows)." 

 
(2) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 
 

(3) When you click Setting Setup Parameter File, the Select parameter screen is displayed. 
Select Windows Parameter File and click OK. 

 
(4) When the Setting Setup Parameter File screen is displayed, select Creation of multiple disk 

copy information files assistant -> Output disk duplication data file in CSV format (I) in 
the Option menu. 

 
(5) When the Open screen is displayed, indicate the disk duplication data file prepared in (1) above 

and open it. 
 

 
 
(6) Indicate the CSV file name to save to and click the OK button. The CSV-format disk duplication 

data file is created and stored in < Folder for Image>\AnsFile\Sysprep\csv. 
 

 The CSV file created here is referred to as a template file from now on. 
 

(7) Edit the template file created in (6) above. Open the CSV file created in (6) located in <Folder 
for Image>\AnsFile\Sysprep\csv. 
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(8) Open and edit the CSV-format template file that has been created and is located in <Folder for 

Image>\AnsFile\Sysprep\csv. 
Each line in the template file is as follows: 
 

(1) 1st line 
Name of the file that is the basis for the template file. 

(2) 2nd line 
Items in the disk duplication data file that can be specified during batch creation. 

(3) 3rd line 
Parameters specified by the file that is the basis for the template file. 

(4) 4th line and later 
Fill in the items corresponding to the 2nd line to perform batch creation. Each line 
corresponds to one disk duplication data file. 
 

 Do not modify lines 1-3. Any modification will make batch creation using the template file 
impossible. 

 
See the table below for details on configuring the 4th line and on. 

 
  If you edit the file as a text file, items are separated by commas ( , ), so enter the 2nd 

line and the 4th line and on in a matching way. 
 Do not include spaces before or after items when editing the 4th line and on in the CSV 

file. Do not use commas ( , ) or double quotes ( " ) in the items. This might prevent 
successful creation of the disk duplication data file. 

 Unless indicated in the table below, the format for each item in the 4th line should be in 
accordance with "5.4.1 Creating a Disk Duplication Data File (Windows)." If an item is 
mentioned in the table below, ensure accurate capitalization. 

 The machine name must be entered. 
 The DNS/WINS for each LAN board corresponds to the DNS/WINS set for each LAN 

board in the file which is the basis for the template file. 
When creating the file that is the basis for the template file, a number of internet 
protocols (TCP/IP) equal to the number of LAN boards is added to the Protocol list to 
be added box in the Protocol Setting screen. The DNS/WINS settings correspond, 
from above, to the LAN board 1, LAN board 2, LAN board 3, and LAN board 4 in the 
table. 
An example of the correspondence is as below. 
 
Protocol list to be added 

 
  
 
 
 
 
 

 

Apple Talk protocol 
Internet Protocol (TCP/IP)  00-00-00-00-00-00 
Internet Protocol (TCP/IP)  00-00-00-00-00-11 
Internet Protocol (TCP/IP) AutoDetect1  
Internet Protocol (TCP/IP) AutoDetect2  
 

LAN board 1 
LAN board 2 
LAN board 3 
LAN board 4 
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Items in the 2nd line Explanation of input items in the 
4th line and later 

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

Computer Name  
(Entry required)  

Input the computer name. Error. 

MAC Address 
(Item only displayed for 
disk duplication) 
(Entry required)  

Input the MAC address of the 
computer. 
 

Error. 

User Name Input name of user of the computer.  Same value as in parameter of 3rd 
line in template file. 

Company name Input the company name. Same value as in parameter of 3rd 
line in template file. 

Product Key Input product key for Retail Version 
or OEM Version other than NEC. 
For NEC OEM Version, NEC OEM is 
input (single-byte space between NEC 
and OEM). Note that if the product key 
in the 3rd line of the template file is not 
NEC OEM, an error will be returned 
during creation of a disk duplication 
information file. 

Same value as in parameter of 3rd 
line in template file. 

Administrator Password Input administrator password in plain 
text. 

Same value as in parameter of 3rd 
line in template file. 

Workgroup Input the workgroup name. 
Note that if Domain, Domain 
Account Name, or Domain Account 
Password are input when the 
workgroup is input, an error will be 
returned during creation of the disk 
duplication data file. 

If Domain is not input, the same 
value as the parameter on the 3rd 
line of the template file is used. 

Domain Input the domain name. 
However, when both a domain and 
workgroup are entered, an error will 
be returned during creation of a disk 
duplication data file. 

If Workgroup is not input, the 
same value as the parameter on 
the 3rd line of the template file is 
used. 

Domain's Account Name Input the domain's account name. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, and 
Domain Account Name are not 
input, the same value as the 
parameter on the 3rd line of the 
template file is used. 

Domain's Account 
Password 

Input domain's account password in 
plain text. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, Domain 
Account Name, and Domain 
Account Password are not input, 
the same value as the parameter 
on the 3rd line of the template file is 
used. 

NIC1 Input the first LAN board If the NIC is 
specified, inputs the MAC address. 
If the NIC is not specified, input 
AutoDetect. 

Set as AutoDetect1, and the IP 
address for NIC1 is Automatically 
Acquire IP Address. The values 
of IP address1 (NIC1)-Metric4 
(NIC1) are not reflected. 
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Items in 2nd line Explanation of input items in the 
4th line and later  

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

IP Address 1 
(NIC1) 

Input the first IP address in LAN board 
1. 
DHCP is entered if automatically 
acquired. 

Set to Acquire the address of 
DNS server automatically. The 
values of SubnetMask1 
(NIC1)-SubnetMask4 (NIC1) are 
not reflected. 

SubnetMask1 
(NIC1) 

Input the first subnet mask in LAN 
board 1. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
1 (NIC1) has been input. 
No setting in all other cases. 

IP Address 2 (NIC1) Input the second IP address in LAN 
board 1. 

No setting. 

SubnetMask2 (NIC1) Input the second subnet mask in LAN 
board 1. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
2 (NIC1) has been input. 
No setting in all other cases. 

IP Address 3 (NIC1) Input the third IP address in LAN 
board 1. 

No setting. 

SubnetMask3 (NIC1) Input the third subnet mask in LAN 
board 1. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
3 (NIC1) has been input. 
No setting in all other cases. 

IP Address 4 (NIC1) Input the fourth IP address in LAN 
board 1. 

No setting. 

SubnetMask4 (NIC1) Input the fourth subnet mask in LAN 
board 1. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
4 (NIC1) has been input. 
No setting in all other cases. 

Gateway1 (NIC1) Input the first gateway in LAN board 1. No setting. 
Metric1 (NIC1) Input the first metric in LAN board 1. Set to 1 only when Gateway1 

(NIC1) has already been input. 
Gateway2 (NIC1) Input the second gateway in LAN 

board 1. 
No setting. 

Metric2 (NIC1) Input the second metric in LAN board 
1. 

Set to 1 only when Gateway2 
(NIC1) has already been input. 

Gateway3 (NIC1) Input the third gateway in LAN board 
1. 

No setting. 

Metric3 (NIC1) Input the third metric in LAN board 1. Set to 1 only when Gateway3 
(NIC1) has already been input. 

Gateway4 (NIC1) Input the fourth gateway in LAN board 
1. 

No setting. 
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Items in 2nd line Explanation of input items in the 
4th line and later  

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

Metric4(NIC1) Input the fourth metric in LAN board 1. Set to 1 only when Gateway4 
(NIC1) has already been input. 

NIC2 Input the MAC address of the second 
LAN board or AutoDetect. 

No setting. 
The values of IP address 1 
(NIC2)-Metric4 (NIC2) are not 
reflected. 

IP Address 1 (NIC2) Input the first IP address of LAN board 
2 if LAN board 2 has been set. DHCP 
is entered if automatically acquired. 

Set to Automatically Acquire IP 
Address. The values of 
SubnetMask1 
(NIC2)-SubnetMask4 (NIC2) are 
not reflected. 

SubnetMask1(NIC2) Input the first subnet mask in LAN 
board 2. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 1 (NIC2) has been input. 
No setting in all other cases. 

IP Address 2 (NIC2) Input the second IP address in LAN 
board 2. 

No setting. 

SubnetMask2(NIC2) Input the second subnet mask in LAN 
board 2. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 2 (NIC2) has been input. 
No setting in all other cases.  

IP Address 3 (NIC2) Input the third IP address in LAN 
board 2. 

No setting. 

SubnetMask3(NIC2) Input the third subnet mask in LAN 
board 2. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 3 (NIC2) has been input. 
No setting in all other cases. 

IP Address 4 (NIC2) Input the fourth IP address in LAN 
board 2. 

No setting. 

SubnetMask4(NIC2) Input the fourth subnet mask in LAN 
board 2. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 4 (NIC2) has been input. 
No setting in all other cases. 

Gateway1(NIC2) Input the first gateway in LAN board 2. No setting. 
Metric1(NIC2) Input the first metric in LAN board 2. Set to 1 only when Gateway1 

(NIC2) has already been input. 
Gateway2(NIC2) Input the second gateway in LAN 

board 2. 
No setting. 

Metric2(NIC2) Input the second metric in LAN board 
2. 

Set to 1 only when Gateway2 
(NIC2) has already been input. 

Gateway3(NIC2) Input the third gateway in LAN board 
2. 

No setting. 

Metric3(NIC2) Input the third metric in LAN board 2. Set to 1 only when Gateway3 
(NIC2) has already been input. 
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Items in 2nd line Explanation of input items in the 
4th line and later 

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

Gateway4(NIC2) Input the fourth gateway in LAN board 
2. 

No setting. 

Metric4(NIC2) Input the fourth metric in LAN board 2. Set to 1 only when Gateway4 
(NIC2) has already been input. 

NIC3 Input the MAC address of the third 
LAN board or AutoDetect. 

No setting. The values of IP 
address 1 (NIC3)-Metric4 (NIC3) 
are not reflected. 

IP address 1(NIC3) Input the first IP address of LAN board 
3 if LAN board 3 has been set. 
DHCP is entered if automatically 
acquired. 

Set to Automatically Acquire IP 
Address. The values of 
SubnetMask1 
(NIC3)-SubnetMask4 (NIC3) are 
not reflected. 

SubnetMask1 
(NIC3) 

Input the first subnet mask in LAN 
board 3. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
1 (NIC3) has been input. 
No setting in all other cases. 

IP address 2(NIC3) Input the second IP address in LAN 
board 3. 

No setting. 

SubnetMask2(NIC3) Input the second subnet mask in LAN 
board 3. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
2 (NIC3) has been input. 
No setting in all other cases. 

IP address 3(NIC3) Input the third IP address in LAN 
board 3. 

No setting. 

SubnetMask3(NIC3) Input the third subnet mask in LAN 
board 3. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
3 (NIC3) has been input. 
No setting in all other cases. 

IP address 4(NIC3) Input the fourth IP address in LAN 
board 3. 

No setting. 

SubnetMask4(NIC3) Input the fourth subnet mask in LAN 
board 3. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP address 
4 (NIC3) has been input. 
No setting in all other cases. 

Gateway1(NIC3) Input the third gateway in LAN board 
3. 

No setting. 

Metric1(NIC3) Input the first metric in LAN board 3. Set to 1 only when Gateway1 
(NIC3) has already been input. 
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Items in 2nd line Explanation of input items in the 
4th line and later 

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

Gateway2(NIC3) Input the third gateway in LAN board 
3. 

No setting. 

Metric2(NIC3) Input the second metric in LAN board 
3. 

Set to 1 only when Gateway2 
(NIC3) has already been input. 

Gateway3(NIC3) Input the third gateway in LAN board 
3. 

No setting. 

Metric3(NIC3) Input the third metric in LAN board 3. Set to 1 only when Gateway3 
(NIC3) has already been input. 

Gateway4(NIC3) Input the third gateway in LAN board 
3. 

No setting. 

Metric4(NIC3) Input the fourth metric in LAN board 3. Set to 1 only when Gateway4 
(NIC3) has already been input. 

NIC4 Input the MAC address of the fourth 
LAN board or AutoDetect. 

No setting. 
The values of IP address 1 
(NIC4)-Metric4 (NIC4) are not 
reflected. 

IP address1(NIC4) Input the first IP address of LAN board 
4 if LAN board 4 has been set. DHCP 
is entered if automatically acquired. 

Set to Automatically Acquire IP 
Address. The values of 
SubnetMask1 
(NIC4)-SubnetMask4 (NIC4) are 
not reflected. 

SubnetMask1(NIC4) Input the first subnet mask in LAN 
board 4. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 1 (NIC4) has been input. 
No setting in all other cases. 

IP address 2(NIC4) Input the second IP address in LAN 
board 4. 

No setting. 

SubnetMask2(NIC4) Input the second subnet mask in LAN 
board 4. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 2 (NIC4) has been input. 
No setting in all other cases. 

IP address 3(NIC4) Input the third IP address in LAN 
board 4. 

No setting. 

SubnetMask3(NIC4) Input the third subnet mask in LAN 
board 4. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 3 (NIC4) has been input. 
No setting in all other cases. 

IP address 4(NIC4) Input the fourth IP address in LAN 
board 4. 

No setting. 

SubnetMask4(NIC4) Input the fourth subnet mask in LAN 
board 4. 

Set to same value as the data in 
the file which is the basis of the 
template file only when IP 
address 4 (NIC4) has been input. 
No setting in all other cases. 
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Items in 2nd line Explanation of input items in the 
4th line and later  

When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
step (9). 

Gateway1(NIC4) Input the fourth gateway in LAN board 
4. 

No setting. 

Metric1(NIC4) Input the first metric in LAN board 4. Set to 1 only when Gateway1 
(NIC4) has already been input. 

Gateway2(NIC4) Input the fourth gateway in LAN board 
4. 

No setting. 

Metric2(NIC4) Input the second metric in LAN board 
4. 

Set to 1 only when Gateway2 
(NIC4) has already been input. 

Gateway3(NIC4) Input the third gateway in LAN board 
4. 

No setting. 

Metric3(NIC4) Input the third metric in LAN board 4. Set to 1 only when Gateway3 
(NIC4) has already been input. 

Gateway4(NIC4) Input the fourth gateway in LAN board 
4. 

No setting. 

Metric4(NIC4) Input the fourth metric in LAN board 4. Set to 1 only when Gateway4 
(NIC4) has already been input. 

 
(9) Save the CSV file after editing it. 
 
(10) Select Creation of multiple disk copy information files assistant -> Create multiple disk 

duplication data files in Option menu of the Create Setup Parameter File screen. 
 
(11) When the Open File screen is displayed, select the CSV file saved in (9) above. The Result of 

creating multiple information files screen is displayed, showing the results of the creation. 
One disk duplication data file is created for each computer registered in the CSV file. 

 
 If "Data file creation failed" is displayed in the Batch Data File Creation Results screen, 

click on Error Information. Detailed information about errors is displayed. Correct the 
CSV file accordingly and perform the operation again. 

 
(12) Click the OK button. Batch creation of the data files is completed. 
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5.4.3. Creating a Disk Duplication Parameter File (Linux) 

This Section describes how to create a disk duplication data file for configuring individual machines 
when performing an OS installation by disk duplication in Linux. 
 

  When creating a disk duplication data file, there are two working modes: Online Mode 
and Offline Mode. 
Online mode: mode for normal use. 
Offline mode: creates files on a local computer without sending files to the 
Management Server. 
This Section mainly explains the Online Mode that is used normally. 

 For a LAN board having a MAC address that is registered to the DPM, configure the 
settings so that network communication is possible, whether the address is acquired 
from a fixed IP address or the DHCP server. If network communication is impossible, 
an executed scenario might not be completed. 

 For disk duplication, use the disk duplication data file that has the same name as MAC 
address of the managed machine registered in the Web Console. 

 
  The disk duplication data file becomes a template used for batch creation of disk 

duplication data files. 
 The disk duplication data file is created using Image Builder installed on the 

Management Server or Image Builder (Remote Console). 
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 Online Mode 

The disk duplication data file (Linux duplication parameter file) is created and managed in the 
Folder for Images on the Management Server over the network. 

 

 
 
 Offline Mode 

The disk duplication data file (Linux parameter file) is created and managed on the machine on 
which Image Builder is launched, using any folder as the work directory. 

 
 
 
 
 
 
 
 
 
 
 
 

 The default temporary directory is [installation directory]\linux\offline. 
 
The working mode and work directory can be changed at any time. 
 

 The disk duplication data file is created in the text file format for Linux. Keep this in mind 
if you edit the file using a text editor or other application on a Windows machine. 

 

Working Linux duplication parameter file 

Temporary folder: install folder \linux\online 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) 

Management Server 

Read file and save 
 
 

Managed folder: Image storage folder \AnsFile\machineinf 

Receive file Send file 

Saved Linux duplication parameter file 

Image Builder 
Machine(Remote Console) 
 

Managed folder: Optional working directory 
Image Builder 

Machine(Remote Console) 

Saved Linux duplication parameter file 
Read file and save 
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Create a new disk duplication data file. If you use an existing file, see "2, Disk Duplication Data File 
(Opening an Existing File)" below. 
 

 The keyboard operations effective with buttons for creating a disk duplication data file are 
the Enter key and space key only. 

 
1. Creating a Disk Duplication Data File (New File) 
This Section describes how to create a new disk duplication data file for configuring individual 
machines when performing an OS installation by disk duplication in Linux. 
 
(1) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 

 
(2) Select Setting Setup Parameter File. 

The Select parameter screen is displayed. Select Linux disk copy parameter file and click 
OK. 

 

 
 

(3) When this function is launched for the first time, or if the environment configuration data file 
LinuxSysRep.cfg is not in the install directory, the LinuxOS Replicate Environment Set is 
displayed. Configure the settings to match your environment. 
 

 
 



Creating a Setup Parameter File 
 

Part II Tools 
275 

 
 

LinuxOS Replicate Environment Set 
 Install Directory Displays the directory where Image Builder has been installed. 

This cannot be edited. 
Work Directory Displays the work directory for offline mode. This can only be 

entered if the selected working mode is offline mode. 
The number of characters allowed is 1-254 single-byte characters. 
Only single-byte alphanumeric characters can be used. 
The following symbols cannot be used. 
, ; * ? " ' < > | [ ] @ 
The default is [Install Directory \linux\offline]. 

Select Working Mode  Select one of the following working modes. 
- Online mode 
- Offline mode 
The default is Online Mode. 

Management Server The IP address of the Management Server that was set during 
installation of Image Builder is acquired from the registry data and 
displayed here. 

Management Server 
Directory 

Displays the directory name on the Management Server where the 
disk duplication data file is to be saved when in online mode. (Fixed 
data) 

CANCLE Discards changes and closes the environment settings screen. 
SAVE Saves the settings to the environment settings file [LinuxSysRep.cfg] 

and closes the environment settings screen. 
 
A confirmation message is displayed when the environment data for installation directory or the 
IP address of the Management Server cannot be acquired from the registry or the .ini file. 
Click on the OK button to close without launching the disk duplication data file creation tool. 
 

 
 

(4) When the configuration is completed, click on the SAVE button and then click Yes to save the 
settings. 
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 If there is an error in the settings, an error message is displayed in red font and saving 

cannot be performed. Correct the settings and re-save. 
 

 
 
If you select CANCLE, the confirmation screen below is displayed. Clicking on Yes 
discards the settings and closes the screen. 
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(5) The LinuxOS Replicate Parameter Making screen is displayed. Configure settings in 

accordance with your environment. 
 

 
 

LinuxOS Replicate Parameter Making 
 
 

MAC Address 
(Entry required) 

Enter the MAC address of the Ethernet device of the managed 
machine which is registered in DPM in 12-digit hexadecimal 
number form. 
Example) "1A-2B-3C-4D-5E-6F", "1a-2b-3c-4d-5e-6f", etc. 
When saving the file, the entered MAC address is used to create 
and save the disk duplication data file. The extension is .rep. 
Example) "1A2B3C4D5E6F.rep", "1a2b3c4d5e6f.rep", etc. 

Primary DNS This is for entering the IP address of the primary DNS server as 
set in the managed machine. This entry is optional. 

Secondary DNS This is for entering the IP address of the secondary DNS server 
as set in the managed machine. This entry is optional. 
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 Network Information Settings 
 

  When a computer with multiple LAN boards (Ethernet devices) is used and IP addresses 
in the same segment are assigned to the LAN boards, communication may fail if there 
are any LAN boards which are not connected to LAN cables. 
It is recommended that the LAN boards that are not connected with a LAN cable
 not 
have a fixed IP assigned, but be set with DHCP, or not set. 

 In an environment where the Network Manager daemon is enabled, the DNS settings 
set by the disk duplication data file won't be applied. 
If you perform DNS setting, please disable the NetworkManager daemon using th
e following method at the time of the master image creation. 

 
1) Confirm the start level of the NetworkManager  

#chkconfig --list NetworkManager 
 

(Execution results Example)  
NetworkManager  0:off  1:off  2:on   3:on   4:on   5:on   6:off 
 
Run the following command if at least one is "on". 
All will change to "off". 
 

2) To disable the NetworkManager (run with root authority)  
#chkconfig NetworkManager off 
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Configure a TCP/IP network for Ethernet devices eth0 through eth6 in the Linux OS duplication 
target machine. 

 
1) Select the Ethernet device to be configured, and click the EDIT button. 
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2) The Network Data Set is displayed. Configure settings in accordance with your environment. 

 

 
 

Network Data Set 
 Device Name Displays the name of the Ethernet device being edited. 

Host Name Displays the host name. Up to 255 single-byte characters can be 
entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ as well as spaces. 
This must be entered for eth0. 

Network Type Select and set the type of TCP/IP network from below. 
- DHCP: IP addresses are set dynamically by a DHCP server. 
- Fixed IP: IP addresses are set manually. 

The default value is DHCP. 
IP Address  

Set the IP address. 
This must be entered only if Fixed IP has been selected as the 
network type. 
Example) "192.168.0.1" "192.168.100.150", etc. 

Network Mask Set the Network Mask. 
This must be entered only if Fixed IP has been selected as the 
network type. 
Example) "255.255.0.0", "255.255.255.0", etc. 

Gateway 
Enter the IP address of the gateway machine that corresponds to 
the IP address of the Ethernet device being configured. 
This does not need to be entered even if either DHCP or Fixed IP 
has been selected as the network type. 
Example) "192.168.0.250" "192.168.100.200", etc. 

CANCLE Closes the Network Data Set without saving the Ethernet device 
settings. 

SAVE Saves the Ethernet device settings and closes the Network Data 
Set. 
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  For a LAN board having a MAC address that is registered to the DPM, configure the 

settings so that network communication is possible, whether the address is acquired 
from a fixed IP address or the DHCP server. 
If network communication is impossible, an executed scenario might not be completed. 

 In the case of SUSE Linux Enterprise, the only setting of the gateway for the Ethernet 
device which is "eth0" is valid. 

 For managed machines registered in DPM, assign a connectable IP address in the 
same segment. If an unconnectable address is assigned, scenario execution may not 
complete. 

 
 If a setting is not correct, an error message is displayed in red at the bottom of the Network 

Data Set and saving cannot be performed. 
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 Time Zone 

 
Select the time zone to set for the Linux duplication target machine from the time zone list in 
the red box. The item in the red box must be set. The default is America/New_York. 
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 Script Data 

 
Set the Linux shell script to be executed after duplication is completed in the Linux OS 
duplication target machine. 

 

  
 

Script Data Enter the script data. Up to 100 lines of numeric characters (256 
characters per line) can be entered. 
Only single-byte alphanumeric characters and symbols can be used. 
The file cannot be read if the total of the previously entered data and 
the file that is read exceeds the character limit. 

 Read Displays the file selection dialogue screen, with the current work 
folder as the default folder. 
Select a file from among the file names to read the script data. 

Clear Deletes all currently entered script data. 
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(6) Save the disk duplication data file as the MAC address name. 

 
 Working Mode: Online 

Save the currently setting of Linux duplication parameters. 
 

1) File menu -> click on Save As MacAddress. 
 

 
 

2) When the file save confirmation message is displayed for the disk duplication data file, 
confirm the name of the file to be saved and click on Yes. 
The file is saved with the entered MAC address name under  
<Folder for Image>\AnsFile\machininf> on the Management Server. The file name is 
MACaddress.rep. 
 



Creating a Setup Parameter File 
 

Part II Tools 
285 

 
 If this message is displayed, check the Management Server and network settings, and 

re-save after resolving any problems. 

 
 

 Working Mode: Offline 
The file is saved as the entered MAC address name under the specified directory. 
The file name is MACaddress.rep. 

 
1) When the Select Directory screen is displayed, select the directory to save the disk 

duplication data file. 
 

 
 

 The directory displayed in the selection is the currently configured directory. If the save 
destination is changed, the new destination becomes the work directory. 

 
2) When the file save confirmation message is displayed for the disk duplication data file, 

confirm the name of the file to be saved and click on Yes. 
 

 If a file with the same file name already exists in the save destination directory, the overwrite 
confirmation message is displayed. To overwrite, click Yes. If not, click No. 
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The following message is displayed when the file has successfully been saved to the selected 
destination directory. 

 

 
 

 If the following message is displayed, check whether there is a problem in the 
destination directory, and save it again. 

 
 
2. Other Operations and Displays 
 
 Opening the Disk Duplication Data File (Existing File) 
 
This Section describes how to create the disk duplication data file using an existing file. 
 
(1) Select parameter screen -> select Linux disk copy parameter file and click OK. 
 

 
 

(2) When the LinuxOS Replicate Parameter Making screen is displayed, open the File menu, 
click on Open, and select MACaddress.rep to open the file. 
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(3) The existing disk duplication data file is displayed. 

 

 
 

 Working Mode: Online 
When the Host Registration File (disk duplication data file in  
<Folder for Image>\AnsFile\machineinf on the Management Server) Selection screen is 
displayed, select the host file (the template file) and click on the Select button. 
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 Working Mode: Offline 

 
1) A list of disk duplication data files in the current work directory is displayed in the Select File 

screen. Select the disk duplication data file and click Open. 
 

 
 

 If there is an error during reading of the disk duplication data file, the following 
message is displayed. Check the disk duplication data file. 

 
 

 Changing the working mode 
The working mode can be changed as needed using the following procedure. 

 
(1) Select parameter screen -> select Linux disk copy parameter file and click OK. 
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(2) When the LinuxOS Replicate Parameter Making screen is displayed, open the Working 

Mode menu and select the Set Online or Set Offline radio button to change the working 
mode. 

 

 
 

 Displaying Replicate Parameter 
 

The parameters set during disk duplication can be displayed as a list or printed in the output format 
of the disk duplication data file. 

 
1) Open the File menu in the LinuxOS Replicate Parameter Making screen and click on 

Display Replicate Parameter. 
 
2) When the LinuxOS Replicate Parameter List screen is displayed, click on Print to print 

out the check list. 
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 If there are any problems or errors with the content set by the currently set disk 

duplication, the Duplication Parameter Error List Screen is displayed instead of the 
LinuxOS Replicate Parameter List screen. 
Check the content displayed in the error list and correct any errors in the LinuxOS 
Replicate Parameter Making screen. 

 
 

 Error Message Display Area 
 

If any problems or errors are discovered during an operation, an error message is displayed in 
red. 
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5.4.4. Batch Creation of Disk Duplication Parameter File (Linux) 
When executing disk duplication on multiple Linux managed machines, a disk duplication data file 
must be created for each machine. 
This Section describes batch creation of Linux disk duplication data files. 
 
(1) Prepare the disk duplication data file that will act as the basis for batch creation of data files. 

See "5.4.3 Creating a Disk Duplication Parameter File (Linux)" for how to create the disk 
duplication data file. 

 
(2) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 

 
(3) When you click Setting Setup Parameter File, the Select parameter screen is displayed. 

Select Linux disk copy parameter file and click OK. 
 

(4) Open the file created in Section 5.4.3, "Creating a Disk Duplication Parameter File (Linux)."  
See "2. Other Operations and Displays in Section 5.4.3, "Creating a Disk Duplication 
Parameter File (Linux)" for how to open an existing file. 

 
(5) When the Creating Linux OS Duplication Parameters screen is displayed, open the 

Replicate Parameter menu and select Make Replicate Parameter. 
 



5 Image Builder 
 

DeploymentManager Ver6.0 Reference Guide 
292 

 
(6) When the Replicate Parameter Extensive creation screen is displayed, configure the settings 

in the red box. 
The disk duplication parameter data can be set for up to 100 Linux duplication machines. Enter 
the network data for Ethernet device eth0 of the target machine for duplication. 
 

 
 

Replicate Parameter Extensive creation  

 Model Host The disk duplication data file name used in the currently read template is 
displayed. 

Host Name 
(Setting required) 

Set the host name for Ethernet device eth0. Up to 255 single-byte characters 
can be entered. 

MAC Address 
(Setting required) 

Set the MAC address of the Ethernet device. The address must be entered in 
12-digit hexadecimal number format. 
Example) 1A-2B-3C-4D-5E-6F, 1a-2b-3c-4d-5e-6f 
When a file is saved, the Linux duplicate parameter file is created and saved 
by using the entered 
MAC address. The extension is ".rep." 
Example) 1A2B3C4D5E6F.rep or, 1a2b3c4d5e6f.rep 

DHCP(0:ON) Select and set the type of TCP/IP network for Ethernet device eth0 from below. 
・ D H C P: Enter 0 to have the DHCP server set the IP address 

dynamically. (Setting required) 
・ Fixed IP: Do not enter anything to have the IP address set manually. 

IP Address Set the IP address for Ethernet device eth0. 
Example) 192.168.0.11, or 92.168.100.150. etc. 
This must be set if the network type is Fixed IP. 

Network mask Set the network mask for the IP address of Ethernet device eth0. 
Example) 255.255.0.0, 255.255.255.0, etc. 
This must be set if the network type is Fixed IP. 

Gateway Enter the IP address of the gateway machine that corresponds to the IP 
address of Ethernet device eth0. 
Example) 192.168.0.250, 192.168.100.200, etc. 
This does not need to be set, whether the network type is DHCP or Fixed IP, it 
is an optional input item. 

DNS Address Enter the IP address of the primary DNS that corresponds to the IP address of 
the Ethernet device. 
Example) 192.168.0.250, 192.168.100.200, etc. 
This does not need to be set, whether the network type is DHCP or Fixed IP. 
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(7) Click on the Save button and save the settings. See the following table for operations of the 

various buttons outlined in red. 
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Replicate Parameter Extensive creation  
 Clear Clears all the content entered in the current screen. 

Read Reads duplication parameter data saved in CSV file format and places it in the 
entry fields for Replicate Parameter Extensive creation. The file selection 
dialogue screen is displayed, with the CSV directory in the currently set work 
directory as the default directory. 
Select the file name and click on Open. 

Check Performs a prior check of the conformance of the disk duplication data file that is 
currently input. 
If there are no problems or errors, the following message dialogue screen is 
displayed. 

 
Save Saves the disk duplication parameter data in CSV file format.  

It is saved to the CSV directory in the currently set work folder. 
The default is <installation folder>\linux\offline\CSV. 
Clicking Save brings up the Save as…" dialogue box. Enter the file name and 
save the file. 

 Extensive Creation This performs an extensive creation of disk duplication data files in accordance 
with the currently input extensive creation duplication parameter data. 
If extensive creation is completed successfully, the Replicate Parameter 
Creation result list screen is displayed. (*1) 

 
Exit Closes the currently displayed Replicate Parameter Extensive creation screen 

and terminates batch creation of duplication parameters. 
To end, click on Yes. Otherwise, click on No. 
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*1 
 Working Mode: Online 

The file is saved with the entered MAC address name under <Folder for 
Image>\AnsFile\machininf> on the Management Server. 

 Working Mode: Offline 
The file is saved with the entered MAC address in the current work directory. 
The file name is MACaddress.rep. 

 
  If there are problems with the settings, the Replicate Parameter Error list is displayed 

instead of the Replicate Parameter Extensive creation screen. Check the content that 
is displayed in the error list, and correct any errors in the Replicate Parameter Extensive 
creation screen. 

 If there is a problem in any of the duplication parameters, the Replicate Parameter 
Error list Screen is displayed, and no files are created. Check the parameters, resolve 
any problems, and reattempt creation. 
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Other Operations and Displays 
 
 Linux OS Duplication Parameter Settings Data 
The data for the Linux OS duplication parameter settings is confirmed as follows. 
 
(1) From the Help menu in the LinuxOS Replicate Parameter Making screen, select Version. 

This displays the LinuxOS Replicate Parameter Making Info screen. 
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5.4.5. Creating a Parameter File for an OS Clear Installation 

(Linux) 
A Linux installation parameter file is a file that stores all of the items required during Linux installation 
setup in advance, enabling unattended OS installation. This Section describes how to create a Linux 
installation parameter file. 
 

  This file must be configured when you install Linux. 
 For a Linux installation parameter file that was created with a version prior to DPM Ver4.21, 

be sure to read the Linux installation parameter file using this version and overwrite it. 
• See "Other Operations and Displays" in this Section regarding reading a saved file. 
• See "Overwrite of the Linux installation parameter file" in this Section regarding overwrite 

saving. 
 The root password is "deploymgr" that is set with the Linux install parameter setting tool. 

Use the following method if you want to change the password. 
(1) If the password is not encrypted: 

Change the "rootpw" line of the Linux installation parameter file (cfg file) saved below. 
<Folder for Image>:\exports\ks 

Example) rootpw –iscrypted  **********.. (encrypted password) 
 

rootpw deploy 
(2) If the password is encrypted: 

Set the password with the Linux standard kickstart file creation tool and create a 
kickstart parameter file. 
Copy the "rootpw" line from the created kickstart parameter file to the "rootpw" line of 
Linux installation parameter file (cfg file) that created using the Linux install parameter 
setting tool and had been saved in below. 
<Folder for Image>:\exports\ks 

Example) rootpw –iscrypted  **********… (encrypted password) 
 

rootpw --iscrypted  XXXXXXXXXX... (encrypted password) 
 

  The Linux installation parameter file creation has two operating modes: online mode and 
offline mode. 
• Online mode: typically used mode. 
• Offline mode: Used for setting up the NFS shared folder (exports) in locations other than 

Folder for Image\exports. 
This Section mainly describes online mode which is usually used. 

 For notes when installing the NFS server on another computer other than the Management 
Server, see Section 3.5.6, "Precautions/Other" in the Operation Guide. 

 
  To create multiple Linux installation parameter files, see Section 5.4.6, "Batch Creation of 

Parameter File for OS Clear Installation (Linux)"  
 You can change the working mode and the work directory as needed. 
 The keyboard operations which are effective with buttons of Linux installation parameter file 

creation tool are the Enter key and the Space bar only. 
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 Online Mode 

The Linux installation parameter file is created and managed over the network in the Folder for 
Images on the Management Server. 

 
 The Linux installation parameter file is comprised of and managed by two files. 

• The Linux boot parameter file (no file extension) Example) nec_host  
• The Linux setup parameter file (extension ".cfg")  Example) nec_host.cfg  
The root password is output to the file as "deploymgr". 

 

 
 
 Offline Mode 
The Linux parameter file is created and managed on the machine on which Image Builder is launched, 
using any work directory. 
 

 
 
 

Temporary folder:install folder \linux\online 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) 

Read file and save 

Managed directory 
:<image storage folder>\AnsFile\ linux(Linux boot parameter file) 
:<Image Storage Folder>:\exports\ks(Linux setup parameter file) 

Image Builder 
Machine(Remote Console) 

Receive file Send file 

Saved Linux install parameter file 

Working Linux installation parameter file 

Managed folder:Optional working folder 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) Image Builder 

Machine(Remote Console) 

Saved Linux installation parameter 
file 

Read file and save 
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 Initial settings for the creation of a Linux installation parameter file  
 
(1) From the Start menu of the Management Server or the computer where Image Builder 

(Remote Console) is installed, select All Programs -> DeploymentManager -> Image Builder 
and launch Image Builder. 

 
(2) Select Setting setup parameter file. 

The Select parameter screen is displayed. Select Linux parameter file and click on the OK 
button. 

 

 
 

(3) The LinuxOS Install Environment Set Screen is displayed. Please set it to match the 
environment you are using. 
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LinuxOS Install Environment Set 
 Install Directory Displays the directory where Image Builder has been installed. 

This cannot be edited. 
Work Directory Displays the work directory for offline mode. This can only be entered if 

the selected working mode is offline mode. 
The number of characters allowed is 1-254 single byte characters. Only 
single-byte alphanumeric characters can be used. 
The following symbols cannot be used. 
, ; * ? " ' < > | [ ] @ 
Default is  
"C:\Program Files\NEC\DeploymentManager\linux\offline" 

Select Working Mode Select one of the following working mode. 
- Online mode 
- Offline mode 
The default is Online Mode. 

Management Server The IP address of the Management Server that was set during 
installation of Image Builder is acquired from the registry data and 
displayed here. 

"ks" Server Directory Displays the directory name on the Management Server where the 
Linux setup parameter file is to be saved when in online mode. 
This cannot be edited. 

 "syslinux" Server 
Directory 

Displays the directory name on the Management Server where the 
Linux boot parameter file is to be saved when in online mode. 
This cannot be edited. 

CANCEL This discards changes and closes the environment settings screen. 
SAVE Saves the settings to the environment settings file LinuxSysRep.cfg and 

closes the environment settings screen. 
 

(4) Once the setting is completed, click on Save. 
 

(5) Click on Yes, and save the settings. 
 

 If there is an error in the settings, an error message is displayed in red font and saving 
cannot be performed. Correct the settings and re-save. 
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 Linux installation parameter file creation 
 

(1) Once the initial startup time settings are completed, the LinuxOS Install Parameter Making 
runs and the main initial screen below is shown. 

 

 



5 Image Builder 
 

DeploymentManager Ver6.0 Reference Guide 
302 

 
 If the configuration data file "LinuxIParm.cfg" is not saved under the install directory, the 

LinuxOS Install Environment Set screen is displayed. See the previous Initial settings 
for the creation of a Linux installation parameter file regarding the LinuxOS Install 
Environment Set screen. 

 
If you cannot obtain the install directory or environment information of the Management 
Server IP address normally, it will end without running the Linux install parameter setting 
tool. 

 
(2) The Linux install parameter is set. 

The Linux install parameters are configured from the following nine types of information 
panels. 

 
Click on each button, then the information panel will change and each item can be set. 

 
 If there are any problems or errors with the information entered into each of the information 

panels, a red error message will be displayed at the bottom of each information panel. 
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 Basic Configuration setting panel  

Set the basic information for the Linux boot parameters and Linux setup parameters. 
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LinuxOS Install Parameter Making 
 Basic Configuration  

(Setting required)  
 Install Linux  

(Setting required)  
Select Linux OS as the type to install from the list box. 
The default is "Red Hat Enterprise Linux ES 3."  
If the boot directory is not entered at the time the install OS is 
selected, the default value of the boot directory appropriate for 
the selected OS will be set as the boot directory. (*1) 

Boot Directory  
(Setting required)  

Select the boot directory or enter the boot directory for the Linux 
OS to install. The number of characters allowed is 1 - 255 
single-byte characters. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank spaces cannot be used. 
, ; * ? " ' < > | [ ] @ 
When you click on the "…" button, the Select Boot Directory 
screen will be displayed. Then select it from boot directory list 
on the Management Server 

 
In the case of offline, you cannot use the Select Boot Directory 
Selection screen, so you must enter and set the boot directory 
name. 

NFS Server  
(Setting required)  

The NFS server IP address is set. Normally this is set as the 
same IP address as the DPM Server. 
The default value is the IP address of the Management Server. 

Install Device  
(Setting required)  

Set the Ethernet device (the normally used install device). 
The default value is eth0. 
If you set a LAN board with a MAC address not registered with 
the Management Server, the scenario may not complete. 

Installation Number  Displays when "Red Hat Enterprise Linux 5.1/5.1 AP" is 
selected as the install OS. 
Please enter the install number of the Red Hat Enterprise Linux 
at the time of the product purchase. 
This entry is not required. 

Install Language  
(Setting required)  

Select the type of language used at the time of installation from 
the list. 
The default value is English. 

Keyboard  
(Setting required)  

Select the type of keyboard used by the managed machine for 
the install from the list. 
The default value is U.S.English. 
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Mouse  
(Setting required)  

Select the type of mouse used by the managed machine for the 
install from the list. 
The default value is Generic Mouse (PS/2). 
If the mouse is not set correctly after an OS clean installation, 
assign "Probe For Mouse" to the mouse and automatically 
search for the mouse. 
This item won't be displayed for Red Hat Enterprise Linux 6. 

3 Button Emulation  If the mouse device uses a 3 button emulation function, enter a 
check in this checkbox. 
By default, the checkbox is not checked. 
This need not be configured. 
This item won't be displayed for Red Hat Enterprise Linux 6. 

Time Zone Select the time zone from the list box. The default value is 
America/New_York. This entry is not required. 

Support Language  
(Setting required)  

Set the language environment from the list. 
To select multiple items, press the Ctrl key while selecting. 
The default value is English. You cannot deselect English. 
In the case of Red Hat Enterprise Linux 5/5AP, all languages 
will be set regardless of the selected content. 

*1 
You can select the install OS from the Linux OSs below from the list. 

 
Install OS  Boot Directory Default Value  Supported Architecture  

Red Hat Enterprise Linux AS 3 RedHatAS3 IA32 
Red Hat Enterprise Linux ES 3 RedHatES3 IA32 
Red Hat Enterprise Linux AS 4 RedHatAS4 IA32/EM64T 
Red Hat Enterprise Linux ES 4 RedHatES4 IA32/EM64T 
Red Hat Enterprise Linux 5.1/5.1 AP RedHatServer5.1 IA32/EM64T 
Red Hat Enterprise Linux 6 RedHatServer6 IA32/EM64T 

 
 Select Red Hat Enterprise Linux 5.1/5.1 AP if the install OS is Red Hat Enterprise Linux 

5.2~5.6/5.2 AP~5.6 AP. 
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 Boot Configuration  

You can do settings related to the boot loader for the managed machine to install. 
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Boot Configuration(required)  
  
 A new boot loader is 

installed  
Select this to install a new boot loader. 
If you select A new boot is installed, the Boot Loader Options will 
be enabled. 
The default value is A new boot is installed. 

 A boot loader is not installed  Select this to not install a boot loader. 
If installing Linux and A boot loader is not installed is selected, the 
scenario will complete successfully, but you cannot run Linux from the 
partition where Linux was installed. 

 Boot Loader Options  Select boot loader option and a new boot loader will be installed. 

 GRUB is used as a boot 
loader  

Set this to install the GRUB boot loader. 
This need not be configured. 
The LILO package will be cancelled for Red Hat Enterprise Linux 
AS4, ES4, and 5/5AP. Select Use GRUB as a Boot Loader when 
installing Red Hat Enterprise Linux AS4, ES4, 5/5AP. 
This need not be configured. 

 GRUB Option  
GRUB Password  

This can be set when selecting GRUB is used as a boot loader. 
This need not be configured. 

LILO is used as a boot 
 loader  

Set this to install the LILO boot loader. 
The default value is set as LILO is used as a boot loader. 
This item cannot be set for Red Hat Enterprise Linux 6. 

 LILO Option Set the working mode for LILO boot loader. 
Enter a check in one of the checkboxes below. 
• Use linear mode 
• Force use LBA32 mode 
This need not be configured. 

A boot loader is installed 
 in a master boot record 
 (MBR) / A boot loader is 
 Installed on the head 
 Sector of a boot partition 
 (You must select one)  

Set the install destination for the boot loader. 
Select one of the following radio buttons. 
• A boot loader is installed in a master boot record (MBR) 
• A Boot loader is installed on the head sector of a boot partition 
Select A boot loader is installed in a master boot record (MBR) 
when performing backup/restore on the disk with boot loader 
installed. 
This item cannot be set for Red Hat Enterprise Linux 6. 

Kernel Parameter  Set the kernel parameters. 
The number of characters allowed is 1 - 255 single-byte characters. 
The allowed characters are single-byte alphabet and numeric 
characters. This need not be configured. 
This item cannot be set for Red Hat Enterprise Linux 6. 
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 Partition Configuration   

Set the environment used for the disk drive of the managed machine for install. 
 

 
 

 You cannot set software RAID with this tool. 
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Partition Configuration 
(Setting required) 

 Master Boot Record 
(Setting required) 

Set the master boot record handling. 
Select one of the following radio buttons. 
• Clear the current master boot record 
• Do not delete the current master boot record 

Partitions 
(Setting required) 

Set the partition handling. 
Select one of the following radio buttons. 
• Remove all of the current existing partitions 
• Remove only the existing Linux partitions 
• Keep the existing partitions 

Disk Label Set 
(Setting required) 

Set the disk level handling. 
Select one of the following radio buttons. 
• Initialize the disk label 
• Do not initialize the disk label 

Add Set the new disk partition information at the time of install. 
Click on the Add button when adding a disk partition. The Partition 
Information Settings screen appears when you click the Add button. 

 
 Mount Point  Select the partition mount directory from the list box or enter it. Only 

single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
, ; * ? " ' < > | [ ] @ 
You cannot select this if the file system type is swap. 
It must be selected if the file system type is other than swap. 

File System Type  
(Setting required)  

Select the file system type from the list box. 
The default value is ext3 type. 

File System Size (MB)  Set the capacity of the partition to create. Enter the units in MB. The 
default value is 1 MB. 
Setting is required when Fixed size is selected Additional Size 
Options. 

Additional Size 
Options 
(Must be entered if 
selectable)  

Set regarding the capacity of the partition. 
Select one of the following radio buttons. 
• Fixed size 
• Fill all space up to (MB) 
• Fill to maximum allowable size 
If you select Fill all space up to (MB), enter the increase in capacity 
in MB. 
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The swapfile size of 
 recommendation is 
 used  

If you select "swap" in the file system type you can enter a check in 
the checkbox. 
If you enter a check, the swap files system capacity will be 
automatically set at the time of install. 

Force to be a primary 
partition 

The partition is forcibly allocated as the primary partition. It will end 
abnormally when this cannot be executed.  
This need not be configured. 

Make partition on 

 
 drive 
(Setting required)  

Create a new partition. 
Enter the disk drive name to add a partition. The allowed characters 
are single-byte alphabet and numeric characters. 
For an IDE disk, set the first as hda and the second as hdb. For a 
SCSI disk, set the first one as sda. 

Use existing partition  
Set the existing partition name. 
Following the partition setting details, the partition is set up on the 
existing partition. 
For the first partition of the primary IDE disk, hda1 should be 
specified, and for the second partition of the secondary IDE disk, 
hdb2 should be specified. Also, for the first partition of the first SCSI 
disk, sda1 should be specified.  

Format partition  Format a partition. 
The default value is Format partition. 

 CANCEL Closes the screen without saving the specified partition information. 
SAVE Closes the screen and save the specified partition information. 

If there is a problem or error with the specified partition's information, 
the error list is displayed and it cannot be saved. 
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Edit Edit the disk partition. 
Select the partition to be edited from the list and click on the Edit 
button. 

 
Partition Information screen appears when you click the Edit button. 

 

 Delete 
Deletes the currently specified disk partition. 
Select the partition to be deleted from the partition list and click on the 
Delete button. 
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 If installing on a machine with multiple disks and you do not specify the drive for install, 

the installer will automatically assign which disk is installed on. Please set the 
installation drive with Create Partition on Specified Drive specifying the install disk. 

 
 Network Configuration 

Set the network information. Set the LAN board specified for the install device in the Basic 
Configuration panel. 
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Network Configuration 
 Host Name Enter the managed machine host name. Up to 255 single-byte 

characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank spaces cannot be used. 
\ / : , ; * ? " < > ' | [ ] @  

Network Type Select and set the type of TCP/IP network from below. 
- DHCP: IP addresses are set dynamically by a DHCP server. 
- Static IP: IP addresses are set manually. 
The default value is DHCP. 

IP Address  Enter the IP address. 
This must be entered only if Static IP has been selected as the network 
type. 

Network Mask Enter the netmask. 
This must be entered only if Static IP has been selected as the network 
type. 

Gateway Enter the IP address of the gateway machine that corresponds to the IP 
address of the Ethernet device being configured. 
This does not need to be entered, even if either DHCP or Static IP has 
been selected as the network type. 

Name Server  Enter the IP address for the DNS server. 
This does not need to be entered, even if either DHCP or Static IP has 
been selected as the network type. 

 
 For a LAN board having a MAC address that is registered to the DPM, configure the 

settings so that network communication is possible, whether the address is acquired from a 
fixed IP address or the DHCP server. If network communication is impossible, an executed 
scenario might not be completed. 
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 Authentication Set 

Set the information for each authentication function used on the managed machine for install. 
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Authentication Set 
 Authentication Select the user authentication method. 

• Use Shadow Password 
Enter a check to Use Shadow Password for the user 
password. 

• Use MD5. 
Enter a check to Use MD5 encryption for the user 
password. 
In the case of Red Hat Enterprise Linux 5/5AP, enter a 
check in Use Shadow Password. 

NIS Configuration Enter a check in the Enable NIS checkbox in the case of 
NIS (Network Information Service) authentication. 

 NIS Domain  
(Setting required) 

Set the NIS domain name. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

Use broadcast to find NIS 
 Server  
(Setting required) 

Enter a check in the checkbox to use broadcast for NIS 
server search. 

NIS Server  
(Setting required) Enter the NIS server name. 

Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
, ; * ? " ' < > | [ ] @ = 

LDAP Configuration 
Enter a check in the Enable LDAP checkbox in the case of 
LDAP (Lightweight Directory Access Protocol). 

 LDAP Server  
(Setting required) 

Set the LDAP server name. 
Only 32 single-byte characters can be entered. 
Only single-byte characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

LDAP Database  
(Setting required) 

Set the LDAP database name. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

Kerberos 5 Configuration Enter a check in the Enable Kerberos 5 CCoonnffiigguurraattiioonn 
checkbox in the case of Kerberos 5 Configuration. 

 Realm (Setting required)  Set the realm name. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used.  
\ / : , ; * ? " < > ' | [ ] @ = 

Domain Controller (KDC) 
(Setting required) 

Set the domain controller (KDC) name. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 
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Master Server  
(Setting required)  Set the master server name. 

Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 
You must specify the KDC name where kadmind is running 
on the KDC belonging to the specified realm. This master 
server will become the KDC server that handles the 
changes in the user information and so forth. 

HESIOD Configuration Enter a check in the Enable HESIOD checkbox in the case 
of HESIOD authentication. 
HESIOD authentication manages the user and group 
information by using DNS. 

 HESIOD LHS 
(Setting required) 

HESIOD LHS (Left-hand side) is set to the LHS that is used 
at the time of the search for the user information and so 
forth. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space characters cannot be 
used. 
\ / : , ; * ? " < > ' | [ ] @ = 

HESIOD RHS 
(Setting required) 

HESIOD RHS (Right-hand side) is set to the RHS that is 
used at the time of the search for the user information and 
so forth. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

SMB Configuration Enter a check in Enable SMB checkbox in the case of SMB 
authentication. 

 SMB Server  
(Setting required) 

Set the SMB server name. 
If there are multiple SMB servers, enter the server names, 
separated by commas. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

SMB Work Group  
(Setting required) 

Set the SMB workgroup. 
Only 32 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / : , ; * ? " < > ' | [ ] @ = 

NSCD Configuration Enter a check in the checkbox for NSCD authentication. 
You can cache the information of user and group and so 
forth if you enter a check in Enable Name Switch Cash 
Domain (nscd) checkbox. 



Creating a Setup Parameter File 
 

Part II Tools 
317 

 
 Firewall Configuration 

This set the firewall environment information of the managed machine for install.  
This information cannot be set for Red Hat Enterprise Linux 6. 
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Firewall Configuration 
 Security Level  

(Setting required)  
Set the level of the firewall. 
Select one of the following radio buttons. 
• High 
• Medium 
• Disabled 
The default value is Medium. 
Select Security Level as Enabled or Disabled with Red Hat 
Enterprise Linux 5/5AP. 
Security Level is automatically set as Disabled with Red Hat 
Enterprise Linux 6. 
The followings are applied for Red Hat Enterprise Linux 3/4 
versions. 
• High, Medium -> firewall is set 
• Disabled     -> firewall is not set 

Customize Select the firewall rules to set. 
Select one of the following radio buttons. 
• Use default firewall rules 
• Customize 

If you select Customize the Firewall Rules, enter a check in 
the checkbox for the following required setting items. 

• Trusted devices 
• eth0 

Setting of the firewall in the selected Trusted devices -> 
eth0 is not done. 

• Allow incoming 
• FTP 
• SSH 
• DHCP 
• Mail (SMTP) 
• Telnet 

Select the communication protocols with authorization to 
communicate through the firewall. You can make multiple 
selections. 
In the case of Red Hat Enterprise Linux 5/5AP, SSH will always 
be authorized regardless of the selected content. 

 Other Ports (1029:tcp)  Select the communication protocols and ports with 
authorization to communicate through the firewall. 
Up to 255 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ / ; - * ? " < > ' | [ ] @ 
Example) 1029:tcp,1040:udp  

 
 Perform the following settings when installing Linux using DPM. If they are not set, you 

cannot perform remote update and remote shutdown from DPM. 
• Red Hat Enterprise Linux 3 update2 and earlier  
Please set the Security Level to a Disabled level. 
Open the following ports when setting the firewall after install. 

56000:tcp, 56010:tcp, 56001:udp 
• Red Hat Enterprise Linux 3 update3 and earlier  
If the Security Level is set to High or Medium level, select Customize and add the 
following Other Ports. 

56000:tcp, 56010:tcp, 56001:udp  
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 X-Window Configuration 

This set the X Window environment information of the managed machine for install. 
This information cannot be set for Red Hat Enterprise Linux 6. 
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X-Window Configuration  
 Configure the X Window 

System  
Set the X Window System. 
If you enter a check in the checkbox, X Window System will be 
forcibly selected in the install package. 
Also, you can select or enter the advanced setting items for X 
Window. 

 Color Depth  
(Setting required)  

Set the color depth. Select this from the list. 
The default value is 8. 
In the case of Red Hat Enterprise Linux 5/5AP, it will be 
automatically set regardless of the selected content. 

Resolution  
(Setting required)  

Set the resolution. Select this from the list box. 
The default value is 640x480. 

Default Desktop  
(Setting required)  

Set the desktop environment. 
Select one of the following radio buttons. The default value is KDE. 
• GNOME 
• KDE 
In the case of Red Hat Enterprise Linux 5.1~5.4, 5.1 AP~5.4AP, it 
will be automatically set regardless of the selected content. 
Enter a check in the Start the X Windows system on boot to start 
X Window when the system starts. 

Select a Video Card  
 

Set the video card. 
Enter a check in Probe for video card checkbox to set it 
automatically. 
Select it from the list to set it manually. 

Select Monitor  Probe the monitor. 
Enter a check in the Probe for monitor checkbox to set it 
automatically. 
Select it from the list to set it manually. 



Creating a Setup Parameter File 
 

Part II Tools 
321 

 
 
 Package Group Selection 

Set the information for each software package to install on the managed machine. 
This information cannot be set for Red Hat Enterprise Linux 6. 

 

 
 

Package Group Selection 
 The package Install Method Set the install method for the packages to be installed. 

Select one of the following radio buttons. 
• A package dependency is solved automatically 
• A package dependency is disregarded 

Install package group Set the package group to install during the installation. Select this 
from the list. You can make multiple selections. 
The content of the list will change based on the Install Linux in 
the basic configuration panel. 

 
 If the managed machine is an x64 edition, /lib/libgcc_s.so.1 is required. 

If /lib/libgcc_s.so.1 does not exist, multicast remote updates will not be possible. Please 
install /lib/libgcc_s.so.1 by one of the following methods. 
1) Select the "Compatibility Arch Support" package when doing an OS clear install. 
2) Install libgcc-3.4.5-2.i386.rpm by unicast using a remote update after the OS clear install. 
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 Script Set 

Set the shell script to run after the managed machine installation has completed. 
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Script Set  
 Run outside of the chroot 

environment  
Run outside the chroot environment. 
Scripts normally run in the chroot environment. Enter a check in the 
Run Outside the chroot Environment checkbox to run outside the 
chroot environment. 

Use an interpreter  Set the interpreter file name to use. 
Enter the interpreter file name to use when using an interpreter 
other than the default shell interpreter. 
Up to 255 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 
The following symbols or blank space cannot be used. 
\ : , ; * ? " < > ' | [ ] @ 
Example) /usr/bin/python 

Input %post Script  
(Text box) 

Set the Linux shell script you want to run after the installation is 
completed. You can enter scripts with up to 320 single-byte 
characters per line and a maximum of 600 lines. 
An error will occur if the script that is read in includes a line with 
more than 320 characters, and the post script won't be read in. 
If there is a line that exceeds 320 characters, correct it so that the 
character count for a line does not exceed 320 characters by 
starting a new paragraph by inserting a "\" at the position to start a 
new paragraph. 
Example) 

A modification example is shown below. ("XXXX---YYY" is a line 
in a script.)  

 
   Before modification -------------------------------------------------------- 
        : 
    XXXXXXXXXXXXXXXXXXXXXXXXXZZZZZZZZZZZZZZZ 
        : 
    ------------------------------------------------------------- 
   After modification -------------------------------------------------------- 
        : 
    XXXXXXXXXXXXXXXXXXXXXXXXX \ 
    ZZZZZZZZZZZZZZZ 
        : 
    ------------------------------------------------------------- 

READ The file is read in as script information. 
The file selection screen is displayed with the current working 
directory as the initial directory. Then open a file. 
When the file is read in, scripts for introduction and setup of DPM 
Client software are automatically configured. 
When a file is read in, the file cannot be read in if the number of 
lines in the combination of complete input content and the file 
content exceeds 600 or if any line exceeds 320 characters. 

CLEAR Deletes all currently entered script data. 

 
(3) The Linux install parameter is saved. 

 
LinuxOS Install Parameter Making 
 
 
 

SAVE The detail settings of the install parameter are saved as the Linux 
installation parameter file and it closes. 

EXIT Closes without saving the detail settings of the install parameter. 
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 Working Mode: Online 
The file is transmitted from the temporary working directory to management directory. 
The default folder is as follows: 

<Folder for Image>\AnsFile\linux (Linux boot parameter file) 
<Folder for Image>\exports\ks (Linux setup parameter file) 

 

 
 

 Working Mode: Offline 
The folder that was specified in work directory is shown, so specify the File Name and save. 
The default folder is as follows: 
C:\Program Files\NEC\DeploymentManager\linux\offline 
 

 
 
The following screen will be displayed if it saves normally. 
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Other Operations and Displays 
 
 Read an existing Linux installation parameter file  

In the File menu, select Open. 
 
 Working Mode: Online 

 
(1) The Linux setup parameter file list that exists under the "Folder for Image \exports\ks" 

directory on the Management Server is displayed. 
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(2) If you double click on the target Linux setup parameter file or select the Linux setup 

parameter file and click on SELECT, the screen with the Linux setup parameter file read in 
will be displayed. 
 

 
 

 The error may be displayed if you select an install parameter file for a version of Linux 
OS that is not supported by this version. See Appendix A, "Support Tables Support for 
Managed Machine OS's" in the First Step Guide for details on supported OSs. 

 
 If some error occurs when the Linux installation parameter file is read, then the 

following message is displayed. Check the contents of the Linux setup parameter file 
and Linux boot parameter file. 
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 Working Mode: Offline 

 
(1) A list of the Linux setup parameter files in the current working directory is displayed. 

 

 
 

(2) If you double click on the target Linux setup parameter file or select the Linux setup 
parameter file and click on Open, the screen with the Linux setup parameter file read in will 
be displayed. 
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 The error may be displayed if you select an install parameter file for a version of 
Linux OS that is not supported by this version. See Appendix A, "Support Tables 
Support for Managed Machine OS's" in the First Step Guide for details on 
supported OSs. 

 
 If some error occurs when the Linux installation parameter file is read, then the 

following message is displayed. Check the contents of the Linux setup parameter 
file and Linux boot parameter file. 

 
 
 Overwrite of the Linux installation parameter file 

The content of the currently displayed Linux installation parameter are overwritten and saved to 
the original file. 
In the File menu, select Overwrite. 

 
 Working Mode: Online 

The following file will be overwritten by the settings of the Linux installation parameter file. 
• Linux boot parameter file: <Folder for Image>\AnsFile\Linux on the Management Server 
• Linux setup parameter file: <Folder for Image>\exports\ks on the Management Server 

 
The following message is displayed when the file has successfully been saved to the 
Management Server. 

 

 
 

 The following message will be displayed if there is any problem in saving the file to 
the Management Server, so please try to save again after resolving the problems 
with the Management Server or on the network, etc. 
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 Working Mode: Offline 

The settings will be overwritten by the settings of the Linux install parameter under the currently 
specified working directory. 

 
The following message is displayed when the file has successfully been saved in the working 
directory. 

 

 
 

 The following message will be displayed if there is any problem in saving the file to 
working directory, so please try to save again after resolving the problems with the 
working directory that is the save destination or on the network, etc. 
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 Saves the Linux installation parameter file with the name 

The contents of the currently specified Linux installation parameter will be newly saved with the 
specified name. 
In the File menu, select Save As New Name. 

 
 Working Mode: Online 

A list of the files that exist in the <Folder for Image>\exports\ks on the Management Server are 
displayed in the Host Name List screen. Enter the Save File Name and click on SELECT. 

 

 
 

• Linux boot parameter file:  
Saved with the file name entered without the extension in the <Folder for 
Image>\AnsFile\Linux on the Management Server. 

• Linux setup parameter file: 
Saved with the file name entered with the extension ".cfg" in the <Folder for 
Image>\exports\ks on the Management Server. 

 
The following message is displayed when the file has successfully been saved to the 
Management Server. 

 

 
 

 The following message will be displayed if there is any problem in saving the file to 
the Management Server, so please try to save again after resolving the problems 
with the Management Server or on the network, etc. 
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 Working Mode: Offline 

A list of the files that are in the currently set working directory is displayed in the Select File 
screen. 
Enter the File Name and click on Save. 

 

 
 

• Linux boot parameter file: 
In the selected directory with the file name entered without an extension. 

• Linux setup parameter file: 
In the selected directory with the file name entered with the extension ".cfg". 

 
 The directory displayed at the time of selection will be the directory that is currently set. 

If the save destination directory is changed, change that directory to the working directory. 
 

The following message is displayed when the file has successfully been saved in the working directory. 
 

 
 
  The following message will be displayed if there is any problem in saving the file to working 

directory, so please try to save again after resolving the problems with the working 
directory that is the save destination, etc. 

 
 If a file with the same file name already exists in the save destination directory, the 

following screen is displayed. To overwrite, click Yes. If not, click No. 
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 Change working mode  

You can change the current working mode. 
 

(1) From the Start menu of the Management Server or the computer where Image Builder 
(Remote Console) is installed, click on All Programs -> DeploymentManager -> Image 
Builder and launch Image Builder. 
 

(2) Select Setting Setup Parameter File. 
 

(3) The Select parameter screen is displayed. Select Linux parameter file and click on the OK 
button. 
 

(4) When the LinuxOS Install Parameter Making screen is displayed, open the Working Mode 
menu and select the Set Online or Set Offline radio button to change the working mode. 
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 Closing the install parameter setting tool 
 
(1) In the File menu, click Exit. 
 
(2) The LinuxOS Install Parameter Making close confirmation screen is displayed, then click on 

Yes to close and No to not close. 
If you close, all of the screens will close and the Linux install setting tool will close. 
The EXIT button on the lower left of the main screen will also close the install parameter setting 
tool. 

 

 
 
 Displaying Settings Data 
 
(1) In the File menu, click Display Install Parameter. 
 
(2) The currently set install parameter details will be displayed in a list in the Linux install parameter 

output format. The currently set Linux install parameter details are displayed. 
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LinuxOS Install Parameter List  
 PRINT  Prints the details of LinuxOS Install Parameter List. 

CLOSE Closes the currently displayed Install Setting Parameter Screen. 

 
 The Install Parameter Error List screen from the previous item will be displayed if there 

is a problem or error with the details of the currently set Linux install parameters. Correct 
any items displayed in the error list. 

 
 
 Linux installation parameter file creation tool information  

The Linux OS install parameter setting information is confirmed with the following steps. 
 

(1) On the LinuxOS Install Parameter Making screen, click on the Help menu -> Version 
and the Linux Install Parameter Making screen will be displayed. 

 
(2) Check the information. 
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5.4.6. Batch Creation of Parameter File for OS Clear Installation 

(Linux) 
This Section describes an explanation of the method for creating the multiple Linux installation 
parameter files. 
 
(1) Prepare the template Linux installation parameter file that will be the base for multiple Linux 

installation parameter files. 
 
 Please do not use a Linux installation parameter file that is not supported by this version. 

See Appendix A, "Support Tables Support for Managed Machine OS's" in the First Step 
Guide for supported OSs. 

 
 See Section 5.4.5, "Creating a Parameter File for OS Clear Installation (Linux)" in the 

Reference Guide for the method for creating a Linux installation parameter file. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
 
(3) Image Builder runs, then click on Setting setup parameter file. 
 
(4) The Select parameter screen is displayed. Select Linux parameter file and click on the OK 

button. 
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When first launching or if the environment configuration data file LinuxIParm.cfg is not in the 
install directory, the LinuxOS Install Environment Set screen is displayed. Configure the 
settings to match your environment. 
 

 
 

Install Directory Displays the directory where Image Builder has been installed.  
Default is "C:\Program Files\NEC\DeploymentManager". 

Work Directory You can change the work directory location for Offline mode. 
This can only be input when Offline mode is selected as the 
working mode. 
Default is  
"C:\Program Files\NEC\DeploymentManager\linux\offline" 
The characters that can be entered are single-byte alphanumeric 
characters. 
The following symbols cannot be used. 
, ; * ? " ' < > | [ ] @  

Select Working Mode  The working mode can be set to Online mode or Offline mode. 
The default is Online Mode. 

 Management Server The Management Server IP address is required. 
 [ks] Server Directory Displays the directory name on the Management Server where 

the Linux setup parameter file is to be saved when in online 
mode. This is fixed value and cannot be edited. 

[syslinux] Server Directory Displays the directory name on the Management Server where 
the Linux boot parameter file is to be saved when in online mode. 
This is fixed value and cannot be edited. 

CANCEL Discards changes and closes the environment settings screen. 
The confirmation message for canceling is displayed, then click 
Yes or No. 

SAVE Saves the settings to the environment settings file 
LinuxIParm.cfg and closes the environment set screen. 
The confirmation message for saving is displayed, then click Yes 
or No. 
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(5) The LinuxOS Install Parameter Making will open. Then select Open from File menu. Selete a 

setup parameter file on the Host Name List screen and click on SELECT. 
 

 
 

(6) The Setup Parameter File will be read, then click on Install Parameter -> Make Install 
Parameter. 
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(7) The details of the currently set Linux installation parameter file are checked, and the Install 

Parameter Extensive creation screen is displayed. Then enter the Ethernet device eth0 
network information for the target machine for the Linux install. 

 

 
 

Install Parameter Extensive creation  

 Model Host The name of the currently loaded Linux installation parameter file 
used for the template is displayed and configured. 

Host Name 
(Setting required) 

Set the host name for Ethernet device eth0. The number of characters 
that can be entered is 255 single-bytes characters. 

DHCP(0:ON) Select and set the type of TCP/IP network for Ethernet device eth0 
from below. 
- DHCP: Enter 0 if the IP address is set dynamically with DHCP 
server. (Setting required)  

- Fixed IP: Do not enter anything if the IP address is set manually. 
IP Address Set the IP address for Ethernet device eth0. 

This must be set if the network type is Fixed IP. 
Network Mask Set the netmask value for the IP address of Ethernet device eth0. This 

must be set if the network type is Fixed IP. 
Gateway Enter the IP address of the gateway machine that corresponds to the 

IP address of Ethernet device eth0. This does not need to be set, 
whether the network type is DHCP or Fixed IP. 

DNS Address Enter the IP address of the primary DNS that corresponds to the IP 
address of the Ethernet device. This does not need to be set, whether 
the network type is DHCP or Fixed IP. 
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If there is a problem with the content of the Linux installation parameter file when the 
Linux installation parameter file is read, please correct the content shown in the Install 
Parameter Error List screen using the LinuxOS Install Parameter Making screen. 

 
 At most 100 install parameter data can be created at one time. 

 
 Explanation of the buttons on the install parameter extensive creation screen  
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IInnssttaallll  PPaarraammeetteerr  EExxtteennssiivvee  ccrreeaattiioonn   
 CLEAR Clears all the content entered in the current screen. 

READ Reads install parameter data saved with CSV file format and places it in 
the entry fields for install parameter batch creation. 
The file selection dialogue screen is displayed, with the CSV directory in 
the currently set work directory as the default directory. Select the file 
name and click on the Open button. 

 

CHECK Performs a prior check of the consistency of the batch creation install 
parameter information that is currently input. 
If there are no problems or errors, the following message dialogue screen 
is displayed. 

 

SAVE The batch creation install parameter information file is saved with the CSV 
file format. 
It is saved to the CSV directory in the currently set work folder. 
The default is <installation folder>\linux\offline\CSV. 
Clicking Save brings up the Save As New Name dialogue box. Enter the 
file name and save the file. 
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 Extensive Creation Performs a batch creation of Linux installation parameter files in 
accordance with the currently input batch creation install parameter data. 
If batch creation is completed successfully, the Install Parameter Creation 
Result List screen is displayed. 

 
• if the Working Mode is Online 

The Linux boot parameter file is saved in the shared directory 
\AnsFile\Linux that named with the input host name without an extension 
on the Management Server. 
The Linux setup parameter file is saved in the shared directory 
\exports\ks that named with the input host name with ".cfg" extension on 
the Management Server. 

• if the Working Mode is Offline 
The Linux boot parameter file is saved in the currently set working 
directory that named with the input host name without an extension. 
The Linux setup parameter file is saved that named with the input host 
name with ".cfg" extension. 

EXIT The currently displayed Install Parameter Extensive Creation dialog 
screen will close and the Install Parameter Extensive Creation operation 
will end. 

 
 
 

The Install Parameter Error List screen will be displayed if there is a problem or error with the 
Linux installation parameter file when reading in the Linux installation parameter file. Correct any 
content that is displayed in the error list screen in the Install Parameter Extensive Creation 
screen. 
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5.5. Package Registration/Modification 
Perform package registration/modification. Follow the steps below. 
 
  Please thoroughly read the RUR installation manual when registering the Expression5800 

series RUR and then register. 
 In addition to the description in this chapter, specialized procedures are required for Windows 

CE (NEC US110). See the corresponding Section 10.2.4, "How to Create a Package for 
Windows CE (for use with NEC US110)" regarding the specialized procedures. 

 Use the PackageDescriber when creation or modification of a package involves any of the 
settings shown below. See Section 6, "PackageDescriber" for an explanation of each setting. 
・ When specifying a hyphen (-), period (.), or underscore (_) for MS Number under the Basic 

tab. 
・ When specifying a file that includes the msp or msu extensions for Execution File under the 

Execution Settings tab. 
・ When specifying a path described in the registry as a file path for File Conditions under the 

Dependency Information tab. 
・ When specifying any of the following for File Conditions or Registry Conditions under the 

Dependency Information tab. 
- Exists (smaller than version) 
- Exists (version or earlier) 
- Exists (larger than version) 
- Exists (version or later) 

・ When specifying multiple conditions using And or Or in Condition Specifications under the 
Dependency Information tab. 

・ When specifying a path described in the registry as the file path under the ID Information tab. 
 
 DPM does not support JIS2004. 
 
(1) From the Start menu of the computer where Image Builder is used, click on All Programs -> 

DeploymentManager -> Image Builder and launch Image Builder. 
 
(2) Click on Package registration/modification. 
 
(3) The Package registration/modification screen is displayed. Then click on the various menus 

under the File menu to register/modify the package. 
 

When creating a Windows package  -> Create Windows Package 
Please see Section 5.5.1, "Create Windows Package," 
for details. 

When modifying a Windows package -> Modify Windows Package 
Please see Section 5.5.2, "Modify Windows Package," 
for details. 

When creating a Linux package  -> Create Linux Package 
Please see Section 5.5.3, "Create Linux Package," 
for details. 

When modifying a Linux package  -> Modify Linux Package 
Please see Section 5.5.4, "Modify Linux Package," 
for details. 
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5.5.1. Create Windows Package 
Explains the Basic, Execution Settings, Applicable OS and language, Dependency information 
and ID information tab settings. 
 

 If you change Type on the Basic tab, the Urgency will change to default. Also, the 
Execution Settings tab settings will change to default. 
• If the type was changed to Service Pack 

Urgency is changed to general. Also, the Restart after the installation and Apply 
independently check boxes on the Execution Settings tab are automatically checked. 
If multiple folders have been added to the copied folder, all folder settings are deleted from 
the package. 

• If the type was changed to HotFix 
Urgency is changed to High. Also, the Restart after the installation and Apply 
independently check boxes on the Execution Settings tab are automatically unchecked. 
If multiple folders have been added to the copied folder, all folder settings are deleted from 
the package. 

• If the type was changed to application 
Urgency is changed to Normal. Also, the Restart after the installation and Apply 
independently check boxes on the Execution Settings tab are automatically unchecked. 

 
(1) Set each item on each tab in the Create Windows package screen. 
 
 Basic tab  

Click on the Basic tab in the Create Windows package screen and set each item. The places 
(types) circled in red are settings that will vary depending on the selected type. 

 
• If HotFix was selected as the type  
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Basic 

 
 

Package ID  
(Entry required) 

Enter the package ID. Up to 63 single-bytes can be entered. Any single-byte 
alphabet and numeric characters or the following symbols can be entered. 
- _ 

Company name Enter the name of the company that issued the package. Up to 127 
single-bytes can be entered. 

Release Date Enter the package release date. Enter it in the year/month/day format. Enter 
the year as four digits and the month and day as two digits. 
If you enter an invalid value, it will be ignored or automatically corrected. 

Package summary Enter package summary information. Up to 511 single-bytes can be entered. 
Type  Select the service pack/HotFix/application from the list box. 

The default is HotFix. 
Urgency Set the urgency (four types) of the package. 

The default is High when you select HotFix. 
The default is Normal when you select service pack or application. (*1) 

MS number Enter the MS (KB) number appended to the service pack or HotFix issued by 
Microsoft. Up to 31 single-bytes can be entered. 
Example) KB889293 

Q819696 
・ In case of a Microsoft HotFix, the value entered in the MS number column 

is compared with the MS number written in the registry (KBXXXXXX or 
QXXXXXX), and if the two values match, it is judged that the HotFix has 
been applied. Please enter the correct value, including the "KB" or "Q." If a 
value is not entered in the MS number column, the application status is 
judged by the registry and file information entered in ID Information. 

・ Microsoft HotFixes for which information has not been entered in either MS 
number or ID Information are not automatically updated. Please specify 
either one when specifying Highest or High urgency. 

・ You do not need to enter the MS number or the ID Information for service 
pack. 

*1 
The handling process will differ according to the type of urgency as shown in the table below. 
 

Urgency Power Status of 
Computer Sending Process 

Highest 

Powered ON computer It will be immediately sent to a managed machine where it can be 
applied. 

Powered OFF computer 

An automatic update notice is immediately issued, but if the 
power is off, automatic update cannot be performed. Next time 
the computer is started up, it is judged whether or not the 
package has been applied based on information set in the 
package, and only packages that have not been applied are 
distributed. 

High 

Powered ON computer It will be sent at a time specified in advance on the Management 
Server side. 

Powered OFF computer 

Automatic update is performed the next time the computer is 
started up. 
It determines whether or not the package has been applied 
based on information set in the package, and only packages that 
have not been applied are distributed. 

Normal  
 

Create a scenario on the Management Server, and distribute it 
manually. Low 
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• If Service Pack was selected as the type  
 

 
 

Basic 

 
 

Major version/Minor 
version 

You must enter major version and minor version if the created package is a 
service pack. Values that can be entered are as follows. 
Major version: 0~65535  
Minor version: 0~65535  
In the case of a Microsoft service pack, the numbers entered in the Major 
Version column and Minor Version column are compared with the service 
pack versions currently installed in the OS, and it is judged whether the 
service pack has been applied. Please enter the correct numbers. 

 
  If an invalid value is input for major version or minor version, it is corrected automatically. 

 In the case of a service pack, the major version and minor version must be entered. 
Please refer to the following table. 
 
Example) For Windows 2000/Windows XP 

 
OS Category   Service Pack  Major Version  Minor Version  

Windows 2000 

SP1 1 0 
SP2 2 0 
SP3 3 0 
SP4 4 0 

Windows XP 
SP1 1 0 
SP2 2 0 
SP3 3 0 
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• If Application was selected as the type  

 

 
 

Basic 

 
 

Display name Enter the application display name. 
This will become the same as the value for the DisplayName saved in 
the registry Uninstall sub-key after the application is installed. Up to 
511 single-bytes can be entered. 

Display version  Enter the application display version. This will become the same as 
the value for the DisplayVersion saved in the registry Uninstall 
sub-key after the application is installed. Up to 127 single-bytes can be 
entered. 
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 Execution Settings tab 

Click on the Execution Settings tab in the Create Windows package screen and set each 
item. 

 

 
 
Execution Settings 

 
 

Folder name Enter the package folder. Up to 255 single-bytes can be entered. 
You cannot use UNC format (\\computer name\Shared 
folder\sub-directory) settings. Perform "Network Drive Assignment" in 
advance and assign a drive letter. 

 Browse  The Browse for Folder screen appears when you click on the Browse 
button. Select the package folder. 

Added folder  
 Add The folder with the folder name entered will be added as an added 

folder. 
Delete The folder selected from the added folder will be deleted. 

The Delete button will only be enabled if you select one or more folders 
from the added folder. 
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Execution File  Enter the executable file. This is less than 255 single-bytes and the path 
will be automatically cleared if the entered path length is larger than 255 
single-bytes. 
Please do not register a file (example: file%9d.exe) with an executable 
file name including %xx(xx is hexadecimal number 0 - f) characters. If a 
package contains %xx, it cannot be correctly downloaded to the 
Management Server. 
Please specify the items in the executable file such that all of the 
following conditions are satisfied. 
・ Silent install can be done. (No response or key entry is needed while 

the file is executing, also, you can create a patch file and do a silent 
install.)  

・ A reboot of the OS does not occur during the install. 
・ You can install with a local system account. (Network browsing is not 

performed.)  
・ The total file size does not exceed 2 GB. 
・ If a child process is created during execution, the parent process 

does not end before the created child process ends. 
 Browse  The open file screen appears when you click on the Browse button. 

Select the package folder. 
 Setup Parameters Set the package setup parameters. 

Specify two parameters: Do not restart after execution, and 
Unattended mode or Quiet mode. 
Entry in the Setup parameter column may be required depending on 
the registered application. In this case, up to 31 single-byte alphabet 
and numeric characters can be entered. 
Set these upon consultation with the service pack or hardware manual. 

• When registering Windows 2000 SP 1/2/3/4 or Windows XP SP1, 
specify -z in the setup parameters so that restart is not performed. It is 
recommended that one of the following two items be set for silent 
install.  
-u: Update with unattended mode. The scenario execution will stop at 

that place if an error occurs during the scenario execution. It will 
show as running a scenario on the Web Console until a timeout 
in the case of OS installation by disk duplication. It will continue 
to show running a scenario on the Web Console during remote 
updates. 

-q: Execute in quiet mode. It progresses to the next step even if an 
error occurs during scenario execution. For this reason, there 
may be cases where the update has not been applied, even 
through the scenario execution has completed on the Web 
Console. 

・ For the parameters of other service packs and HotFix, run the 
execution file with /? In advance to see parameters. 

・ Contact your sales or support representative about application of 
service packs. 

 Restart after the 
installation 

Set it to restart after the package is applied. Effective when applied by 
automatic update type. 

 Apply independently 
 

Set for service pack and HotFix which require exclusive application. If 
you enter a check, it will automatically restart before application. 
Effective when applied by automatic update type. 
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  The registered service pack/HotFix/Linux patch file/application must be copied to an 

internal folder on the Management Server. The free space required for registration is 
twice as much as the space of required for the service pack/HotFix/Linux patch 
file/application to be registered. 

 The service packs/HotFix/Linux patch files/applications registered here are limited to 
those which are silently installed and do not require restart after installation. (For those 
that display a security warning screen due to digital signature information, a confirmation 
screen appears on the managed machine when it is applied, and installation cannot 
continue.) 

*Silent installation means that when an executable file type (setup.exe or Update.exe) is 
run, setup is performed automatically and does not require clicking Next or entering 
values. 

*For service packs, HotFix, etc. that require a restart, please register an image with the 
option to not perform restart (generally -z) and set the Restart Required After Applying 
option in the scenario. 

 Setup parameters can be examined by executing a service pack or HotFix with the /h or 
-? option. Make sure to specify setup parameters for silent installation and no-restarting 
after installation. 

 
  You may not be able to use normal handling in the case where the security patch or 

application method provided by Microsoft includes double byte characters in the 
execution path. It is recommended that you create the patch and application storage 
Folder name with single-byte characters. 

 Register patches in folder units. Please only store one patch in one folder. 
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 Applicable OS and language tab 

Click on the Applicable OS and language tab in the Create Windows package screen and set 
each item. 

 

 
 
Applicable  OS and language 
 OS  Select the OS to which the package is to be applied. 

Correctly set the OS supported by the service pack/HotFix. 
If you select All OS, all OSs will be target. 

Lang  Select the corresponding language of the OS to which the 
package is to be applied. 

 Add Add the selected OS and Lang. 
Delete Delete the selected OS and Lang. 

Base Service Pack Select a server pack that is required for applying the HotFix. 
 Add Add the selected Base Service Pack. 

Delete Delete the selected Base Service Pack. 
Absorbing Service Pack Select the next Server Pack. Use it combined with Base 

Service Pack. 
Example) If there is a Windows 2000 computer with SP4 

applied; enter SP4 as the Base Service Pack, and SP5 as 
the Absorbing Service Pack. In this way, the conditions 
will be [this will apply to computers where SP4 is applied but 
SP5 is not applied]. 

 Add Add the selected Absorbing Service Pack. 
Delete Delete the selected Absorbing Service Pack. 
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 Dependency Information tab 

Click on the Dependency information tab in the Create Windows package screen and set each 
item. 

 
The dependent information is checked when a package is applied. It will be applied only when 
dependent conditions are satisfied. 
Required package is a prerequisite package when applying a package. If it is dependent on an 
OS service pack, please set Base Service Pack on the Applicable OS and language tab. 
 
Dependency information is classified into the following 3 types. 

• Package dependency 
• File dependency 
• Registry dependency  

 
 If you are adding a composite of package dependency, file dependency, and registry 

dependency, it will only apply if all of the condition items have been met. 
Example) If package dependency is A, file dependency information is B, and registry 

dependency is C. The composite application conditions are as below. 
 

 Added 
information Application conditions 

Composite 
application 
condition 

A 
1 

All of 1, 2 and 3 are applied. A is met  
and 

B is met  
and 

C is met   

2 
3 

B 1 Conditions of either 1 or 2 are satisfied 2 

C 1 Conditions of either 1 or 2 are satisfied 2 
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Dependency information 

 Check the package 
dependency relationship 

The settings become valid when the Check for package 
dependency relationship check box is checked. 

Required packages The package can be applied only if the package it depends on has 
been installed. 
Enter a check in the Required package checkbox and set. 
Required packages are selected from other packages registered by 
Image Builder or PackageDescriber. Also, if multiple required  
packages have been added, application is performed if all required  
dependent packages have been applied. 
Example) 

You cannot install the Internet Explorer 8 cumulative security 
refresh program (KB982381) if Internet Explorer 8 is not installed. 
In this case, the dependent condition for applying (KB982381) is 
Internet Explorer 8. 

 Add The Add package dependency screen appears when you click the 
Add button. 

 
The packages displayed on the Add package dependency screen 
are those currently registered on the Management Server. Select a 
dependent package from the list and click the Add button. 

Delete When you select a package from the dependent package list and click 
the Delete button, the dependent package is deleted. 

Apply depending on the 
existence of any of the 
following files   

It is determined if the package should be applied depending on 
whether a file exists or not by the dependent file information. If 
multiple files are added, it will be applied if at least one is met. 
Enter a check in the Apply depending on existence of any of the 
following files checkbox and set. 
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 Add When you click the Add button, the Add file dependency 
information screen appears. Add the package dependent 
information. 

 
• File path 

Enter the dependent file path and file name. 259 single-bytes can be 
entered. 

• File version  
Enter the file version. Please enter in "x.x.x.x" format with less than 
31 single-bytes. The characters that can be entered are single-byte 
numeric characters or symbols ("." only). 
If a file version is not entered, the existence of the file becomes a 
dependency. 
You can check the file version in the file properties Version tab. 
You do not need to enter anything if there is nothing in the 
properties Version tab or if the File version item in the Version tab 
is blank. 

• Conditions 
 - Exists: 

The package will be applied if the entered file exists. 
 - Does not exist: 

The package will be applied if the entered file does not exist. 
Modify When you select a file and click on Modify, the Modify file 

dependency information screen is displayed. 
Delete When you select a file and click on Delete, the dependent file is 

deleted. 
Apply depending on the 
existence of any of the 
following registries     

It is determined if the package should be applied depending on 
whether the registry exists or not by the dependent registry 
information. If multiple registry information is added, it will be applied if 
at least one is met. 
Enter a check in the Apply depending on the existence of any of 
the following registries checkbox and set. 
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 Add When you click the Add button, the Add Dependent Registry 
Information screen appears. Add the package registry. 

 
• Key name  

Enter the registry name including the root key. Up to 255 
single-bytes can be entered. 

• Name 
Enter the value associated with the key name (ValueName) as less 
than 255 single-bytes. 

• Data  
Enter the value data (ValueData). You can enter the following 
number of characters. 
-"REG_SZ" and "REG_BINARY"--up to1024byte 
-"REG_DWORD"------------0~4294967295 characters 
-"REG_QWORD" type------------ 0~18446744073709551615 
characters  

• Type 
Select the value type (ValueType) from the list box. You can select 
the following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 

• Conditions 
- Exists 

The package will be applied if the entered registry exists. 
- Does not exist 

The package will be applied if the entered registry does not 
exist. 

 Modify When you select a registry and click on Modify, the Modify registry 
dependency information screen is displayed. 

 Delete When you select a registry and click on Delete, the Dependent 
Registry is deleted. 
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 ID information tab 

Click on the ID Information tab in the Create Windows package screen and set each item. 
 
It determines whether a package has been applied to a machine using the ID information. 
File and registry changes occurring due to the fact that a service pack/HotFix/Application was 
installed are entered as ID information. 
Example) Patch A is registered, and distributed to machines. 

1) Before distribution: Which patches have been installed? 
How is the file information or the registry?  

2) After distribution: When patch A is distributed, what will the files and registry change to? 
The package application status is determined based on the difference information 
obtained by comparing 1) and 2) above. If all entered file change information and 
registry change information is satisfied, it is judged that the package was applied. 

 
 If the ID information is not entered when the package is registered, the package will 

become an unrecognized package and automatic update notice will not be sent. 
If either the MS number or the ID information is not entered when a HotFix is registered, 
a scenario will be created on the Management Server side and it must be sent. 

 
  If the created package file is a service pack or HotFix issued by Microsoft, even if no 

ID information was entered, the MS number entered on the Basic tab is compared 
with the MS number (KBXXXXXX or QXXXXXX) written in the registry, and if the two 
values match, it is judged that the package has been applied. 

 ID information must be entered in the case of a package that does not have an MS 
number or whose MS number cannot be identified, or when applying a package in 
which no information except the registry remains. 
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ID Information 

 File change information Used when judging whether a package was applied based on change 
information occurring in the file system due to the fact that the 
package was applied. 

 Add When you click on the Add button, the Add file information screen 
appears. Add the package file information. 

 
• File path 
Enter the changed file path and file name. Up to 259 single-bytes 
can be entered. 
As the file path may vary depending on the usage environment, 
please enter the system environment variables. 
Example) 

If there is a change in winsock.dll under C:\WINNT\system32\  
%WinDir%\system32\winsock.dll 

• File version  
Enter the file version. Please enter in "x.x.x.x" format with less than 
31 single-bytes using only single-byte characters and ".". 
If a file version is not entered, the existence of the file becomes ID 
information. 
You can check the file version in the file properties Version tab. You 
do not need to enter anything if there is nothing in the properties 
Version tab on the OS or if the File version item in the Version tab 
is blank. 

• Change type 
Select it from the list box. 
Create new: 

Select when the file is newly created by application of the 
package. 

Version up: 
Select when the file is overwritten by application of the package 
only in the case that it is newer than the existing file. 

Replace: 
Select when the file is unconditionally overwritten by application 
of the package. 

Delete: 
Select when the file is deleted by application of the package. 

Modify Modify file ID information of the added package. 
Delete Delete file ID information of the added package. 
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Registry change  Used when judging whether a package was applied based on registry 
information that changed due to the fact that it was applied. 

  Add When you click on the Add button, the Add registry information 
screen appears. 

 
• Key name  
Enter the registry name including the root key. 

• Name 
Enter the value (ValueName) associated with the key name. 

• Type 
Enter the value Type (ValueType). 

• Data  
Enter the value data (ValueData). The item will be enabled if you 
enter Name. 

• Change  
Select it from the list box. 
Create new: 

Select when the registry is newly created by application of the 
package. 

Replace: 
Select when the registry is unconditionally overwritten by 
application of the package. 

Delete: 
Select when the registry is deleted by application of the package. 

Modify Modify registry ID information of the added package. 
Delete Delete registry ID information of the added package. 

 
(2) When you click on the OK after entering the required information, the package is created. 

When you click on the Cancel button, all entered information is discarded and the Create 
Windows package screen will close. 

 
Input of the information required for Windows package creation is completed. 
Click on the OK button on the Create Windows package screen to create the Windows package. 

 
 Sequential registration is possible with Image Builder. Enter the next package information 

and click on the OK button again to continue registering. To complete the registration 
process, click the Finish button. The Cancel button will become the Finish button once 
you click the OK button. 
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5.5.2. Modify Windows Package 

(1) When you select the Modify Windows package, the Select Windows package screen is 
displayed. 

 

 
 
(2) Select the package from the Select Windows Package screen, and click on the Modify 

button. 
 
(3) The Modify Windows package screen is displayed so make the various modifications on each 

tab of the screen. The following items can be modified. 
Please see Section 5.5.1, "Create Windows Package," regarding each tab of the screen. 
・ You can make modifications on the Basic tab except Package ID and Type. 
・ You can make modifications on the Execution Settings tab except Folder to be copied 

and Execution file. 
・ You can modify all items on the Applicable OS and language tab. 
・ You can modify all items on the Dependency information tab. 
・ You can modify all items on the ID Information tab. 
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5.5.3. Create Linux Package 
If you select the Create Linux package menu item, the Create Linux package screen is displayed. 

 
 Basic tab  

Click on the Basic tab in the Create Linux package screen and set each item. 
 

 
 

Basic 

 
 

Package ID  
(Entry required)  

Enter the package ID. Up to 63 characters can be entered. Any 
single-byte alphanumeric character and the following symbols can be 
entered.  
- _ 

Company name Enter the name of the issuing source that issued the package. Up to 127 
characters can be entered. 

Release date Enter the package release date. The date is entered in the YYYY/MM/DD 
format. 

Package summary  Enter package summary information. Up to 511 characters can be 
entered. 

Type  Select the Linux patch or application. 
Urgency Select the package urgency level. It cannot be changed. 
OK Once all of the required items are correctly entered, the OK button will be 

enabled. 
The Linux package will be created when you click on the OK button. 

 Cancel The screen closes without any processing. 
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 Execution Settings tab 

Click on the Execution Settings tab in the Create Linux Package screen and set each item. 
 

 
 
Execution Settings 

 
 

Folder name Enter the package folder. Up to 255 single-bytes can be entered. 
The Browse for Folder screen appears when you click on the Browse 
button. Click on the OK button after selecting the package folder. 

 Browse  The Browse for Folder screen appears when you click on the Browse 
button. Select the package folder. 

Added Folder Display the package folder that was added. 
- You can only add one folder in the case of a Linux patch. 
- For an application, multiple folders can be added. 

 Add The folder entered in the Folder Name text box will be added as an 
added folder. 

Delete The folder selected from the added folder column will be deleted. 
The Delete button will only be enabled if you select one or more folders 
from the added folder. 
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Execution File  Enter the executable file. This is less than 255 single-bytes and the path 
will be automatically cleared if the entered path length is larger than 255 
single-bytes. 
Please do not register a file (example: file%9d.exe) with an executable 
file name including %xx (where xx is hexadecimal number 0~f) 
characters. If a package contains %xx, it cannot be correctly 
downloaded to the Management Server. 
Please specify the items in the executable file such that all of the 
following conditions are satisfied. 
・ Silent install can be done. (No response or key entry is needed while 

the file is executing, also, silent installation can be performed with 
batch files being created.)  

・ A reboot of the OS does not occur during the install. 
・ You can install with a local system account. (Network browsing is not 

performed.)  
・ The total file size does not exceed 2 GB. 
・ If a child process is created during execution, the parent process 

does not end before the created child process ends.. 
・ If a file path with "&" is entered, the execution file may not operate 

properly. 
 Browse  The open file screen appears when you click on the Browse button. 

Select the package execution file. 
 Setup parameters Set the package setup parameters. 

Set two parameters from Do not Restart After Execution and 
Unattended Mode, or Quiet Mode. Up to 128 single-bytes of 
single-byte numeric characters can be entered. 

Requires restarting 
after the installation This item is unavailable. 

Requires apply 
independently This item is unavailable. 

 
 When you register an rpm package, set the options for the install application with "-I" or 

"-U", etc. as the command options. 
 

  There is a case that the processing cannot be done normally depending on the 
specification of the application when double byte characters are included in the 
execution path. It is recommended that you create the application storage Folder 
name Entry Field with single-byte characters. 
Also, the execution path should not include double byte characters when registering 
for a Linux managed machine. You may not be able to correctly confirm the execution 
path depending on the characters if they include double byte characters. 

 Please do not output any messages on the console if you register a shell script. The 
scenario will fail if a message is output. If a message is required, it should be redirected 
to a log file, and unnecessary messages should be redirected to /dev/null, etc. 

Example) To output to a log  
  dmseg >> /tmp/dmesg.log 
Example) To not save a message  
  /etc/rc.d/init.d/depagtd start > /dev/null 

 If you register a shell script and so forth, the script should return 0 at the normal 
end. If the script returns a value other than 0, a scenario that runs the script ends 
up in a state of Scenario Execute Error even though the script successfully ends. 
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 When registering an RPM package, the package with "-i" option may not be installed 

properly depending on the package registered. The cause may be that there is a signature, 
or it may be an rpm with a dependency. Also, it might fail if it has already installed. 
Representative options are indicated below. Specify the setup parameters based on the 
content. 

Options  Sub-Options Contents 
-i  Installs a new package. 
-U  Upgrades the already installed packages. Installs 

when it is not installed. The installed package is 
uninstalled if an earlier version exists. 

-F  Updates older packages only if an older package  
exists. 

-i --oldpackage Installs packages that are older than the already installed 
packages. 

-i --replacefiles Installs the packages even if they replace files which has 
been installed in the already installed package. 

-i  --replacepkgs Installs the packages even if some of them are already 
installed. 

-i --force the same as the oldpackage, replacefiles, and 
replacepkgs options together 

-i --nodeps Forcibly installs ignoring dependencies. 
-i --nosignature Dose not examine the package or header signature 

when reading in. 
Also, when you specify options with a normal output, the install can fail so do not specify. 
The display system options are shown below 

-v, --verbose Displays more information. Normally, routine 
progress messages are displayed. 

-vv Prints debugging information. 
-h, --hash The progress status is displayed using 50 hash 

marks "#" as it is taken from the package archive. 
--percent  The percentage is displayed as the file is taken from 

the package archive. 
See the online help documents of the Linux you are using for option details. 

 
With the above, input of the information required for Linux package creation is completed. 
Click on the OK button on the Create Linux Package screen to create the Linux package. 
 

 Image Builder can register multiple packages in series. To do so, enter the next package 
Data, and click OK again. To finish registration, click Finish. (Once OK is clicked, the Cancel 
button is replaced by a Finish button). 
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5.5.4. Modify Linux Package 

(1) When you select the Modify Linux Package, the Select Linux Package screen is displayed. 
 

 
 
(2) Select the package to modify from the Select Linux Package screen, and click on the Modify 

button. 
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(3) The Modify Linux Package screen is displayed so make the various modifications on each tab 

of the screen. The following items can be modified. Please see Section 5.5.3, "Create Linux 
Package," regarding each tab of the screen. 
• Other than Package ID and Type and Urgency Level, it is modifiable. 
• Other than Folder to be copied and Execution file, it is modifiable. 
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5.5.5. Package Creation/Registration 
 
When you click on the Exit menu, the Package registration/modification screen closes. 
 
At this time, whether automatic update notification will be sent to the managed machine is decided 
based on the urgency level of the registered package. 
If the registered package has the Highest urgency level, automatic update notice will be sent to 
managed machines where the package is applicable and it will be promptly installed. 
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5.6. Delete Package 
Delete the image data created in Image Builder. Follow the steps below to delete. 
 
(1) From the Start menu of the machine where Image Builder is used, click on All Programs -> 

DeploymentManager -> Image Builder and launch Image Builder. 
 
(2) Click on Delete Registered Data. The Delete Registered Data screen appears. 
 

 
 
Delete registered data  

 
 

Image type  
 

When you select the image type the applicable images are shown in the 
table below. 
 You can select from the following. 
• Image file  
• Operating system  
• setup parameter file  
• Linux parameter file  
• Service Pack/HotFix/Linux patch  
• Application  



Delete Package 
 

Part II Tools 
367 

Delete The Delete button is enabled only if you select one of the image files from 
the image type. You can select and delete multiple image files. 
A confirmation dialog box appears when you click on the Delete button. If 
you click on Yes, the image file is deleted and the Delete Result 
Confirmation screen is displayed. 

 
Close The Delete Registered Data screen closes. 

 
  You can temporarily delete the package registered by automatic download using the 

Image Builder delete package function. However, if you do not delete the corresponding 
package from the Package Web Server, it will be downloaded again at the time of the set 
automatic download. 

 Use PackageDescriber to delete the package from the Package Web Server. See Section 
6, "PackageDescriber" for details. 

 You cannot delete a disk duplication data File or CSV file from Delete Registered Data. 
Please manually delete the file from the Management Server <Folder for Image>\Ansfile 
folder if it is a Windows file. 

 
Example) If the Folder for Image is on the C: drive. 
・ Disk duplication data file (Windows parameter file(Express))  

C:\Deploy\Ansfile\ ExpressSysprep\ XX-XX-XX-XX-XX-XX.inf 
XX-XX-XX-XX-XX-XX.bat 
XX-XX-XX-XX-XX-XX.xml 

・ Disk duplication data file (other than a Windows parameter file(Express))  
C:\Deploy\Ansfile\sysprep\ XX-XX-XX-XX-XX-XX.inf 

XX-XX-XX-XX-XX-XX.bat 
XX-XX-XX-XX-XX-XX.xml 

・ Multiple disk duplication data file of disk duplication data file  
C:\Deploy\Ansfile\sysprep\csv\ XXX.csv 
C:\Deploy\Ansfile\unattend\csv\ XXX.csv 
 

For a Linux file, the disk duplication parameter file is the file from the <Folder for 
Image>\Ansfile on the Management Server, so manually delete the file from the location 
indicated when the CSV file is saved. 

 
Example) If the Folder for Image is on the C: drive. 

C:\Deploy\Ansfile\machineinf\XXXXXXXXXXXX.rep 
If the working directory and the install directory are default  
C:\Program Files\NEC\DeploymentManager\linux\offline\CSV\XXX.csv 
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5.7. Batch Registration 
 Normally, the image data created in Image Builder is temporarily saved on the computer using 

Image Builder, and later automatically sent to the Management Server. However, the data is not 
sent and the data remains local in the following cases. 
・ When doing a system update or copying drivers from the EXPRESSBUILDER CD-ROM. 
・ When the network to the Management Server is disconnected after the temporary creation. 

In these cases, there are the following two methods for registering the locally created image data 
to the Management Server. 
・ Closing Image Builder (Remote Console) 
・ Using Register all. 
 

 This Section explains the process for registering to the Management Server using Register all. 
(1) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 

 
(2) Click on Register all. The Registration file list screen is displayed. The batch register 

data list is displayed. 
 

 
 

Register file list  

 
 

Yes (register)  
 

Sends the image to the Management Server. 

Stop Cancels Register all. 

Delete all  Deletes the data that remains locally. 

 
(3) Click Yes(register). Batch registration to the Management Server is completed. 

 
 If you register an online utility from remote Image Builder, one group of utilities can be 

split into multiple files and uploaded. If you do not understand the file details, upload all 
at the time of Register all. (If there are identical files, please overwrite)  
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5.8. License Agreement Display Settings 
When registering an image file, if you enter a check in the Do not Display this Screen Next Time 
this is Selected in the agreement screen for the license agreement, you won't see the agreement 
screen later for the license agreement. Select Initialize License Agreement Display Settings(S) 
from the system menu to once again display the screen. Once again, the screen will be displayed at 
the time registration handling for all of the image files. 
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6. PackageDescriber 
 
 
 
 
 
 
 
 
 
This chapter explains PackageDescriber, the tool for registration on the Package Web Server. 
 
The items covered in this chapter are as follows: 
 
 
• 6.1 Initial settings: Set Environment ..............................................................................372 
• 6.2 Create Package .......................................................................................................377 
• 6.3 Modify/Delete Package ............................................................................................403 
• 6.4 Registration and Deletion in  ...................................................................................406 
• 6.5 Online Update ..........................................................................................................409 
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6.1. Initial settings: Set Environment 
PackageDescriber is used in the following applications. 

• Creation and modification of packages for Windows 
• Registration and deletion of packages on Package Web Server 
• Online update of OS definition file and language definition file 

 
 PackageDescriber is a package creation tool for Windows. Use Image Builder to 

register Linux packages. 
 

 Configure the Package Web Server so that the Management Server can download 
packages stored in the Web shared folder of the Package Web Server using HTTP. For 
the configuration, refer to Section 3.6.2, "Precautions" in the First Step Guide. 

 All created and modified packages are saved in the Temporary Folder of 
PackageDescriber. Register them to the Package Web Server as necessary. 

 When a package is registered in the Package Web Server from the Register in/Delete 
from the Package Web Server window, it will become downloadable to the Management 
Server. 

 
The relationships among folders associated with PackageDescriber are illustrated in the diagram 
below. 
 
 

Temporary save folder 

 

Web shared folder 

4) Package Web Server registration 

5) Delete from Package 
Web Server 

 

1) Create package 
2) Modify package 

3) Delete package 

Recycle bin 

 
Recycle bin 

 

Package folder 

PD running machine Package Web Server 

 
 
Package ABC is described here as an example. 

 
(1) When you create the package, PackageDescriber copies the specified package ABC 

folder (file) to a PackageDescriber Temporary Folder. 
(2) When you modify the package, PackageDescriber modifies the package ABC stored in 

the PackageDescriber Temporary Folder. 
(3) When you delete the package, PackageDescriber deletes the package ABC from the 

PackageDescriber Temporary Folder. 
(4) When you register the package ABC in the Package Web Server, PackageDescriber 

copies from the PackageDescriber Temporary Folder to the Web shared folder. 
(5) When you delete the package ABC from the Package Web Server, PackageDescriber 

deletes the package ABC from the Web shared folder. 
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<<Initial Setting>> 
This Section describes the initial Setting of PackageDescriber. 
 
(1) From Start menu, select All Programs, select DPM PackageDescriber. When 

PackageDescriber starts, the Initial settings: Set Environment window is displayed. 
 

 
 
(2) Click on Browse on the Web shared folder, the folder selection dialog is displayed, specify 

the folder and click Open. 
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(3) The folder specified as the WebShare folder is displayed. Perform the same procedure to 

change the Temporary folder only if necessary.  
 

 
 
(4) Click the OK button to save settings and close the Initial settings: Set Environment screen. 

 
  If the Web shared folder is not set, the Management Server cannot automatically download 

packages. Furthermore, the Web shared folder and the Temporary Folder cannot be 
omitted. 

 Confirm that the Web shared folder has Read and Write properties. 
 The registered package will be stored in the Web shared folder. Be sure to secure enough 

free space. 
 If the shared folder of the network computer is specified as a Web shared folder, it is 

recommended to assign a local drive to the shared folder beforehand. If a drive is not 
assigned, the shared folder of the network computer may not be accessible. 

 If the Web shared folder is changed, previously registered packages must be re-registered. 
 The< PackageDescriber install folder> cannot be specified in the Web shared folder. 
 The Temporary Folder and the Web shared folder cannot be specified in the same folder. 
 Please note the combination of the folder (normally the temporary folder) to store package 

and the package ID. 
In DPM, a folder having the name specified as the package ID is created under the folder 
in which the package is saved, and the package is managed. 
If a folder of the same package ID already exists, that folder is temporarily deleted and the 
package is created. For this reason, do not specify a folder used for applications other 
than saving the package, such as system folders, etc., as the folder in which the package 
is saved. 

 The file cannot be specified in the Temporary Folder. 
 The write access is required to specify the folder in the Temporary Folder. 
 On Windows Vista, if UAC is enabled, take note of the following. 

・ Change the Temporary Folder from its initial setting, because even users having 
administrator right do not have write access for %ProgramFiles%. 

・ The PDconfig file cannot be set manually. 

・ When you install PackageDescriber in an environment where PackageDescriber has 
been uninstalled, the Initial settings: Set Environment window may not be displayed. 
In this case, modify the setting from Set Enviroment windows from Settings menu. 

・ When PackageDescriber is first started after the UAC setting (enable/disable) has been 
switched, re-set Web shared folder and Temporary Folder which was set before UAC 
has changed. 
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  The setting of Web shared folder can be changed from Set Environment of the 
Settings menu. 

 It may take time for PackageDescriber to start up. 
 When the Web shared folder and Temporary Folder have been set and the OK 

button is clicked, information is written into the PackSerFolder (Web shared folder) and 
PackageSavePath (Temporary folder) of <PackageDescriber installation 
folder>¥PDconfig. 

 Once the Web shared folder or Temporary Folder has been set and the OK button 
has been clicked on the Initial settings: Set Environment window, the values are 
written into PDconfig and please check the values from it. 

 If PDconfig has been edited directly, please restart PackageDescriber. 
After restart, the PDconfig settings will be reflected. 

 The saved folder when creating package can be set in the Temporary Folder. 
The default is <PackageDescriber installation folder>¥Packages. 

 
<<Environment Settings>> 
This Section describes how to configure the Package Web Server. 
 
(1) Select Start, then select All Programs, then select DPM PackageDescriber to open 

PackageDescriber. 
 

(2) Select Settings, then select Set Environment, and set the Web shared folder and 
Temporary folder. 

 

 
 

 The Package Web Server shared folder cannot be set while the Register in/delete 
from the Package Web Server window or Online update window is open. 
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Environment Configuration 
 Web shared folder Cannot be omitted. The folder specified during the initial setting is 

displayed. 
You can enter up to 259 characters. The allowed characters are numeric 
characters and symbols. 
If the Web shared folder is changed, previously registered packages must 
be re-registered. 

Temporary  folder The folder specified during the initial setting is displayed. 
You can enter up to 245 characters. The allowed characters numeric 
characters and symbols.  

Browse  Open the folder selection dialog box. 
Packages that are not registered to the Package Web Server cannot be 
automatically downloaded by the Management Server. 

OK Save the settings and closes the window. An error message appears if 
the setting failed or the Web shared folder was not specified. 

Cancel Closes the window without saving settings. 
 

  Confirm that the Web shared folder and Temporary Folder have Read and Write 
attributes. 

 The registered package will be stored in the Web shared folder and Temporary Folder. 
Be sure to secure enough free space. 

 If a network computer's shared folder is specified as the Web shared folder or 
Temporary Folder, it is recommended to assign a local drive to the folder in advance. If 
a drive is not assigned, the network computer's shared folder may not be accessible  

 
(3) Click the OK button to close the Window. Packages registered in Register in/delete from 

the Package Web Server window are all saved under the Web shared folder. 
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6.2. Create Package 
6.2.1. Basic Information 

His Section describes how to enter basic package information. 
 
Click the PackageDescriber File menu -> Create Package, the Create Package window is displayed 
in the main window. Set the items on the Basic tab. The place (type) circled in red frame is settings 
that will vary depending on the selected type. 
 
 If the type has been changed, Urgency and Execution Settings information change to the 

default. Please verify it again. 
• If the type was changed to Service Pack 

Urgency is changed to Normal. Also, the Requires restarting after the installation and 
Requires applying independently check boxes on the Execution settings tab are 
automatically checked. 
If multiple folders have been added to the folder to be copied, all folder settings are deleted 
from the package. 

• If the type was changed to HotFix 
Urgency is changed to High. Also, the Requires restarting after the installation and 
Requires applying independently check boxes on the Execution Settings tab are 
automatically unchecked. 
If multiple folders have been added to the folder to be copied, all folder settings are deleted 
from the package. 

• If the type was changed to Application 
Urgency is changed to Normal. Also, the Requires restarting after the installation and 
Requires applying independently check boxes on the Execution settings tab are 
automatically unchecked. 

 
• If HotFix was selected as the type 
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Basic 
 Package ID  

(Enter required) 
Enter the package ID. 
It can be entered with numeric character, - (hyphen), and (underscore) up to 63 
characters_ 
Do not include hexadecimal number characters (%0D, %0A, etc.) 
in the package ID. 
The package cannot be correctly downloaded to the Management Server. 

Company name Enter the name of the company from which patches and applications were  
issued. 
Up to 127 characters can be entered. The allowed characters are numeric 
characters and symbols . 

Release date Enter the date when the patch or application was released. 
Please enter using YYYY/MM/DD format. 
If an invalid value is entered, it will automatically become blank. 

 Package Summary Enter summary information of the package. 
Up to 511 characters can be entered. The allowed characters are numeric 
characters and symbols. 

 Type  Select the package type. You can select from the following. 
• HotFix 
• Service Pack  
• Application  
The default is HotFix. 
When the type is changed, the screen switches in accordance with the changed 
type. (If the screen does not switch, change the type by using the mouse.) 

 Urgency Set the urgency of the package. You can select from the following four types. 
• Highest 
• High 
• Normal 
• Low 
The default is Normal, but it is High only if the type is HotFix. 
If a package is registered as an automatically updated package, set the urgency to 
highest or high. (*1) 

 MS number  Enter the MS (KB) number pre-assigned to the service pack or HotFix issued by 
Microsoft. Up to 31 characters can be entered. The allowed characters are numeric 
characters. 
Example) KB889293 

Q819696 
• If service pack was selected as the type, there is no need to enter the MS 
number and ID information. 

• In case of a Microsoft HotFix, the value entered in the MS number field is 
compared with the MS number written in the registry (KBXXXXXX or QXXXXXX), 
and if the two values match, it is judged that the HotFix has been applied. Please 
enter the correct value, including the "KB" or "Q."  If a value is not entered in the 
MS number field, the applied status is judged by the information of registry, the 
files and so forth, entered in ID Information tab. 

• When you create a package for a HotFix that does not write the MS number in the 
registry, if letters that cannot be entered by PackageDescriber are included in the 
MS number, ID information must be entered in order to perform automatic 
updates. 

• If both MS number and ID information are not entered for Microsoft's HotFix, the 
HotFix will be excluded from the automatic update. When selecting the urgency 
Highest or High, make sure to enter at least one of these fields  
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*1 
 The process will be different when the Management Server executes automatic download differs 

depending on urgency type. Please refer to the following table. 
 

Urgency Power Status of 
Computer Process After Package Registration 

Highest 

Power on An automatic update notice is immediately issued. 

Power off 

An automatic update notice is immediately issued, but if the 
power is off, automatic update cannot be performed. At the next 
startup of computers, it is judged whether or not the package has 
been applied based on information set in the package, and only 
packages that have not been applied are distributed. 

High 

Power on Automatic update is performed at the time specified by the 
Management Server. 

Power off 

Automatic update is performed when the computer is started up 
next time.  
It is judged whether or not the package has been applied based 
on information set in the package, and only packages that have 
not been applied are distributed. 

Normal  
 

There is no distribution with the automatic update. 
Create a scenario on the Management Server, and distribute it 
manually. Low 

 
 Other than urgency, the following items must be set in order to be a target of automatic updates. 

If they are not set, there will be no distribution with automatic updates even if urgency is Highest 
or High. Create a scenario on the Management Server, and distribute it. 

• HotFix   … MS number (or ID information)  
• Service Pack  … Major version and Minor version 
• Application  … Display name and Display version (or ID information) 

 For a package with Highest urgency, an automatic update notice is issued to all computers 
whose operating systems are target OS of the package. However, automatic updates are not 
performed on computers whose power is off or whose automatic update notice is set to constantly 
off. 

*2 
 If an invalid value is input for major version or minor version, it is corrected automatically. 

In the case of a service pack, the major version and minor version must be entered. Please 
refer to the following example. 
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Example) Windows 2008/Windows 7 

OS type Service Pack Major Version Minor Version 

Windows 2008 SP1 1 0 
SP2 2 0 

Windows 7 SP1 1 0 
 
• If Service Pack was selected as the type 

 

 
 

Basic 
 Major version/Minor 

 version 
If service pack was selected as the type, enter the major version and 
minor version. 
This can be set in the range of "0~65535". 
In the case of a Microsoft service pack, the numbers entered in the 
Major version and Minor version field are compared with the service 
pack versions currently installed in the OS, and it is judged whether or 
not the service pack has been applied. Make sure to enter the correct 
numbers. (*2) 
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• If Application was selected as the type  
 

 
 

Basic 
 Display Name • If Application was selected as the type, enter the display name. 

Up to 511 single-byte characters can be entered. 
In order to register as a target package of automatic update, enter the 
application name displayed in Programs and Features. (*3) 
For applications not displayed in Programs and Features even after being 
installed, please enter the ID information. Please see Section 6.2.5, "ID 
Information," for details. 

Display Version  • If application was selected as the type, enter the display verison. 
Do not enter anything if the version number is not displayed in Programs 
and Features. 
In order to register as a target package of automatic update, enter the 
application version displayed in Programs and Features. (*3) Do not enter 
anything if the version number is not displayed in Programs and Features.  
Up to 126 numeric characters can be entered. 
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*3 

Example) Display Name and display Version displayed in Programs and Features 
 

In case of Windows Server 2003 R2 
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6.2.2. Execution Setting Information 

This Section describes how to enter the execution setting information of package. 
 
Click the PackageDescriber File menu -> Create package to display the Create package screen in 
the main window. Set the items on the Execution settings tab. 
 

 
 
Create package 
Execution settings 
 Folder to be copied 

 Folder name Specify the folder where the patch or application is stored. 
Up to 255 characters. 
Only single-byte alphanumeric characters can be used. 
 

Browse  Click the Browse button, and select the folder where the patch or 
application is stored. 
 

Add Specify the Folder name and click the Add button to add it to the 
Added folder. 
 

Added folder Displays the package folders that were already added. 
• When the package type is Service Pack or HotFix, one folder can be 

added. 
• When the package type is Application, multiple folders can be added. 
 

Delete Click the Delete button, and delete the folder selected in Added folder. 
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Install 
 execution  File  

(Entry required)  
Enter the execution file name. 
Up to 255 characters. 
Only single-byte alphanumeric characters can be used. 
Do not specify a file names that includes %xx. A file with such a file 
name cannot be downloaded to the Management Server correctly. 
"xx" indicates hexadecimal number 0 ~ f. Example: file%9d.exe 
• For Execution file, be sure to specify the one that fulfills all of the 

following conditions. 
  - Silent installation is possible. (Response by key input, etc., during 

file execution is not required. Or, create a batch file capable of silent 
installation.) 

  - OS is not restarted during installation. 
  - Installation is possible by a local system account. (referring the 

network is unnecessary.)  
  - The total file size does not exceed 2GByte. 
  - If a child process is created during execution, the parent process 

does not end without waiting for the end of the created child 
process. 

Browse  Click the Browse button and select the execution file. 
Setup parameters Enter and set the setup parameters used when executing patches and 

applications. Only 128 single-byte characters can be entered. Only 
single-byte alphanumeric characters can be used. 
• When registering Windows 7 SP1 or Windows 2008 SP1/2, specify -z 
as a command option so that restart is not performed. 
Also, to perform silent installation, specify either of the following as a 
command option. 

-u: Execute in unattended mode. If an error occurs during 
automatic update or scenario execution, the scenario execution 
or automatic update are stopped, and the status on the 
Management Server stays as Running a scenario or 
Applying a package. 

-q: Execute in quiet mode. It will proceed to the next even when an 
error occurs during the scenario execution or automatic update. 
Therefore, even when it is indicated as the scenario execution 
is completed on the Management Server; it may not have been 
applied. 

• For parameters of other service packs and HotFix, run the execution 
file with /? in advance to see parameters. 

• Contact your sales or support representative about application of 
service packs. 

Restarts restarting 
After the installation 

Set this parameter to perform restart after the package is applied. 
Effective when applied by automatic update type. 

 Requires applying 
independently 

Set for patches or applications which need to be applied independently 
(for example, service pack). When this check box is checked, restart is 
performed automatically before application. effective when applied by 
automatic update type. 
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  The registered service pack/HotFix/application must be copied to an internal folder on 

the Management Server. The amount of free space required for registration is 
approximately twice of the space required for the service pack/HotFix/application to be 
registered. 

 The service packs/HotFix/applications registered here are limited to those which are 
silently installed and do not require restart after installation. (For those that display a 
security warning screen due to digital signature information, a confirmation screen 
appears on the managed machine when it is applied, and installation cannot continue.) 
*Silent installation means that when an executable file type (setup.exe or Update.exe) 
is run, setup is performed automatically and does not require clicking Next or 
entering values. 

*For service packs, HotFix, etc. that require a restart, please register an image with 
the option to not perform restart (generally -z) and set the Restart Required After 
Applying option in the scenario. 

 Setup parameters can be examined by executing a service pack or HotFix with the /h 
or -? option. Make sure to specify setup parameters for silent installation and 
no-restarting after installation. 
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6.2.3. Applicable OS and Language Information 

This Section describes how to enter the Applicable OS and language information for the created 
package. 
 
Click the PackageDescriber File menu -> Create package to display the Create package screen in 
the main window. Set the items on the Applicable OS and language tab.  
 

 
 

Create package 
Applicable  OS and language 
 OS  

(Setting required)  
Select the OS to which the package is to be applied. Select the OS 
to which the package corresponds. 
If All OS is selected, all selectable OS other than Other OS and 
Windows CE 5.0 (FOR US110) are the targets. Also, it is applied to 
all machines without awareness of OS information. 

Language  
(Setting required)  

Select the corresponding language of the OS to which the package 
is to be applied. 

Add Add the selected OS and Language. 
Delete Delete the selected OS and Language. 
Base Service Pack Set the base service pack to which service pack/HotFix/application 

can be applied. Add or delete using the Add or Delete button. 
Absorbing Service Pack Set the next service pack. Use it combined with the Base Service 

Pack. Add or delete using the Add or Delete button. 
Example) If Windows 2008 SP2 is entered as Base Service Pack 
and Windows 2008 SP3 is entered as Absorbing Service Pack, 
the condition will be apply to the computer that is applied with SP2 
and un applied with SP3. 
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6.2.4. Dependency Information 

This Section describes how to configure the dependency information of a package. 
 
Click the PackageDescriber File menu -> Create package to display the Create package screen in 
the main window. Set the items on the Dependency information tab. 
 
At the time of package application, the dependency information is checked, and the package is 
applied only when the dependency conditions are satisfied. 
Also specify the package, file or registry that can be the prerequisite in order to apply the package. 
Example) 

Internet Explorer 8 cumulative security update program (KB982381) 
KB982381 cannot be applied unless Internet Explorer 8 has been installed. It is necessary to add 
dependency information that indicates that Internet Explorer 8 has been installed. 
 

There are three types of dependency information. 
• Package dependency 
• File dependency 
• Registry dependency 

 
 If a combination of package dependency, file dependency and registry dependency has 

been added, the package is applied only when all of the package dependencies are satisfied 
and either the conditions set in file dependency or registry dependency is satisfied. 

Example) 
If the package dependency is A, the file dependency is B and the registry dependency 
is C, then the composite application condition is as follows. 

 Added 
information Application conditions 

Composite 
application 
condition 

A 
1 

All of 1, 2 and 3 are applied. 
A is satisfied, 
and conditions 
set in B and C 
are all satisfied 

2 
3 

B 1 
AND/OR may be optionally set. 
Conditions of either 1 or 2 are 
satisfied 

2 

C 
1 
2 

 

 
  If the package is dependent on a service pack, please select Base Service Pack on the 

Applicable OS and language tab. 
 If ">" is used in the registry dependency, it may not be correctly applied. 
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(1) Click the PackageDescriber File menu -> Create package to display the Create package 

screen in the main window. On the Dependency information tab, check the Check the 
package dependencies relationship while applying the package check box, and configure 
the various items. 
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Dependency information 
 Check the package 

dependency 
relationship while 
applying the 
package 

The settings become valid when Check the package dependency 
relationship while applying the package check box is checked. 

Required packages Can be applied only if the package it depends on has been installed. 
Dependent packages are selected from other packages registered in 
PackageDescriber. Also, if multiple dependent packages have been added, 
application is performed if all dependent packages have been applied. 
 

 Add The Add package dependency screen appears when you click the Add 
button. 

 
The packages displayed on the Add package dependency screen are those 
currently registered on the Package Web Server. Select a dependent package 
from the list and click the Add button. 

Delete When you select a package from the dependent package list and click the 
Delete button, the dependent package is deleted. 

Condition List 
File Condition List Applying the package depends on the existence of either file. To specify a file 

as a condition for applying package, check the File Condition List check box. 
The dependency condition is judged only after Select Conditions is selected. 
When the File Condition List and Registry Condition List are added, it will 
not be judged. 
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 Add When you click the Add button, the Add file dependency information screen 
appears. Configure each item and click the OK button. 

 
• File path 
Up to 259 single-byte characters can be entered. The allowed characters are 
single-byte alphanumeric characters. 
File path can specify the path written in the registry. 
Specify the full-path registry name surrounded by single-byte brackets ("{", 
"}"). 
Example) 

To specify EXCEL.EXE under 
C:\Program Files\Microsoft Office\Office Assume that value of 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Excel\Insta
llRoot\Path 

Is set as C:\Program Files\Microsoft Office\Office\. In this case, 
please specify 

{HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Excel\Inst
allRoot\Path}EXCEL.EXE  

as the file path. 
• File version 
Only 31 single-byte characters can be entered. 
The allowed characters are single-byte alphanumeric characters/symbols ("." 
only). Please enter in "x.x.x.x" format. 
If a file version is not entered, the dependency is the existence of the file. 
The file version can be confirmed on the Version Information tab of file 
properties, but if the Version tab does not exist, or if the File version item on 
the Version tab is blank, there is no need to enter it.  
The case that the File version was entered and Does not exist was set as a 
condition is matched when entered version does not exist. 
Example) 

The case where 4.0.0.0 was entered as the file version and Does not 
exist was set as a condition matches the case where file 3.0.0.0 or 5.0.0.0 
exists. If file 4.0.0.0 exists, it does not match. 

• Condition 
Select the package application conditions. 
(*1) 

 Modify When you select a file and click the Modify button, the Modify file 
dependency information screen appears. Please change the configuration. 

Delete When you select a file and click the Delete button, the dependent file is deleted. 
Registry Condition 

 

Applying the package depends on the existence of either registry. To specify a 
registry as a dependency, check the Registry Condition List check box. 
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 Add When you click the Add button, the Add Dependent Registry Information 
screen appears. Configure each item and click the OK button. 

 
• Key name 
Enter the registry key name including the root key. Up to 255 single-byte 
characters can be entered. Only single-byte alphanumeric characters can be 
used. 

• Name 
Enter the value (ValueName) that belongs to the key name. 
Up to 255 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 

• Data 
Enter the value data (ValueData). The allowed characters vary depending on 
the type selecting in Type. 
-"REG_SZ" 

Single-byte characters, up to 1024 single-byte characters 
-"REG_BINARY" 

Single-byte characters, up to 1024single-byte characters 
-"REG_DWORD" 

Single-byte characters from 0 to 4294967295  
-"REG_QWORD" 

Single-byte characters from 0 to 18446744073709551615 
• Type 
Select the value type (ValueType). You can select from the following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 

• Condition 
Select the package application conditions. 
If Exist is specified, only the key name and name are compared. 
For REG_BINARY, only Does not exist, Exist and Exist (=) can be selected. 
(*2) 

Modify When you select a registry and click the Modify button, the Modify registry 
dependency information screen appears. Please change the configuration. 

Delete When you select a registry and click the Delete button, the dependent registry 
is deleted. 
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*1 
 When reading a package created with DPM Ver5.0 or earlier with this version, the conditions 

are converted as follows. 
 

DPM Ver5.0 or Earlier This Version  
Does not exist Does not exist 
Exists 
(File version has been entered) 

Exist (=) 

Exists 
(File version has not been entered) 

Exist (Version Check does not Apply) 

 
 The operations performed when the respective conditions have been specified are as 

shown below. 
 

Set Value Managed Machine Status 

File 
Version 

Condition 
File Exists (version is shown below) File does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 None 

Unspecified 
Does not exist No No No No Yes 
Exists 
(version not checked) 

Yes 
Yes Yes Yes 

No 

2.0.0.0 

Does not exist Yes No Yes Yes Yes 
Exists 
(equal to version) 

No Yes 
No No No 

Exists 
(lesser than version) 

Yes 
No No No No 

Exists (version or below) Yes Yes No No No 
Exists 
(greater than version) 

No No 
Yes 

No No 

Exists (version or above) No Yes Yes No No 
(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 

*2 
 Key name, name and data are not case-sensitive. 
 Data comparison with respect to REG_SZ is a simple character string comparison. In the 

case of 9.0.0.0 and 10.0.0.0, 9.0.0.0 is judged to be greater. 
 When reading a package created with DPM Ver5.0 or earlier with this version, the 

conditions are displayed as follows. 
 

DPM Ver5.0 or Earlier This Version  
Does not exist Does not exist 
Exists 
(data has been entered) 

Exist (=) 

Exists 
(data has not been entered) 

Exist 
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 The operations performed when the respective conditions have been specified are as 

shown below. 
1) When only the key name is specified 

Set Value Managed Machine Status 
Condition Exists Does not exist 

Does not exist No Yes 
Exists Yes No 

(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 
 

2) When the name is specified 
• REG_SZ 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name does 

not exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 

Blank 
Does not exist No No No No Yes 
Exists Yes Yes Yes Yes No 

2.0.0.0 

Does not exist Yes No Yes Yes Yes 
Exists (=) No Yes No No No 
Exists (<) Yes No No Yes No 
Exists (<=) Yes Yes No Yes No 

Exists (>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 
 

• REG_BINARY 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name does 

not exist AA BB CC None 

Blank 
Does not exist No No No No Yes 
Exists Yes Yes Yes Yes No 

BB 
Does not exist Yes No Yes Yes Yes 
Exists (=) No Yes No No No 

(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 
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• REG_DWORD 

Set Value Managed Machine Status 

Data Condition 
Name Exists 

Name does not exist 
1 2 3 

Blank 
Does not exist No No No Yes 
Exists Yes Yes Yes No 

2 

Does not exist Yes No Yes Yes 
Exists (=) No Yes No No 
Exists (<) Yes No No No 
Exists (<=) Yes Yes No No 

Exists (>) No No Yes No 

Exists (>=) No Yes Yes No 
(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 

 
• REG_QWORD 

Set Value Managed Machine Status 

Data Condition 
Name Exists 

Name does not exist 
1 2 3 

Blank 
Does not exist No No No Yes 
Exists Yes Yes Yes No 

2 

Does not exist Yes No Yes Yes 
Exists (=) No Yes No No 
Exists (<) Yes No No No 
Exists (<=) Yes Yes No No 

Exists (>) No No Yes No 

Exists (>=) No Yes Yes No 
(Yes: Dependency condition is satisfied. No: Dependency condition is not satisfied) 
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(2) After configuring the File Condition List and Registry Condition List of the Condition List 

group box, click the Select Conditions button and configure the conditions. 
 

 
 

  Conditions used in an AND/OR condition cannot be deleted. 
 For the file condition below the deleting condition, if the registry condition is 

specified with AND, OR, this condition cannot be deleted. 
Example) 

When the third file condition is used  AND, OR, the first and second file 
condition cannot be deleted  
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1) Click the Select Conditions button to display the Select Conditions screen, and then click the 

Add button. 
 

 
 
2) The OR Condition Specification screen appears. Specify AND and OR of the conditions. 

Select file conditions or registry conditions, click the " " button, and add an OR condition 
to Condition Items. 

If you wish to delete the OR condition that you added to Condition Items, click the " " 
button. 
 The condition numbers on the Select Conditions screen are treated as AND conditions, 

and conditions separated by pipes (|) are treated as OR conditions. 
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6.2.5. ID Information 

This Section describes how to configure the ID information of a package you are creating. 
It is judged whether or not a package has been applied to a managed machine using the ID 
information. 
 
File and registry changes occurring due to the fact that a package was installed are entered as ID 
information. 
Example) 

Package A is registered, and distributed to managed machines. 
1) Before distribution : Which patches have been installed as of now? 

How was file information or the registry affected? 
2) After distribution : When package A is distributed, in what way will the files 

and registry change? 
 

The difference information obtained by comparing 1) / 2) is registered as ID information. 
In DPM, it judges the package application situation based on the ID information specified here. If all 
entered file change information and registry change information is satisfied, it is judged that the 
package was applied. 
 

  If the created package file is a service pack or HotFix issued by Microsoft, even if no 
ID information was entered, the MS number entered on the Basic tab is compared 
with the MS number written in the registry (KBXXXXXX or QXXXXXX), and if the two 
values match, it is judged that the package has been applied. 

 If the created package is a service pack issued by Microsoft, even if no ID information 
was entered, the major version and minor version entered on the Basic tab are 
compared with the service pack version currently installed in the OS, and it is judged 
whether or not the service pack has been applied. 

 ID information must be entered in the case of a package that does not have an MS 
number or MS number cannot be identified, or when applying a package in which no 
information except the registry remains. 
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(1) Click the PackageDescriber File menu -> Create Package to display the Create Package 

screen in the main window. Set the items on the ID Information tab. 
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ID Information 
 File Change information Used when judging whether a package was applied based on 

change information occurring in the file system due to the fact 
that the package was applied. 

 Add When you click the Add button, the Add file information screen 
appears. Add the file ID information of the package. 

 
• File path 
Enter the changed file path and file name. Up to 259 single-byte 
characters can be entered. 
Only single-byte alphanumeric characters can be used. 
As the file path may vary depending on the usage environment, 
please enter the system environment variables. (Please see 
Section 6.2.4, "Dependency Information," "File Condition List," 
"Add" for examples of input. 

• File version 
Enter the file version. Only 31 single-byte characters can be 
entered. 
The allowed characters are single-byte alphanumeric 
characters/symbols ("." only). 
If the file version is not entered, an identification is the existence 
of the file. 
The file version can be confirmed on the Version tab of File 
Properties, but if the Version tab does not exist, or if the File 
Version item on the Version tab is blank, there is no need to 
enter it. 

• Change type 
Set the change type. You can select from the following. 
・ Create new: Select when newly produced by application of 

the package. 
・ Replace: Select when unconditionally overwritten by 

application of the package. 
・ Version up: Select when it can be overwritten only when 

newer than the existing file by application of the package. 
・ Delete: Select when deleted by application of the package. 

(*1) 
Modify When you select a file and click the MMooddiiffyy  button, the MMooddiiffyy  

file information screen appears. Please mmooddiiffyy the 
configuration. 

Delete When you select a file and click the Delete button, the file is 
deleted. 

 Registry change 
information 

Used when judging whether a package was applied based on 
registry information that changed due to the fact that the package 
was applied. 



6 PackageDescriber 
 

DeploymentManager Ver6.0 Reference Guide 
400 

 Add When you click the Add button, the Add registry information 
screen appears. Add the registry ID information of the package. 

 
• Key Name 
Enter the registry key name including the root key. Up to 255 
single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 

• Name 
Enter the value (ValueName) associated with the key name. 
Up to 255 single-byte characters can be entered. 
Only single-byte alphanumeric characters can be used. 

• Data 
Enter the value data (ValueData). The allowed characters vary 
/characters kinds depending on the type selected in Type. 
-"REG_SZ" 

Single-byte characters, up to 1024 single-byte characters 
-"REG_BINARY" 

Single-byte characters, up to 1024 single-byte characters 
-"REG_DWORD" 

Single-byte characters from 0 to 4294967295 
-"REG_QWORD" 

Single-byte characters from 0 to 18446744073709551615 
• Type 
Select the value type (ValueType). You can select from the 
following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 

• Change type 
Set the change type. You can select from the following. 
- Create new: Select when newly produced by application of 
the package. 

- Replace: Select when unconditionally overwritten by 
application of the package. 

- Delete: Select when deleted by application of the package. 
(*2) 

Modify Modify registry ID information of the added package. 
Delete Delete registry ID information of the added package. 
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*1 
 The operations performed when the respective conditions have been specified are as 

shown below. 
 

Set Value Managed Machine Status 

File 
Version 

Condition 
File Exists (version is shown below) 

File does not exist 
1.0.0.0 2.0.0.0 3.0.0.0 None 

Unspecified 

Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Version up No No No Yes No 
Delete No No No No Yes 

2.0.0.0 

Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Version up No Yes Yes No No 
Delete No No No No Yes 

(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 
*2 
 The operations performed when the respective conditions have been specified are as 

shown below. 
1) When only the key name is specified 

Set Value Managed Machine Status 

Condition Exists Does not exist 
Create new Yes No 

Delete No Yes 
(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 

 
2) When the name is specified 

• REG_SZ 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 

Blank 
Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Delete No No No No Yes 

2.0.0.0 
Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 
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• REG_BINARY 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name  

Does not 
exist AA BB CC None 

Blank 
Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Delete No No No No Yes 

BB 
Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 
 
• REG_DWORD 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name  

Does not exist 1 2 3 

Blank 
Create new Yes Yes Yes No 
Replace No No No No 
Delete No No No Yes 

2 
Create new Yes Yes Yes No 
Replace No Yes No No 
Delete No No No Yes 

(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 
 

• REG_QWORD 

Set Value Managed Machine Status 

Data Condition 
Name Exists Name  

Does not exist 1 2 3 

Blank 
Create new Yes Yes Yes No 
Replace No No No No 
Delete No No No Yes 

2 
Create new Yes Yes Yes No 
Replace No Yes No No 
Delete No No No Yes 

(Yes: Identification condition is satisfied. No: Identification condition is not satisfied) 
 
(2) When you click OK after entering the necessary information, the package information file is 

created. 
When you click Cancel, all entered information is discarded and the Create package screen is 
closed. 

 
Input of the information necessary for package creation is completed. 
Click the OK on the Create package screen to create the package. 
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6.3. Modify/Delete Package 
This Section describes how to modify or delete a created package. 
 
(1) Click the PackageDescriber File menu ->Modify/delete package to display the Local 

package list screen, and click the Select Folder button. 
 

 
 

 The sort order of packages can be changed by clicking on a column heading on 
the Local package list screen. 

 
(2) The Select Folder dialog box appears. Select the folder of the package you wish to modify or 

delete and click the Open button. 
 

 
 
(3) The packages in the folder specified on the Local package list screen are displayed. Select a 

package, and modify or delete it. 
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(4) In the case of modification, the Save screen is opened after modification. Select the folder to 

be saved and click the Save button. 
 

 
 

  The package list initially displayed on the Local package list screen is the 
package list of the folder specified as the Temporary folder. 

 File Name and File Type: All files are displayed on the screen. Select a folder. 
 When saving a folder in a folder other than the Temporary folder, check that 

packages having the same package ID do not exist in that folder so as not to 
accidentally overwrite backup packages. 

 
(5) Select a package from the Local package list screen and perform modification or deletion. 

 
Local package list  
 Modify When you click the Modify button, the Modify package screen opens. 

Delete When you click the Delete button, the selected package is deleted. 
Close When you click the Close button, the screen closes. 
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(6) Click the Modify button on the Local package list screen to display the Modify package 

screen. Modify the items on the Basic, Execution Settings, Applicable OS and language, 
Dependency information and ID information tabs. 

 

 
 
 

 If you modify a package that was already added to the Package Web Server, click File 
menu ->Register in/Delete from the Package Web Server -> Register/Re-register. 
Please see Section 6.4, "Registration and Deletion in Package Web Server," for details. 

 
 The Package ID and Type on the Basic tab cannot be modified. 

Please see Section 6.2.1, "Basic Information," through Section 6.2.5, "ID Information," 
for a description of each tab. 
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6.4. Registration and Deletion in Package 
Web Server 

This Section describes how to register or delete a created package on the Package Web Server. 
Created packages can be automatically downloaded from the Management Server by registering 
them on the Package Web Server. 

 
 When registering a package on the Package Web Server, perform operations after 

stopping the HTTP service. 
Example) •World Wide Web Publishing Service(IIS)  

• Apache Tomcat 
 

 Packages not registered on the Package Web Server cannot be automatically 
downloaded from the Management Server. 

 
(1) Click the PackageDescriber File menu -> Register in/Delete from the Package Web 

Server to display the Register in/Delete from the Package Web Server screen. 
Packages registered on the Package Web Server are displayed on the Register in/Delete 
from the Package Web Server screen. 
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Register in/Delete from the Package Web Server 

 Register/Re-regist

 

When you click the Register/Re-register button, the Local package list 
screen appears. Please see the procedure of item (2) regarding the Local 
package list screen. 

Delete The package is deleted from the Package Web Server. 
When you select the package you wish to delete and click the Delete 
button, a confirmation screen appears. To delete, click the Yes button. 
If the package selected for deletion is dependent on another package, the 
following confirmation screen appears. To delete, click Yes. Otherwise, 
click No. 

 
 
(2) When you click the Register/Re-register button, the Local package list screen appears. 

Click the Select Folder button and select a folder from the Open dialog box, and register or 
re-register the package on the Package Web Server. 

 

 



6 PackageDescriber 
 

DeploymentManager Ver6.0 Reference Guide 
408 

 
Local package list  
 Select Folder The folder of the package you wish to register or re-register can be 

selected and changed on the Local package list screen. Please see 
Section 6.3, "Modify/Delete Package," for details. 

Add When you select the package you wish to register and click the Add 
button, the package is copied to the Web Server folder and registered 
on the Package Web Server. 
It is also displayed on the Register in/Delete from the Package Web 
Server screen. 
When re-registering a package, if that package is dependent on 
another package, the following confirmation screen appears. To 
re-register, click Yes. Otherwise, click No. 

 
An error message will be displayed if the selected package does not 
exist. 

Cancel Click the Cancel button to end the operation and close the Local 
package list screen. 
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6.5. Online Update 
When a new service pack is released (for example, when SP3 was released for Windows Server 
2003), the OS definition file and language definition file must be updated and the new service pack 
information must be added in the supported OS information. 
PackageDescriber downloads the latest definition files from the DPM public website and updates 
them using the Online update function. 
By using this function, the correct information files can be created in patches and applications 
released in the future as well. 
The information for using this function (OS information URL column and Language information 
URL column) is currently blank. When this function becomes available, information will appear on the 
DPM product web page. 
 
The following describes how to perform online updates. 

 
(1) Select Start -> All Programs -> DPM PackageDescriber, and start PackageDescriber. 

 
(2) Click the PackageDescriber Help menu -> Online update to display the Online update 

screen, fill in each item, and click the Update button. 
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Online update 
 OS information URL Enter the public URL of the OS definition file. There is no 

need to change it from the default value. 
Language information URL Enter the public URL of the language definition file. There is 

no need to change it from the default value. 
Proxy (check box) Check this check box when accessing the DPM website via 

a proxy server. 
It does not have to be checked when connecting directly to 
the Internet. 

Proxy  Enter the address of the proxy server. Up to 259 
single-bytes can be entered. 
If you have checked the Proxy check box, the domain name 
or IP address must be entered. 

Port  Specify the port number of the proxy server. 
This can be set in the range of "1~65535". 

Update Download and save files from the entered OS information 
URL and language information URL. 

Save & Close Saves the OS information URL and language information 
URL to a file and Closes the screen. 

 
(3) Online update begins. 

The Description area of the Online Update screen becomes the Status area, which displays 
the status and results of online update. 

 
 If you do not know the proxy server and port number, please contact the administrator. 
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7. Other Tools 
 
 
 
 
 
 
 
 
 
 
This chapter explains the tools used in DPM. 
 
The items covered in this chapter are as follows: 
 
 
• 7.1 Port Opening Tool ....................................................................................................412 
• 7.2 Disk Configuration Check Tool ................................................................................415 
• 7.3 Automatic Update Status Display Tool ....................................................................424 
• 7.4 Scenario Option Setting Tool ...................................................................................426 
• 7.5 Backup Image File Verification Tool ........................................................................427 
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7.1. Port Opening Tool 
This Section describes the Port Opening Tool. 
The Port Opening Tool is a tool for opening ports used by DPM when the Windows firewall is on. Ports 
are automatically opened when DPM is installed. 
 

7.1.1. Port Number Setting 
For Management Servers and managed machines, refer to the Sections below regarding 
configuration of port numbers when firewall settings are in effect. 
 

• Management Server 
If firewall settings are in effect and management is performed by DPM, the following ports used by 
DPM are automatically opened. 

 
<The ports which are opened automatically> 

Item Protocol Port Number 
Ports used by DPM Server UDP 67 

UDP 69 
TCP/UDP 111 
TCP/UDP 2049 

UDP 4011 
TCP 56011 
TCP 56020 
TCP 56022 
TCP 56023 
TCP 56024 
TCP 56028 
TCP 56030 
TCP 56050 
TCP 56060 

 
<The ports which are not opened automatically> 
The following ports are not opened by Port Opening Tool automatically. 

Item  Protocol Port Number 
Ports used by DPM Server UDP 137(*) 

TCP 80 
*Only for using NetBIOS name resolution, please open the ports manually. 
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• Managed machines 

If the OS of the managed machine is any of the following and if firewall settings are in effect and 
management is performed by DPM, the following ports used by DPM are automatically opened. 

 
OS  Item Protocol Port Number 

Windows XP Professional SP2/SP3 
Windows Server 2003 SP1/SP2 
Windows Server 2003 R2 
Windows Server 2008 R2 
Windows Server 2008 
Windows Vista 
Windows 7 

Check Power Status ICMP 8 (Echo incoming) 

Remote Update TCP 56000 
UDP 56001 

Shutdown TCP 56010 

Automatic Update TCP 56025 

 
  When the services below are in the stopped state, ports cannot be opened by the Port 

Opening Tool. 
(On Windows Server 2003 SP1/SP2 or Windows Server 2003 R2, these services are 
disabled by default. Run the Port Opening Tool after starting the services.) 
・ Windows Firewall/Internet Connection Sharing(ICS) 
・ Windows Firewall 

 Using the DPM remote update function, the Port Opening Tool cannot be used on 
machines whose ports have not been opened. 
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7.1.2. Executing the Tool on Each Machine 
This Section describes how to use the Port Opening Tool of the Management Server and managed 
machines. 
 

(1) Insert the installation DVD into the DVD drive of the machine on which you wish to use the 
Port Opening Tool. 
 

(2) Run the Port Opening Tool as follows. 
 

D:\TOOLS\OPENPORT\DepOpnPt.exe 
(D: indicates the DVD drive.)  

 
 If -s is specified as a command option, it can be executed in silent mode without 

messages being displayed. 
Example) Execute the following command from the command prompt. 

D:\TOOLS\OPENPORT\DepOpnPt.exe –s 
(D: indicates the DVD-ROM drive.)  

 
(3) A confirmation screen appears. Click the OK button to open ports. 
 

 
 

Port opening is now completed. 
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7.2. Disk Configuration Check Tool 
This Section describes the Disk Configuration Check Tool. 
The Disk Configuration Check Tool checks the HDD configuration information (number of HDDs and 
partition configuration) of managed machines via the network. 
 

(The items that can be confirmed) 
• Number of HDDs 
• Partition configuration (file system, partition size) 
• Disk management method (basic/dynamic/GPT) 
• Disk number and partition number specified for backup/restore  

 
  When executing backup/restore, check the disk number of the HDD to be used by 

this function, and specify an appropriate value as the disk number of the 
backup/restore scenario. 

 In the default configuration of DiskViewer, all hidden partitions are not displayed. 
Therefore, the partition configuration on the managed machine displayed by the OS 
and by DiskViewer may differ. 

 The disk size and partition size displayed by DiskViewer and by the managed 
machine may differ. 

 
  When a Disk Configuration Check scenario is executed for a disk which has been 

converted to a dynamic disk from a basic disk on which partitions were not 
created, it is displayed by DiskViewer as a basic disk of 0GByte. 

 The disk configuration and partition configuration that can be checked by the Disk 
Configuration Check scenario has the same limitations as backup/restore. For 
details, see Section 3.1, "Executing Backup," in the Operation Guide. It does not 
result in a scenario execution error if disk or partition recognition fails due to this 
limitation. 

 

7.2.1. Creating a Disk Configuration Check Scenario 
There are two ways to execute the Disk Configuration Check scenario, as follows:  
 

• Use System_DiskProbe scenario which is already ready. 
In this case, use the existing System_DiskProbe by referring to Section 7.2.2, "Assigning a Disk 
Configuration Check Scenario."  

 
• Use a newly created disk configuration check scenario. 

In this case, create a new disk configuration check scenario by referring to Section 3.13.4, 
"Backup/Restore Tab."  

 
 A disk configuration check scenario cannot be specified with other than Options tab 

at the same time. 
Also, the Hidden Partition Is Disregarded setting in the Partition Setting of   
Backup/Restore Target of the Backup/Restore tab is invalid regardless of the 
setting on the screen. 
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7.2.2. Assigning a Disk Configuration Check Scenario 
The following describes how to assign the scenario. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource -> Machines -> Machine Group. 
 
(3) The Managed Machine List group box appears in the main window. Click Managed 

Machine to which the scenario is to be assigned. 
 
(4) In the Operation menu, click Assign Scenario. 

 
(5) The Assign Scenario screen appears in the main window. Assign the scenario created in 

Section 7.2.1, "Creating a Disk Configuration Check Scenario". Please see Section 3.8.3, 
"Assign Scenario." for details about Assign Scenario screen. 

 

 
 

 The System_DiskProbe scenario is stored in the Built-inScenarios scenario group. 
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7.2.3. Executing a Disk Configuration Check Scenario 
The following describes how to execute the Disk Configuration Check scenario. 
 
Please see Section 3.8.6, "Execute Scenario, "regarding how to execute the scenario. 
 
In the Scenario Execution List group box in the main window, when the Status column 
corresponding to the managed machine that executed the scenario indicates Scenario execution 
complete, the scenario is completed. 
 

 
 
The Disk Configuration Check scenario results are stored in the following folder. 
 
    Storage Folder: <Folder for Image>\probe 
    file name   : probe_MAC Address.log 

                 * The MAC address is that of the LAN board on the target machine. 
 

Example) C:\Deploy\probe\probe_001122334455.log 
The Folder for Image can be set from Management view – DPM Server – 
Configuration menu – Detail Setting. Please see Section 2.7.1.1, " 
"General" Tab, "regarding the screen. 

 
 If the power of the managed machine is on when you attempt to execute the scenario, the 

scenario will not run. If this happens, perform one of the following operations:  
• On the Edit Scenario screen, place a checkmark next to Forced Execution Of A 
Reboot Is Performed Before Execution in the Scenario Execution Option Setting 
group box on the Option tab. 

* If the Windows managed machine has the following status, you cannot restart, 
even if you enter a checkmark next to Forced Execution Of A Reboot Is 
Performed Before Execution. 

- The machine is locked by a workstation lock 
- The machine is locked by a password protected screensaver 
- The machine is connected from a remote desktop, terminal service, or 

other remote connection software 
- The machine has data that is currently being edited or an application that 

will not respond to a shutdown request 
• Reboot the managed machine manually. 
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 Even if the following message appears on the screen of the target machine, there is no 
problem in operation. 
"ERROR:  Cannot find the corresponding disk(X)." 

* X contains one or more numerals. 
 

7.2.4. Checking the Disk Configuration Check Scenario 

Execution Results 
This Section describes how to check the Disk Configuration Check scenario execution results. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> Machine group for checking disk 

configuration check scenario execution results. 
 

(3) The Machine List group box appears in the main window. Check the execution results of 
the disk configuration check scenario from Status. 

 
 When you click the Status column, the Monitor view – Scenario Execution List group 

box appears. Please see Section 4.3, "Scenario Execution List" regarding the screen. 
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7.2.5. Checking the Disk Number (Partition Number) by 

DiskViewer 
This Section describes how to check the disk number (partition number) by DiskViewer. 

 
(1) From the Start menu, select All Programs -> DeploymentManager -> DiskViewer. 

 
 When DiskViewer reads a file, it retains the content. For this reason, if a file has been 

read, the disk number (partition number) of the file read the previous time appears 
when DiskViewer starts up. 

 
 
 

 
 

Item Descriptions 
Menu bar Reads and saves log files, switches between disk 

list/partition list display, and switches to hidden partition 
display. 

Disk list  Displays the disk list of the target machine. 
Disk list/Partition list Displays a disk list or a partition list of the disk selected on 

the disk list on the top of the screen. 
 

(2) After starting DiskViewer, click File menu -> Read. 
 

Menu Bar 
 

Disk List 
 

Disk List / Partition List 
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(3) Open the disk information file stored in the folder below. 

 
Storage folder: <Folder for Image>\probe 
 

 
 

(4) When the selected disk information file is read, the disk number (partition number) of the 
managed machine is displayed. 

 

 
 

(5) On the Display menu of DiskViewer, click List of Partitions. 
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(6) The partition list of the disk selected on the disk list appears on the bottom of the screen. 

 

 
 

(7) From the information displayed in the disk size, partition size and partition list, compare the 
disk numbers and partition numbers that are subject to backup/restore. 

 
 In DPM DiskViewer, partition numbers are allocated in the following order. 

It may differ from the display order of partitions displayed by Windows Disk Management. 
• Primary partition 
• Extended partition logical drive  
 

Example) Disk device is as below 

Primary 
partition (C:) 

Extension partition 
Primary 
partition (F:) 

     
 Partition Partition Partition Partition 
 no. 1 no. 3 no. 4 no. 2 

 
 
 

The DiskViewer display is as below 
     Partition 1  Partition 2  Partition 3  Partition 4  

Primary 
partition (C:) 

Primary 
partition (F:) Logical drive (D:) Logical drive (E:) 

 

 

Logical drive (D:) Logical drive (E:) 
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(8) Based on the results of comparison, check the disk numbers and partition numbers in the 

Backup/Restore scenarios. 
 

Example) 
When checking the disk numbers and partition numbers in the Backup scenario 

 

 
 
 
 
 

 

The number assigned to the partition number 
(1~1000) for the scenario file.  
 

The number assigned to the disk number (1~1000) for the scenario file.  
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  The number specified in partition Number may differ depending on the contents 

set in Operation view -> Add Scenario screen -> Backup/Restore tab –> 
Backup/Restore Target group box. To check the partition number specified, 
switch between display/non-display of hidden partitions from DiskViewer Display 
menu -> A hidden partition is disregarded. 

 The results displayed by DiskViewer can be saved in a separate file. The saved file 
can also be read in again. 
To save a file, click Save from the File menu of DiskViewer. The Save As screen 
appears. Specify the save location and file name. 

 
 
<Folder for Image>\Probe\Probe.dat is a file written as a temporary file in 
DiskViewer. Do not specify it for reading. 
The extension of the saved file is automatically set to .dat. 

 
(9) To close the DiskViewer, click Exit from the File menu of DiskViewer, or click the x button 

on the top right of the window. 
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7.3. Automatic Update Status Display Tool 
The Automatic Update Status Display Tool displays the automatic update status as an icon in the 
task tray of the managed machine. 
 

 This function is not compatible with managed machines in the following environments. 
・ x64 Edition(Windows Server 2003/Windows XP only) remote desktop 
・ Windows Server 2008(Server Core Install) 
・ Linux OS 

 
The icons displayed in the task tray are shown in the table below. 
 

Icon Managed Machine Status Description 

  

Ready This appears when automatic update and scenario 
execution are not being performed. (The icon at left 
also appears when there is a scenario execution 
error. 

 

Automatically Updating This appears after automatic update begins, while 
the package to be applied is searched for and 
judged. 

Transferring Automatic 
Update File  

This appears when transferring an automatic 
update file to a managed machine. 

Confirming Automatic 
Update User  

This appears when the Run Immediately or Run 
at Next Start Up dialog box appears. 

Waiting for Automatic 
Update Restart  

This appears under any of the following conditions:  
• Waiting for restart after Execute At Next Start 

Up is set 
• Waiting for restart after Cancel button is clicked 

in Restart dialog 
Applying an Automatic 
Update Package 
(Package ID) 

This appears when applying an automatic update 
package. 
The package ID is also displayed. 

Running Scenario  This appears when a scenario is running. 

 

Automatic Update Error  
This appears when an error has occurred in the 
automatic update. 

 
 A popup hint appears when you hover over an icon with the mouse pointer. 

 
The menu of the Client Setting Tool and About DeploymentManager can be used by 
right-clicking an icon. 
Refer to Section 7.3.1, "Client Setting Tool," through Section 7.3.2, "About DeploymentManager," 
regarding these menus. 
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7.3.1.  Client Setting Tool 

Configure display/non-display of the Automatic Update Status Display Tool. 
 

(1) Right-click the Automatic Update Status Display Tool icon. 
 

(2) Select Client Configuration from the displayed menu to display Client Setting Tool. 
Or, from the Start menu, select All Programs -> DeploymentManager -> Client Setting 
Tool to display the Client Setting Tool. 

 
(3) Configure whether or not to display the Client Automatic Update Status Display Tool icon, 

and click OK. 
 

 
 

7.3.2. About DeploymentManager 

The version of the DPM Client being used can be checked from the About DeploymentManager 
screen. 
The About DeploymentManager screen will be displayed if you right-click the Automatic Update 
Status Display Tool icon and select About DeploymentManager. 
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7.4. Scenario Option Setting Tool 
To do a full sector backup of all of the data on the disk, set the full sector option in the scenario option 
setting tool (SnrOpEdt.exe). 
The Scenario Option Setting Tool is stored in the DPM Server installation folder. The default 
installation folder of DPM Server is C:\Program Files\NEC\DeploymentManager. 
 
Start it up by opening the installation folder in Explorer and double-clicking it directly. 
When SnrOpEdt.exe is started up, the Backup/Restore Scenario list appears for each disk. 
Select the scenario for which you wish to configure (or cancel) scenario options, and change the 
configuration by double-clicking. 
Changes are reflected instantly. When making changes, check that the scenario is not running. 
 

 In a backup scenario with the full sector option, the entire content of the disk is backed up. As 
a result, there will be no compression or the compression rate will be low, and the backup 
image size may be the same size as the disk size being backed up. 

 
 It may be necessary to set the full sector option depending on the disk to be backed up. 

See the following regarding the full sector option setting pattern. 
・ Section 1.2.1, "Backup/Restore," in the First Step Guide. 
・ Appendix A, "Support Tables Support for Managed Machine OS's" in the First Step Guide 
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7.5. Backup Image File Verification Tool 
The Backup Image File Verification Tool is for checking before restoring whether a backup file is 
incorrect and can be restored correctly. 
This Section describes how to use the Backup Image File Verification Tool. 
 
(1) From the Start menu of the DPM Server, select All Programs -> DeploymentManager -> 

Backup image file verification tool. 
 
(2) The following screen appears. Select Refer, select the backup file you wish to check, and click 

the Verify button. 
 

 
 

(3) A Progress screen appears, and the backup file check begins. Please wait a moment. 
To interrupt the process, click the Stop button. 

 

 
 

When you click the Stop button, a confirmation dialog box appears. To interrupt, click Yes. Click 
No to return to the Progress screen. 
 
If you click the Yes button of the confirmation dialog box, the following screen appears. Click the 
OK button. 
 

 
 

(4) When checking of backup files is finished, A dialog box appears. Click the OK button. 
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This Section explains DPM Command Line. 
 
 
• 8 Command Reference ...............................................................................................431 
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8. Command Reference 
 
 
 
 
 
 
 
 
 
 
This chapter explains command lines used by the DPM. 
 
The items covered in this chapter are as follows: 
 
 
• 8.1 Operation from the Command Line .........................................................................432 
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8.1. Operation from the Command Line 
Using the DPM Command Line (dpmcmd.exe), you can view managed machine information, execute 
scenarios, and perform other tasks from the command line instead of the Web Console. Supported 
command options are described in the table below. 
 
 Following is an explanation of how to execute commands from the command line: 

 
(1) Start the command prompt from the machine where DPM Server or DPM Command Line is 

installed. 
 

(2) On the command prompt, move to the directory where DPM Command Line is installed. 
 

(3) Specify dpmcmd.exe and the options listed in the table below, and then execute. 
 

Options Function 
srvlist Displays the DPM Server. 
clilist Displays the managed machine List, managed machine Details. 
snrlist Displays the Scenario List. 
powon Powers On. 
shutdown Shuts down . 
assign Assigns Scenario/Remove Scenario Assignment. 
snrexec Executes Scenario. 
snrstop Interrupts the Scenario Execution. 
progress Displays the Scenario Execution Status. 
stsclear Clears the Status. 
cliadd Registers managed machines. 
cliremove Deletes managed machines. 
?, /?, /help Displays Help. 

 
 The default install destination is: 

<System drive> :\Program Files\NEC\DeploymentManager  
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 The command parameters are explained below. 

 
Parameter Meaning 
DPM Server 
(Specification 
required) 

Specify a DPM Server IP address or DPM Server DNS name. 

DPM Server (2) Specify a DPM Server IP address or DPM Server DNS name. 
These parameters may be omitted for DPM Ver6.0 or later. If dpmcmd was used 
for .bat or other files in versions prior to Ver6.0, it is not necessary to change 
settings before use. 

Managed 
Machine (Client) 
Machine Name or 
/M MAC Address 
(Specification 
required) 

Specify the managed machine (client) machine name, or the MAC address. 
In this Section's command descriptions, locations which must be specified as 
either Managed Machine (Client) or /M option appear as: /M MAC Address | 
Managed Machine (Client). 
Example) /M "00-03-ff-00-65-11" 

"ComputerName" 
 

Scenario 
(Specification 
required) 

Specify the scenario name for the scenario registered to the DPM Server. 

Password 
(Specification 
required) 

Specify a password for the deployment_user registered to the DPM Server. The 
initial password is "dpmmgr". 

/P Web Port Specify the http/https port (0 – 65535) used by the DPM Server (IIS). 
If this option is omitted, the ports below are used. 
・ If /S is not specified -> IIS default 80 
・ If /S is specified -> IIS default 443 

Specification not required. 
/S HTTPS Specify to communicate by HTTPS. 

If this option is omitted, communication by HTTPS does not occur. 
This parameter may be omitted. 

/W Wait Time Specify to wait for scenario execution to complete. 
The command exits if scenario execution completes within the specified time, or 
a scenario execution error occurs, or the specified time is exceeded. 
Specify 0 – 360 (unit: minutes) for Wait Time. 
If 0 is specified, the command waits indefinitely for scenario execution to 
complete. If this option is omitted, the command exits immediately. 
This parameter may be omitted. 

/NAME Managed 
Machine (Client) 
Name 

Specify a managed machine (client) machine name to register to the DPM 
Server. 
Up to 63 single-bytes may be entered. 
You may not enter managed machine (client) names containing only numerals 
or any of the symbols/ single-byte spaces below: 
. , ; ` ~ % ! @ # $ ^ & * = + { } \ | : ' " < > / ? [ ] 
This parameter may be omitted. 
If registering a machine, you can specify this parameter and Managed Machine 
(Client) Machine Name or /M MAC Address simultaneously. 
At this time, you can specify both the machine name and MAC address. 
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/G Group Name 
(Specification 
required) 

Specify the group name corresponding to the specified managed machine 
(client). 
Up to 64 single-bytes may be entered. The following symbols cannot be 
entered: 
; # 

/F This option is specified to check whether a group specified by /G exists and add 
a group. 
・ If there is not a group specified by /G ->a group is added. 
・ If there is a group specified by /G -> a group is not added, and the machine 

is added to an existing group. The group's network settings are not changed. 
This parameter may be omitted. 

/GW default 
gateway 

Specify when setting the default gateway of the group registered to the DPM 
Server. 
・ If /F is not specified, can not specify. 
・ If group network settings and the DPM Server have the same subnet mask, 

can not specify. 
This parameter may be omitted. 

/MASK Subnet 
mask 

Specify when setting the subnet mask of the group registered to the DPM 
Server. 
・ If /F is not specified, can not specify. 
・ If group network settings and the DPM Server have the same subnet mask, 

can not specify. 
This parameter can be omitted. 

 
 To specify a parameter that includes spaces, such as a DPM Server name or scenario 

name, please enclose them in double quotation marks ("). 

 
  Parameters that do not need to be specified appear enclosed by square brackets 

("[" and "]") in the command descriptions of this Section. 
 If a command successfully executes, the return value is "0". 
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8.1.1. DPM Server Display 

Displays the specified DPM Server's IP address and machine name. Command details are listed in 
the table below. 

 
Command dpmcmd.exe DPM Server srvlist [/S] [/P Web Port] 
Function  Obtains and displays the DPM Server IP address and machine name. 
Results Display Normal Displays the DPM Server IP address and DPM Server name. 

Abnormal Displays error message. 
 

8.1.2. Display Managed Machine List and Managed Machine 

Details 

Display a list of information regarding the managed machine (client) registered to the specified DPM 
Server or details about the specified managed machine (client). Command details are listed in the 
table below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] clilist [/S] [/P Web Port] 
Function  Displays all machine information (machine name/ MAC address/ power status/ 

status/ assigned scenario) under the specified DPM Server. 
Results Display Normal Display managed machine (client) information in a list. 

Abnormal Display error message. 
 

Command dpmcmd.exe DPM Server [DPM Server (2)] clilist [/S] [/P Web Port] /M MAC 
Address | Managed Machine (Client) 

Function  Displays information (machine name/ OS name/ service pack/ assigned 
scenario/ managed machine (client) status/ UUID/ MAC address) for the 
specified machine. If the specified managed machine (client) does not exist, 
an error is displayed. 

Results Display Normal The details for the specified managed machine (client) are 
displayed. 

Abnormal Displays error message. 
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8.1.3. Display Scenario List 

Displays a scenario list. Command details are listed in the table below. 
 

Command dpmcmd.exe DPM Server [DPM Server (2)] snrlist [/S] [/P Web Port] 
Function  Displays all scenario information under the specified DPM Server. 
Results Display Normal A scenario list is displayed. 

Abnormal Displays error message. 
 

 Scenario configuration information is as follows: 
・ HW -> HW image 
・ OS -> OS clear install 
・ SP -> Service pack/ HotFix/ Linux patch file  
・ PP -> Application 
・ BK -> Backup 
・ RS -> Restore 
・ DC -> Disk Configuration Check 

 
For each scenario, "1" is displayed if setting items are specified, and "0" is displayed if not. 
Example) 

 

 

8.1.4. Power On 

Turns on the power of the specified managed machine (client). Command details are listed in the 
table below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] powon [/S] [/P Web Port] /M MAC 

Address | Managed Machine (Client) Name  Password 
Function  Turn on the power of a specified machine. 

If the specified managed machine (client) or password is incorrect, an error is displayed. 
Results 
Display 

Normal Nothing is displayed. 
Abnormal Displays error message. 

 

 C:\>dpmcmd 192.168.32.1 snrlist 
 Scenario Name Specified Function 

HW OS SP PP BK RS DC 

--------------------------------------------------------- 

 Scenario 01    1  0  0  0  0  0  0 

 Scenario 02   1  1  1  0  0  0  0 

 Scenario 03   1  1  0  1  1  0  0 

 Scenario 04   0  0  0  0  1  0  0 

 Scenario 05   0  0  0  0  0  1  0 

 Scenario 06   0  0  0  0  0  0  1  
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 Managed machines in the following statuses cannot be turned on. Please re-execute 

after performing 8.1.10 Status Clear. 
・ Scenario Execute Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 

 

8.1.5. ShutDown 

Shuts down the specified managed machine. Command details are listed in the table below. 
 

Command dpmcmd.exe DPM Server [DPM Server (2)] shutdown [/S] [/P Web Port] /M MAC 
Address | Managed Machine (Client) Name  Password 

Function  Shuts down the specified machine. 
If the specified managed machine (client) or password is incorrect, an error is 
displayed. 

Results 
Display 

Normal Nothing is displayed. 
Abnormal Displays error message. 

 

  managed machines in the following statuses cannot be shut down. Please re-execute 
after performing 8.1.10 Status Clear. 
・ Scenario Execute Stop   
・ Scenario Execution Error  
・ Remote Power ON Error  

For Scenario Executing, please wait until the scenario completes and then execute. 
 On the Web Console, the power status of managed machines controlled by 

DianaScope is on at the moment the power is turned on. 
However, if a shutdown command is executed in the time after OS startup and before 
the DPM Client startup, an error occurs and shutdown fails. 
Please ensure the managed machine's OS is running before executing a shutdown 
command. 
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8.1.6. Assign Scenario/Remove Scenario Assignment 

Assigns scenario and remove scenario assignment for the specified managed machine. Command 
details are listed in the table below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] assign [/S] [/P Web Port] /M MAC 

Address | Managed Machine (Client) Name  Password  Scenario 
Function Assigns a specified scenario to a specified managed machine (client). 

If the specified managed machine (client), scenario, or password is incorrect, an error 
is displayed. 

Results 
Display 

Normal Nothing is displayed. 
Abnormal Displays error message. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] assign [/P Web Port] /U Managed 

Machine (Client) | /M MAC Address  Password  
Function Removes the assigned scenario from the specified managed machine (client). 

If the specified managed machine (client) or password is incorrect, an error is 
displayed. 

Results Display Normal Nothing is displayed. 
Abnormal Displays error message. 

 
 managed machines in the following statuses cannot assign or remove a scenario. Please 

re-execute after performing 8.1.10 Status Clear. 
・ Scenario Execute Stop   
・ Scenario Execution Error  
・ Executing Remote Update 
・ Remote Power ON Error  

For Scenario Executing, please wait until the scenario completes and then execute. 
 

8.1.7. Execute Scenario 

Executes scenario for the specified managed machine. Command details are listed in the table 
below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] snrexec [/S] [/P Web Port] [/W Wait Time] /M 

MAC Address | Managed Machine (Client) Name  Password 
Function  Executes the assigned scenario for the specified managed machine (client). 

If the specified managed machine (client) or password is incorrect, an error is displayed. 
If there is no scenario assigned to a specified managed machine (client), an error is displayed. 

Results 
Display 

Normal If /W option is specified, the scenario execution results are displayed on the 
screen. 
If /W option was not specified, nothing is displayed. 
If results are not returned within the time specified in /W option, Scenario 
Executing is displayed. 

Abnormal Displays error message. 
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 managed machines in the following statuses cannot execute scenarios. Please re-execute 
after performing 8.1.10 Status Clear. 
・ Scenario Execute Stop   
・ Scenario Execution Error  
・ Executing Remote Update 
・ Remote Power ON Error  

For Scenario Executing, please wait until the scenario completes and then execute. 
 

8.1.8. Interrupt Scenario Execution 

Interrupts execution of a scenario for a specified managed machine. Command details are listed in 
the table below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] snrstop [/S] [/P Web Port] /M MAC 

Address | Managed Machine (Client) Name  Password 
Function  Interrupts the execution of a scenario on the specified managed machine (client). 

If the specified managed machine (client) or password is incorrect, an error is 
displayed. 
If the status of the specified managed machine (client) is not executing scenario, an 
error is displayed. 

Results Display Normal Nothing is displayed. 
Abnormal Displays error message. 

 
 Scenario execution cannot be interrupted on managed machines in the following statuses. 

・ Non-executable scenario statuses 
・ Scenario Execute Stop   
・ Remote Power ON Error  
・ Scenario Execution Error  

 

8.1.9. Display Scenario Execution Status 

Displays scenario execution status for the specified DPM Server. Command details are listed in the 
table below. 

 
Command dpmcmd.exe DPM Server [DPM Server (2)] progress [/S] [/P Web Port] 
Function  Displays the name of the managed machine (client) executing a scenario, the 

scenario name, and percentage rate of progress. 
Results Display Normal Displays the scenario execution status. 

Abnormal Displays error message. 
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8.1.10. Status Clear 

Clears the specified managed machine error. Command details are listed in the table below. 
 

Command dpmcmd.exe DPM Server [DPM Server (2)] stsclear [/S] [/P Web Port] /M MAC 
Address | Managed Machine (Client) Name 

Function  Clears the specified managed machine (client) error. 
If the specified managed machine (client) name is incorrect, an error is displayed. 

Results Display Normal Nothing is displayed. 
Abnormal Displays error message. 

 
 An error status indicates one of the states below. 

・ Remote Power ON Error  
・ Scenario Execution Error  
・ Scenario Execute Stop   

 

8.1.11. Managed Machine Registration 

Registers the specified managed machine. Command details are listed in the table below. 
 

Command dpmcmd.exe DPM Server [DPM Server (2)] cliadd [/S] [/P Web Port] /M MAC 
Address [/NAME Managed Machine (Client) Name]/G Group Name [/F /GW 
Default Gateway/ MASK Subnet Mask] [/ASSIGN Scenario Name] Password 

Function  Registers the specified managed machine (client). 
If the specified managed machine (client) or password is incorrect, an error is 
displayed. 
If the specified scenario is not registered to the DPM Server, an error is displayed. 

Results Display Normal Nothing is displayed. 
Abnormal Displays error message. 
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8.1.12. Delete Managed Machine 

Deletes the specified managed machine (client). Command details are listed in the table below. 
 

Command DPM Server [DPM Server (2)] cliremove [/S] [/P Web Port] /M MAC Address 
| Managed Machine (Client) Name Password 

Function  Deletes the specified managed machine (client). 
If the specified managed machine (client) or password is incorrect, an error is 
displayed. 

Results Display Normal Nothing is displayed. 
Abnormal Displays error message. 

 
 Machine Delete cannot be performed for clients in the following statuses: 

・ Scenario Execute Stop 
・ Remote Power ON Error 
・ Scenario Execution Error 
・ Automatic Update In Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

For Scenario Executing, please wait until the scenario completes and then execute. 
 

8.1.13. Help 

Displays Help. Command details are listed in the table below. 
 

Command dpmcmd.exe ? 
dpmcmd.exe DPM Server [DPM Server (2)] /? 

Function  Displays Help. 
Results Display Normal Displays Help. 

Abnormal ―― 
 
 

 Detailed help information for a command can be displayed if a help command is added to the 
end of that command. 
・ srvlist 
・ clilist 
・ snrlist 
・ powon 
・ shut down 
・ assign 
・ snrexec 
・ snrstop 
・ progress 
・ stsclear 
・ cliadd 
・ cliremove 
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9. Maintenance 
 
 
 
 
 
 
 
 
 
 
This chapter explains information about the maintenance of DPM. 
 
The items covered in this chapter are as follows: 
 
 
• 9.1 Changing the Management Server IP Address .......................................................446 
• 9.2 Changing a Managed Machine's IP Address ..........................................................449 
• 9.3 Notes for Machines Mounted with Multiple LAN Cards ...........................................450 
• 9.4 Device and Storage Notes .......................................................................................451 
• 9.5 Data Backup Plan ....................................................................................................453 
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9.1. Changing the Management Server IP 
Address 

Explains the procedure to change the IP address of the Management Server after DPM Server is 
installed while the DPM is operating. 
 

 If procedures are not followed properly, the DPM Server cannot operate normally. 
When changing the IP address and network configuration at the same time, see Section 
3.5.1, "Edit Machine Group" to modify the Network Setting of each group. 

 
 If ANY is selected under IP Address on the Web console's Management View -> DPM Server 

icon -> Detail Setting screen -> General tab 
 

(1) Close all DPM related processes. 
 

(2) Change the Management Server IP address. 
 

(3) Restart the Management Server. 
 

(4) On the Web Console, shut down or execute a remote update scenario for all machines that 
are registered in the DPM Server whose IP addresses were changed. 

 
 If an option other than ANY is selected under IP Address on the Web console's Management 

View -> DPM Server icon -> Detail Setting screen -> General tab 
 

(1) Close all DPM related processes. 
 
(2) Insert the install media in the Management Server's DVD drive. 
 
(3) Execute the following files located on the install media. 

 

 For SSC product: IA32:<Install Media>:\DPM\TOOLS\IP\IA32\RegSet1.reg 
EM64T:<Install Media>:\ DPM\TOOLS\IP\AMD64\RegSet1.reg 

For DPM unbundled product:IA32:<Install Media>:\TOOLS\IP\IA32\RegSet1.reg 
EM64T:<Install Media>:\TOOLS\IP\AMD64\RegSet1.reg 

 
(4) The following screen appears. Click Yes. 

 

 

. BIOS/HWのアップデート 
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(5) The following screen appears. Click the OK button. 

 

 
 

(6) Change the Management Server IP address. 
 

(7) Restart the Management Server. 
 
(8) Select the IP address to be used by the Management Server from IP Address on the Web 

Console Management View -> DPM Server icon -> Detail Setting screen -> General tab, 
and then configure. 

 

 Please be sure to click the OK button on the Detail Setting screen. If you do not do, the 
Management Server may not operate properly. 

 
(9) Insert the install media in the Management Server's DVD drive. 

 
(10) Execute the following files located on the install media. 

 

 For SSC products: IA32:<Install Media>:\DPM\TOOLS\IP\IA32\RegSet2.reg 
EM64T:<Install Media>:\ DPM\TOOLS\IP\AMD64\RegSet2.reg 

For DPM standalone products:  IA32:<Install Media>:\TOOLS\IP\RegSet2.reg 
EM64T:<Install Media>:\TOOLS\IP\AMD64\RegSet2.reg 

 
(11) The following screen appears. Click the Yes button. 
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(12) The following screen appears. Click the OK button. 

 

 
 

(13) On the Web Console, shut down or execute a remote update scenario for all machines that 
are registered in the DPM Server which IP address was changed. 
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9.2. Changing a Managed Machine's IP 
Address 

If a managed machine's IP address is changed, the Management Server is notified automatically. No 
further action is necessary. 
However, when changing Management Server's IP address and managed machine's IP address at 
the same time, the Management Server is not notified automatically. In this case, see "DPM Client 
upgrade by install media" in Section 3.3.2, "Manually Upgrading the DPM Client" in the Installation 
Guide to reset the Management Server's IP address. 
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9.3. Notes for Machines Mounted with 
Multiple LAN Cards 

Configure the BIOS startup order so that only a LAN board managed by the DPM is set to positions 
higher than the HDD, and all other LAN boards are set to positions lower than the HDD. If a LAN 
board, which DPM does not manage, is set to be higher than HDD, problems such as scenario 
execution error may occur. 
 



Device and Storage Notes 
 

Part IV Maintenance Information 
451 

 

9.4. Device and Storage Notes 
9.4.1. Compatibility Module 
A compatibility module is an update module that enables the machine model not supported by the 
bundled Deploy-OS to be used as managed machines. 
For notes about the compatibility module, please contact your sales or support representative. 
 

9.4.2. HDD Multi-Vendor Support 
Even if two machines have the same product name, products from two different vendors may be 
mounted to the built-in HDDs. Thus, even if the same model is released in the same time by different 
manufacturers, the mounted HDD may have a different disk size. Typical cases are illustrated below. 
 

 If Company A calculates 1GByte as 1000MByte and Company B calculates 1 GByte 
as 1024MByte for the same disk sold as 30GByte, the following discrepancy occurs: 
 

30GByte HDD 

Company A 30,000 MByte (30×1000) 

 

Company B 30,720 MByte (30×1024) 
 

 
DPM does not support restore for HDD of a different size when operating the back-up. However, DPM 
is able to restore some different sized HDDs to accommodate devices with multi-vendor support. 
Since all devices are not supported, it is recommended that you evaluate carefully before using. 
 

 Restorable HDDs of a different size than at backup are limited to: 
・ Disks larger than at the time of backup. 
・ Backup when the entire disk is specified. 
・ Only those configured as basic disks. 
・ NTFS file system only. 
・ For other notes, see Section 2.2.2, "Regarding Backup/Restore,"  

in the First Step Guide. 
 

720MByte 
discrepancy 
  

 



9 Maintenance 
 

DeploymentManager Ver6.0 Reference Guide 
452 

 
In the event that devices eventually have multi-vendor support, it is recommended you do either of the 
following in advance. Note that the disk must be configured as a basic disk. 
 
<Provision 1> 

If the devices are supported by multi-vendor, operate the backup from the smallest disk. 
<Provision 2> 

Considering for the possibility of changing to multi-vendor support in the future, create small 
partitions, set the remainder as "Unassigned", and execute a backup. 

 

C:NTFS D:NTFS Unassigned 
 
 
 
 
 

C:NTFS D:NTFS Unassigned 
 

 It is recommended that you create unassigned area with the margin of about 10% of the total 
space area, in addition to the 24MByte (1024-1000) difference per 1GByte as described 
above. 

 

Since unassigned area is not the target of backup, if actual 
partitions (in this example, C: and D:) are of a size that can be restored, 
it is possible to restore to a small disk. 
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9.5. Data Backup Plan 
9.5.1. Backing up Data of DeploymentManager When 

Configuring the Initial Setup or Changing the 

Configuration 
Please make notes of the following data when configuring or registering to the DPM Server. 
 

 There is no need to re-collect unless settings are changed. 

 
 Folder for Backup Image Path 

The value set for Folder for Backup Image under Image Setting, selected on the Web 
Console Management view -> DPM Server -> Detail Setting -> General tab 

 
 Folder for Image Path 

The value set for Folder for Image under Image Setting, selected on the Web Console 
Management view -> DPM Server -> Detail Setting -> General tab 

 
 DPM Server Setting Value 

The IP address displayed under Server Information on the Web Console 
Management view -> DPM Server -> Detail Setting -> General tab 

 
 User Information Registered to the DPM Server 

The value set for username/password and other fields on the User List screen after the 
User icon is clicked in the Management tree view on the Web Console. 
(Save the 2 files below to a desired folder.) 

<DPM Server Install Folder>\WebServer\App_Data\Data  
-Encypted.dat 
-DpmProfile.xml 

 
 Other 

Save the settings that you have changed manually such as files and registries. 
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9.5.2. Backing Up the Updated Data of DeploymentManager 
The following explains the procedure to back up data updated as the following operations are 
performed during DPM operation. 
Perform a backup on a machine installed with DPM Sever. 
・ Adding/Deleting of managed machines 
・ Creating/Editing/Deleting of packages 
・ Creating/Editing/Executing/Deleting of scenarios 
 

(1) Log in to the machine as a user with Administrator authority. 
 

(2) Close all DPM related processes. 
 

 Please ensure that all of the processes below are completed. 
・ No scenario is running (If a scenario is running, please wait until the scenario 

completes.) 
・ DPM Web Console (all types of DPM tools) and other processes of DPM are 

not running 
 

(3) Select Start menu -> Control Panel ->Administrative Tools -> Services, and then open 
the Service screen. Stop all services which names begin with "DeploymentManager" on 
the service list. Select a service name and click Stop Service. 

 
(4) Perform a backup of the DPM Server data. 

Backup all of the files contained in the folders below. 
・ <DPM Server Install Folder>\Datafile  
・ <DPM Server Install Folder>\PXE\Images 
・ <DPM Server Install Folder>\Linux 
・ <DPM Server Install Folder>\Log  

 
  The default install folder of the DPM Server is: 

C:\Program Files\NEC\DeploymentManager 
 Please make note of the DPM Server's install folder path when restoring back 

up data to a reconfigured DPM environment. 
 

・ Folder for Image 
 

 Check the Folder for Image on the Web Console at Folder for Image under Image 
Setting, selected from Management view -> DPM Server -> Detail Setting -> 
General tab. The default location of Folder for Image C:\Deploy. 

 
・ Folder for Backup Image 

 
 Check the Folder for Backup Image at Folder for Backup Image under Image 

Setting, selected from the Web Console Management view -> DPM Server -> 
Detail Setting -> General tab. The default location of Folder for Backup Image 
C:\DeployBackup. 
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(5) Backup the database. 

Enter the backup command below at the command prompt, and then extract backup file 
(DPM.bak). 
 

osql.exe -E -S localhost\DPMDBI 
BACKUP DATABASE DPM 
TO DISK='DPM.bak' 
WITH INIT 
GO 

 
 In the database, values of the following parameters used as fixed values: 

 Instance name: DPMDBI 
 Database name: DPM 
A backup file (DPM.bak) is created in the folder below: 
<Microsoft SQL Server's Install Folder>\Backup 
The default value of <Microsoft SQL Server's Install Folder> 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI\MSSQL 

 
(6) Perform a registry data backup. 

Execute the following commands at the command prompt and extract the registry data 
backup file (RegExportDPM.reg). 
(The following command is written in 2 lines due to notation but enter it in the one line.) 
 
・ For IA32: 

regedit /e RegExportDPM.reg "HKEY_LOCAL_MACHINE\SOFTWARE\NEC 
\DeploymentManager" 

・ For EM64T: 
regedit /e RegExportDPM.reg "HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node 
\NEC\DeploymentManager" 

 
 RegExportDPM.reg will be created in the folder where the command is executed. 

 
(7) Start all services that were stopped in step (3). 

 
The backup of data updated during the DPM operation is now completed. 
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9.5.3. Restoring Backup Data 
Follow the procedures below to restore data that was backed up as described in Section 9.5.1, 
"Backing up Data of DeploymentManager When Configuring the Initial Setup or Changing the 
Configuration" or Section 9.5.2, "Backing Up Updated Data of DeploymentManager". 
 
(1) Log in to the machine as a user with Administrator authority. 

 
(2) Follow the procedures listed in the Installation Guide to install the DPM. 

For an environment already installed with DPM, these procedures are not necessary to restore 
data. Proceed to (3). 

 
 Specify the path you made note of (4) in the Section 9.5.2, "Backing Up Updated Data of 

DeploymentManager" as the DPM install path. 
 
(3) Set the IP address that you noted in "DPM Server Setting Value" in Section 9.5.1, "Backing up 

Data of DeploymentManager When Configuring the Initial Setup or Changing the 
Configuration" to the Web Console Management view -> DPM Server -> Detail Setting -> 
General tab- Server Information. 

 
(4) Select Management view -> DPM Server -> Detail Setting -> General tab on the Web 

Console and set the Folder for Image of the Image Setting by the folder you noted in 
"Folder for Image path" in Section 9.5.1, "Backing up Data of DeploymentManager When 
Configuring the Initial Setup or Changing the Configuration". 

 
(5) Select Management view -> DPM Server -> Detail Setting -> General tab on the Web 

Console and set the Folder for Backup Image under Image Setting by the folder you noted of 
in Folder for Backup Image path under Section 9.5.1, "Backing up Data of 
DeploymentManager When Configuring the Initial Setup or Changing the Configuration". 

 
(6) Stop all services whose names begin with "DeploymentManager" from the Start menu -> 

Control Panel -> Management Tools -> Service. 
 
(7) Overwrite the backup of the DPM Server that had been collected in step (4) of Section 9.5.2, 

"Backing Up Updated Data of DeploymentManager" 
 
(8) Start the command prompt, and then execute the command below. (This command overwrites to 

the same folder path used during backup of the database backup file (DPM.bak) from which data 
was extracted in step (5) of Section 9.5.2, "Backing Up Updated Data of DeploymentManager"). 

 
osql -E -S localhost\DPMDBI 
RESTORE DATABASE DPM 
FROM DISK = 'DPM.bak' 
WITH REPLACE 
GO 
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(9) Follow the procedure below to check the database configuration. 

1) From Explorer, display the properties of backup file (<DPMDBI Install 
folder>:\MSSQL\Backup), and confirm whether a user that begins with SQLServerMSSQL 
exists on the Security tab. 

2) Click the Detailed Setting tab, and if a user name starting with "SQLServerMSSQL" 
existed in 1), confirm whether the "Allow inheritable permissions from the parent to this 
object and all child objects. Include these with entries explicitly defined here" checkbox is 
checked. 
If a user name that starts with "SQLServerMSSQL" did not exist in 1), check the "Allow 
inheritable permissions from the parent to this object and all child objects. Include these 
with entries explicitly defined here" checkbox. (If this checkbox is checked, a username 
starting with "SQLServerMSSQL" is added to the Security tab.) 

 
(10) Apply the registry data backup file (by double clicking from Explorer, etc.) extracted during step 

(6) in Section 9.5.2, "Backing Up Updated Data of DeploymentManager"). 
 

(11) Use the information you made note of to set each field in Other under Section 9.5.1, "Backing 
up Data of DeploymentManager When Configuring the Initial Setup or Changing the 
Configuration". 

 
(12) Start all services that were stopped in step (6). 

 
(13) Overwrite two files that had been collected in "User Information Registered to the DPM Server" 

of Section 9.5.1, "Backing up Data of DeploymentManager When Configuring the Initial Setup 
or Changing the Configuration" on the same folder when you backed up. 

 
To reboot the IIS, start the command prompt and then execute the command below. 
Iisreset /restart 
Iisreset -restart 

 
The DPM data is now restored. 
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10. Precautions 
 
 
 
 
 
 
 
 
 
 
This chapter explains precautions regarding the Web Console, etc. 
 
The items covered in this chapter are as follows: 
 
 
• 10.1 Web Console ...........................................................................................................460 
• 10.2 NEC US110 Support ................................................................................................461 
• 10.3 Notes on Using MasterScope Network Manager ....................................................472 
• 10.4 Notes for Simultaneous Execution of Multiple Scenarios ........................................479 
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10.1. Web Console 
Precautions regarding the Web Console are described below. 

 
・ Using browser specific shortcut keys such as F1 may affect Web Console operation. 
・ When platform dependent characters are entered for items, such as group names and 

machine names, the characters appear garbled. 
・ In DPM, you can execute the operations such as Obtain List and Create Folder toward all 

folders and files on Management Server through a browser. 
If any problematic folder or file exists when these operations are executed, it is recommended 
to change from Local System Account, the default logon account, to another account with 
administrator privileges for the following service and restrict against the account. 
DeploymentManager API Service 

・ JIS2004 is not supported by DPM. 
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10.2. NEC US110 Support 
NEC US110 (hereinafter, US110) is supported as a managed machine from DPM Ver5.1 US110 
can be updated by using the DPM function by managing US110. 
 

The following procedures are necessary to make US110 a managed machine. 
・ Confirming Installation of DPM Client 
・ Creating a US110 package 
・ Distributing a US110 package 

 
Each procedure is explained below. 
 

10.2.1. Confirming Installation of DPM Client 

Follow the below procedures to confirm whether the DPM Client is installed to the US110 in use. 
 

(1) Start US110. 
 

(2) Open Control Panel, and then select System. 
 

(3) The System Properties screen is displayed. Select the Information tab. If 
"DeploymentManager Agent" is listed in the displayed information, the DPM Client is 
installed. Depending on the version installed, "DeploymentManager Agent" may be 
followed by character strings. 

 

 
 

(4) If the DPM Client is not installed, obtain the US110 firmware update module from the 
download page below and follow the procedure provided to install the DPM Client. (US110 
update modules other than DPM Client are also installed together) 

 
Express5800 Series Portal (http://www.nec.com/global/prod/express/) 

->Select Download under NEC Express5800 Server Series 
->Select Thin Client Terminals under Servers 
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  Be sure to update US110 by either using DPM or using US110 function. If both 
functions are used, update may be repeated. 

 After the DPM Client is installed on US110 and US110 is registered to the DPM 
Server, do not use US110 function but apply by DPM to update US110. If the DPM 
Client is applied with US110 function again, a part of the DPM Client may be 
damaged, and there is a possibility that DPM cannot be used. If the DPM Client is 
applied with US110 function by mistake, you can obtain the modified DPM Client from 
above mentioned download page (if not, ask your sales or support representative) 
and apply the DPM Client again. 

 The modified version of the DPM Client can be obtained on the above mentioned 
download page. When you update US110 by US110 function (network install), 
replace the modules on server on the network where the DPM Client is used. 
However replace it when the figure of the XXX of XXX.DpmAgeCE.cab is larger than 
the figure of the server on the network in the download modules. It is not necessary to 
replace when it is smaller or same number. 

 Apply those modules when an individual update modules are released on the above 
mentioned download page. 

 

10.2.2. Creating a Package for US110 

The following explains how to create a US110 package. 
 

(1) Obtain a US110 update from the download page listed in 10.2.1 Confirming Installation of 
DPM Client. 

 
(2) Register the US110 package to the DPM server. 

For registration procedure, see 10.2.4 How to Create a Package for Windows CE (for use 
with NEC US110). 

 

10.2.3. Distributing a Package for US110 

Use the automatic update type to distribute the packages. 
For distribution via the automatic update type, see Section 4.4, "Installing Service Packs, HotFixes, 
and Applications (Automatic Update Type)" in the Operation Guide  
 

 To update US110, operation using the configurations below is recommended. 
• Automatic Update is set to ON At Startup 
• Application timing is set to Next Startup 
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10.2.4. How to Create a Package for Windows CE (for use with 

NEC US110) 

Both PackageDescriber and Image Builder can be used to register a US110 update to the DPM 
Server. This Section explains how to create a package using PackageDescriber. 
 

 If a US110 package is already registered to the DPM Server, be sure to delete the old 
package before registering. If an old package remains, the update may be repeated. 

 
 The information entered is the same if creating a package using Image Builder. If a 

package is registered using Image Builder, enter the information listed in this Section 
according to the procedure in Section 5.5, "Package Registration/Modification", and 
then create the package. 

 

10.2.4.1. Preparation Before a Package Registration 

It is necessary to prepare the BAT file to distribute a package to US110. 
The purpose of this BAT file is to associate and execute CAB files and nb0 files for the US110 
update (hereafter, together noted as CAB files). 
 
 Preparations Before Update 
 
(1) Obtain the latest US110 update, and expand with an arbitrary folder. 

 
(2) Delete XXX.DpmAgeCE.CAB included in the expanded update. 

XXX.DpmAgeCE.CAB is always maintained the latest by the automatic upgrade function in the 
DPM Client of US110. (It is not necessary to register as a package) 
 

(3) Store XXX.us_Update.CAB and all other CAB files to another folder. Moreover, list.txt file is 
included in the update modules; store it in the folder that stored other CAB files. 
(XXX.us_Update.CAB is stored in one folder, and other files are stored in another folder.) 

 
 Do not register XXX.DpmAgeCE.CAB as a package. (It is the DPM Client for US110. 

XXX indicates a numeric value). It may fail in the replacement of the file that relates to the 
DPM Client if you apply by mistake, and there is a possibility that it may cause the 
malfunction. The update module of the DPM Client can be obtained from the mentioned 
download page listed in Section 10.21.1, "Confirming Installation of DPM Client". Apply 
this DPM Client by the function of US110 again if you apply by mistake. 
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 Creating a BAT File 
 
(1) Create a BAT file in each of the 2 folders where the update is stored. The BAT file name is 

arbitrary. 
 

Example) 
BAT for installation 
(US_Update.BAT) 

 

 
 
(2) Open the created BAT file with such as the text editor, and enter information by the following 

format. 
 

us_Update.exe CAB FILENAME CAB FILE UPDATE DATE (YYYY/MM/DD-hh:mm:ss) 
 

 Enter seconds (where the "ss" part) of the CAB file update as "00" even if the number of 
seconds for an actual modified date is not "00." 

 
Example) 

Installation BAT file information 
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(3) Enter all information in the order listed in list.txt for the installation BAT in the folder where the 

other CAB files are stored. 
(However, XXX.DpmAgeCE.CAB and XXX.us_Update.CAB are excluded) 

Example) When the following are written in list.txt. 
004.us_Update.CAB 
000.UTR_1W.CAB 
001.DpmAgeCE.cab 
001.ICA.CAB 
  ･･･ 
006.NK.nb0 

 
Enter the following to the BAT: (Do not enter XXX.DpmAgeCE.CAB and 
XXX.us_Update.CAB to the BAT) 
us_Update.exe 000.UTR_1W.CAB xxxx/xx/xx-xx:xx:00 
us_Update.exe 001.ICA.CAB xxxx/xx/xx-xx:xx:00 
  ･･･ 
us_Update.exe 006.NK.nb0 xxxx/xx/xx-xx:xx:00 

 
 Please save the BAT file character code as ANSI. 
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10.2.4.2. Creating Packages in PackageDescriber 
When creating a package in PackageDescriber, enter the following information. 
See Section 6.2, "Create Package" for the procedure to create a package with PackageDescriber. 

 
 Create a XXX.us_Update.CAB package  

Create a XXX.us_Update.CAB package. 
 

・ Basic tab 
Under Type, select Application. It is not necessary to set Display Name or Display 
Version. Furthermore, set Urgency to High or above to distribute a package via the 
automatic update type. 
 
Example) Basic tab 
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・ Execution Settings tab  

Set the folder containing CAB and BAT files to Folder name under Folder to be copied. 
Set the BAT file created in Section 10.2.4.1," Preparing to Register a Package" to 
Execution file under Installation. 
 
Example) Setting the Execution Settings tab 

 

 
 
・ Applicable OS and language tab  

Select Windows CE 5.0 [FOR US110] for OS. 
 
Example) Setting the Applicable OS and language tab 
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・ ID Information tab 

Add the information below to Add registry information. 
 

Item Setting Value 
Key name HKEY_LOCAL_MACHINE\SOFTWARE\NEC\Version 

(Fixed value) 
Name XXX.us_Update.CAB 

(enter a number for XXX) 
Data Modified date of the XXX.us_Update.CAB file entered in the BAT file 
Type  REG_SZ 

(Fixed value) 
Change type Create new 

 
 Enter accurate information to ID information. 

If the registry information is not set to the ID information correctly, it may not 
distribute the package that automatic update function is used or misbelieved may 
occur. 

 
Example) Add registry information setting 

 

 
 
The creation of XXX.us_Update.CAB is completed. 
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 Other CAB File Packages 

The method to create other CAB files is the same as for XXX.us_Update.CAB, except for the 
following two items. Set the BAT file created in Section 10.2.4.1, "Preparing to Register a 
Package" to execution File. 
 
・ Dependency information tab 

Add the information below to Registry Condition List. 
 
Item Setting Value 
Key name HKEY_LOCAL_MACHINE\SOFTWARE\NEC\Version 

(Fixed value) 
Name XXX.us_Update.CAB 

(CAB file name specified at the time us_Update.CAB package was 
created) 

Data None (blank) 
Type  REG_SZ 

(Fixed value) 
Condition Exist 

(While a difference between the conditions that can be selected in 
PackageDescriber and Image Builder exists, select Exist in either case) 

 
Example) Add registry dependency information Settings 
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If the Select Conditions button is clicked after Add registry dependency information, the OR 
Condition Specification screen is displayed. Specify conditions, and then click the OK button. 
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・ ID Information tab 

Add the information below to Registry change information. 
 
Item Setting Value 
Key name HKEY_LOCAL_MACHINE\SOFTWARE\NEC\Version 

(Fixed value) 
Name Last Installed CAB file name listed in the BAT file 

(may be a nb0 file) 
Data Last Installed CAB file update date listed in the BAT file 

(may be a nb0 file) 
Type  REG_SZ 

(Fixed value) 
Change Type Create new 

 
Example) Modify registry information setting 

 

 
 
Creation of the package necessary to US110 update distribution is completed. 
 

10.2.5. DPM Client Upgrade Installation (for use with NEC US110) 
NEC US110 cannot be upgraded from the DPM installer. If an upgrade installation is necessary, the 
automatic upgrade function of the DPM Client automatically performs an upgrade. 
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10.3. Notes on Using MasterScope Network 
Manager 

 When upgrading the DPM Server after setting MasterScope Network Manager's TFTP 
service to cooperate with DPM, perform steps (7) to (11) again of "To install a DPM Server 
on a machine installed with MasterScope Network Manager, follow the procedure below". 

 
 When you install DPM Server on the machine on which MasterScope Network Manager is 

installed, MasterScope Network Manager's Trivial File Transfer Protocol (TFTP) service conflicts 
with DPM's TFTP service, and each TFTP service might not work properly. 
To resolve this, do not use DPM's TFTP service and allow MasterScope Network Manager's 
TFTP service to cooperate with DPM instead. For details on the cooperation and so forth, refer to 
MasterScope Network Manager Resource Manager User's Manual. 
 

 Perform the following configuration only if the MasterScope Network Manager and DPM are 
using a duplicate IP address. 

 
 To install a DPM Server on a machine installed with MasterScope Network Manager, follow the 

procedure below:  
 
(1) Select Start menu -> Control Panel ->Administrative Tools -> Services on the 

Management Server, and then open the Service screen. 
 
(2) Stop all MasterScope Network Manager services. 
 
(3) Install the DPM Server. 
 
(4) Select Start menu -> Control Panel ->Administrative Tools -> Services on the 

Management Server, and then open the Service screen. 
 
(5) Stop the following services: 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

 
(6) Stop the following service, and then change Startup type to Disabled. 
DeploymentManager PXE Mtftp 
 
(7) Insert the DPM install media into the DVD drive on the Management Server. 
 
(8) Execute the following operations as required for the OS architecture in use. 
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・ For IA32: Execute the following files located on the install media. 

 
 For SSC product: : 

<Install media> :\DPM\TOOLS\TFTP\IA32\RegTFTP1.reg  
For DPM unbundled product: 

<Install media> :\TOOLS\TFTP\IA32\RegTFTP1.reg  
 

・ For EM64T: Select Run from the Start menu. Enter "%WINDIR%\SysWOW64\cmd.exe" 
for the name of the program to execute, and then click on the OK button. The command 
prompt appears. Execute the following file from the command prompt. 

 
 For SSC products: 

<Install media> :\DPM\TOOLS\TFTP\AMD64\RegTFTP1.reg 
For DPM unbundled products: 

<Install media> :\TOOLS\TFTP\AMD64\RegTFTP1.reg 
 

(9) The following screen appears. Click the Yes button. 
 

 
 
(10) The following screen appears. Click the OK button. 
 

 
 
(11) Copy all of the files under (the DPM Server installation folder) \PXE\Images to the TFTP root 

folder of MasterScope Network Manager. (For the MasterScope Network Manager TFTP 
root folder, refer to the MasterScope Network Manager User Manual.) 
Make sure that you do not delete files under (the DPM Server's installation folder) \PXE\Images 
in this step. 
 

(12) Select Run from the Start menu on the Management Server. Enter "regedit" for the name of the 
program to execute, and then click the OK button. 
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(13) Registry Editor starts up. Please change the following registry: 
 

Registry path 
IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager 

Value name Value data 
PxeDosFdDir TFTP root folder of MasterScope Network Manager\DOSFD 
PxeHwDir TFTP root folder of MasterScope Network Manager\HW 
PxeHW64Dir TFTP root folder of MasterScope Network Manager\HW64 
PxeLinuxDir TFTP root folder of MasterScope Network Manager\pxelinux 
PxeNbpDir TFTP root folder of MasterScope Network Manager\NBP 
PxeNbpFdDir TFTP root folder of MasterScope Network Manager\NBP 

 
Registry path 

IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager\PXE\Mtftpd 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager\P
XE\Mtftpd 

Value name Value data 
BASE_DIR TFTP root folder of MasterScope Network Manager 

 
(14) Referring to information in "competition of TFTP server with other soft on MasterScope Network 

Manager install server" of the MasterScope Network Manager User's Manual, modify the 
contents of the nvrmap.ini file and reboot the machine. 

 
DPM and the MasterScope Network Manager TFTP service are now linked. 
 

 If the Management Server IP address was changed after the above configuration, perform 
steps (7) to (10) again. 

 
 To install MasterScope Network Manager on a machine installed with DPM Server, follow the 

procedure below: 
 
(1) Select Start menu -> Control Panel ->Administrative Tools -> Services on the 

Management Server, and then open the Service screen. 
 

(2) Stop the following services: 
DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 
 

(3) Stop the following service, and then change Startup Type to Disabled. 
DeploymentManager PXE Mtftp 
 

(4) Insert the DPM install media into the DVD drive on the Management Server. 
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(5) Execute the following operations as required for the OS architecture in use. 

• For an IA32 architecture machine: Execute the following files located on the install media. 
 

 For SSC product        :\DPM\TOOLS\ TFTP\IA32\RegTFTP1.reg 
For DPM unbundled product :\TOOLS\TFTP\IA32\RegTFTP1.reg 

 
• For EM64T: Select Run from the Start menu. Enter "%WINDIR%\SysWOW64\cmd.exe" for 

the name of the program to execute, and then click on the OK button. The command prompt 
appears. Execute the following file from the command prompt. 

 
 For SSC product :\DPM\TOOLS\TFTP\AMD64\RegTFTP1.reg 

For DPM unbundled product :\TOOLS\TFTP\AMD64\RegTFTP1.reg 
 
(6) The following screen appears. Click the Yes button. 
 

 
 
(7) The following screen appears. Click on the OK button. 
 

 
 
(8) Refer to the MasterScope Network Manager User's Manual and install MasterScope Network 

Manager. 
 
(9) Copy all of the files under (the DPM Server installation folder) \PXE\Images to MasterScope 

Network Manager's TFTP root folder. (For the MasterScope Network Manager TFTP root folder, 
refer to the MasterScope Network Manager User's Manual.) 
Make sure that you do not delete files under (the DPM Server's installation folder) \PXE\Images 
in this step. 
 

(10) Select Run from the Start menu on the Management Server. Enter "regedit" for the name of the 
program to execute, and then click the OK button. 
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(11) Registry Editor starts up. Please change the following registry: 
 

Registry path 
IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager 

Value name Value data 
PxeDosFdDir TFTP root folder of MasterScope Network Manager\DOSFD 
PxeHwDir TFTP root folder of MasterScope Network Manager\HW 
PxeHW64Dir TFTP root folder of MasterScope Network Manager\HW64 
PxeLinuxDir TFTP root folder of MasterScope Network Manager\pxelinux 
PxeNbpDir TFTP root folder of MasterScope Network Manager\NBP 
PxeNbpFdDir TFTP root folder of MasterScope Network Manager\NBP 

 
Registry path 

IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager\PXE\Mtftpd 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager\
PXE\Mtftpd 

Value name Value data 
BASE_DIR TFTP root folder of MasterScope Network Manager  

 
(12) Referring to information in "competition of TFTP server with other soft on MasterScope Network 

Manager install server" of the MasterScope Network Manager User's Manual, modify the 
contents of the nvrmap.ini file and reboot the machine. 
 

DPM and the MasterScope Network Manager TFTP service are now linked. 
 

 If the Management Server IP address was changed after the above configuration, perform 
steps (4) to (7) again. 
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 To uninstall MasterScope Network Manager, follow the procedures below. 
 
(1) Copy all of the files under MasterScope Network Manager's TFTP root folder to (the DPM 

Server installation folder) \PXE\Images. After the files are copied, delete all files under the 
TFTP root folder of MasterScope Network Manager. (For the MasterScope Network Manager 
TFTP root folder, refer to the MasterScope Network Manager User's Manual.) 

 
(2) Uninstall MasterScope Network Manager. 
 

(3) Select Start menu -> Control Panel ->Administrative Tools -> Services on the 
Management Server, and then open the Service screen. 

 
(4) Stop the following services: 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

 
(5) Insert the DPM install media into the DVD drive on the Management Server. 

 
(6) Execute the following operations as required for the OS architecture in use. 

• For IA32: Execute the following files located on the install media. 
 

 For SSC product: 
<Install media> :\DPM\TOOLS\TFTP\IA32\ RegTFTP2.reg  
For DPM unbundled product: 
<Install media> :\TOOLS\TFTP\IA32\ RegTFTP2.reg  

 
• For EM64T: Select Run from the Start menu. Enter "%WINDIR%\SysWOW64\cmd.exe" for 

the name of the program to execute, and then click the OK button. The command prompt 
appears. Execute the following file from the command prompt. 

 
 For SSC product: : 

<Install media> :\DPM\TOOLS\TFTP\AMD64\RegTFTP2.reg 
For DPM unbundled product: 
<Install media> :\TOOLS\TFTP\AMD64\RegTFTP2.reg 

 
(7) The following screen appears. Click the Yes button 
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(8) The following screen appears. Click on the OK button. 
 

 
 
(9) Select Run from the Start menu on the Management Server. Enter "regedit" for the name of 

the program to execute, and then click the OK button. 
 

(10) Registry Editor starts up. Please change the following registry: 
 

Registry path 
IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager 

 
Value name Value data 

PxeDosFdDir DPM Server install destination folder\PXE\Images\DOSFD 
PxeHwDir DPM Server install destination folder\PXE\Images\HW 
PxeHW64Dir DPM Server install destination folder\PXE\Images\HW64 
PxeLinuxDir DPM Server install destination folder\PXE\Images\pxelinux 
PxeNbpDir DPM Server install destination folder\PXE\Images\NBP 
PxeNbpFdDir DPM Server install destination folder\PXE\Images\NBP 

 
Registry path 

IA32:HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager\PXE\Mtftpd 
EM64T:HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager

\PXE\Mtftpd 
Value name Value data 

BASE_DIR DPM Server install destination folder\PXE\images 
 

(11) Select Start menu -> Control Panel ->Administrative Tools -> Services on the 
Management Server, and then open the Service screen. 

 
(12) Set the Startup Type to Automatic for the below service, and then reboot the machine. 

DeploymentManager PXE Mtftp 
 

This completes the procedure to uninstall MasterScope Network Manager. 
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10.4. Notes for Simultaneous Execution of 
Multiple Scenarios 

To run multiple multicast distributed scenarios simultaneously, configure the Backup/Restore tab on 
the Add Scenario screen or the Edit Scenario screen so that multicast IP addresses are not 
duplicated. 
 

 It is not necessary to set the multicast IP for a scenario whose Transmit Data by 
Unicast checkbox is checked. 

 
 Use the following procedure to set the multicast IP address. 
 
(1) Displays the Add Scenario or Edit Scenario screen on the Web Console. 

 
(2) Click the Package or Backup/Restore tab. 

 
(3) Set different IP addresses in the scenarios which are planned to executed simultaneously. 

To Installing service packs, hotfixes, Linux patch files, and applications, select Package tab -> 
Distribution Condition Setting -> Transmit Data by Multicast, and set the IP address at 
Multicast IP Address(Package). 

 
To restore, select Backup/Restore tab ->Multicast Condition Setting, and set the IP address 
at Multicast IP Address(Restore). 
Example) 

If there are three scenarios for application install 
Set each IP address as follows: 
1) the first scenario…239.192.0.1 
2) the second scenario…239.192.0.3 
3) the third scenario…239.192.0.4 
*The reason 239.192.0.2 is not used is that this value is already the default setting in 
Restore. 
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11. Troubleshooting 
 
 
 
 
 
 
 
 
 
 
This chapter explains how to handle when the problem occurs on DPM. 
 
The items covered in this chapter are as follows: 
 
• 11.1 Web Console ...........................................................................................................482 
• 11.2 Database..................................................................................................................486 
• 11.3  .................................................................................................................................487 
• 11.4 Managed Machine ...................................................................................................489 
• 11.5 Scenario ...................................................................................................................490 
• 11.6 Execute Scenario .....................................................................................................491 
• 11.7 Managed Machine Registration ...............................................................................508 
• 11.8 Automatic Update ....................................................................................................509 
• 11.9 Automatic Download ................................................................................................515 
• 11.10 Power On .................................................................................................................517 
• 11.11 Schedule Management ............................................................................................518 
• 11.12 Machine Information Import/Export .........................................................................519 
• 11.13 Network Settings ......................................................................................................520 
• 11.14 Operating Without DHCP Server .............................................................................522 
• 11.15 PackageDescriber ...................................................................................................524 
• 11.16 Inquiry of Obstacle Occurrence ...............................................................................525 
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11.1. Web Console 
 
  

 

When you click Detail under HotFix/Application on the Machine Detail screen, the 
HotFix/Application List screen items are not displayed. 

To manage the managed machine in this version, the DPM Client for this version must be 
installed on the managed machine. If it is already installed, reinstall. See Section 2.2, 
"Installing the DPM Client" in Installation Guide for the installation method. 
From the Start menu on the managed machine, select Control Panel ->Administrative 
Tools -> Services, and confirm that DeploymentManager Agent Service or 
DeploymentManager Remote Update Service Client is running. It is automatically installed 
if the OS is installed using DPM. For details, see Section 3.5, "Executing OS Clear Installation 
(Linux)" in the Operation Guide. 

  

 

The screen Socket error has occurred. is displayed when you update information. Or, the following 
message is displayed as detailed information: 
No connection could be made because the target machine actively refused it. Management Server IP 
address:56050 

The Management Server may be shut down. From Start menu -> Control Panel -> 
Administrative Tools -> Services, confirm that all of the services listed in  DPM Server 
under Appendix A, "Services List" in Reference Guide are running. 
If the service is stopped, start all of the services that are not running. Furthermore, try to 
reconnect to Management Server after services started. 

  

 

If you start Web Console from the Web browser, error The Page cannot be displayed appears. 
One of the following is possible: 

The URL to start the Web Console may be incorrect. Confirm that the URL is correct. 
The Web Server may not be running. Select Start menu -> Control Panel -> Administrative 
Tools -> Internet Information Services (IIS) Manager, and confirm that Default Web Site is 
running. 

  

 

Start Web Console on Windows Server 2003 and the following message is displayed each time the 
screen switches. 
 

 
 

Click on the OK button. 
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Something is wrong with the display of the error message. 
If you use an HTML tag (<xx>) for a computer name or group name etc, the entered text is 
interpreted as HTML syntax and may not be properly displayed in the error message. 
However, operations are not affected. 

  

 

Even if you start Web Console from the Web browser, nothing is displayed on the Web browser. 
The following is possible : 

・ Open Internet Explorer Tools menu -> Internet Options, select Trusted Sites on the 
Security tab and click Sites. Then add a URL which connects to the Management 
Server. 

Example) If the Management Server IP address is 192.168.2.41 
 

 
 

  

 

If you start Web Console on Windows Server 2003, the following message is displayed: 
 

 
 

Confirm that the URL is not wrong, and then click Add and add the Web site to the 
Trusted Sites zone. 
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You performed one of the following operations, but the File Download screen is not displayed, and 
you could not download CSV files. 
・ On the Monitor view -> Scenario Execution Result List -> Scenario Execution Result List 

Screen, click Operation menu, click Save in CSV. 
・ On the Monitor view -> Automatic Update Result List -> Automatic Update Results List 

screen, Click Operation menu, click Save in CSV. 
・ On the Operations view -> Group List screen Configuration menu, click Export Machine Data  

Check Internet Explorer's security settings. 
Select the Internet Explorer Tools menu -> Internet Options, then click Security tab -> 
Security 
level for this zone -> Custom level button, and configure as follows: 
・ Set Enable from Downloads – File download. 
・ Set Enable from Downloads – Automatically prompting for file downloads. 
・ Set Prompt from Downloads – Font download. 

  

 

You tried to start Web Console, but HTTP Status 404 and other messages were displayed on the 
screen, and you could not start it. 

The Web Server may not be running. Select Start menu -> Control Panel -> Administrative 
Tools -> Internet Information Services (IIS) Manager, and confirm that Web Site is running. 

  

 

When you start Web Console, the following message is displayed on the screen and it cannot start. 
 
HTTP Error 404.17 - Not Found 
The requested content appears to be script and will not be served by the static file handler. 
 

There are case that above messages are displayed in IIS7.0/IIS7.5. 
Referring to the following procedure, set "v2.0" to ".NET Framework version". 

 
Example) When the IIS is 7.0, 

1) From the Start menu, click Administrative Tools -> Internet Information Services 
(IIS) Manager. 

2) Internet Information Services (IIS) Manager screen is displayed. 
On the left side of the screen, select Application Pools. 

3) In the center of the screen, the list of Application Pools is displayed. 
Select DeploymentManagerPool and click Basic Setting in the right of the screen. 

4) In the Basic Setting, set "v2.0" to NET Framework version. 
  

 

When you open Web Console screen (such as Add Machine screen or Add Scenario screen) the 
characters displayed on the screen are garbled. 

This may be avoided by turning off Auto-Select of Encoding on Internet Explorer. 
You may turn the setting off by removing the check mark of View menu, then select 
Encoding, then select Auto-Select. 

  

 

On the Backup/Restore tab of the scenario, you click the Browse button on the Image File and a 
network drive or USB hard disk are not displayed. 

Only local disk is displayed as a drive. When you specify a network drive or USB hard disk, 
input the image file path on Image File text box directly. 
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The managed machine MAC address is not displayed on the Web Console. 
The MAC address may not display temporarily as a result of LAN board replacements to 
other machines, or other factors. 
If such a phenomenon occurs, manually reboot the managed machine. 
If the phenomenon occurs after reboot, delete the corresponding managed machine from the 
Web Console and then reregister. 
*If the managed machine MAC address is not displayed, you cannot perform the following 
operations: 

・ Set the Automatic Update Time for the managed machine 
・ Obtain the power status 
・ Obtain the managed machine information 
・ Execute Scenario 
・ Power ON 
・ Shutdown 

The MAC address for a managed machine running on Linux OS and mounted with multiple 
LAN boards may not display during operation. 
In such a case, the corresponding managed machine may be registered to a New Machine 
group. Delete the corresponding managed machine from the New Machine group, and then 
reboot the DPM Client on the managed machine. If the phenomenon occurs after reboot, 
delete the corresponding managed machine from the Web Console and then reregister. 
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11.2. Database 
There is no Troubleshooting Section for databases in DPM Ver6.0. 
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11.3. Management Server 
  

 

When you set different machines as DHCP server and Management Server, you cannot obtain the 
MAC address for the managed machine. 

The DHCP service on the Management Server may still be running. On the Management 
Server, select Start ->Control Panel-> Administrative Tools -> Services, and confirm that 
Status under DHCP Server is not Started. If it is Started, open the Properties screen, disable 
Startup type, and stop the service. 
In Detail Setting, the DHCP server is installed on an another machine checkbox may not 
be checked. Select Management view -> DPM Server -> Detail Setting on the Web Console, 
click the DHCP Server tab, and confirm that the DHCP server is installed on an another 
machine checkbox is checked. If the checkbox is not checked, enter a check and click the OK 
button, and then reboot the Management Server. (If the Management Server cannot be 
rebooted, stop all services listed in Appendix A, "Service List ", at Start menu -> Control 
Panel ->Administrative Tools -> Services, and then start all of the stopped services.) 

  

 

The DPM Server services are not running. 
A service may terminate if an error occurs during scenario execution. 
If a scenario is executing, wait until it completes and then perform the following operations. 
Select Start menu -> Control Panel ->Administrative Tools -> Services on the 
Management Server, and then restart the following services. 
(If a service is stopped, please start it.) 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

By performing an overwrite installation of the DPM Server, it will be recovered. 

  

 

You cannot start the DeploymentManager API Service service. 
Port (TCP:56050) may be in use by other applications. 
Open port (TCP:56050) and then start DeploymentManager API Service service. 

  

 

You cannot start the DeploymentManager Remote Update Service service. 
Furthermore, the following error log is listed in <DPM Server Install Folder>\Log\rupdssvc.csv : 
"RUPDSSVC: FUNCTION: CreateSocket(): bind Failed, error code=10048"  

Port (TCP:56024, TCP:56028) may be in use by other applications. 
Open port (TCP:56024, TCP:56028) and then start DeploymentManager Remote Update 
Service service. 

  

 

If you uninstall and then install the DPM Server, scenarios and groups existing before the uninstall 
still remain. 

The uninstall may not be performed correctly. Follow the procedure below to reinstall: 
(1) Perform uninstall again. 
(2) Reboot the machine installed with DPM Server. 
(3) Delete the contents under the folder installed with DPM Server and the Folder for Image  

(the defaults are C:\Program Files\NEC\DeploymentManager and C:\Deploy). 
(4) Install again. 
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If you perform an overwrite installation after interrupting uninstall, an error message appears and you 
cannot overwrite. 

Install the DPM Server newly after the it is completely uninstalled. 
 

  

 

There is no response even if you execute the DPM Server silent installation. 
The network connection may not have been detectable. 
After confirming the network environment, install the DPM Server again. 
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11.4. Managed Machine 
  

 

The standby function did not appear when you finish the managed machine. 
Check the following: 
・ If the terminal service is enabled, you cannot use the standby function. From the control 

panel, disable the terminal service. 
・ Unless the device driver is installed normally, the standby function cannot be used.  

  

 

If you used remote desktop to perform an Install/Upgrade Install/Uninstall of the DPM Client, the 
following message was displayed: 
 

The following error occurred on the file, xxxxx\DepAgent.dll. 
Access is denied. 
(0x5) 
 
* xxxxx is a (variable) file path. 

 
If an Install/Upgrade Install/Uninstall is performed while Event viewer on the managed 
machine is open, the above message may be displayed. 
To Install/Upgrade Install/Uninstall, after selecting the Ignore button and closing the above 
message, reboot the managed machine and re-execute. 
For Uninstall, the DepAgent.dll file is automatically deleted after the machine restarts, so it is 
not necessary to re-execute. 

  

 

You cannot start DeploymentManager Remote Update Service Client service. 
Furthermore, the following error log is listed in rupdsvc.log. 

* rupdsvc.log is located in the following folder: 
・ For IA32: %SystemRoot%\System32\ 
・ For EM64T: %SystemRoot%\SysWOW64\  

"RUPDSVC: bind() failed, code = 10048"  
Port (TCP:56000, TCP:56025) may be in use by other applications. 
Open port (TCP:56000, TCP:56025) and then start DeploymentManager Remote Update 
Service Client service. 

  

 

You cannot start DeploymentManager Update Service Client service. 
Furthermore, the following error log is listed in rupdsvc.log. 

* rupdsvc.log is located in the following folder: 
・ For IA32: %SystemRoot%\System32\  
・ For EM64T: %SystemRoot%\SysWOW64\  

"RMulticast receive socket create error, code = 10048"  
Port (UDP:56001) may be in use by other applications. 
Open port (TCP:56001) and then start DeploymentManager Remote Update Service 
Client service. 

  

 

Joining a Windows Server 2008/Windows Vista/ Windows 7 managed machine to the domain will 
initialize the Firewall's setting and enable it. 

This happens when the domain security policy is undefined in the domain server. 
Define the domain security policy before joining to the domain. 
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11.5. Scenario 
  

 

You cannot assign a scenario to a managed machine. 
A scenario cannot be assigned to a machine in the following statuses: Scenario Executing, 
Scenario Execute Stop, Scenario Execute Error or Remote Power ON Error. Assign a scenario 
either after scenario execution completes, or clear the machine status. 

  

 

You want to change the scenario file name. 
The scenario name cannot be changed. Please create a new scenario. 
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11.6. Execute Scenario 
11.6.1. Overview 
  

 

You executed a scenario, but the managed machine Status is not Scenario Executing. 
If you click Refresh from Operation menu, or refresh the screen by pressing the F5 key, the 
status changes to Scenario Executing. Until the machine icon displays Running, do not 
edit, delete or Remove Scenario Assignment for any running scenario. The scenario may not 
execute properly. 

  

 

You checked the Forced Execution Of A Reboot Is Performed Before Execution checkbox on 
the scenario Option tab, but the machine does not reboot. 

When installing service packs, HotFix, and applications, the machine does not reboot before 
executing a scenario. 

  

 

An error occurred while a scenario was running. 
Use the following method to remove the error. 
Next, check the error contents in the Event Viewer, confirm that the machine is in the correct 
status on the Web Console, and then re-execute the scenario. 
Example 1) Error Removal Method 

(1) Click on the machine in error status on the Machine List, and a machine detail 
screen is displayed. 

(2) Click Remove Error under Operation menu on the machine detail screen. 
Example 2) Error Removal Method   

(1) Click Monitor view - Scenario Execution List. 
(2) In the tree view, click Scenario Execution List. 
(3) In the Operation menu, click Batch Clear Status. 
(4) On the Status Clear screen, select Scenario Execute Error. 
(5) Click on the OK button. 

  

 

A Running Scenario does not complete. 
Check the following: 
・ Confirm installation of DPM Client. 

The DPM Client must be installed on the managed machine. 
If DPM Client is not installed, interrupt the scenario, install DPM Client, and re-execute. 

・ Confirm that the IP address of the Management Server set when DPM Client was installed 
on the managed machine is correct. 
If it is incorrect, either change the following registry, or reinstall DPM Client and set the 
correct IP address. 
<Windows> 

Key: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\depagent\Parameters 
Key name: ServerIpAddress  

<Linux> 
Correct the following files in the /opt/dpmclient/agent/etc/ folder. 
File Name: server.inf  
Key name: dpmserverip= 

・ At the time a scenario completes, the DPM Client setting permits communication with the 
Management Server. 
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A scenario execution error occurred immediately after you executed a scenario. 
he location of installation or settings of DHCP may be wrong, or the DHCP Service may not be 
operating properly. Check the current situation from the following: 
・ Select Management view - DPM Server - Detail Setting - DHCP Server tab on the Web 

Console, and confirm that settings are correct for use with DHCP server. 
・ Confirm that the lease IP address in the DHCP scope is not inactive. 
・ Confirm that the DHCP server is recognized and the IP address is available for lease. 
・ Confirm that the DHCP address pool has not run out. If the pool has run out, please secure 

a sufficient pool of addresses. 
・ If using a DHCP service other than Windows, confirm that fixed addresses (for example, 

such as when the DHCP server was built on Linux) are configured. 
A remote update scenario may have been executed on a machine that exceeded the 
Distribution Condition Setting - Maximum Targets configured in the scenario. 
Reduce the number of machines to execute, or increase the value of Maximum Targets. 
HW configuration, OS installation, disk configuration check, or a Backup/Restore scenario 
may have been executed for a machine with power turned ON. 
To re-execute with the machine's power turned OFF, or to force execute on a machine with 
power turned ON, check the Forced Execution Of A Reboot Is Performed Before 
Execution checkbox on the scenario's Option tab. 
The command (execute file path + execute file name + setup parameter) of executed package 
for a remote update scenario may exceed 259 single-bytes. Correct to make 259 single-bytes 
or less using Image Builder and PackageDescriber. 

  

 

An error occurred while a scenario was running. 
If you check the Event Viewer, you see that error log information is registered. 

Check the log information registered in the Event Viewer, and perform the processes for each 
item. 
A problem that still occurs after re-executing may cause incorrect behavior in related services. 
If a scenario is executing, wait until it completes and then perform the following operations 
from the Management Server. Select Start menu - Control Panel - Administrative Tools - 
Services on the Management Server, and then restart the following services. (If a service is 
stopped, please start it.) 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

 Log Information 1 
･Error: Timeout error and stop run scenario. No response from target: 
Explanation 
The scenario execution timed out because there was no response from the machine within 
a given time. The machine may have stopped due to an awaiting input status, error display, 
or other reason. After checking the machine, scenario content, setup parameter files and 
other information, remove the error from the machine. Next, turn the machine power OFF 
and then re-execute the scenario. 

 Log Information 2 
･Error cannot create thread (xxxxxxxxxxx) 
･Error cannot allocate xxxxxxxxxxxxxxxx 
Explanation 
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Failed to create the thread which processes machine requests and to allocate buffer 
memory. There is the possibility that there are insufficient resources due to factors such as 
the Management Server's high load state. 
After checking the Management Server status, remove the error from the machine. Next, 
turn the machine power OFF and then re-execute the scenario. 

 Log Information 3 
･Error cannot read CLF 
･Error cannot change CLF 
Explanation 
Failed to read/write managing machine information. 
Remove the error from the machine, and then turn the machine power OFF. After waiting a 
while, re-execute the scenario. 

 Log Information 4 
･Error cannot get xxxxxx path 
･Error cannot read xxxxxx 
･Error cannot open xxxxxx 
Explanation 
Failed to obtain the path for, open, and read file xxxxxx. 
There may be insufficient resources or registry information may be damaged due to factors 
such as the Management Server's high load state. After checking the Management Server 
status, remove the error from the machine. Next, turn the machine power OFF and then 
re-execute the scenario. 

 Log Information 5 
･Starting process of the computer failed MAC = XX-XX-XX-XX-XX-XX 
Explanation 
Failed to remotely turn the machine power ON. 
The network cable is not connected, or remote power ON is not configured. If the machine 
is forcibly shut down while the POST screen is displayed, remote power ON may not 
function the next time the machine boots up. 
Please confirm HW settings and try again. 

 Log Information 6 
･ Starting process of the computer failed when execute scenario MAC = 
XX-XX-XX-XX-XX-XX  
Explanation 
Failed to remotely turn the machine power ON. 
The network cable is not connected, or remote power ON is not configured. If the machine 
is forcibly shut down while the POST screen is displayed, remote power ON may not 
function the next time the machine boots up. 
Please confirm HW settings and try again. 

 Log Information 7 
･scenario start write shared memory MAC : error = XX-XX-XX-XX-XX-XX : XXX 
Explanation 
The service may have abnormally terminated. 

 
(1) Select Start menu - Control Panel - Administrative Tools - Services on the 

Management Server, and then stop the following services:  
DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 
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(2) Start the services you stopped in (1). 
 
(3) Execute the scenario again. 

 
 Log Information 8 
･scenario start update module copy MAC : error = XX-XX-XX-XX-XX-XX : XXX 
･scenario start dir delete error MAC = XX-XX-XX-XX-XX-XX 
Explanation 
The Management Server Folder for Image may not be accessible. 
Confirm access rights for Folder for Image, and then execute the scenario again. 

  

 

An error occurred while a scenario was running. 
When you connected the display to the machine, the following errors were displayed. 

Perform each process following the messages displayed. 
 Message 1 

Error: Partition is too small for install windows operation system. 
Explanation 
If you select Use Existing Partition during window installation, this message is displayed 
when the existing partition is smaller than 4 GB. 
If installing Windows in a partition smaller than 4 GB, perform the local setup in manual 
mode. 

 Message 2 
Error: No partitions defined. 
Explanation 
If you select Use Existing Partition during Windows installation, this message is displayed 
when there is no existing partition. 
Select Create New Partition, and re-execute the operation. 

 Message 3 
Error: No disk found. 
Explanation 
This message is displayed if a hard disk drive is not connected during Windows installation. 
Confirm that the hard disk is connected correctly, and then re-execute the operation. 

  

 

The managed machine does not turn on when the power is turned on or a scenario is executed. 
If the power is forced turned off during POST, the system may fail in Wake On LAN when 
restarted. 
Turn off the power after completion of POST or start the operating system and perform the 
shutdown process. 

  

 

The power was turned off during scenario execution by mistake. 
On the Web Console, click Operations in the title bar to switch to the Operations view. In the 
tree view, click Machines icon, and then select the group to which the machine which power 
was turned off is registered. Select the specified machine, and then select Scenario Execute 
Stop to interrupt the scenario. After the status returns to normal, execute the scenario again. 

  

 

The managed machine is not booted through the network, and the scenario cannot be executed. 
The network boot priority in the BIOS settings may be lower than the hard disk boot priority. 
Make the network boot priority higher than the hard disk boot priority, and re-execute the 
scenario. 
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When you execute Command Line for DPM, the specified command does not run. 
In addition, an error does not appear at the command prompt. 

You may be using a previous version's DPM Command Line (Command Line for DPM). If you 
are using DPM Command Line (Command Line for DPM) from a previous version, perform an 
upgrade installation, see Section 3.5, "Upgrading DPM Command Line" in Installation Guide. 

  

 

When you executed a scenario to multiple managed machines simultaneously, a Remote Power On 
error occurred. 

In the case of executing a scenario to multiple managed machines simultaneously, the default 
timeout value of the Remote Power On, which is specified in the Management view -> DPM 
Server -> Detail Setting - Network tab, may cause a timeout error. 
As a guide, set the Remote Power On Timeout to the following value: 
(Remote Power On Interval) multiplied by (the number of scenario executing machines) plus 
(managed machine startup time). 

  

 

When a scenario finishes or a running scenario is stopped, the following message appears on the 
managed machine and the machine cannot be turned off: 
ERROR: Failed to power down by calling APM BIOS. The system has halted. 

A machine that does not support Advanced Power Management (APM) BIOS might not be 
automatically turned off. In this case, turn off the managed machine manually. 

 

 

When you execute a command of DPM Command Line, the following message appears, and you 
cannot execute the command: 
The system cannot execute the specified program. 

This message appears when runtime modules required for running DPM Command Line are 
not properly installed. 
Run the following file in the install media to install the run-time modules: 
• For SSC product:           :\DPM\Setup\VCRTL\vcredist_x86_2008.exe 
• For DPM unbundled product :\Setup\VCRTL\vcredist_x86_2008.exe 
To install the modules, Windows Installer 3.1 or later is required. 

 

 

When you execute DPM Command Line, the following log is output to "System" in the [Event 
viewer]. 
Source: SideBySide  
Event ID:32 
Explanation: The dependent assembly Microsoft..VC90.CRT could not be detected. 
Error: The referenced assembly is not installed to the system. 

This message appears when runtime modules required for running DPM Command Line are 
not properly installed. 
Run the following file in the install media to install the run-time modules: 
• For SSC product: :\DPM\Setup\VCRTL\vcredist_x86_2008.exe 
• For DPM unbundled product :\Setup\VCRTL\vcredist_x86_2008.exe 
To install the modules, Windows Installer 3.1 or later is required. 
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11.6.2. Creating a Linux Install Parameter File 
  

  

When you select Open under File menu from the installation parameter setting tools and when 
reading the existing Linux installation parameter file, the following message appears: 
 

A candidate host file cannot be read. 
 

In the selected Linux installation parameter file, OS may not be supported in this version. For 
the details of supported OS, see Section 3.8.1, "System Requirements" or Appendix A, 
"Support Tables Support for Managed Machine OS's" in First Step Guide. 
 
The Linux installation parameter file may be damaged. 
Check the contents of the Linux setup parameter file and Linux boot parameter file. 

  

  

When you select Open under File menu from the installation parameter setting tools and when 
reading the existing Linux installation parameter file, the following message appears: 
 

The Linux OS install parameter file cannot be read. 
 

In the selected Linux installation parameter file, OS may not be supported in this version. For 
the details of supported OS, see Section 3.8.1, "System Requirements" or Appendix A, 
"Support Tables Support for Managed Machine OS's" in First Step Guide. 
 
The Linux installation parameter file may be damaged. 
Check the contents of the Linux setup parameter file and Linux boot parameter file. 
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11.6.3. OS Installation by Disk Duplication 
  

  

While you set up the OS by disk duplication, the following message appeared on the machine 
screen and processing stopped. 
"The parameter file for this system is not prepared, or failed to be copied. Follow the wizard to setup 
displayed after reboot. Press any key to reboot." 

The number of machines trying to access the Management Server may exceed the 
maximum number of machines concurrently accessible. Reduce the number of machines 
concurrently accessing the Management Server concurrently. 

  

  

During the Windows OS setup, performed by disk duplication, the process stopped under the 
condition of being logged onto the machine. 
Furthermore, machine names, etc., that were specified by parameters are not set correctly. 

Individual reflection of disk duplication may have failed, due to the time taken to initialize 
Windows OS. 
Open C:\Sysprep\DepConfig.ini by Text Editor or similar tool, and change the following 
Timeout value (milliseconds). (Please use single-byte numeric characters.) 
C:\Sysprep\DepConfig.ini may be edited after Copy-ExpressSysprep.vbs script is executed 
on the master machine, at the time that a disk duplication master image being created. 

 

 
 

Example) 

 
  

  

During the OS setup by disk duplication of Windows Server 2008/Windows Vista/Windows 7, one of 
the following message appeared and the process stopped. 
・ "Windows could not parse or process the unattended answer file for pass [specialize]. The 

settings specified in the answer file cannot be applied. The error was detected while processing 
settings for component [Microsoft-Windows-Shell-Setup]." 

・ "The computer restarted unexpectedly or encountered an unexpected error. Windows installation 
cannot proceed. To install Windows, click "OK" to restart the computer and then restart the 
installation." 

The OS type and Product-Key of the disk duplication data file for the deploy target machine 
may differ from the OS type and Product-Key of the master machine's setup parameter file. 
Change the OS type and Product-Key of the disk duplication data file so that it matches the 
settings of the setup parameter. Then, after restoring the master image, redistribute the disk 
image. 

  

 

While you setup the OS by disk duplication, the following message appeared on the machine 
screen and processing stopped. 
"The system registry contains invalid file paths. Installation cannot proceed. This system image was 
applied without guaranteeing that drive-letter assignments would match across computers." 

This error may be displayed if the system configuration of the master image of the disk 
duplication is multiboot. 
Confirm that the master image is not a system configuration of multiboot. Disk duplication in 
a multiboot environment is not supported. (Be sure to construct the master image as a single 
system.) 

[SYSPREP] 
Timeout=300000 
 

[SYSPREP] 
Timeout=60000 
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After you set up the OS by disk duplication, the characters of the connection name registered in 
Network and Dial-up Connections were garbled. 

If this occurs, change the connection name manually. 

  

 

During disk duplication, a screen appeared that requested IMJPZP.DI_ file or other files. 
If IMJPZP.DI_ was requested, copy IMJPZP.DI_file from the location below to the 
\SYSPREP\I386\LANG (for Windows XP/Windows Server 2003/Windows 2000, 
\SYSPREP\I386\LANG\JPN) folder of master machine created in Section 3.3.1.3, "Preparing 
Sysprep" in Operation Guide. If LANG folder does not exist under I386, create one. 

For Windows XP, Windows Server 2003: (CD-ROM) drive:\I386\LANG\IMJPZP.DI_ 
For Windows 2000: (CD-ROM) drive:\I386\LANG\JPN\IMJPZP.DI_  

After the above file is copied, perform disk duplication again, referring to Section 3.3.1.4, 
"Executing Sysprep.bat" in Operation Guide. 
If other file was requested, use the same procedure to add the file to the master machine, 
and perform disk duplication again, referring to Section 3.3.1.4, "Executing Sysprep.bat" in 
Operation Guide. 

  

 

After disk duplication, messages such as the following appear at Linux OS startup. Or, X-Window 
does not start. 
"Could not look up internet address for "Hostname" This prevents GNOME from operating correctly. 
It may be possible to correct the problem by adding "hostname"* to the file /etc/hosts." 

*"Hostname" is the host name of each machine after disk duplication. 
An error may occur at X-Windows startup because a host name is not registered to the file 
/etc/hosts. Register the hostname in the /etc/hosts file. If the environment uses a fixed IP 
address, register the line as the following. 
Example) 192.168.0.1 servername 

If the computer obtains an IP address from DHCP, register the hostname with a 
loopback address as follows: 

Example) 127.0.0.1 localdomain.localhost localhost servername 
  

 

IP address conflict occurred after disk duplication. 
If an alias interface is configured in the master machine, IP address conflict occurs after disk 
duplication. Use the following procedure to delete the alias interface configuration file, and 
then restart the machine. 

 
# cd /etc/sysconfig/network-scripts 
# rm -f ifcfg-eth*:* 
# rm -f ifcfg-bond*:* 

  

 

If you perform a disk duplication backup of a Linux-installed VMware ESX/ESXi virtual machine as 
a master machine, the following error appears during POST process of the first reboot after 
completing the backup process, and then the machine was shut down. 
"Determining IP information for eth[]…failed; no link present. Check cable?" 

Configuration described in Section 3.4.1.3, "Deleting Specific Information" in the Operation 
Guide may not have been configured correctly during the preparation for disk duplication on 
the master machine. 
Confirm the procedure and configuration, and then perform the disk duplication again. 
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If you perform a disk duplication for a VMware ESX/ESXi virtual machine, the following error 
appears during POST operations at startup after the individual settings are reflected, and the 
network adaptor is not recognized. 
"Determining IP information for eth[]…failed; no link present. Check cable?" 

When the disk duplication data file was created, the script data listed in Section 5.4.3, 
"Creating a Disk Duplication Parameter File (Linux)" may not have been configured properly. 
Confirm the procedure and configuration, and then perform the disk duplication again. 

  

 

A scenario execution error occurred on the managed machine in either Windows Server 2008 or 
Windows Vista environment. 

If a OS installation by disk duplication is performed when a Management Server is Windows 
Server 2003 SP2 or Windows Server 2003 R2 SP2 and the managed machine is Windows 
Server 2008 or Windows Vista, a timeout may occur due to network workload etc., and lead 
to a scenario execution error. 
Try the following: 
・ Follow the procedures described in the following Microsoft site: 

http://support.microsoft.com/kb/948496/en-us 
・ Change the following registry values to a value larger than the default. 

Key: HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager  
Value name:PingIntervalSnrwatch               (* default:30 [units:seconds])  
Value name:PingRetryCountSnrwatch            (* default:120 [units:times])  

 

11.6.4. OS Clear Installation 

 

After Distribution of floppy disk image for BIOS/firmware and an OS clear installation scenario was 
executed, a scenario execution error occurs before you reboot the machine. 

Is there a check-in on the Forced Execution Of A Reboot Is Performed Before Execution 
checkbox on the scenario Options tab? If not, a scenario will not be executed for any 
machine that has been turned ON. Modify the scenario or turn the machine OFF and 
execute the scenario again. 

  

 

Scenario execution has stopped and the following message appeared on the machine's screen 
during the execution of an OS clear installation scenario. 

"Cannot connect data server. Please stop running scenario on management server and 
press any key to reboot" 
The maximum number of machines that accessing the Management Server simultaneously 
may have been exceeded. Reduce the number of machines that are accessing the 
Management Server simultaneously and execute again. 

  

 

The OS installation has stopped due to an error. 
OS installation will stop with error if you specified unusable character in the machine name. 
For a list of unusable characters, please refer to the manual or other reference of the OS you 
are using. 

  

 

During Linux installation, the following message appears, and the installation could not be 
completed. 

Could not allocate requested partitions; Partitioning failed: 
Could not allocate partitions as primary partitions 
The partition settings may be wrong. (For example, if the number of primary partitions on 
one basic disk exceeds the upper limit (4))  
While creating the Linux installation parameter file, select Disk Information Settings - 
Partition Settings - Delete All Existing Partitions and execute the Linux installation again. 
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During Linux installation, the following message appears, and the installation could not be 
completed. 

+--------------- Kickstart Error ------------+ 
Error opening: kickstart file 
/tmp/ks.cfg: No such file or 
directory 

[OK] 
+-----------------------------------------+ 

Confirm that the NFS shared folder is configured correctly. 
Refer to Appendix E, "NFS Server Configuration" of the Installation Guide to configure the 
folder correctly, and then install Linux. 
If you uninstall the DPM server with the exports folder as an NFS shared folder as previously 
mentioned in Setting Up the NFS Service, and then reinstall the DPM Server, the NFS 
shared property is configured in Explorer, but the above error may occur when you actually 
perform the installation. In this situation, release and then reconfigure the NFS shared 
property. 
Confirm that the install device you are using is configured to Installation Device of Linux 
installation parameters. 
Refer to Section 5.4.5, "Creating a Parameter File for an OS Clear Installation (Linux)" to 
configure Installation Device correctly, and then install Linux again. 

 

11.6.5. Service Packs / HotFixes / Linux Patch Files / Application 

Installation 
  

 

Perform the following operations if scenario execution errors continue to occur in remote update. 
Restart the Management Server. (If the Management Server cannot be rebooted, stop all 
services described in Appendix A, "Service List" from Start menu -> Control Panel -> 
Management Tools -> Services, and then start all of the services you stopped.) 

  

 

When you executed the scenario of installing service packs, HotFix, Linux patch files, and 
applications, but the machine in the Status column of the Monitor view -> Scenario Execution 
List remains in Running Scenario, and the scenario execution does not complete. 

If the command option is not configured correctly, a confirmation dialog box appears on the 
machine and the scenario execution does not complete. You can confirm the command 
option by running the service pack or the HotFix with the option /h or -? , or refer to 
distributors homepage. Make sure that you specify the command options to execute silent 
installation and not to restart after installation. 

  

 

Failed to create an image file during the registration of Installing service packs, HotFix, Linux patch 
files, and applications by Image Builder. 

In installing service packs, HotFix, Linux patch files, and applications, image file is saved in 
ZIP file. If these ZIP files size exceed 2GB, creation of the image file fails. 
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When you modified a package by Image Builder, the message "Failed to compress the file." is 
displayed and package modification fails. 

If the modification date is earlier than the package creation date, package modification fails. 
There may be some reasons, such as, the date-time of the computer was changed after 
creating the package, or that date-time of the Management Server is different from one of 
the Image Builder  
(Remote Console) computer. After the date that the package was created, modify the 
package, or delete the package and create the package again. 
 
The packages are stored in Management Server's Folder for Image \HotFix, or Folder for 
Image \PP. 
(The default of the Folder for Image is  
C:\Deploy, and the package file name is "ServerID"-"PackageID".zip.) 

  

 

When you modify a package by Image Builder (Remote Console), "Failed to register in the 
Management Server." is displayed and the modification of package failed. 

If the modification date is earlier than the package creation date, package modification fails. 
There may be some reasons, such as, the date-time of the computer was changed after 
creating the package, or that date-time of the Management Server is different from one of 
the Image Builder (Remote Console) computer. 
After the date that the package was created, modify the package, or delete the package and 
create the package again. 
 
The packages are stored located in Management Server's Folder for Image \HotFix, or 
Folder for Image \PP. 
(The default of the Folder for Image is  
C:\Deploy, and the package file name is "ServerID"-"PackageID".zip.) 

  

 

Even if applying a service pack/HotFix/Linux patch file fails, the Web Console displays that scenario 
execution completed successfully. 

When the execution of a service pack or HotFix fails, the failure may not be detected. In such 
case, fix the cause of the execution failure, and then execute the scenario again. 

  

 

You want to create a scenario that Distribution of floppy disk image for BIOS/firmware and Installing 
service packs, HotFix, Linux patch files, and applications are executed at the same time. 

You cannot register a scenario with Distribution of floppy disk image for BIOS/firmware and 
Installing service packs, HotFix, Linux patch files, and applications. If you want to perform 
these at the same time, register a scenario that executes the OS installation and add the 
settings for BIOS/firmware update and service pack/HotFix/Linux patch file/application install 
to the scenario. 

  

 

A scenario execution error occurs if you execute a scenario Distribution of floppy disk image for 
BIOS/firmware or apply Installing service packs, HotFix, Linux patch files, and applications install. 

Did the execution interruption process complete correctly? If interruption is cancelled before 
execution and then the scenario is executed, the scenario execution error may occur. 
Furthermore, if you want to execute the same scenario simultaneously on multiple 
machines, set the maximum target number of multicast distribution conditions to the number 
of machines you want to interruption process is completed, and then execute the scenario. 
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A scenario execution error occurs if you try to execute multiple service pack/HotFix/Linux patch 
file/application install scenarios at the same time. 

See the Scenario Details screen and check whether the same multicast IP address is 
specified. If the same multicast IP address is not being used, reduce the maximum transfer 
rate, or execute the scenarios one by one. (If the scenario is the same, you may also execute 
the scenario on multiple machines.) 

  

 

A scenario of installing service packs, HotFix, Linux patch files, and applications does not start. 
If the maximum target is not configured, or is greater than the machine attempting to execute, 
the scenario executes after the maximum wait time passes. (The default setting of the 
maximum wait time is 10 minutes.) 

  

 

The maximum transmission rate has been set higher, but the scenario execution time does not 
decrease. 

Maximum transmission rate depends on varies widely with a customer's network environment. 
You cannot obtain a transmission rate higher than the network environment's performance. 

  

 

If you register an application or service pack/HotFix by Image Builder (Remote Console), the error 
Failed to register to Management Server is displayed. 

This error may occur when the size of the file to register is extremely large. 
To prevent this error, edit the timeout value (number of seconds) that is specified by the 
following registry: 

Hive : HKEY_LOCAL_MACHINE 
KEY : SOFTWARE\NEC\DeploymentManager 
NAME : DIBReqTimeOut 
Type : REG_DWORD 
Value : 120 
-> The default is 120 seconds. Set the timeout value. 
Even if an error is displayed, registration is successful. Re-registration is unnecessary. 
When you exit Image Builder, perform the following operations: 

(1) Select Yes (Register) at batch registration. 
(2) Select No (Delete) at the confirmation of overwriting. 

  

 

If you register a service pack/HotFix/Linux patch file by Image Builder (Remote Console), the data 
creation has succeeded. However, the registration to the Management Server fails. 

This may occur if the path for the setup command name is extremely long. 
If registering to the Management Server from the Remote Console, the upload process checks 
the full path, including the Folder for Image path on the Management Server side as the 
maximum path length. If the upper limit of the full path is exceeded, the registration fails. 
Register a shorter full path by moving the files to be registered to a location close to the drive 
root on the Remote Console, and register the files again. 
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If you interrupt the execution of the scenario of installing service packs, HotFix, Linux patch files, 
and applications, and then cancel the interruption and execute the scenario again, a scenario 
execution error occurs. 

If the interruption occurs when communications with the managed machine is disrupted for 
some reason, the interruption process cannot be completed, and the machine remains in an 
interrupt status. In this status, even if a scenario is executed after the interruption is 
cancelled, a scenario execution error occurs. 
In this case, wait for a while (about 10 minutes) and before executing the scenario again. 
If the scenario execution errors persist, perform the following operations. 
 
On the managed machine, select Start menu -> Control Panel -> Management Tools 
->Services, and restart DeploymentManager Remote Update Service Client. (If the 
service is stopped, please start it.) 

  

 

After executing DPM Client automatic upgrade scenario for a Linux managed machine, and then 
execute another remote update scenario, which does not start. 

When another remote update is executed within two minutes of executing the DPM Client 
automatic upgrade scenario and the DPM Client service does not start correctly. Restart the 
DPM Client service or restart the OS. To restart the DPM Client service, start the Console 
and execute the following:  

> service depagt stop 
> service depagt start 

  

 

If remote update is executed for a Linux managed machine, a scenario execution error occurs. 
When installing service packs, HotFix, Linux patch files, and applications in Image Builder, 
an option that outputs to the console may be specified to Setup Parameters on the 
Execution Configuration screen. The option may be specified. 
See Section 5.5.3, "Create Linux Package," and confirm that relevant options are not 
specified. 
If the relevant options are specified, delete scenarios including that packages, correct the 
packages from which relevant options were removed. Recreate the scenario file with the 
corrected packages, and then execute the scenario again. 

  

 

If a remote update is executed by multicast for the EM64 Linux managed machine, a scenario 
execution error occurs. 

The necessary libraries may not be installed. Confirm that /lib/libgcc_s.so.1 exists. 
If /lib/libgcc_s.so.1 does not exist, install the following rpm package: 

libgcc-3.4.5-2.i386.rpm 
After the installation, restart the DPM Client service or restart the OS. 
To start the DPM Client service, start the Console and execute the following: 

> service depagt start 
  

 

When the remote update scenario is distributed by multicast, the scenario execution to a part of the 
managed machines fails. 

If all of the following is applied and a remote update scenario is distributed by multicast, 
scenario execution fails. 
If managed machines are connected to multiple LAN boards on the Management Server, 
create and execute different scenarios for each LAN board. 
・ ANY is selected on the Web Console screen under Management View -> DPM Server 

icon -> Detail Setting screen -> General tab -> IP Address. 
・ The managed machines are connecting with multiple LAN boards on the Management 

Server. 
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11.6.6. Backup/Restore 
  

 

The partition number specified when the scenario is created is different from the partition number 
displayed on the machine screen. 

A hidden partition may exist in the target hard disk. The hidden partitions will not be included 
in the total count if the check box was checked for Hidden Partition Is Disregarded in 
partition specification Backup/Restore. Uncheck the check box off, or enter a supported 
partition number correctly. 

 

 

Only several tens of MBs are transferred per minute during Backup/Restore operations. 
The maximum transmission rate may be specified too low, such as 1—10MB/minute. Confirm 
the Maximum transmission Rate column on the Multicast Condition Setting panel in 
Backup/Restore tab on the Scenario Edit screen. If you want to save time, uncheck the check 
box. If you want to reduce network workload, check the check box and specify the appropriate 
values. 
Data may not be transferred smoothly due to a high network workload. Minimize use of the 
network as much as possible during the scenario execution. 

  

 

A scenario execution error suddenly occurred suddenly while data transfer was in progress during 
backup. 

Data transmission may not be possible due to sufficient free space on the Management 
Server. Make sure there is insufficient free space on Management Server where the backup 
data is to be saved. Backup will not operate properly if there is not enough free space. 
Reconsider the backup file destination, or reserve sufficient free space. 

 

 

When you start the OS on the machine that is restored, the disk image of another machine was 
restored. 

The image files that you backed up may have been overwritten with the backup image of 
another machine. When performing a backup, make sure that you do not use a redundant 
image file name. Otherwise, the previous data will be overwritten. 
Furthermore, if the same scenario is assigned to multiple machines and execute backup 
simultaneously, check whether machine name, MAC address, or UUID under the textbox on 
the scenario file Backup/Restore tab is checked. 

  

 
 

Even if restore is executed simultaneously, several of the managed machines do not execute 
scenarios, and Waiting for Restore Execution is displayed on the Backup/Restore Execution List 
screen. 

The Maximum Targets set for the scenario file may be less than the actual machine number 
you are trying to execute. In this case, after completing the execution of preceding scenario, 
and then the scenarios for the rest machines start. 

  

 

The restore operation has been in waiting for restore execution status and does not start. 
The setting of the Maximum Waiting Time column under the Multicast Condition Setting 
on the Backup/Restore tab for the scenario file can not to be configured. If the column is 
empty, the scenario will not execute until the number of machines ready to execute scenarios 
reaches the Maximum Target value. Click Run Now on the Backup/Restore Execute List 
screen, or interrupt the execution and specify an appropriate value for Maximum Wait Time 
of the scenario file. 
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Even if you the maximum target number as 10 in the restore scenario, and then execute the scenario 
on 10 machines simultaneously, the scenario executes on only 5 machines at once. 

If the Management view -> DPM Server -> Detail Setting -> Network tab ->Machines For 
Simultaneous Execution value is 5, the scenario executes on only 5 machines at once, even 
though the maximum target value is specified as 10. If you want to execute on 10 machines 
simultaneously, change the value of Machines For Simultaneous Execution under Detail 
Setting to 10. 

  

 

The maximum transmission rate has been set higher, but the scenario execution time does not 
decrease. 

Maximum transmission rate depends on customer's network environment. You cannot obtain 
a transmission rate higher than the network environment's performance. 

  

 

Even through the execution of a backup scenario, a unicast restore scenario, or disk configuration 
check scenario completed, the status of Scenario Execution List status remains Preparing. 

If you executed a backup scenario, a unicast restore scenario, or disk configuration check 
scenario on another machine before the same scenario execution has completed, the status 
of Scenario Execution List in the Web Console may display Preparing from the time the 
backup, restore, disk configuration check completes to the time that the execution of the 
scenario completes. However, it does not affect the operation. 

  

 
 

When checking scenario execution status on Backup/Restore Execution List while a multicast 
restore scenario is executing, the scenario status is displayed as already complete even though 
execution was still in progress, or it may not be displayed. 

Backup/Restore Execution List cannot be updated immediately, even when the scenario 
was executed. The status is updated when reading or writing to the Backup/Restore disk 
starts. 
Until that time, the pre- execution status of the scenario is displayed. When the screen was 
displayed before an update, wait a moment, and then reopen the screen, and click Refresh. 

  

 

During backup, a scenario execution error occurs, but no error message is displayed. 
If the OS did not shut down properly when the machine was power off, the delayed write to 
disk process may not have been completed during shutdown, and the file system may be 
damaged. Furthermore, if the machine was power off and shutdown was not performed while 
the disk was accessing, physical damage on the disk may have occurred. 
If a backup was performed on such a disk, a scenario execution error may occur. 
In such case, reinstall the OS, or use a file system fix tool or similar tools to fix the file system, 
and then perform backup again. 
Furthermore, if there is a physical damage on the disk (bad sector), you cannot 
backup/restore using a fix tool, etc. If there are bad sectors, change a new HDD and recover it 
by physically formatting and then execute a restore from a previous backup image. 

  

 

When multiple restore scenarios are executed simultaneously, a scenario starts on the first machine 
booted up, but after getting Backup System image is displayed on the other machines, a scenario 
execution error has occurred, and the error is displayed on the Scenario Execution List screen. On 
the machine screen, the following error message was displayed: 

"ERROR: Received the error from the PXE server. 
Please contact your system administrator or support group." 

The same multicast IP address is specified when the scenario was created may be specified 
in all scenario files. Open the Edit Scenario screen, and check the value of multicast IP 
address on the Multicast Condition Setting panel of the Backup/Restore tab. If the 
specified IP address is the same to another restore scenario, one of the two scenarios may 
not start correctly. Enter a non-redundant IP address again on the Modify Scenario screen. If 
Remove Scenario Execute Error is selected for the machine on which an error was 
occurred, error display disappears, and the scenario can be executed again. 
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If you specify a partition and then restore, the scenario execution error occurs and the following error 
message was displayed. 
ERROR: Cannot be restored to a different partition scheme. 

The partition format (number of partitions, arrangement, size or file system) of the restore 
destination to which you are trying to restore may be different from the backup source of the 
backup file. The restore destination must be the same partition format (number of partitions, 
arrangement, size or file system) as the backup source with partition specified backup/restore. 
Also, restore to the same partition as when backing up. Open the Edit Scenario File screen, 
reset the applicable partition and then execute the scenario again. 
You may have specified a partition as the restore destination which is different from the 
backup source. Restore to the partition when it was backed up. Open the Edit Scenario File 
screen, reset the applicable partition and then execute the scenario again. 
If the Hidden Partition Is Disregarded checkbox was checked and the scenario is executed 
on the managed machine existing hidden partitions, the machine may be trying to specify a 
partition that is different from the backup source while executing the scenario. In this case, 
uncheck the Hidden Partition Is Disregarded checkbox, and then execute the scenario 
again. 

  

 

Processing without ending, while executing a backup/restore scenario, and the following messages 
are displayed on the managed machine: 

FS: Cannot open root device "" or xx:xx 
Please append a correct "root=" boot option 
Kernel panic: VFS: Unable to mount root fs on xx:xx 

There may be a problem in the LAN connection between the Management Server and the 
managed machine, or the workload on the Management Server may be high. Check the LAN 
connection and the Management Server workload, and then turn off the machine and execute 
the scenario again. 

  

 

While executing a restore scenario, the following message is displayed on the managed machine, 
and a scenario execution error occurs. 
ERROR: Backup Data is un-restorable because Size is larger than HDD. 

Check the HDD sizes of the backup source and the restore destination. 
If the HDD size of the restore destination is smaller, this message may be output. 
Use a HDD with the same or larger size than the backup source 

  

 

When the following error occurs and a process ends with error for some reason, you cannot execute 
a shutdown or re-boot even if you press p or r (Key input cannot be recognized). 

ERROR: <error message> 
Press the p key to power off, and the r key to reboot:  

Key input may not function on certain kinds of machines using a USB keyboard/mouse which 
cannot be recognized. 
Press (and hold down) the power button to turn off the power. 

  

 

If you interrupted the execution of a restore scenario, the following message was displayed on the 
managed machine: 
ERROR: Unpredictable end of data. 
There may be a mismatch between header information and actual data. 
(XXXXXX, XXXXXX) 

This message is displayed when a scenario execution is interrupted. This message displays 
because the data of the intended size could not be obtained due to a disconnected 
communication between Management Server and the managed machine. 
This is not problematic to the scenario execution interruption process. 
While executing a restore scenario, the restore data cannot be read. 
Confirm that the backup image is not damaged and there is no trouble on the network. 
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When a restore scenario is multicast distributed, the restore does not executed, and scenario 
execution is interrupted. 
Furthermore, the following message was displayed on the managed machine, and then the machine 
restarted. 
(After the restarting, a scenario execution error was displayed on the status of the managed machine 
on the Web Console.) 
ERROR: Unpredictable end of data. 
There may be a mismatch between header information and actual data. 
(XXXXXX, XXXXXX) 
This System is rebooted after XX seconds. 
gzip: stdin: Unexpected end of file. 

This phenomenon may occur when both ANY is specified for the IP address used by 
Management Server and the restore scenario is distributed by multicast. Configure other than 
ANY for the IP Address used by Management Server (the IP address configured by the using 
LAN board). For configuration method details, see Section 2.7.1.1, "General Tab". 

  

 

PXE boot fails on the managed machine. 
Is the Management view -> DPM Server -> Detail Setting -> DHP Server tab set to Do Not 
Use a DHCP Server?  
If Do Not Use a DHCP Server is selected, a PXE boot cannot be executed on the managed 
machine. 
If a PXE boot is necessary, configure a DHCP server, and select Use a DHCP server. 
Furthermore, restart the Management Server after changing it since the configurations are 
enabled after Management Server restarts. 

 

11.6.7. Distribution of BIOS/Firmware Floppy Disk Images 
  

 

The managed machine does not boot by the network boot after a scenario that Distribution of floppy 
disk image for BIOS/firmware is executed. 

If BIOS is upgraded, the BIOS configuration may return to the default settings. Check whether 
the priority order of the network boot is not changed. If the priority order is changed, set 
network boot to the top priority. 

  

 

A scenario execution error occurs when you execute a Distribution of floppy disk image for 
BIOS/firmware, Installing service packs, HotFix, Linux patch files, and applications install scenario. 

Did the execution interruption process complete correctly? If interruption is cancelled before 
the process of the interruption completes and then the scenario is executed, a scenario 
execution error may occur. 
Are you trying to execute the same scenario which is being executed on another machine? If 
you want to execute the same scenario on multiple machines simultaneously, specify the 
maximum target number under Multicast Condition to the number of machines that you want 
to execute, and then execute the scenario. 

  

 

A scenario execution error occurs before the machine restarts after a scenario of Distribution of 
floppy disk image for BIOS/firmware and a scenario of OS clear installation is executed. 

Did you specify the Forced Execution Of A Reboot Is Performed Before Execution on the 
scenario Options tab before execution? If not, a scenario is not executed for any machine that 
is power on. Modify the scenario, or turn off the machine and execute the scenario again. 
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11.7. Managed Machine Registration 
  

 

Even if you turn on a managed machine, a new registration is not performed. 
The DHCP configuration may be wrong, or the DHCP Service may not operate properly. 
Check the following items: 
・ Select Management view - DPM Server - Detail Setting - DHCP Server tab on the Web 

Console, and confirm that the Use A DHCP Server configurations are correct. 
・ Confirm that the lease IP address in the DHCP scope is not inactive. 
・ Confirm that the DHCP server is recognized and the IP address is available for lease. 
・ Confirm that the DHCP address pool has not run out. If the pool has run out, please secure 

a sufficient amount of addresses. 
・ If using a DHCP service other than Windows (for example, such as when the DHCP server 

was built on Linux), confirm that fixed addresses are configured. 
The managed machine may be a model that does not support PXE boot, or the network 
startup order may be set lower than the HDD. 
On an IA32 architecture machine, check the network startup order in the BIOS settings. For 
methods to check the BIOS, contact your sales or support representative. 
If operating without using the DHCP Server, and the Management view - DPM Server -Detail 
Setting - DHP Server tab was changed to Do Not Use A DHCP Server, it is necessary to 
restart the Management Server to enable the settings. Restart the Management Server, and 
then restart the managed machine. 
If multiple LAN boards are mounted on the managed machine, confirm that the LAN board 
used for DPM communications is registered to the DPM Server. 
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11.8. Automatic Update 
  

 

Open Monitor view -> Automatic Update Results List screen, and check the detailed information 
of the corresponding machine and date/time, then registration of error log information can be 
confirmed. 

Check the detailed information, and fix each problem. 
If you perform automatic update after fixing the problem, reboot the managed machine. 
 
<Detailed Information 1> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ An error occurred while preparing for the automatic update. 
・ …… 

Description Management Server resource may be insufficient. Restart the Management 
Server. 

 
<Detailed Information 2> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ A socket error occurred. 
・ …… 

Description WinSock initialization failed. 
Check the network configuration of the Management Server (if TCP/IP protocol is installed) 
If there is no problem, restart the Management Server. 

 
<Detailed Information 3> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ The connection to the client failed. 
・ …… 

Description: The Management Server couldn't connect to the managed machine. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a space between ping and the IP address/host name.) 
 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the machine 
side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 4> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ Search for the packages that are applicable to the client failed. 
・ …… 

Description DPM may not support the OS of the machine on which the error occurred. 
Check the machine's OS and language. Following is a list of supported OS for the DPM's 
automatic update. The supported language is English only. 
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OS Name 
Windows 2000 Professional 
Windows 2000 Server 
Windows 2000 Advanced Server 
Windows XP Professional 
Windows Server 2003 Standard Edition 
Windows Server 2003 Enterprise Edition 
Windows Server 2003 Standard x64 Edition 
Windows Server 2003 Enterprise x64 Edition 
Windows Server 2003 R2 Standard Edition 
Windows Server 2003 R2 Enterprise Edition 
Windows Server 2003 R2 Standard x64 Edition 
Windows Server 2003 R2 Enterprise x64 Edition 
Windows Vista Business 
Windows Vista Enterprise 
Windows Vista Ultimate 
Windows CE (for US110) 
Windows Server 2008 Standard 
Windows Server 2008 Enterprise 
Windows Server 2008 Standard x64 
Windows Server 2008 Enterprise x64 
Windows Server 2008 R2 Standard 
Windows Server 2008 R2 Enterprise 
Windows Server 2008 R2 Datacenter 
Windows 7 Professional 
Windows 7 Ultimate 
Windows 7 Enterprise 

 
<Detailed Information 5> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ Reconfirmation of the connection to the client failed. 
・ …… 

Description A communication error occurred with the machine. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a space between ping and the IP address/host name.) 
 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the machine 
side. 

(If a service is stopped, please start it.) 
DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 

http://www.microsoft.com/products/info/product.aspx?view=22&pcid=2abf99cd-a5e4-469c-802e-55ca8ec542d5�
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 <Detailed Information 6> 

・ Computer: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file in the client failed. 
・ …… 

Description The disk space of the machine may be insufficient. 
Check the machine disk free space. Normally, it required free disk space that at least 
three times the size of the package to send. 
Example) To apply a 100MB package, it is necessary that the free space of the managed 

machine system drive should be at least 300MB. 
 
<Detailed Information 7> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ An error occurred while preparing for the file transfer. 
・ …… 

Description An error occurred in the process before the file is transderred. 
The Management Server may have insufficient resources. Restart the Management 
Server. 

 
<Detailed Information 8> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file transfer control thread failed. 
・ …… 

Description Failed to call WindowsAPI (CreateThread()). 
The resource on the Management Server may be insufficient. Restart the Management 
Server. 

 
<Detailed Information 9> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file transfer control thread failed. 
・ …… 

Description Failed to call WindowsAPI (CreateThread()). 
The resource on the Management Server may be insufficient.. Restart the Management 
Server. 
 

<Detailed Information 10> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ An error occurred during the transfer of xxxxxxxx. 
・ …… 

Description A communications error occurred when sending a file. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the 
OK button. The command prompt appears. Enter ping IP address or ping 
hostname and press Enter. (Enter a space between ping and the IP address/host 
name.) 
If there is no response, check whether there is a problem in the network configuration. 
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 (2) If there is no problem in the network, restart the following services on the machine side. 

(If a service is stopped, please start it.) 
DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 11> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ File transfer to the client failed. 
・ …… 

Description A communications error occurred when sending a file. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. 

(If a service is stopped, please start it.) 
DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

(3) A file in transit may be in use by another process on the machine. 
If virus scan or other such software is running on the machine, a file in transit may be 
locked by the virus scan software, and transmission may fail. In such a case, when the 
next automatic update executes, the file is sent again and applied.. 

 
<Detailed Information 12> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ During the execution of xxxxxxxx package, an error occurred. 
・ …… 

Description The package was sent to the machine, but an error occurred during execution. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 

(2) The disk space may be insufficient. 
This error occurs when the machine disk space is insufficient. Check the machine disk 
free space. Normally, it requires free disk space that at least three times the size of the 
package to send. 
Example) To apply a 100MB package, it is necessary that the free space of the 

managed machine system drive should be at least 300MB.. 
(3) Uncompressing failed. 

Check whether there is a problem in the package sent to the machine. Confirm whether 
the package can be uncompressed on the machine. 

 
<Detailed Information 13> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ "Automatic update completed" response could not be received from the client. 
・ …… 
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 Explanation 

(1) Use the following procedures to execute ping for the machine. 
From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a single-byte space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 14> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ automatic update notice begins 
・ A socket error occurred. 

No such host is known. 
・ …… 

Explanation 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click on the OK 
button. The command prompt appears. Enter ping IP address or ping hostname and 
press Enter. (Enter a single-byte space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 15> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update time setting begins 
・ Automatic update or scenario execution is in progress in the client. 

Automatic update time setting will become valid after restarting the client. 
・ …… 

Explanation 
The automatic update time configurations will be enabled when the machine is started next 
time. 
 

<Detailed Information 16> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update time setting begins 
・ Setting in the client failed. 

Automatic update time setting will be valid after restarting the client. 
・ …… 

Explanation 
Connection to the managed machine failed because the managed machine power status is 
OFF, or the communications port is closed. The automatic update time configurations will 
be enabled after the client is restarted. 
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The same package is distributed repeatedly in automatic update. 
Until the Management Server recognizes that the package has been applied, the distribution 
is repeated at every automatic update. Check the following items, and perform the process for 
each. 
<When the package type is HotFix>  
・ The MS number is wrong  

Check the MS number and correct it. 
・ The HotFix that cannot be discerned from the MS number  

Set the ID information. 
・ OS and language are not correct 

Check the OS and language, and correct them. 
・ ID information is wrong 

If a file such as text format(*.txt) without file version is specified for ID information file path, 
the applied status cannot be recognized if the file version is specified.. If the file version is 
need to be specified, make the item blank. Also, if it is specified to replace or version up 
as the changed type using text format file, the applied status cannot be correctly 
recognized. In the case of text format, specify new or delete for the changed type 

<When the package type is service pack>  
・ Major version and minor version are wrong. 

Check major version and minor version and correct them. 
・ OS and language are not correct  

Check the OS and language, and correct them. 
・ ID information is wrong 

ID information is not necessary in the case of service pack. Set the correct values to for 
major version and minor version. 

<When the package type is application>  
・ Display name, display version is wrong. 

Check the display name and display version and correct them. 
・ OS and language are not correct. 

Check the OS and language, and correct them. 
・ ID information is wrong 

If a file such as text format (*.txt) without file version is specified for ID information file 
path, the applied status cannot be recognized if the file version is specified. If the file 
version is need to be specified, make the item blank. Also, if it is specified to replace or 
version up as the changed type using text format file, the applied status cannot be 
correctly recognized. In the case of text format, specify new or delete for the changed 
type. 

  

 

An automatic update error is displayed on the screen, and automatic update fails. 
The disk capacity of the Management Server may be insufficient. 
Check the disk capacity of the Management Server. If disk capacity is insufficient, secure the 
necessary disk capacity, and then restart the Management Server. 
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11.9. Automatic Download 
  

 

An error occurred in automatic download. In Management view -> DPM Server icon -> Package 
Download Settings screen -> Latest Download Information column, XXXX/XX/XX XX:XX:XX 
Automatic Download Failed is displayed, and check the Event Viewer to find an error log 
registered. 

Check the log information registered in the Event Viewer, and perform the processes for each 
item. 
After the processes complete, execute the automatic download again. 
 
<Log Information 1> 
・ DownloadFile: Failed to create the download directory, Dir = XXX. 

Explanation: 
Failed to create directory. 
This error occurs when the disk space of the managed machine is insufficient. Check the disk 
free space. 
 

<Log Information 2> 
・ DownloadFile: Failed to parse URL, URL = XXX. 

Explanation: 
Unable to analyze address. 
IP address of the Package Web Server may not be correct. Confirm items such as whether 
only valid characters are used, or port configurations are correct. For details, see Section 
2.7.3, "Package Download Setting." 

 
<Log Information 3> 
・ DownloadFile: Failed to connect proxy server, Serve Name = XXX. 

Explanation: 
Cannot connect to the proxy server. 
 

Check the below items in the following order: 
(1) The proxy server address may not be correct. Confirm items such as whether only valid 

characters are used, or port configurations are correct. 
(2) The network settings may not be correct. 

Check whether user identification is set to the proxy server. Use an HTTP proxy if using 
a proxy. 

 
<Log Information 4> 
・ DownloadFile: Failed to connect server, Serve Name = XXX. 

Explanation: 
Failed to connect to the Package Web Server. 
 

Check the below items in the following order: 
(1) IP address of the Package Web Server may not be correct. Confirm items such as 

whether only valid characters are used, or port configurations are correct. 
(2) The network settings may not be correct. 

Check whether user identification is set in the proxy server. Use the HTTP proxy if 
using a proxy. 

 
<Log Information 5> 
・ DownloadFile: Web server happened exception, Serve Name  = YYY. 

Refer to the following detailed message in the log information registered to the event viewer. 
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SendRequest: Http response error status = XXX. 
(Possible values for XXX are: 500, 501, 502, 503, 504, 505)  

 
An error code in line with RFC2616 is added to an error message indicated by error code 
XXX. For details, see RFC2616. 
 

<Log Information 6> 
・ DownloadFile: Failed to get response or response is error, URL = YYY. 

Refer to the following detailed message in the log information registered to the event 
viewer. 
SendRequest: Http response error status = XXX. 
(Possible values for XXX are: 400, 401, 402, 403, 404, 405, 406, 407, 408, 409, 410, 
411, 412, 413, 414, 415)  
 
An error code following RFC2616 is added to an error message displayed by error code 
XXX. For details, see RFC2616. 

 
Example) SendRequest:  Http response error status = 404 
 ->The specified URL does not exist. 

 
<Log Information 7> 

・ DownloadFile: The free disk isn't enough to download, URL = XXX. 
Explanation: 
This error occurs when the disk space of the Management Server is insufficient. Check 
the disk free space. 

 
<Log Information 8> 

・ DownloadFile: The file cannot be refresh, Filename = xxx. 
Explanation: 
Failed to update the file. Check whether a file named xxx is in use. 
If the file is in use, close it, and then download again. 

 
<Log Information 9> 

・ PmDlDownloadPackages: Failed to compress files, Web Server ID = xxx,  
Package ID = xxx. 

Explanation: 
This error occurs when the disk space of the Management Server is insufficient. Check 
the disk free space. 

  

 
 

Automatic download is configured, but it is not executed even when the set time is reached. 
Check the items below by the following order: 

(1) In Management view -> Package Download Setting screen, check Latest Download 
Information. 
If XXXX/XX/XX XX:XX:XX Automatic Download Failed is displayed, refer to Log Information 
1 through 9 of Section 11.9, "Automatic Download." 

(2) Check if the Package Web Server is added as the target of automatic download on the 
Package Download Setting screen. If none of the Package Web Servers are added, 
automatic download is not executed. After adding a Package Web Server, perform an 
automatic download again. 

(3) Check whether the Perform Automatic Download checkbox is selected on the Package 
Download Setting screen. If not, the automatic download cannot be performed. 

If the above procedure does not solve the problem, confirm that automatic update is not in progress, 
and then restart the Management Server. 
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11.10. Power On 
  

 

The machine cannot be turned ON when executing Power On or executing scenario. 
When the machine was forcibly shut down on the POST screen, Remote Power On may not 
function at the next time. 
In this case, turn off the power after finishing POST, or startup the OS and then shut it down. 

  

 

Even though the power is ON, the icon displayed on the machine is power OFF. 
The screen may not be updated. Click Refresh on the Operation menu, or enter F5 to 
refresh the screen. 

  

 

The power is turned ON, but a remote power ON error is displayed on the machine list. 
The managed machine may not support PXE boot, or the network boot order may be set 
lower than the HDD. 
For IA32 architecture machine, check the network boot order in the BIOS settings. For 
methods to check the BIOS, contact your sales or support representative. 

  

 

The VMware ESX/ESXi virtual machine cannot be turned ON when executing Power On or 
executing scenario. 

The VMware ESX/ESXi virtual machine cannot be turned on because Remote Power On is 
not support for these machines. Turn the power ON manually. 
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11.11. Schedule Management 
  

 

Though you set the power management schedule, the machine power is not turned ON/shut down at 
the specified time. 

The machine may have been running a scenario. If the machine is running a scenario at the 
time set to Power ON/shutdown, the power will not be turned ON/shut down. 
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11.12. Machine Information Import/Export 
  

 

Though the machine information is imported, the machine is not displayed on the managed 
machine list. 

Click Refresh on the Operation menu, or refresh the screen by pressing the F5 key, and 
then the machine will be displayed. 
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11.13. Network Settings 
  

 

The following error message was displayed: 
 
 
 
 

The machine may not be connected to the network. 
Check whether the network cable is connected to the machine, and then restart it. 

  

 

Once DHCP server and Management Server have been separately on the different machines, the 
machine's MAC address cannot be obtained. 

The DHCP service on the Management Server may be running. On the Management Server, 
select Start -> All Programs -> Management Tools -> Services, and confirm that "DHCP 
Server" is stop. If it is running, disable Startup Type on the Properties screen, and stop the 
service. 
On the Web Console, Management view -> DPM Server icon -> Detail Setting, -> DHCP 
Server tab -> DHCP Server is installed on an another machine checkbox may be unchecked. 
Check if DHCP Server is installed on an another machine is checked. If the checkbox is not 
checked, enter a check and click the OK button, and then reboot the Management Server. (If the 
Management Server cannot be rebooted, at Start menu -> Control Panel -> Management 
Tools -> Services, stop all services listed in Appendix A, "Service List", and then start them.) 

  

 

The scenario cannot be executed because the managed machine cannot execute network boot. 
Network booting order may be set lower than the HDD in the BIOS configuration. Set the start 
order of the PXE network boot higher than the HDD, and then execute the scenario again. 

  

 

When you try to manage different network by using multiple LAN boards, the following errors are 
displayed. 
PXE-E51: No DHCP or proxyDHCP offers were received. 
PXE-E55: proxyDHCP service did not reply to request on port 4011. 

Please perform the following procedures (1) and (2). 
(1) Change the IP used by the DHCP Server uses. 

1) Select Programs -> Administrative Tools -> DHCP. 
In the dialog right-click on the server name from the tree view of the left screen, and then 
select Properties. 

2) Click the Advanced tab of the dialog box. 
3) Click Binding on the Advanced tab. 
4) Ensure that only check the IP to be used on the displayed screen. 

(Uncheck the IPs not to be used) 
5) Click the OK button to close the screen. 

Select Start menu -> Control Panel -> Management Tools -> Services, and then restart 
the DHCP Server. 

(2) Change the IP used by DPM. 
1) From Management View -> DPM Server icon -> Detail Setting screen -> General tab -> 

IP Address on the Web console screen, select IP Address. 
  

 

When DHCP Server and Management Server have been separately on the different machines , the 
following error was displayed at network boot execution. 
PXE-E55: proxyDHCP service did not reply to request on port 4011. 

A DHCP server may exist which is set to option 60(060 Class ID) in DHCP server options. Check 
the DHCP server option settings, and delete the option 60(060 Class ID) setting. 

 Failed to delete the computer name of the server. 
 Check the network environment, and restart. 
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If you execute a scenario, the following error is displayed. 
PXE-E53:No boot filename received  

The DHCP server installation location configuration is incorrect. 
Open Management View -> DPM Server icon -> Detailed Settings screen on the DPM main 
window screen, and check that the setting of DHCP server tab is correct. 
Even if configuration is already correct, reconfigure the settings. 
If an error is displayed despite correct settings, first change the current settings to different 
settings (if the actual environment is DHCP Server is installed on the machine, then change it 
to DHCP Server is installed on an another machine, and if it is DHCP Server is installed on 
an another machine, then change it to DHCP Server installed on the machine), and then 
reconfigure the settings correctly. 
Example) If DHCP Server is installed on the machine is selected::  

(1) Select DHCP Server is installed on an another machine 
(2) Click OK  
(3) According to the message displayed on the screen to restart the services 
(4) Select DHCP Server is installed on the machine 
(5) Click OK  
(6) According to the message displayed on the screen to restart the services 

  

 

If you assigned IP addresses of the same segment to a machine with multiple LAN boards, power status 
cannot be detected normally. 

If static IP addresses are assigned to LAN boards which are not connected to LAN cables, the 
machine may not be able to communicate correctly. If any LAN boards are not connected to LAN 
cables, either use DHCP settings without assigning static IP addresses, or set nothing for them. 

  

 

During network boot, the following message is displayed on the screen of the managed machine, and a 
scenario execution error occurs. 
  PXE-E32: TFTP open timeout 

The TFTP port (port number: 69) may be blocked due to the port blocking functionality of 
Windows Firewall, or other security software. Confirm that the TFTP port is not blocked on the 
Management Server. It is necessary to unblock the TFTP port in order to perform operations on 
DPM. 
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11.14. Operating Without DHCP Server 
  

 

An error occurs in Power ON, or Add Machine. 
Confirm if DPM Client is installed on the managed machine. See Section 2.2, "Installing the 
DPM Client" in Installation Guide for the installation method. 

  

 

Failed to execute Backup scenario/restore scenario/ disk configuration check scenario from 
bootable CD. 

Check the following: 
Is the managed machine registered? 
Is a scenario assigned to the managed machine? 
Is the scenario assigned to the managed machine correct? 
Is a Multicast Scenario assigned? 
Does the scenario specify multiple tabs, such as specifying both the Backup/Restore tab 
and the HW Setting tab selected? 
An error occurs by scenarios excluding backup scenario, restore (unicast) scenario, or 
disk configuration scenario. 

  

 

If you insert a bootable CD into the managed machine and execute Backup/Restore Scenario 
from the Web Console, the scenario executes on a machine other than the machine specified and 
the scenario completes normally, but a scenario execution error occurs on the machine specified 
in Operation. 

The machine may be mounted to multiple LAN boards which is executed the scenario, and 
each of those boards may be registered to DPM. If there are multiple registrations for the 
same machine, delete the unnecessary registrations, and then execute backup/restore 
again. 

  

 

Even if you set a bootable CD to start the machine, the backup/restore scenario does not start. 
Is the CD the first in boot order? 
If not, change the boot order so that CD boot comes first. 

  

 

If you insert the bootable CD and start the machine, A state of communication was bad 
condition is displayed on the screen. 

Some kind of error may have occurred. 
・ If timeout occurs before the managed machine connect to the Management Server: 

Set a greater value for Remote Power ON Timeout on the Network tab of the Detail 
Setting screen, and then run backup/restore again. 
For details, see Section 2.7.1.3, "Network Tab." 

・ If using a bootable CD and Do Not Use A DHCP Server is not selected on the DHCP 
Server tab of the Management Server Detail Setting screen: 
see Section 2.7.1.4, "DHCP Server Tab," and set the DHCP Server tab items which 
correspond to the correct environment. 
*The Management Server must be restarted after the configuration is changed. 

・ If the MAC address of the LAN board on the managed machine is not registered to DPM, 
which is in communication with Management Server: 
Register an appropriate MAC address to DPM, and execute backup/restore again. 

・ If neither of the above apply: 
For reasons such as the network being unconnected or influences from the network, the 
Management Server and the managed machine may be under a condition where they 
cannot connect with each other. Check the network status between the Management 
Server and the managed machine, and then execute backup/restore again.  
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If you insert the bootable CD and start the managed machine, the following message is displayed 
on the screen, and processing is interrupted: 

linuxrc: Cannot find CD-ROM Drives. 
This error occurs when the bootable CD is unable to recognize a device. 
If using a USB CD/FD drive, change the port which connects to the drive, and then try 
again. 
The CD drive used may not be supported by DPM. 
The following CD drives of Panasonic are able to be supported: 

KXL-840/RW11/RW20/RW21/RW31 
If you are using any of these drives, prepare another CD drive, or execute backup/restore 
by using Use A DHCP Server. 

  

 

Backup/restore does not start, and the following message appears on the screen. 
(The x below is a number. The following describes what to do if 5 is displayed for x.) 

ERROR: Failed to read a file (x) 
If backup target correspond to one of the following situation, error is displayed because the 
following target must be recognized earlier than disk, 
・ If a USB device is connected to backup target machine. 
・ When interface is existing for backup target machine in order to connect USB device. 
・ When CD-DVD drive is built in Enclosure. 
In this case, change the disk number of the scenario, and then execute the scenario. 
Also, the recognized disk number depends on the device, so if the same error occurs after 
changes, change the device numbers again and then execute backup. 

  

 

If restore is interrupted, the following messages are displayed: 
  ERROR: Found the eof during the input of a binary stream. 
  gzip: stdin: unexpected end of file. 

If restore is interrupted during data transfer, these messages may be displayed. If this 
message was displayed after restore was interrupted, execute restore again, or setup the 
OS. 
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11.15. PackageDescriber 
  

 

If you try to start PackageDescriber on Windows Vista, the following error is displayed: 
"Unable to access jarfile PackageDescriber.jar" 

The configuration of Temporary Save Folder may not have been modified from the default. 
Perform one of the following procedures: 
・ Disable user account control (User Account Control: UAC), and use PackageDescriber. 

To disable UAC, open Start menu -> Control Panel -> User Account, select Turn User 
Account Control on or off, then uncheck Use User Account(UAC) to help protect your 
computer. 

・ Run as Administrator. 
(1) Open Start menu -> All Programs ->right click on DPM PackageDescriber, and then 

select Properties. 
(2) The DPM PackageDescriber Properties screen is displayed. Next, perform the following 

configurations, and then click the OK button. 
・ Shortcut tab 

Edit the Target as follows. 
[Before edit] 

C:\Windows\system32\javaw.exe –jar PackageDescriber.jar 
[After edit] 

%ProgramFiles%\Java\jre6\bin\javaw.exe –jar PackageDescriber.jar 
・ Compatibility tab 

Check the Run this program as an administrator on the Privilege level. 
(3) The Access Denied screen appears. Click the Continue. 
(4) Right-click on the DPM PackageDescriber shortcut icon on the desktop, select 

Properties, 
and then perform configurations (2) to (3). 

 
The User Account Controls screen is displayed when PackageDescriber is started first time 
after the above configuration is performed. Click Allow. 
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11.16. Inquiry of Obstacle Occurrence 
 When you would like to inquire a failure while you use DPM, please send the following information: 

・ Information of DPM version/the module for the machine 
・ Managed machine information 

- Machine model/Product number 
- Configuration of optional products/Product number 
- Machine name 
- MAC address 
- OS type 

・ Date and time that the obstacle occurred 
・ Failure information 

- How to operate DPM, and what occurred. 
・ Display on screen 

- Management Server 
- Managed machine 

・ Repeatability 
- Always occurs 
- There is a case that it succeeds 
- Succeeded in the past, but it began to fail one day 
- On other managed machine, it occurred or not 

・ DPM log collected by DPM Log tool 
- Management Server 
- Managed machine 
*When the failure occurred, please collect log immediately 
If a scenario is executed on the same machine again, the log file maybe overwritten. 
After about 1 week since the failure occurred, the DHCP Server's log will be 

overwritten. 
・ The figure of network configuration 

 
The method to collect the DPM log is listed below. You may delete the collected log after inquiry. 
Target machine of collecting logs are the Management Server and managed machines. 

 
 Log collection Procedure (Windows IA32/EM64T)  
 

(1) End all the processes related to DPM. 
 
(2) Log on to the machine with Administrator right. 
 
(3) When you collect logs on the Management Server, it is unnecessary to do this procedure. 

Skip to (4).When you collect logs on the managed machine, copy the following folder to the 
arbitrary folder. 

 
 For SSC products: 

<Install Media>:\DPM\TOOLS\DpmLog 
For DPM products: 
<Install Media>:\TOOLS\DpmLog 
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(4) From Start menu, select Run and enter "cmd", and click OK. 

A command prompt is run. Move to the following folder. 
・ On the Management Server:  <DPM Server installation folder>\DpmLog 
・ On the managed machine:  The folder which was copied in the procedure (3). 

Example) If the location of the folder copied is Step (3) is C:\ in Step 3 
cd /d C:\DpmLog 

 
(5) Add option -A, and execute DpmLog.exe. Refer to the following message and send the 

collected log. 
 

 
 

 While DpmLog.exe is running, do not perform any DPM operation. 
 

(6) Delete the saved log folder. 

C:\DpmLog>DpmLog A[Enter] 
 

Collecting logs has finished. Compress the folder and send it. 
 
location: log 
 
If you set the log output mode with -T option, 
Reset the setting with -I option. 
 

C:\DpmLog> 
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 Log collection Procedure (Linux) 

Collect the following files. When you collect the files, try not to change the time stamp (for 
example, -p option of cp command), then use a command such as zip or gzip to compress on 
Linux, and then send. 

- System Setting File 
/etc/hosts 
/etc/resolv.conf 
/etc/sysconfig/network 
/etc/sysconfig/clock 
/etc/sysconfig/iptables 
/etc/sysconfig/ipchains 
/etc/rc.d/rc 
/etc/sysconfig/network-scritps/ifcfg-* 

 
- Files related to DPM Client 

All files located in folder /opt/dpmclient/ 
All files located in folder /var/log/message 
 

- Network Information 
Collect the execution results of the following command. 

ifconfig -a 
netstat -a | grep 560 
route 
ps -axm | grep depagtd 
iptables -L 
 

- System Information 
Collect the execution results of the following command. 

lspci -vx 
dmidecode 
biosdecode 
dmesg -s 65536 
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Appendix A Service List 
 
The followings are the DPM services and processes displayed in the Process tab of Windows Task 
Manager. 
 

 Processes for which service name is noted as None or (Child Process), are those processes 
which start at the time related functions are executed. They are not resident services. 

 
 DPM Server 

Service Name Process/File Name 
(Display number)*1 

Function 

DeploymentManager API Service apiserv.exe(1) Scenario execution and 
Configuration of each item 

 (Child process) mkParams.exe (optional) Tool to create the Windows 
disk duplication data file 

magicsend.exe(1) Execution of Remote 
Power-on 

ipconfig.exe (optional) Network Configuration 

nbtstat.exe (optional) Network Configuration 

DeploymentManager Backup/Restore 
Management 

bkressvc.exe(1) Execution of backup/restore 

DeploymentManager Get Client Information depssvc.exe(1) Receiving OS/service 
packs/patches information 
from a managed machine 

DeploymentManager PXE Management pxesvc.exe(1) Managing Network (PXE) 
booting 

 (Child process) ipconfig.exe (optional) Network configuration 

nbtstat.exe (optional) Network configuration 

DeploymentManager PXE Mtftp pxemtftp.exe(1) TFTP server function 
DeploymentManager Remote Update Service rupdssvc.exe(1) Execution of remote update 
 (Child process) zip.exe(1) File compressing tool 

unzip.exe(1) Command for extracting 
Compressed file 

DeploymentManager Schedule Management schwatch.exe(1) Managing schedule 
 (Child process) magicsend.exe(1) Execution of Remote 

Power-on 
ipconfig.exe (optional) Network Configuration 

nbtstat.exe (optional) Network Configuration 

DeploymentManager Transfer Management ftsvc.exe(1) File transfer service 
 (Child process) CHKOS32.exe (optional) Tool for acquiring information 

of OS 
SQL Server (DPMDBI) sqlservr.exe(1) *2 SQL database (DPM) 
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*1  
The default installation folder is C:\Program Files\NEC\DeploymentManager. 

*2  
The default installation folder is  
C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI\MSSQL\Binn. 

 
 Image Builder (Remote Console) 

Service Name Process/File Name 
(Display number)*1 

Function 

None DIBuilde.exe(1) Image Builder 

 (Child process ID) DIBPkgMake.exe(1) Tool for creating a package 

DIBPkgDel.exe(1) Tool for deleting a package 

mkParams.exe(1) Tool for creating the Windows disk duplication 
data file 

ExecLinuxIParm.jar(1) Tool for creating the Linux install parameters 

ExecLinuxSysRep.jar(1) Tool for creating the Linux disk duplication data 
file 

winftc.exe(1) File transferring tool 

zip.exe(1) File compression tool 

CHKOSCD.EXE(1) OS CD-ROM check tool 

CVTKEY.EXE(1) Convert tool 

*1  
The default installation folder is C:\Program Files\NEC\DeploymentManager. 
 

 DPM Command Line 
Service Name Process/File Name 

(Display number)*1 
Function  

None dpmcmd.exe (optional) Scenario execution from command line 

*1  
The default installation folder is C:\Program Files\NEC\DeploymentManager. 
 

 DPM Client (Windows) 
Service Name Process/File Name 

(Display number)*1 
Function  

DeploymentManager Agent 
Service 

DepAgent.exe(1) Execution of power on and off from the DPM 
Server 

DeploymentManager Remote 
Update Service Client 

rupdsvc.exe(1) Execution of remote update 
Sending OS/service packs/patches 
information to 
the DPM Server 

 (Child process ID) unzip.exe(1) Command for extracting 
Compressed file 

Executable File (1) Package Installer 

None DPMTray.exe (optional) Automatic update status display 
*1  

The default install folders are: 
• Computer with IA32 architecture: C:\WINDOWS\system32 
• Computer with EM64T architecture: C:\WINDOWS\SysWOW64 
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 DPM Client (Linux) 

Service Name Process/File Name 
(Display number) 

Function  

Depagt depagtd(1,2)*1 Remote update service Agent service 
 (Child process ID) 

Starts by system 
function 

depagtd(1) Remote update service Agent service 
rpm(1)  rpm package installer 
shutdown(1) Shutdown command 
mv(1) Command for file transferring 
echo(1) Command for displaying messages 
unzip(1) Command for extracting compressed 

files 
touch(1) Command for changing the time stamp 

*1  
The install directory is fixed value /opt/dpmclient/agent/bin. 

 

Methods and Order of Start Service, Stop 
Service 
The DPM Server is linked to and dependent on each DPM related service, so please manually start or 
stop services in the following order. 
Furthermore, there is no start/stop order for any of the DPM Client services. 
 
•Start service order 
(1) SQL Server (DPMDBI) 
 
(2) Services that begin with DeploymentManager 

 
•Stop service order 
(1) Services that begin with DeploymentManager 
 
(2) SQL Server (DPMDBI) 
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Appendix B Event Log 
 
About the event log, please contact your sales or support representative. 
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Appendix C Error Information 
 
About error information, please contact your sales or support representative 
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Appendix D Network Port and Protocol 
List 

 
 Communication Ports used by DPM  

 
 About opening the communication port using by DPM automatically or manually, refer to Section 7.1, 

"Port opening tool". 
 

• Management Server and managed machine Communications 
Item Management Server Protocol Connecti

on  
Direction 

Address 
Specifica
tion 

Managed Machine 
Executable 
File Name 

Port  
No. 

Port No. 
Modify 
Permis
sion 

Port  
No. 

Port No. 
Modify 
Permis
sion 

Executab
le File 
Name 

Power 
On 

magicsend.e
xe 

*1 Deny UDP -> DirectBro
adcast 

*2 

5561 Deny  

Shutdow
n 

apiserv.exe 
schwatch.ex
e 

*1 Deny TCP -> Unicast 56010 Deny For 
Windows:  
DepAgent
.exe 
 
For Linux:  
Depagtd 

Existenc
e 
Confirma
tion 
(Power 
ON/OFF 
Status 
Check) 

apiserv.exe 
schwatch.ex
e 

- *3 Deny ICMP 
Echo 

request 

-> Unicast 8 *3 Deny  

apiserv.exe 
schwatch.ex
e 

0 *3 Deny ICMP 
Echo 

request 

← Unicast - *3 Deny  

Network 
Boot 

pxesvc.exe 67 Deny DHCP ← Broadcast 
*4 *5 68 Deny  

pxesvc.exe 4011 Deny UDP ← Unicast 68 Deny  
pxesvc.exe 4011 Deny UDP ← Unicast 4011 Deny  
pxemtftp.exe 69 Deny UDP 

(TFTP) 
-> Unicast *6 Deny  

bkressvc.exe 56030 Deny TCP ← Unicast 56030 Deny  
bkressvc.exe 56022 Deny TCP ← Unicast 56022 Deny  

OS 
installati
on by 
disk 
duplicati
on *7 

ftsvc.exe 56023 Deny TCP ← Unicast *1 Deny  

Restore/
Multicast 
*8 

ftsvc.exe 56023 Deny TCP ← Unicast *1 Deny  
bkressvc.exe 56020 Deny TCP ← Unicast 56020 Deny  
bkressvc.exe 56021 Deny UDP -> Multicast 56021 Deny  
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Restore/
Unicast 
*8 

ftsvc.exe 56023 Deny TCP ← Unicast *1 Deny  
bkressvc.exe 56020 Deny TCP ← Unicast 56020 Deny  

Backup 
*8 

ftsvc.exe 56023 Deny TCP ← Unicast *1 Deny  
bkressvc.exe 56020 Deny TCP ← Unicast 56020 Deny  

Disk 
Format 
Check *8 

ftsvc.exe 56023 Deny TCP ← Unicast *1 Deny  

Installing 
service 
packs, 
hotfixes, 
Linux 
patch 
files, and 
applicati
ons by 
remote 
update 

rupdssvc.exe *1 Deny TCP -> Unicast 56000 Deny For 
Windows:  
rupdsvc.e
xe 
 
For Linux:  
Depagtd 

rupdssvc.exe *1 Deny UDP -> Multicast 56001 Deny For 
Windows:  
rupdsvc.e
xe 
 
For Linux:  
Depagtd 

rupdssvc.exe 56028 
 

Deny TCP ← Unicast *1 Deny rupdsvc.e
xe 
(Windows 
only) 

Acquisiti
on of 
managed 
machine 
OS/HotFi
x 
informati
on 

depssvc.exe 56011 Deny TCP ← Unicast *1 Deny For 
Windows:  
rupdsvc.e
xe 
 
For Linux:  
Depagtd 

Automati
c Update 
Request 

rupdssvc.exe 56024 Deny TCP ← Unicast *1 Deny rupdsvc.e
xe 

rupdssvc.exe 56028 Deny TCP ← Unicast *1 Deny rupdsvc.e
xe 

automati
c update 
notice 

rupdssvc.exe *1 Deny TCP -> Unicast 56025 Deny rupdsvc.e
xe 

rupdssvc.exe 56024 Deny TCP ← Unicast *1 Deny rupdsvc.e
xe 

rupdssvc.exe 56028 Deny TCP ← Unicast *1 Deny rupdsvc.e
xe 

Operatio
n without  
using 
DHCP 
Server  

pxesvc.exe 56060 Deny TCP ← Unicast *1 Deny  
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*1 
The port is automatically assigned. 

*2 
A machine with the same segments as the Management Server is addressed 255.255.255.255. 
If the segments are different than those of the Management Server, the address specification is 
direct broadcast. 
Example) The segment 192.168.0.0(MASK=255.255.255.0) is addressed 192.168.0.255. 

*3 
With ICMP (Internet Control Message Protocol), communication specifying the port number is not 
performed, but is routed using the value in the ICMP Type field value. 

*4 
A packet relayed by DHCP relay may be addressed as Unicast. 

*5 
Only if the DHCP and Management Server are installed on different machines. 

*6 
Depends on the LAN board ROM of the machine. 

*7 
The protocols and port numbers listed in Restore are also required. 

*8 
If operations are performed using DHCP, the protocols and port numbers listed in Network Boot 
items are also required. 
If operations are performed without using DHCP, the protocols and port numbers listed in 
Operation without Using DHCP Server are also required. 

 
 When OS of managed machine is Windows Vista/Windows 7/Windows Server 

2008/Windows Server 2008 R2, depending on the status of the network used when the 
DPM Client is installed, either of ports in public profile, private profile or domain profile of 
Windows Firewall will be opened 
 
When the managed machine joins domain and the Domain Profile is changed, the port 
used by DPM will be blocked, and cannot communicate anymore. 
Open the port in Domain Profile used by DPM in advance on the managed machine that 
joins domain or the master machine of OS installation by disk duplication, 
Open the managed machine's ports in Domain Profile, following steps below. 
･Setup by domain policy: 
Configure the domain policy of domain controller on Windows Server 2008(or later), 

･Setup locally on the managed machine: 
(1) On the managed machine, from Inbound Rules of Windows Firewall with 

Advanced Security, right-click the following items and select Properties. 
-Common 
DeploymentManager(TCP:56000) 
DeploymentManager(TCP:56010) 
DeploymentManager(TCP:56025) 
DeploymentManager(UDP:56001) 

-Windows Vista/Windows7 
Network - Echo Request(ICMPv4-In) 

-Windows Server 2008/Window Server 2008 R2 
File and Printer Sharing (Echo Request – ICMPv4-In)   

(2) In Advanced tab of Properties dialog, select Domain checkbox in Profiles. 
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•Communication between DHCP server and managed machine 

Item DHCP Server  Protocol Connecti
on 
Direction 

Address 
Specifica
tion 

Managed Machine 
Executable 
File Name 

Port  
No. 

Port No. 
Modify 
Permis
sion 

Port  
No. 

Port No. 
Modify 
Permissi
on 

Executable 
File Name 

Network 
Boot 

 67 Deny DHCP ← Broadcast 
*1 68 Deny  

*1 
A packet relayed by DHCP relay may be addressed as Unicast. 

 
• Communication between NFS Server and managed machine 

Item NFS Server  Protocol Connecti
on 
Direction 

Address 
Specifica
tion 

Managed Machine 
Executable 
File Name 

Port 
No. 

Port No. 
Modify 
Permis
sion 

Port 
No. 

Port No. 
Modify 
Permissi
on 

Executable 
File Name 

OS Clear 
Installation 

- *1 111 Deny TCP ← Unicast *2 Deny *1 
- *1 111 Deny UDP ← Unicast *2 Deny *1 
- *1 1048 

*3 
Deny TCP ← Unicast *2 Deny *1 

- *1 1048 
*3 

Deny UDP ← Unicast *2 Deny *1 

- *1 2049 Deny TCP ← Unicast *2 Deny *1 
- *1 2049 Deny UDP ← Unicast *2 Deny *1 

*1 
The file name is a Linux OS related module. (Not included in DPM products.) 

*2 
The port is automatically assigned. 

*3 
This port number may be dynamically changed. If communication fails, use the "rpcinfo -p" command to 
check the port number used by mountd (NFS mount daemon) service, and then open the port. If the 
problem is not solved by this method, turn off the Windows firewall. 

 
• Communication between Web Console and Management Server 
Item Machine used for Web 

Console 
Protocol Connecti

on 
Direction 

Address 
Specifica
tion 

Management Server 

Executable 
File Name 

Port 
No. 

Port No. 
Modify 
Permis
sion 

Port 
No. 

Port No. 
Modify 
Permissi
on 

Executable 
File Name 

Web 
console 

 
*1 

Deny 
HTTP 

-> Unicast 
80 

Deny Web 
service 
(IIS) 

* 1 
The port is automatically assigned. 
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• Communication between Image Builder (Remote Console) and Management Server 
Item Machine used for Image 

Builder (Remote Console) 
Protocol Connecti

on 
Direction 

Address 
Specifica
tion 

DPM Server 

Executable 
File Name 

Port 
No. 

Port No. 
Modify 
Permis
sion 

Port 
No. 

Port No. 
Modify 
Permissi
on 

Executable 
File Name 

Image 
Builder 
(Remote 
Console) 

DIBuilde.exe 

*1 

Deny 

TCP 

-> Unicast 
5602
3 

Deny ftsvc.exe 

* 1 
The port is automatically assigned. 

 
• Communication between DPM Command Line and Management Server 
Item Machine used for DPM 

Command Line 
Protocol Connecti

on 
Direction 

Address 
Specifica
tion 

Management Server 

Executable 
File Name 

Port 
No. 

Port No. 
Modify 
Permis
sion 

Port 
No. 

Port No. 
Modify 
Permissi
on 

Executable 
File Name 

DPM 
Command 
Line 

dpmcmd.exe 
*1 

Deny 
HTTP 

-> Unicast 
80 

Deny Web service 
(IIS) 

* 1 
The port is automatically assigned. 

 
 Depending on the type of OS, the DPM service may not be able to start if there is a port conflict 

between the DPM service and other service or application causing by the Ephemeral port. For 
methods of checking and handling problems with ephemeral ports, see "Regarding ports used by 
DPM", of Section 2.2.1, "Regarding the Network Environment," in First Step Guide. 

 
 For router and switch configuration, refer to the HW manual, or contact the vendor. 
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Appendix E DPM Log Output 
 
 DPM Server 

DPM outputs the following logs. 
 

Folder <DPM Server Install Folder>\Log 
(Default: C:¥Program Files¥NEC¥DeploymentManager\Log) 

File apiserv.csv 
apitrace.log 
bkressvc.csv 
DepInit.csv 
depssvc.csv 
DIBPkgMake.csv 
ftsvc.csv 
pmdb.log 
pminfo.log 
pxemtftp.csv 
pxesvc.csv 
rupdssvc.csv 
schwatch.csv 
rupdssvc_managed machine MachineName_ managed machine 
MACAddress.log 
CmdUserJSLog_YYYYMMDD.csv 
CmdSelfJSLog_YYYYMMDD.csv 

*YYYYMMDD is a date. 
Output Content DPM trace log, monitor log, error information, database access log 
Recording Method The maximum size of apitrace.log is 1MB. The maximum size of 

pmdb.log and pminfo.log is 16KB. There is no maximum size restriction 
for CmdUserJSLog_YYYYMMDD.csv and 
CmdSelfJSLog_YYYYMMDD.csv, and the maximum size of the other 
files is 10MB. 
 
All *.csv files except CmdUserJSLog_YYYYMMDD.csv  
and CmdSelfJSLog_YYYYMMDD.csv are 5 generation management.  
(If *.csv exceeds the maximum file size, the file is renamed to *.csv.1, and 
each original *.csv.n file is renamed to *.csv.n+1, and *.csv.4 is deleted.) 
CmdUserJSLog_YYYYMMDD.csv and CmdSelfJSLog_YYYYMMDD.csv 
are saved by the date (YYYYMMDD) on that day. 
If apitrace.log exceeds the maximum file size, the overwritten in order 
from the top location in the file. 
 
pmdb.log and pminfo.log and rupdssvc_manmaged machine 
MachineName_managed machine MACAddress.log are 2 generation 
management. (If the maximum file size is exceeded, the file is renamed 
to *.log.bak, and the original *.log.bak is deleted.) 
 
Furthermore, each file can be deleted manually. (*.csv and apitrace.log 
cannot be deleted while DPM Service is running. After the service is 
stopped, the logs can be manually deleted.) 
 
CmdUserJSLog_YYYYMMDD.csv and CmdSelfJSLog_YYYYMMDD.csv 
files that are dated to the current day cannot be deleted while DPM 
Service is running. Thus, only those files whose dates have already 
passed can be manually deleted. Furthermore, a file is automatically 
deleted when 30 days have elapsed from the file creation date. 
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Folder <DPM Server Install Folder>\Datafile\LogFile\SnrReport  

(Default: 
C:¥Program Files¥NEC¥DeploymentManager\Datafile\LogFile\SnrReport) 

File Scenario.rpt 
Output Content Scenario Execution Results 
Recording Method There is no maximum size restriction for the file. About 80 single-bytes 

increase per each time when a scenario starts/finishes. 
Furthermore, you can delete it from the Web Console. (For delete 
procedure details, see Section 4.5.2, "Delete.Log") 

 
Folder <DPM Server Install Folder>\DataFile\LogFile\AuReport  

(Default: 
C:¥Program Files¥NEC¥DeploymentManager\DataFile\LogFile\AuReport) 

File Index.rpt 
managed machine MACaddress.rpt 

Output Content Execution log for automatic update (application automatic delivery) on a 
managed machine 

Recording Method Each managed machine is individually managed by MAC address. 
There are no maximum size restrictions on these files. 
The maximum record numbers of the logs can be set from the Web 
Console. 
 
According to the setting of maximum number of logs, if the log number 
exceeds it, the logs will be deleted from index.rpt file from the oldest in 
order, or 10% of the logs will be deleted from the oldest. 
 
For maximum number of log settings, see Section 4.7.2, "Maximum 
Number of Logs Settings"  
 
Furthermore, when the oldest log records from Index.rpt are deleted, the 
related information is deleted from managed machine MACaddress.rpt. 
Also, you can delete the log file from the Web Console. (For delete 
procedure details, refer to Section 4.7.4, "Delete Log") 

 
Folder <DPM Server Install Folder>\Datafile\JSLog 

(Default: 
C:¥Program Files¥NEC¥DeploymentManager\Datafile\JSLog) 

File MngUserJSLog_YYYYMMDD.csv 
MngSelfJSLog_YYYYMMDD.csv 
 
* YYYYMMDD is a date. 
*Image Builder and DPM Command Line are installed when DPM Server is 
installed, so in addition to the above, refer to "Image Builder (Remote 
Control)", and "DPM Command Line "described later. 

Output Content Monitor log (the user operations/DPM Server internal operations) 
Recording Method Each file is saved to a file dated to the current day. 

There are no maximum size restrictions on these files. 
The files dated to the current day cannot be deleted while DPM Service is 
running. Only those files whose dates have already passed can be 
manually deleted. Furthermore, a file is automatically deleted when 30 
days have elapsed from the file creation date. 
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Folder <DPM Server Install Folder>\WebServer\Logs  

(Default:  
C:¥Program Files¥NEC¥DeploymentManager\WebServer\Logs) 

File Browser.log 
Error.log 
JSOX-Event.csv 
LibAPI.log 
Polling.log 
Trace.log 
WebConsole.log 

Output Content Web Console error notifications, traces, and monitor logs 
Recording Method The maximum size of Polling.log is 1MB. The maximum size of the other 

files is 10MB. 
 
Polling.log is increased in one file, and the JSOX-Event.csv file is 2 
generation management. (If the maximum file size is exceeded, the file 
name is renamed to JSOX-Event.csv.1, and the original 
JSOX-Event.csv.1 is deleted.) 
 
The other files are 6 generation management. (If *.log exceeds the 
maximum file size, the file name is renamed to *.log.1, and each original 
*.log.n file is rename to *.log.(n+1), and *.log.5 is deleted.)  
Each file can also be deleted manually. 

 
Folder <Folder for Image>\upload\dpmupload 

(Default: C:\Deploy\upload\dpmupload) 
File managed machine MACaddress_B.zip 

managed machine MACaddress_B.Error.zip 
managed machine MACaddress_R.zip 
managed machine MACaddress_R.Error.zip 
managed machine MACaddress_P.zip 
managed machine MACaddress_P.Error.zip 
managed machine MACaddress.zip 
managed machine MACaddress_Error.zip 

Output Content managed machine-side results from execution of backup/restore/disk 
format check 

Recording Method Each managed machine is individually managed by MAC address. 
The maximum size of each file is approx. 50KB, and the file is overwritten 
each time a scenario executes. Furthermore, the file can be deleted 
manually. 

 
Folder %SystemRoot% 

(Default: C:\WINDOWS)  
File Inst_Dpm_Db.log 

Inst_Dpm_Ports.log 
Inst_DPM_Mng.log 
Inst_Dpm_Jre.log 
Inst_DPM_Win_Cli.log 

Output Content DPM installation log 
Recording Method There are no file size restrictions on any of the files. 

Inst_Dpm_Db.log and Inst_Dpm_Jre.log files are overwritten each time 
DPM Server is installed, and do not increase in size after DPM Server is 
installed. Other files monotonically increase. 
Furthermore, each file can also be deleted manually. 



Appendix E DPM Log Output 

DeploymentManager Ver6.0 Reference Guide 
548 

 
Folder %ProgramFiles%\MSSQL10_50.DPMDBI\MSSQL\Log 

(Default: 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI 
\MSSQL\Log) 

File ERRORLOG 
log_n.trc (n is a number) 

Output Content SQL Server log 
Recording Method There are no file size restrictions on any of the files. 

 
ERRORLOG is 7 generation management. (If ERRORLOG exceeds 
the maximum file size, the file name is changed to ERRORLOG.1, and 
each original ERRORLOG.n file is changed to become 
ERRORLOG.(n+1), and ERRORLOG.6 is deleted.) 
 
log_n.trc is 5 generation management. (If SQL Server (DPMDBI) 
service is restarted at a state in which log_1.trc to log_5.trc exist, 
log_1.trc is deleted, and new log_6.trc is created.) 
 
Furthermore, ERRORLOG cannot be deleted. 
Log_n.trc cannot delete while SQL Server (DPMDBI) service is running. 
Thus, only logs whose dates have already passed can be manually 
deleted. 

 
 DPM Client (Windows) 

Logs output to the managed machine installed with DPM Client (Windows) are as follows: 
 

Folder •For IA32 
C:\WINDOWS\system32 

• For EM64T 
C:\WINDOWS\SysWOW64 

File DepAgent.log 
rupdsvc.log 
DPMTray.log 

Output Content DPM Client service log 
Recording Method The file size of DPMTray.log can be a maximum 1MB. Other files are 

maximum 2MB. 
DepAgent.log and rupdsvc.log are 2 generation management. (If the 
maximum file size is exceeded, the file name is changed to *.log.bak, 
and the original *.log.bak is deleted.) 
Each file can also be deleted manually. 

 
Folder %SystemRoot%\DeploymentManager\JSLog 

(Default:C:\WINDOWS\DeploymentManager\JSLog)  
File CliSelfJSLog_YYYYMMDD.csv 

  *YYYYMMDD is a date. 
Output Content Monitor log (DPM Client internatl operations) 
Recording Method There are no file size restrictions. 

Saved to a file dated to the current day. 
Files dated to the current day cannot be deleted while DPM Service is 
running. Thus, only those files whose dates have already passed can 
be manually deleted. Furthermore, a file is automatically deleted when 
30 days have elapsed from the file creation date. 
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 DPM Client (Linux) 

Logs output to the managed machine installed with DPM Client (Linux) are as follows: 
 

Folder /opt/dpmclient/agent/log 
File depinst.log 
Output Content Install log for DPM Client (Linux) 
Recording Method There are no restrictions on file size, and the file is overwritten each time 

the DPM Client (Linux) is installed. 
Furthermore, the file can be deleted manually. 

 
 Image Builder (Remote Console) 

The following logs are output to the machine installed with Image Builder (Remote Console): 
 

Folder <Install folder for Image Builder (Remote Console)>\Datafile\JSLog  
(Default: C:¥Program Files¥NEC¥DeploymentManager\Datafile\JSLog) 

File ImgUserJSLog_YYYYMMDD.csv 
ImgSelfJSLog_YYYYMMDD.csv 

* YYYYMMDD is a date. 
Output Content Monitor log (operations performed by the user/Image Builder internal 

operations) 
Recording Method There are no maximum size restrictions for each file, and each file is 

saved to a file dated to the current day. 
Files dated to the current day cannot be deleted while DPM Service is 
running. Thus, only those files whose dates have already passed can be 
manually deleted. Furthermore, a file is automatically deleted when 30 
days have elapsed from the file creation date. 

 
 DPM Command Line 

Logs output to the machine installed with DPM Command Line are as follows: 
 

Folder <DPM Command Line Install Folder>\Log  
(Default: C:¥Program Files¥NEC¥DeploymentManager\Log) 

File DPM_Trace1.csv 
Output Content Monitor log (operations performed by the user/DPM Command Line 

internal operations) 
Recording Method DPM_Trace1.csv is a maximum 10MB. 

5 generation management. (If DPM_Trace1.csv exceeds the maximum 
file size, the file name is changed to DPM_Trace2.csv, and each original 
DPM_Tracen.csv file is changed to become DPM_Trace[n+1].csv, and 
DPM_Trace5.csv is deleted.) 
Each file can also be deleted manually. (Files cannot be deleted while 
DPM Command Line is running. After DPM Command Line exits, the files 
can be manually deleted.) 
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Appendix F How to Check Component 
Versions 

 
 DPM Server 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 
4) Check the Version displayed on DeploymentManager (DPM Server). 

Example) 6.00.000 
 
 DPM Client (Windows) 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 
4) Check the Version displayed on DeploymentManager. 

Example) 6.00.000 
 
 DPM Client (Linux) 

1) Execute the command below, and check the version displayed. 
cd /opt/dpmclient/agent/bin 
depagtd –v 

 
Example) DeploymentManager Ver6.0 

 
 Image Builder (Remote Console) 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 
4) Check the Version displayed on DeploymentManager (Image Builder). 

Example) 6.00.000 
 
 DPM Command Line 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 
4) Check the Version displayed on DeploymentManager (DPM Command Line). 

Example) 6.00.000 
 
 PackageDescriber 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, check the Version check box and click the OK button. 
4) Check the Version displayed on DPM PackageDescriber. 

Example) 6.00.000 
 
 Web Console 

Check the bottom of the screen (footer) in Web Console. 
For methods to start or login Web Console, refer to Section 5.1.1, "Starting the Web Console" and 
Section 5.1.2, "Log In," of the Installation Guide. 

Example) Version: DeploymentManager 6.0 
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Appendix G Glossary 
 

 Alphabetical order 
 

A 
 
 
 

Automatic Download Function which automatically downloads a new package from the Package 
Web Server to the Management Server at timing configured in advance. 

automatic update The managed machine checks the Management Server at timing configured 
in advance, if there has packages which has not been applied. It will send 
distribution request and automatically apply those packages. 

automatic update notice Notification that the Management Server issues to the managed machine so 
that automatic update can be performed in real time when a package of 
highest urgency is registered to the Management Server. 

B  
 
 

Backup/Restore Function to backup or restore data contained on a disk by either disk unit or 
partition unit. 

D  
 
 

Deploy-OS A Linux OS (kernel) customized for DPM that runs on the managed machine. 
The Deploy-OS is sent to the managed machine from the Management 
Server, and deploys on the memory of the managed machine during 
backup/restore/disk configuration check. 
Furthermore, if operation without using a DHCP server, Deploy-OS is 
included in the bootable CD. 

DHCP server DHCP (Dynamic Host Configuration Protocol) is a protocol that dynamically 
modifies the IP address. 
DHCP sever refers to the machine or network device which has the 
functionality to provide configuration information by DHCP. 
In DPM, the DHCP server is used when a managed machine performs a PXE 
boot, or to assign an IP address during OS installation by disk duplication. 

Disk configuration check  Function to check disk configuration before backup/restore is executed. You 
can confirm the disk number specified at the time of backup/restore. 

DPM Client DPM component. It runs on a managed machine and transfers data to the 
DPM Server. Also controls the managed machines (shutdown and other 
operations) and sends information such as package applied/not applied. 

DPM Command Line DPM component. It performs processes such as status check of the 
managed machine and scenario execution from the command line. 

DPM Server DPM component. It performs processes to the managed machine through 
Web Console operations or the DPM Command Line. 
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E  
 
 

Effective sector backup Backup of the only effective sectors of a hard disk. 

ESX, ESXi Virtualization software offered by VMWare, Inc. 

Express5800 Series Business-oriented workstation server offered by NEC. 

Full sector backup Backup all sectors of hard disk. 

G  
 
 

Guest OS The OS operating on the virtual machine. 

H  
 
 

Host OS Indicates the OS which is the infrastructure on which virtual machine 
programs run. 

Hyper-V Microsoft virtualization software offered by Microsoft. 

I  
 
 

IIS Abbreviation for Internet Information Services, software for internet services 
offered by Microsoft. 

Image Builder Create packages, and disk duplication data files used by OS installation by 
disk duplication, and then registers them to the Management Server. 

Image Builder (Remote 
Console) 

Image Builder used on machine other than the Management Server. 

Install Media Indicates the media bundled in DPM product. 

L 
 
 
 

LAN board Board used to connect to a LAN (Local Area Network). Also called NIC 
(Network Interface Card) or LAN adaptor. 
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M  
 
 

MAC Address Abbreviation for Media Access Control address, which is a fixed ID number 
for each LAN board. 

Managed Machine Machine which managed by DPM. May be noted as Computer, Client, or 
Client Computer. 

Management Server The physical server that DPM Server is installed. 

Master Image Disk image of the machine which is the master of OS installation by disk 
duplication source. 

Master Machine The machine which is the master of OS installation by disk duplication 
source. 

O  
 
 

OS clear Installation Function that installs RedHat Enterprise Linux while setting detailed 
configurations for the managed machine. 

OS installation by disk 
duplication 

Machine cloning function using Sysprep tools (master image creation tools) 
and DPM backup/restore functionality. 

P  
 
 

Package  The combination of patch, application or package application file. 
Created by either Image Builder or PackageDescriber. 

Package Information File File that basic information, execution information, applicable OS information, 
dependent information and identification information of a patch or an 
application are stored. 
Created by either Image Builder or PackageDescriber. 

Package Registration Upload a package created by PackageDescriber to the Package Web Server. 
Furthermore, the package needs to be re-uploaded if has been modified by 
PackageDescriber to the Package Web Server. 

Package Web Server  The web server which stores the packages. The Package Web Server can 
share packages for multiple Management Servers. Access must be allowed 
by HTTP protocol. 

PackageDescriber DPM component. A tool that creates packages and registers them to the 
Package Web Server. 

Patch Windows OS service packs and HotFix releases by Microsoft. 

PXE boot (network boot) Abbreviation for Preboot eXecution Environment boot. 
A boot method that using PXE (network booting standard) by the LAN board 
to start a program through the network. 
It is used by DPM to detect a managed machine, or to perform 
backup/restore or package distribution. 
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R  
 
 

Remote update Installing service packs, HotFix, Linux patch files, and applications, and 
applications 

S  
 
 

Scenario  A configuration used to execute processes such as Distribution of floppy disk 
image for BIOS/firmware, OS clear installation, Installing service packs, 
HotFix, Linux patch files, and applications, and backup/restore/disk 
configuration check. 

SigmaSystemCenter The management software of IT platforms including virtual environment. 
DPM is bundled into SSC software suit. 

SQL Server Relational model database server provided by Microsoft. The data of DPM is 
stored in SQL Server. 

Sysprep Windows OS deployment tool provided by Microsoft. 

U  
 
 

US110 Small-sized desktop thin client terminal used by a thin client system. 

V  
 
 

Virtual Machine Indicates the machines virtually run on the virtual machine server. 

VirtualPCCenter Software product that manages a virtual PC-type thin client. 

VLAN Technology which builds a logical network, and then divides the network into 
multiple broadcast domains, unlike physically network configuration. 

W  
 
 

Web Console Checks the status of a managed machine and executes processes to a 
managed machine. 

WOL(Wake On LAN) Function in which allows a machine to be turned on the power by a network 
message from another machine. 

X  
 
 

XenServer Virtualization software provided by Citrix. 
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Appendix H Windows OS/Service Pack 
Support 

 
About the Windows OS/service pack information for DPM, please contact your sales or support 
representative. 
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Appendix I Revision History 
 
 First Edition(Rev.001)(2011.09): New 
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